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This document provides information on the dispatch console configuration and dispatch functions. It is intended for

dispatch console administrators who configure SmartPTT Dispatcher and operators who will use it.

Additional Information

The document assumes that radioserver is properly configured and started. All the required configuration is

presented in SmartPTT Installation and Configuration Guide.

The document does not provide information on dispatch console computer configuration and its operating system

administration. All the necessary information can be obtained from the Microsoft Docs website, a Microsoft

documentation storage for end users, developers, and IP professionals.

About This Document

https://docs.microsoft.com/en-us/
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1 SmartPTT Dispatcher Interface

SmartPTT Dispatcher interface includes various elements, indications, and controls that provide you with the

necessary information and functionality.

NOTE

Some SmartPTT Dispatcher elements are unavailable if the operator does not have corresponding rights.

SmartPTT Dispatcher interface is divided into the following sections:

• Title bar

• Menu bar with Quick launch buttons

• Main area

• Information bar

Title Bar

The title bar is located at the top of SmartPTT Dispatcher. It shows the application icon (   ), application name with

the current operator name in the Dispatcher - <name> format, and standard Windows  Minimize (   ), Maximize ( 

 ), and Close (   ) buttons.
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Menu Bar

The menu bar is located under the title bar and provides menus and quick access buttons to open panels and

windows, and perform various operations in the system. The menu bar provides the following elements:

Tools

Contains all the panels used in SmartPTT Dispatcher. When a panel is open, in the Tools menu, a check mark icon

appears next to the panel name. For details, see Tools.

Map

Provides the ability to open and configure a range of maps, and to manage displaying of radios and other objects

on maps. For details, see Maps.

Event Log

Provides the ability to view information on all events registered in the SmartPTT Dispatcher database, and

configure Event Log settings. For details, see Event Log.

Service

Contains a range of secondary functions, including radio check, saving and restoring dispatcher settings,

configuring voice notifications, and so on. For details, see Service.

Reports

Provides the ability to build reports on the basis of system events. For details, see Reports.

Quick Launch Buttons

Provide a quick access to some application functionality:

• The Conference Call (   ) button opens the Conference Call window for initiating conference calls. For

details, see Conference Calls.

• The Telephone Subscribers (   ) button opens the Telephone Subscribers window for initiating calls to

telephone subscribers from SmartPTT Dispatcher. For details, see Telephone Interconnect.

• The Dispatchers (   ) button opens the Dispatchers window for initiating calls to external dispatchers from

SmartPTT Dispatcher. For details, see Dispatchers.

Settings (   )

Provides the ability to configure system settings such as general settings, sound and control devices settings, and

so on. For details, see Settings.

Help (   )

Provides the ability to read the application help file, learn about the application, and check for updates. For details,

see Help.

UI Layout Settings (   )

Provides the ability to save, lock, or apply the saved console layout. For details, see UI Layout Settings.

Change Operator (   )

Restarts SmartPTT Dispatcher to select another operator.
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Main Area

The main area of SmartPTT Dispatcher is a main working area in which all open panels and windows appear.

Information Bar

The information bar is located at the bottom of SmartPTT Dispatcher and provides the following elements:

• The Unread messages button with the number of unread messages (if you have them) in the left corner.

• Name of the currently selected/unselected object in green.

• Name of a license customer, and the license expiration date next to the caption The license belongs to.

• The application version in the right corner.

For information on layout customization, see the sections below.

1.1 Layout Customization

SmartPTT dispatch console provides the ability to customize its layout in the following ways:

• Move panels

• Tab panels

• Undock panels

• Resize panels

For information on layout customization, see the sections below.

1.1.1 Moving Panels

Follow the procedure to move a panel inside the main area.

Prerequisites: 

Ensure the current layout is unlocked.

Procedure: 

1. Press and hold the title bar of the desired separate or tabbed panel, and then drag it.

In the main area, the positioning controls appear.

2. Move the panel to the desired position:

To move the panel and attach it to one of

the main area sides,

drop it to the corresponding positioning control of the main

area.
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The panel is moved and attached to the selected main area

side. Other opened panels move to the opposite direction.

To move the panel to the side of another

panel,

drop it on the corresponding positioning control inside the

another panel.

The first panel is moved and attached to the selected side of

the second panel. The second panel moves to the opposite

direction.

NOTE

Do not drop the panel on the Tabbing (   ) control unless

you want to tab panels.

For information on tabbing panels, see Tabbing Panels.
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1.1.2 Tabbing Panels

Follow the procedure to tab panels into a tab panel.

NOTE

The Calls, Sound, Cross Patches, and Radio Fleet panels cannot be tabbed.

Prerequisites: 

• Ensure the current layout is unlocked.

• Ensure in the main area open at least two panels that can be tabbed.

Procedure: 

1. Press and hold the panel title bar, and then drag it over the second panel.

On the second panel, the positioning controls appear.

2. Drop the panel on the Tabbing (   ) control.

The panels become tabbed.
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1.1.3 Undocking Panels

Follow the procedure to undock a panel into a separate window.

Prerequisites: 

Ensure the current layout is unlocked.

Procedure: 

In the main area, press and hold the title bar of the panel, and then drag it to any place of the screen except the

positioning controls.

The panel appears as a separate window.

1.2 UI Layout Settings

The UI Layout Settings (   ) menu provides the ability to save, lock, or apply the existing dispatch console layout.

The menu provides the following options:

• Locking the current layout.

For details, see Lock UI Layout.

NOTE

The Lock UI Layout option is available only to the Administrator.

• Managing user interface layouts.

For details, see Set UI Layout.

NOTE

The Set UI Layout option is unavailable if the layout is locked.

1.2.1 Lock UI Layout

The Lock UI Layout option provides the ability to lock the current layout.

Important

Only the Administrator can lock the layout.

When the layout is locked, the dispatcher cannot perform the following actions:

• Open and close panels

• Move and tab panels

• Switch between user interface layouts

• Resize open panels

For information on locking the user interface layout, see the section below.
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1.2.1.1 Locking Layout

Follow the procedure to lock the current layout.

Procedure: 

On the menu bar, click UI Layout Settings (   ) → Lock UI Layout.

The check mark icon appears to the left of the Lock UI Layout option. The layout is locked.

NOTE

If the Event Log is open when the layout is locked, all features for the Event Log management are available to the

dispatcher. If closed, the Event Log becomes unavailable.

Postrequisites: 

To unlock the layout, click Lock UI Layout again.

The check mark icon disappears.

1.2.2 Set UI Layout

You can use the Set UI Layout feature to perform the following actions:

• Save the current layout

• Apply the existing layout

• Delete the added layout

For information on managing the user interface layouts, see the sections below.

1.2.2.1 Set UI Layout Window

The Set UI Layout window provides the ability to save the current, apply the existing, and delete the added user

interface layout.

You can open the Set UI Layout window by clicking UI Layout Settings (   ) → Set UI Layout on the menu bar.
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The window provides the following elements:

Layouts

The list of available layouts, including the user-added layouts and the default Calls and Event log and Calls,

Channels and Event log layouts.

Add

Opens the New UI Layout window to save the current layout. For details, see New UI Layout.

Delete

Deletes the selected layout.

NOTE

The button is unavailable if the default layout is selected.

Apply

Applies the selected layout.

1.2.2.2 New UI Layout

The New UI Layout window provides the ability to add a new layout.

The window appears when clicking Add in the Set UI Layout window. For details, see Set UI Layout Window.

The New UI Layout window provides the following elements:

Layout name

Provides the ability to type the name of the new layout.

OK

Saves the current layout.

If the Layout name field is left empty, when clicking OK, a warning window indicating the need to type the

window configuration name appears.

Cancel

Closes the New UI Layout window without saving a layout.
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1.2.2.3 Managing Layouts

Follow the procedure to save, apply, or delete the layout.

Procedure: 

1. On the menu bar, click UI Layout Settings (   ) → Set UI Layout.

The Set UI Layout window appears.

1. In the opened window, perform one of the following actions:

To save the current layout, perform the following actions:

1. Click Add.

The New UI Layout window appears.

2. In the opened window, in the Layout name field,

type the layout name.

3. Click OK to apply changes and close the window.

The saved layout appears in the list of layouts.

To apply the existing layout, select the desired layout from the list, and then click

Apply.

To delete the layout, select the desired layout from the list, and then click

Delete.

NOTE

In the list of layouts, Calls and Event log and Calls,

Channels and Event log are default window

configurations that cannot be deleted.

2. In the Set UI Layout window, click Close to close the window.
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2 Settings

The Settings (   ) menu provides the ability to configure general SmartPTT Dispatcher parameters, parameters of

available functionality, and activate and configure parameters of additional functionality.

Most of the Settings menu options are available only to the Administrator..

For information on the operator rights, see Operators.

The menu provides the following configuration options:

• Configuring SmartPTT Dispatcher interface settings, such as general interface settings, call windows, custom

consoles, notification panels, web pages, and the SCADA module.

For details, see Interface.

• Configuring the control device and sound settings.

For details, see Equipment.

• Configuring connection to telephone subscribers.

For details, see Telephone Interconnect.

• Configuring operator permissions.

For details, see Operators.

• Configuring the call recording feature and the database backup settings.

For details, see Information Storage.

• Configuring the list of radios, their categories, statuses and other related settings.

For details, see Radios.

NOTE

The Radios options are unavailable in the Settings menu if the operator does not have the corresponding rights.

For information on the operator rights, see Operators.

• Configuring GPS and Indoor Tracking settings.

For details, see Positioning Systems.

• Configuring the list of other dispatchers and connection parameters of the current SmartPTT Dispatcher.

For details, see Dispatchers.

• Configuring event-based rules defining the SmartPTT Dispatcher behavior.

For details, see Rules.

NOTE

The Rules options are unavailable in the Settings menu if the operator does not have the corresponding rights.

• Installing licenses required for access to additional SmartPTT Dispatcher functionality.

For details, see Licenses.

• Configuring SmartPTT Dispatcher databases.

For details, see Database.

• Configuring radioserver parameters.

For details, see Radioservers.



29

Settings Interface

2.1 Interface

The Interface submenu is available from the Settings (   ) menu on the SmartPTT Dispatcher menu bar. It provides

the following configuration options:

• Configuring general SmartPTT Dispatcher settings, such as the interface language, authentication, updates,

and others.

For details, see General Settings.

• Creating and configuring custom consoles.

For details, see Custom Consoles.

• Configuring parameters of call windows.

For details, see Call Window Settings.

• Configuring parameters of emergencies, system messages, and incoming calls.

For details, see Notification Panels.

• Configuring access to web pages through SmartPTT Dispatcher panels.

For details, see Web Pages.

• Activating and configuring the SCADA module.

For details, see SCADA.
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2.1.1 General Settings

The General Settings window provides controls for configuring basic SmartPTT Dispatcher parameters, such as the

interface language, authentication, Call Alert, and others.

You can open the General Settings window by clicking Settings (   ) → Interface → General Settings on the

menu bar.

The General Settings window provides the following elements:

Language

The language of the SmartPTT Dispatcher interface.

You can select the desired language from the list by clicking the current language parameter.

To apply a new language, you need to restart SmartPTT Dispatcher.
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Windows authentication

Activates Windows authentication for authorization in SmartPTT Dispatcher.

To use Windows authentication, you need to create a SmartPTT Dispatcher operator account with the same name

as a Windows user or the group to which the user belongs. For details, see Operator Window.

If the check box is not selected or the operator's name does not match that of the Windows user or user group,

the Authorization window prompting for the operator's credentials appears at launch of SmartPTT Dispatcher.

NOTE

Starting from Windows 8, users can be authorized if they are members of either domain or local user groups.

If selected, at startup, SmartPTT Dispatcher does not request entering the operator's credentials. It uses

credentials of the current authorized Windows user instead. In this case, the Change Operator (   ) button

becomes unavailable.

NOTE

To access the SmartPTT Dispatcher Authorization window when Windows authentication is enabled, start the

program using a Windows user account whose name or the name of the group to which the user belongs does

not match the name of the existing SmartPTT Dispatcher operator account.

Launch the dispatch console on Windows start

If selected, SmartPTT Dispatcher launches automatically at Windows startup using a specific operator's profile. You

can select the desired operator from the list on the right.

Important

To apply this option, run SmartPTT Dispatcher as administrator.

NOTE

The list of operators is unavailable if the Windows authentication check box is selected.

Ask for confirmation before closing or changing the operator

If selected, SmartPTT Dispatcher will prompt you for confirmation every time you close the program or change the

operator.

Show radio user name

If selected, the name of the radio user is displayed next to the radio name in SmartPTT Dispatcher.

NOTE

The name of the radio user is displayed only if the user authorization service is activated and users are added in

the SmartPTT Radioserver settings. For details, see “Radio Users” in SmartPTT Installation and Configuration Guide.

Outgoing call tone

Activates playback of a special tone after clicking the PTT button in SmartPTT Dispatcher. The tone indicates that

the channel is free and the dispatcher can start speaking.

You can select the desired audio file in the Sound File Selection window by clicking the Browse (   ) button.

Audio file must comply with the specific requirements and have the WAV format. For details, see “Audio File

Requirements” in SmartPTT Installation and Configuration Guide.

Call Alert

Provides the ability to configure the call alert tone played in SmartPTT Dispatcher. This area provides the following

elements:
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• The Tone duration (s) field provides the ability to set the desired duration of the call alert tone.

The default value is 15 seconds.

• The Tone field provides the ability to specify the desired path and name for the custom call alert tone audio file

by typing it or by clicking the Browse (   ) button and selecting it in the Sound File Selection window.

Audio file must comply with the specific requirements and have the WAV format. For details, see “Audio File

Requirements” in SmartPTT Installation and Configuration Guide.

• The Volume level slider adjusts the volume of the call alert tone.

Possible values range from 0 to 100.

NOTE

The specified level affects only SmartPTT Dispatcher and depends on the volume level of the operating system.

For information on configuring general settings, see the section below.

2.1.1.1 Configuring General Settings

Follow the procedure to perform a SmartPTT Dispatcher base configuration.

Prerequisites: 

• To use Windows authentication, create a SmartPTT Dispatcher operator account with the same name as a

Windows user or the group to which the user belongs. For details, see Adding and Editing Operator Accounts.

• To configure the dispatch console to launch on Windows start, run SmartPTT Dispatcher as administrator.

• To display the name of the radio user, activate the user authorization service and add users in SmartPTT

Radioserver Configurator. For details, see “Radio Users” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → General Settings.

The General Settings window appears.

2. In the opened window, perform the desired actions:

To change the language of the SmartPTT

Dispatcher interface,

perform the following actions:

1. Click the current Language value.

The Select Language window appears.

2. In the opened window, select the desired language

from the list.

3. Click OK.

To use credentials of the current authorized

Windows user at SmartPTT Dispatcher startup,

select the Windows authentication check box.

To launch SmartPTT Dispatcher automatically

at Windows startup,

perform the following actions:

1. Select the Launch the dispatch console on

Windows start check box.
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2. (Optional) To launch SmartPTT Dispatcher on

Windows start using a specific operator's profile,

perform the following actions:

a. Clear the Windows authentication check

box.

b. From the list to the right of the Launch the

dispatch console on Windows start check

box, select the desired operator account.

To ask for confirmation when closing SmartPTT

Dispatcher or changing an operator,

select the Ask for confirmation before closing or

changing the operator check box.

To display the name of the radio user next to

the radio name in SmartPTT Dispatcher,

select the Show radio user name check box.

To configure a sound notification when clicking

the PTT button in SmartPTT Dispatcher,

perform the following actions:

1. Select the Outgoing call tone check box.

2. Click the Browse (   ) button to the right of the

text field.

The Sound File Selection window appears.

3. In the opened window, specify the desired audio

file, and then click Open.

To configure the call alert tone played in

SmartPTT Dispatcher,

perform the following actions:

1. In the Tone duration (s) field, type the desired

duration (in seconds) of the call alert tone.

2. (Optional) To the right of the Tone field, click the

Browse (   ) button, specify the desired call alert

tone audio file in the opened Sound File Selection

window, and then click Open.

The specified path and file name are displayed in

the Tone field.

NOTE

You can also type or paste the full file path into this

field.

3. Move the Volume level slider to the desired level

of the call alert tone volume.

3. Click Finish at the bottom of the window to save changes and close the window.

Postrequisites: 

If you change the interface language, restart SmartPTT Dispatcher to apply the new language.
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2.1.2 Custom Consoles

Custom consoles are fully customizable SmartPTT Dispatcher panels that provide access to the radio objects and

functionality available in the dispatched radio system.

Custom consoles provide the ability to create SmartPTT Dispatcher panels that are best suited for a specific radio

system and/or dispatcher. You can configure the panel layout, add and customize the elements corresponding to

the required radio system objects and functionality to facilitate access to them.

NOTE

Custom consoles are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

You can open the Custom Consoles window for creating and configuring the desired custom panels by clicking

Settings (   ) → Interface → Custom Consoles on the menu bar.

SmartPTT Dispatcher provides the ability to work with more than one custom console at the same time. The

configured custom consoles are available from the Tools menu. For details, see Custom Consoles.

For information on the functionality provided by custom consoles and their configuration, see the corresponding

sections below.
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2.1.2.1 Custom Consoles Window

The Custom Consoles window provides the ability to manage custom consoles.

You can open the Custom Consoles window by clicking Settings (   ) → Interface → Custom Consoles on the

menu bar.

The Custom Consoles window provides the following elements:

Add

Opens the Console Configuration window where you can configure a new custom console. For details, see Console

Configuration Window.

Edit

Opens the Console Configuration window where you edit the selected custom console. For details, see Console

Configuration Window.

Delete

Deletes the selected custom console.

Custom Consoles Table

Contains the custom consoles created in SmartPTT Dispatcher. The table consists of the following columns:
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• The Name column contains the custom console name.

• The Active column contains the check box for activating or deactivating the selected console. If the check box

is selected, the console becomes available in the Tools menu. For details, see Custom Consoles.

You can sort the column content by clicking the desired column header.

2.1.2.2 Console Configuration Window

Custom consoles provide a wide range of customization options for adjusting the panel to the needs of a specific

radio system and/or dispatcher.

You can configure a new custom console or change the settings of an existing console in the Console Configuration

window that is called according to the name of the console Console “<name of the console>”.

In the Console Configuration window, you can perform the following actions to customize the panel layout:

• Add and configure elements representing radio objects.

• Add and configure elements providing access to SmartPTT Dispatcher functionality.

• Configure the panel layout by setting a wallpaper, moving and resizing the elements located in it.

You can open the Console Configuration window from the Custom Consoles window in one of the following ways:

• By clicking Add (   ) in the top part of the window.
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• By clicking the desired console in the Custom Consoles table, and then clicking Edit (   ) in the top part of the

window.

• By double-clicking the name of the desired console in the Custom Consoles table.

The Console Configuration window provides the following elements:

Name

Name of the custom console. By default, new consoles are called Console <consecutive number>. The console name

is displayed in the Tools menu and as part of the Console Configuration window name.

Wallpaper

Path to the image that is used as the custom console background image. You can select the desired image in the

BMP, JPG, or PNG format by clicking the Browse (   ) button. To remove the selected wallpaper, click the Delete ( 

 ) button.

Undo (   )

Cancels the last action applied to the custom console element. The button becomes available only after at least

one action was applied to the elements in the console workspace.

Redo (   )

Cancels the last Undo command. The button becomes available only after cancellation of at least one action using

the Undo (   ) button.
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NOTE

The Undo (   ) and Redo (   ) buttons affect the actions applied to the console elements in the workspace only,

such as adding, deleting, moving, and resizing. The changes applied in the Properties area cannot be canceled

using these buttons and must be edited manually.

Delete (   )

Removes the selected element from the console workspace.

Elements Area

Contains the elements representing available radio objects and SmartPTT Dispatcher functionality that can be

added to the console workspace.

The elements in the upper part of the Elements area are located inside expandable lists with one or more levels.

For some of the element types, such as Radios, Talkgroups, and Voice Notifications, the search box is available.

Workspace

Provides the ability to configure the custom console layout that will be available to the operator after the panel

configuration is complete.

Properties Area

Provides the ability to configure properties of the selected element. Depending on the element, different

properties may be available.

The properties under the Properties heading are element-specific. For information on the properties that are

available to each element, see description of the desired element in Custom Console Elements.

The properties under the Style heading affect the element appearance in the console workspace. The following

customization options may be available:

• Color provides the ability to set the color of the element. The default color is light blue. You can select the

desired color from the expandable palette by clicking the box displaying the current color on the right. When

making a voice call, the color of the radio object element is changed depending on its status. For information

on voice call indication, see Color Indication of Voice Calls.

Some elements may change their color depending on their state. For information on available indication

options, see description of the desired element in Custom Console Elements.

• Font Size provides the ability to set the font size for the text on an element. You can select Small, Medium, or

Large. The default font size is Small.

• Gradient provides the ability to apply or remove the gradient effect to the element. By default, it is applied to

all new elements added to the workspace. You can apply/remove the gradient by selecting/clearing the

Gradient check box.

• Icon provides the ability to show or hide the element icon.

• Word Wrap provides the ability to wrap long element names.

Scale

Provides the ability to expand the custom console workspace by decreasing the size of all the elements located in

it. You can change the scale by dragging the slider to the left or to the right to decrease or increase the workspace

respectively.
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Console Preview

Miniature view of the custom console. If some part of the workspace does not fit the window size, a rectangle

framing the currently displayed area of the workspace appears. You can change the displayed part of the

workspace area by dragging the rectangle to the desired part using the four-point arrow that appears when you

point to the console preview.

For information on available custom console elements and their configuration, see the corresponding sections

below.

2.1.2.3 Custom Console Elements

Custom consoles provide a range of elements representing the radio objects and functionality available in SmartPTT

Dispatcher. You can add them to the custom console, customize their appearance, and set their properties in the

Console Configuration window.

NOTE

Access to some of the elements may require the corresponding operator permission and/or license. For details,

see description of the desired element below.

SmartPTT Dispatcher provides the following custom console elements (listed in alphabetical order):

• Broadcast Call

• Channel Selector

• Channels

• Cross Patches

• Dispatchers

• Image

• Incoming Events

• Incoming Telemetry

• Multiselect

• Outgoing Telemetry

• Panel

• PTT

• Radios

• SCADA Points

• Talkgroups

• Telephone Subscribers

• TMS

• Voice Notifications
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2.1.2.3.1 Broadcast Call

The Broadcast Call element provides the ability to initiate a group call or an All Call on all available channels of the

dispatched radio system at the same time. The element is unavailable in the analog radio systems.

NOTE

To make broadcast calls, talkgroups must be configured in the radio system settings in SmartPTT Radioserver

Configurator. For details, see “Adding and Editing Talkgroups” in the corresponding network settings description

in SmartPTT Installation and Configuration Guide.

The Broadcast Call element provides the following information and controls:

Broadcast Call Icon

Default icon indicating the element type.

Broadcast Call Name

Name of the Broadcast Call element (if it is set in the element settings in the Properties area).

Active Channels

Counter that provides information on how many channels SmartPTT Dispatcher is currently broadcasting and

how many channels are available in total. For example, 2 out of 3 means that SmartPTT Dispatcher is currently

broadcasting on two out of three available channels. Detailed information on the initiated calls is available in

SmartPTT Dispatcher Event Log. For details, see SmartPTT Dispatcher Event Log.

In the Properties area, you can customize the element in the following ways:

• Set the name displayed at the top of the element by specifying it in the Element Name box.

• Set the talkgroups to which the call will be initiated by specifying their ID in the Talkgroup ID box.

The default value is 0 which corresponds to the All Call on all available channels. If you specify another value,

the call will be initiated to all available talkgroups with the specified ID.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

Information on which talkgroups are configured for the element is unavailable to operators from the custom

console. For this reason, it is recommended that you set an informative name for each Broadcast Call element.
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2.1.2.3.2 Channel Selector

The Channel Selector element provides the ability to switch to the control station channel represented by the

element. Each element corresponds to one control station channel.

If no control station is connected or active in the radio system, the element is unavailable. For correct functioning of

the Channel Selector element, the control station channels must be configured in SmartPTT Radioserver

Configurator.

For information on MOTOTRBO control stations see the “MOTOTRBO Control Stations” section in SmartPTT

Installation and Configuration Guide.

 

The Channel Selector element contains the round indicator of the control station channel status and the channel

name that is set in SmartPTT Radioserver Configurator.

To provide an operator with the ability to switch between channels, you need to add the elements corresponding to

each of the desired channels to the custom console workspace.

Important

To switch between the control station channels, an operator needs to have the Change channel on control

station right. For information on the operator rights, see Operators.

Depending on the color of the indicator, the Channel Selector element may exist in two states:

• Gray color indicates inactive channels.

• Green color indicates active channels.

In the Properties area, you can customize the element in the following ways:

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.
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2.1.2.3.3 Channels

The Channel element provides the ability to work with the control stations and IP Site Connect available in the radio

system.

 

The Channel element provides the following information and controls:

Channel Icon

Default channel icon indicating the element type.

Channel Name

Name that is set in SmartPTT Radioserver Configurator and, if configured, the name of the radioserver.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the channel sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Channel Selector (   /   )

Available to control stations only. Provides the ability to switch the control station channels.

Call Target

Talkgroup or All Call that is currently selected on the channel. Operators can select the desired call target on the

configured custom console. In the Console Configuration window, the control is unavailable.

Missed Calls (   )

Counter that provides information on the missed calls on the channel. The counter appears only if the Missed

Calls check box is selected in the Properties area.

Actions (   )

The channel Actions menu button.

For information on actions, see Channel Actions Menu.

In the Properties area, you can customize the element in the following ways:

• Show or hide the number of missed calls on the channel by selecting or clearing the Missed Calls check box.
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• Show or hide the radioserver name next to the name of the channel by selecting or clearing the Radioserver

Name check box.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.3.4 Cross Patches

The Cross Patch element provides the ability to interact with cross patches. For details, see Cross Patches in the

“Tools” section.

 

New elements contain only the default Cross Patch icon indicating the element type. You can assign the desired

cross patch to the element only from the configured custom console.

If a cross patch is assigned to the element, the following information and controls appear on the Multiselect element:

Cross Patch Icon

The default cross patch icon in the upper-left corner of the element. The default icon cannot be changed.

Cross Patch Name

Name of the cross patch which is set in the Cross Patch window. For details, see Cross Patch Window.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the cross patch sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Cross Patch Members

Names of the cross patch members.

Actions (   )

The cross patch Actions menu button.

For information on actions, see Cross Patch Actions Menu.

In the Properties area, you can set the element color and gradient applied to it by specifying the corresponding

parameters.
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2.1.2.3.5 Dispatchers

The Dispatcher element provides the ability to interact with other SmartPTT dispatchers.

The Dispatcher element provides the following information and controls:

• Avatar that is set in the dispatcher's settings. If no custom avatar is set, the default icon is used. For details,

see Dispatcher Window.

• Name of the dispatcher. Depending on the settings, it may be the name of a fixed dispatcher or the dispatcher

selected by the operator from the expandable list on the element.

 

Important

To interact with other dispatchers, the operator's profile must be assigned the Connect with external

dispatchers permission. For details, see Operators.

In the Properties area, you can customize the element in the following ways:

• Set the operator's ability to reassign the element to another dispatcher be selecting or clearing the Allow

Changes check box. If the check box is cleared, the element will be associated with the dispatcher you assign in

the Console Configuration window. If the check box is selected, the operator will be able to select the desired

dispatcher from the expandable list on the element.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.3.6 Image

The Image element provides the ability to add an image in the BMP, JPG, or PNG format to the custom console.

You can set the desired image by specifying the path to it in the Path box in the Properties area.

If no image is assigned to the element, it is displayed as a blank area of the default color.
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2.1.2.3.7 Incoming Events

The Incoming Events element provides information on incoming events in SmartPTT Dispatcher, such as missed

private calls, messages, and call alert commands received during the current operation session.

In the Properties area, you can customize the element by setting the color of the element header in the

corresponding expandable palette. The default color of the element background cannot be changed.

2.1.2.3.8 Incoming Telemetry

The Incoming Telemetry element provides the ability to monitor the current status of GPIO pins on the radios in the

dispatched radio system. For information on the telemetry settings configuration, see Telemetry Settings Window.

The Incoming Telemetry element provides the following information and controls:

Name

Name or ID of the radio on which the pin is installed.

Update Status (   )

Button that sends a request for the radio pin status update.

NOTE

On clicking the Update status (   ) button on the element, the status will be automatically updated for all the

pins installed on this radio.

Last Update Time

Time of the last pin status update. The status can be updated manually using the Update Status (   ) button or

automatically with the interval that is set in the radio settings. The last update time appears on the element after

the first update received from the radio by SmartPTT Dispatcher. For details, see Telemetry for Radio Window.

Status Indicator

Square indicator filled with the color assigned to the current pin status in the element settings. For the pins that

are assigned two telemetry actions of the High Level and Low Level types, next to the square indicator, the text

description of the current pin status is displayed.
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In the Properties area, you can customize the element in the following ways:

• Set the colors indicating the High Level and Low Level pin statuses by selecting the desired colors from the

corresponding expandable palettes. This color is displayed in the square status indicator on the element when

the radio pin reports the corresponding state.

By default, the green color corresponds to the High Level status of the pin, dark gray - to the Low Level status.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.3.9 Multiselect

The Multiselect element provides the ability to create multiselect groups consisting of radios and/or talkgroups.

Multiselect groups can be used for the following purposes:

• Making calls to multiple radio objects at the same time (multiselect calls). All participants of a multiselect call can

hear the operator and cannot hear other members of their multiselect group.

• Sending messages to multiple radio objects at the same time using the TMS element. For details, see TMS.

• Performing other actions available to multiple radio objects using the hot keys assigned in SmartPTT

Dispatcher settings. For details, see Keys.

New elements contain only the default Multiselect icon indicating the element type. Members of the Multiselect

group can be added only from the configured custom console.

If the Multiselect group is assigned at least one member, the default icon disappears and the following information

and controls appear on the Multiselect element:

• Name of the multiselect group (if specified).

• Names of the multiselect group members.

• Button to mute/unmute the sound of talkgroups added to the multiselect group.

• The multiselect group Actions (   ) menu button. For information on the menu, see Multiselect Group Actions

Menu.

In the Properties area, you can set the element color and gradient applied to it by specifying the corresponding

parameters.
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2.1.2.3.10 Outgoing Telemetry

The Outgoing Telemetry element provides the ability to send preconfigured telemetry commands and monitor the

current status of GPIO pins on the radios in the dispatched radio system. For information on the telemetry settings

configuration, see Telemetry Settings Window.

The Outgoing Telemetry element provides the following information and controls:

Name

Name or ID of the radio on which the pin is installed.

Update Status (   )

Button that sends a request for the radio pin status update.

NOTE

On clicking the Update status (   ) button on the element, the status will be automatically updated for all the

pins installed on this radio.

Last Update Time

Time of the last pin status update. The status can be updated manually using the Update status (   ) button or

automatically with the interval that is set in the radio properties. The last update time appears on the element

after the first update received from the radio by SmartPTT Dispatcher. For details, see Telemetry for Radio

Window.

Status Indicator

Square indicator filled with the color assigned to the current pin status in the element settings.

Telemetry Command

Button that sends the preconfigured telemetry command to the radio. The name of the button corresponds to

the description specified in the telemetry action settings. For details, see Telemetry Command Settings Window.

In the Properties area, you can customize the element in the following ways:

• Set the colors indicating the High Level and Low Level pin statuses by selecting the desired colors from

expandable palettes. This color is displayed in the square status indicator on the element when the radio pin

reports the corresponding state.

By default, the green color corresponds to the High Level status of the pin, dark gray - to the Low Level status.

• Show or hide the pin status indicator by selecting or clearing the Show Status check box.

• Set the color and gradient applied to the element by specifying the corresponding parameters.
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• Set the font size for the element text by specifying it in the Font Size list.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.3.11 Panel

The Panel element provides the ability to interact with multiple custom console elements at the same time. Panels

may hold all types of custom console elements except another Panel element. Actions applied using functional

elements, such as the PTT, TMS and Voice Notification elements, will be applied to all available elements located

within the same Panel element.

You can add elements to the panel by dragging them from the Elements area. All the elements within the panel are

moved together with the panel.

If you remove an element from the panel or resize the panel so that some of the elements are located outside of it,

the actions applied to the panel will not affect these elements. The elements located on the border of the panel are

treated as located outside of it.

In the Properties area, you can customize the element in the following ways:

• Set the color applied to the element by specifying the corresponding parameter.

• Set the name displayed at the top of the element in the Panel Name box.

2.1.2.3.12 PTT

The PTT element provides the ability to initiate a call to all available radios and talkgroups that are located within the

same Panel element as PTT.
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To provide correct functioning of the PTT element, it must be added to a Panel element together with the desired

radios, and/or talkgroups. When the PTT element is located outside any panel, or if there are no available radio

objects added to it, the element becomes inactive.

In the Properties area, you can set the element color and gradient applied to it by specifying the corresponding

parameters.

2.1.2.3.13 Radios

The Radio element provides the ability to initiate private voice calls to radios added to the SmartPTT Dispatcher list of

radios.

Depending on the intended use, you can add two types of the Radio element:

• Element assigned to a specific (fixed or reassignable) radio.

• Element with a number pad for calling radios by manual entering their ID or selecting them from the SmartPTT

Dispatcher list of radios.

The assigned type of the Radio element can be added by dragging the desired radio from the expandable Radios list

in the Elements Area to the workspace.

 

This type of the Radio element provides the following information and controls:

Radio Icon

Icon that is set in the radio settings. For details, see Common Radio Properties.

Radio Name

Name or ID of the radio. Depending on the settings, it may be a fixed radio or an expandable list of radios added

to SmartPTT Dispatcher.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

Location Indicator

The Valid Coordinates (   ) / Outdated Coordinates (   ) icon. Depending on the update status of the radio

location data, the icon indicates that the radio GPS coordinates are valid or outdated/missing. The icon appears

only if the GPS service is activated and the coordinates update parameters are specified in the radio location

settings. For details, see Radio Location Properties.

Actions (   )

The radio Actions menu button.

For information on actions, see Radio Actions Menu.
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In the Properties area, you can customize an element of the assigned type in the following ways:

• Set the operator's ability to reassign the element to another radio by selecting or clearing the Allow Changes

check box. If the check box is selected, the operator will be able to select the desired radio from the expandable

list on the element. If the check box is cleared, the element will be associated with the radio you assign in the

Console Configuration window.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

The Radio element with a number pad can be added by dragging the corresponding icon (   ) from the

expandable Radios list in the Elements Area to the workspace.

This type of the Radio element provides the following information and controls:

Radio Icon

Default radio icon.

Actions (   )

Button that opens the radio Actions menu. The button becomes available when the operator enters the ID or

selects from the list a radio added to SmartPTT Dispatcher list of radios.

Search field (   )

Box that provides the ability to find the desired radio by entering its ID on the keyboard or the number pad below.

Number Pad

Panel that provides controls for entering the desired radio ID. Instead of the number pad, the operator can use a

keyboard.
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Number Pad (   )

Button that switches the element to the manual dialing mode by displaying the number pad under the search

box.

List of Radios (   )

Button that switches the element to the selection mode by displaying the SmartPTT Dispatcher list of radios under

the search box.

After the operator finds a radio that is added to the SmartPTT Dispatcher list of radios, the top part of the element

starts functioning as the assigned type of the Radio element and provides the same information, controls, and

indication options.

In the Properties area, you can set the element color and gradient applied to it by specifying the corresponding

parameters.

2.1.2.3.14 SCADA Points

The SCADA point element provides information on the SCADA point parameters in the real time and can be used for

quick access to the SCADA point dashboard in SmartPTT Dispatcher SCADA panel.

Important

The SCADA point element is available only if the SCADA module is activated in SmartPTT Dispatcher settings. For

details, see Activating SCADA Module.

The SCADA element contains the icon and the name of the SCADA point that are set in the SCADA system and cannot

be changed in SmartPTT Dispatcher.

To add a SCADA point element to the custom console, it must be added to SmartPTT Dispatcher SCADA module and

appropriately configured in the SCADA system. For details, see SCADA Module Setup and User Guide and Adding

SCADA Points.

In the Properties area, you can customize the element in the following ways:

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.
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2.1.2.3.15 Talkgroups

The Talkgroups element provides the ability to interact with talkgroups and initiate All Calls.

The custom console provides two types of the Talkgroup element:

• Element for interacting with talkgroups

• Element for initiating All Calls on the preconfigured channel

 

Depending on the type, the element may provide the following information and controls:

Talkgroup Icon

Default icon indicating the element type.

Name

Name of the All Call, or talkgroup. The All Call and talkgroup names are set in SmartPTT Radioserver Configurator.

Channel Name

Name of the channel that corresponds to the network name. The network name is set in SmartPTT Radioserver

Configurator.

Radioserver Name

Name of SmartPTT Radioserver that is set in the radioserver settings in SmartPTT Dispatcher.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the group sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Actions (   )

The group Actions menu button.

For information on actions, see Talkgroup Actions Menu and All Call Actions Menu.

In the Properties area, you can customize the element in the following ways:

• Set the operator's ability to reassign the element to another talkgroup by selecting or clearing the Allow

Changes check box. If the check box is selected, the operator will be able to select the talkgroup from the

expandable list on the element. If the check box is cleared, the element will be associated with the talkgroup

you assign in the Console Configuration window.

• Show or hide the network name by selecting or clearing the Channel Name check box.

• Show or hide the radioserver name by selecting or clearing the Radioserver Name check box.

• Set the color and gradient applied to the element by specifying the corresponding parameters.
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• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.3.16 Telephone Subscribers

The Telephone Subscriber element provides the ability to interact with telephone subscribers added to SmartPTT

Dispatcher.

Important

The Telephone Subscriber element is available only if the Telephone Interconnect license is installed and an

operator has the Make telephone calls permission. For details, see Licenses and Operators.

 

The Telephone Subscriber element provides the following information and controls:

• Avatar that is set in the telephone subscriber's settings. If no custom avatar is set, the default icon is used. For

details, see Telephone Subscriber Window.

• Name of the telephone subscriber. Depending on the settings, it may be the name of a fixed subscriber or the

subscriber selected by the operator from the expandable list of telephone subscribers added to SmartPTT

Dispatcher.

In the Properties area, you can customize the element in the following ways:

• Set the operator's ability to reassign the element to another telephone subscriber by selecting or clearing the

Allow Changes check box. If the check box is cleared, the element will be associated with the subscriber you

assign in the Console Configuration window. If the check box is selected, the operator will be able to select the

desired subscriber from the expandable list on the element.

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Set the font size for the element text by specifying it in the Font Size list.

• Show or hide the element icon by selecting or clearing the Icon check box.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.
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2.1.2.3.17 TMS

The TMS element provides the ability to send text messages to a single or multiple radios and talkgroups in the

dispatched radio system.

The TMS element provides the following information and controls:

Message (   )

Button that expands the list of preconfigured message templates. For information on message templates, see

Managing Message Templates.

Text Box

The box for typing the text of the message.

Send (   )

Button that sends the message from the text box.

Send Message (   )

Button that opens the Send Message window. For details, see Send Message Window.

Selected Object Name

If the operator selects a Radio or a Talkgroup element in the custom console, the name of the selected object is

displayed at the top of the element. If more than one radio object is selected, instead of the object name, the

Selected heading is displayed.

Location of the TMS element affects the way the messages will be sent in the following way:

• If the TMS element is located within a Panel element, the message will be sent to all the radios and talkgroups

located inside the same panel. For details, see Panel.

• If the TMS element is located outside any Panel element, the message will be sent to the radios and/or

talkgroups selected by the operator in the custom console.

In the Properties area, you can set the element color and gradient applied to it by specifying the corresponding

parameters.

2.1.2.3.18 Voice Notifications

The Voice Notifications element provides the ability play a preconfigured voice notification for a selected talkgroup

or channel.

For information on voice notifications, see Voice Notifications.

Important

Voice notifications are created and configured in SmartPTT Radioserver Configurator. For details, see “Voice

Notifications” in SmartPTT Installation and Configuration Guide.
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The Voice Notifications element provides the following information and controls:

• The voice notification name that is set in SmartPTT Radioserver Configurator.

• The Play (   ) / Stop (   ) button that starts or stops the voice notification playback.

• The counter which shows the number of successful voice notification playbacks.

In the Properties area, you can customize the element in the following ways:

• Set the color and gradient applied to the element by specifying the corresponding parameters.

• Show or hide the radioserver name next to the name of the voice notification by selecting or clearing the

Radioserver Name check box.

• Set the font size for the element text by specifying it in the Font Size list.

• Enable or disable word wrapping for the text inside the element by selecting or clearing the Word Wrap check

box.

2.1.2.4 Managing Custom Consoles

Follow the procedure to to manage (add, edit, activate/deactivate, or delete) a custom console.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Custom Consoles.

The Custom Consoles window appears.

2. In the Custom Consoles window, perform the desired action:

To add a new custom console, perform the following actions:

1. In the top part of the window, click Add (   ).

The Console Configuration window for adding a

new console appears.

2. Perform the desired configuration of the new

console. For details, see Configuring Console

Workspace.

3. Click Save in the bottom part of the Console

Configuration window to save changes and close

the window.

The configured console appears in the Custom

Consoles window.



56

Settings Interface

To edit an existing custom console, perform the following actions:

1. In the Custom Consoles table, select the desired

console, and then click Edit (   ).

The Console Configuration window for editing the

console appears.

2. Edit the desired settings and/or elements. For

details, see Configuring Console Workspace.

3. Click Save to save changes and close the window.

To activate/deactivate an existing custom

console,

in the Custom Consoles table, select the desired custom

console, and then select or clear the Active check box.

The console appears or disappears from the Tools

menu.

To delete an existing custom console, perform the following actions:

1. In the Custom Consoles table, select the desired

custom console, and then click Delete (   ).

2. In the confirmation window, click OK.

The console is removed from the Custom

Consoles table.

2.1.2.5 Configuring Console Workspace

Follow the procedure to set the custom console name and wallpaper and add, move, or resize the elements in the

console workspace.

Procedure: 

1. If closed, open the Custom Consoles window by clicking Settings (   ) → Interface → Custom Consoles on

the menu bar.

The Custom Consoles window appears.

2. In the Custom Consoles window, in the Custom Consoles table, double-click the desired console name or

select it, and then click Edit (   ).

The Console Configuration window for editing the console appears.

3. (Optional) In the Name box in the top part of the window, type the custom console name.

4. (Optional) Next to the Wallpaper box in the top part of the window, click Browse (   ), and then, in the window

that appears, select the desired image.

5. Depending on the type of the element you want to add, perform one of the following actions:

• For the elements located in the upper-left corner of the window, expand the list of the corresponding

element type, and then drag the desired element to the console workspace.
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NOTE

Some of the radio object elements, such as Radios and Channels, may be located in expandable lists under the

main one.

• For the elements located in the bottom-left corner of the window, drag the desired element to the

workspace.

6. Select the element added to the console workspace, and then, in the Properties area, edit the desired element

properties.

For details, see description of the desired element in Custom Console Elements.

7. (Optional) Resize the element by dragging the resizing controls that appear when you select the element to the

desired position.

Postrequisites: 

• To remove the element added to the console workspace, select it, and then press Delete, or click Delete (   ) in

the top part of the window.

• To remove the wallpaper, click Delete (   ) to the right of the Wallpaper box.
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2.1.3 Call Window Settings

The Call Window Settings window provides the ability to customize Call Window appearance and behavior. For

example, specify individually the maximum number of opened Call Windows or specify the Call Window closing

timeout.

One can configure Call Window parameters by clicking Settings (   ) → Interface → Call Windows on the menu bar

of SmartPTT Dispatcher.

The Call Window Settings window provides the following elements:

Call Window Closing Timeout (s)

Sets the time period in seconds at the end of which Call Windows will be closed automatically. The default value is

60 seconds.

NOTE

If you enter 0 in the field, Call Windows will not be closed automatically. It suggests manual closing.

Open Call Window for Event Types

Specifies types of events triggering the Call Window opening. For information on event types, see Event Types.
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Maximum Number of Opened Call Windows

Sets the maximum number of Call Windows opened automatically. The default value is 20. The 0 value cancels

automatic opening of Call Windows.

NOTE

This setting does not influence the quantity of Call Windows opened manually.

Show Photo in Call Window

Displays the radio avatar, the talkgroup avatar, the all call avatar in Call Windows.

For information on the Call Window of the desired object, see Radio Call Window, Talkgroup Call Window, or All Call

Window.

Show Pinned Call Windows on Console Launch

Restores all pinned (   ) Call Windows before the SmartPTT Dispatcher closing during the next launch of SmartPTT

Dispatcher.

Set Focus to Call Window upon Popup

Makes the Call Window active when it is opened.

Reset Saved Call Window Positioning

Resets the pinned earlier position of Call Windows on a monitor screen.

2.1.3.1 Configuring Call Windows

Follow the procedure to to configure Call Window appearance and behavior.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Call Windows.

The Call Window Settings window appears.

2. In the Call Window Settings window, perform the desired actions:

To set the Call Window closing timeout, type the desired value in the Call Window Closing

Timeout (s) field.

NOTE

To reset the automatic closing of Call Windows,

type the 0 value.

To specify types of events triggering the Call

Window opening,

select check boxes of the desired event types in the

Open Call Window for Event Types area.

To set the maximum number of Call Windows

opened automatically,

type the desired value in the Maximum Number of

Opened Call Windows field.

To display the radio avatar, the talkgroup avatar

and the all call avatar in Call Windows,

select the Show Photo in Call Window check box.

To restore all pinned Call Windows during the next

launch of SmartPTT Dispatcher,

select the Show Pinned Call Windows on Console

Launch check box.
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To make the Call Window active when it is opened, select the Set Focus to Call Window upon Popup

check box.

To reset the pinned earlier position of Call Windows

on a monitor screen,

click the Reset Saved Call Window Positioning

button.

3. Click Finish at the bottom of the window to save changes and close the window.

2.1.4 Notification Panels

The Notification Panels window provides the ability to configure the event processing in the system, including

notifications through the Emergencies, System Messages, and Recent Incoming Calls panels.

To open the Notification Panels window, on the menu bar of the SmartPTT Dispatcher window, click Settings ( 

 ) → Interface → Notification Panels.

The Notification Panels window consists of three tabs. They provide the following settings:

• Settings for the emergencies.

For details, see Emergencies.
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• System message settings.

For details, see System Messages.

• Recent incoming calls settings.

For details, see Recent Incoming Calls.

For information on these settings, see the corresponding sections below.

2.1.4.1 Emergencies

On the Emergencies tab, you can configure the emergency situation processing.

The Emergencies tab provides the following elements:

Notify dispatcher about emergency

• Opens the Emergencies panel automatically upon receipt of an incoming alarm signal from the radio. For

details, see Emergencies.

NOTE

The Emergencies panel appears only when emergency signal is registered. You cannot open it manually.

• Displays the radio activated the emergency mode in the opened map window. For details, see Maps.

Category for emergency

Provides the ability to set the category of objects that will not be hidden on the map upon receipt of an alarm

signal from a radio.

You can select the desired category by clicking the Browse (   ) button.

For details, see Categories.

Play Sound

Activates playback of a special tone at the emergency situation.

You can select the desired audio file in the Sound File Selection window by clicking the Browse (   ) button.

Audio file must comply with the specific requirements and have the WAV format. For details, see “Audio File

Requirements” in SmartPTT Installation and Configuration Guide.
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2.1.4.1.1 Configuring Emergency Situation Processing

Follow the procedure to configure the emergency situation processing.

Prerequisites: 

• To select a category for emergency, first add at least one category. For details, see Managing Categories.

• (Optional) Ensure that a map is opened to display the radios activated the emergency mode and the objects

added to the category for emergency. For details, see Maps.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Notification Panels.

The Notification Panels window appears.

2. Select the Notify dispatcher about emergency check box to enable the emergency situation processing.

To enable the emergency situation processing, select the Notify dispatcher about emergency

check box.

To disable the emergency situation processing, clear the Notify dispatcher about emergency

check box.

3. (Optional) Configure additional settings for the emergency situation processing:

To add the category of objects that will not be

hidden on the map upon receipt of an alarm

signal from a radio,

perform the following actions:

1. Next to the Category for Emergencies field, click

Browse (   ).

2. In the Categories window, select the

corresponding category.

3. Click OK.

To activate playback of the default audio file at

the emergency situation,

select the Play Sound check box.

To configure a sound notification at the

emergency situation,

perform the following actions:

1. Select the Play Sound check box.

2. Click Browse (   ) to specify a path to the desired

audio file.

4. Click Finish in the bottom part of the window to save changes and close the window.
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2.1.4.2 System Messages

On the System Messages tab, you can configure the system messages processing, including displaying system

messages on the System Messages panel. For details, see System Messages.

The Network events area provides the following elements:

Errors

Select to show error messages indicating major functionality failures, which can lead to the system breakdown, on

the System Messages panel.

Clear to show error messages in separate windows.

Warnings

Select to show warning messages indicating minor functionality failures, which are not critical for the current

system operation, on the System Messages panel.

Information Messages

Select to show information messages indicating functionality restoration after its failure on the System Messages

panel.

The Hardware events area provides the following elements:

Critical problems

Select to show messages about the loss of a significant part of the radio network functionality on the System

Messages panel.

Non-critical problems

Select to show messages about the loss of an insignificant part of the radio network functionality on the System

Messages panel.

NOTE

Hardware events processing works only if Monitoring is activated. For details, see the “Configuring Monitoring

Database Connection” in SmartPTT Installation and Configuration Guide.
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If you select the check boxes in the Network events area or the Hardware events area when the System

Messages panel is closed, it opens automatically with the appeared corresponding message.

If you do not select the check boxes in the Network events and Hardware events areas, system messages appear

in the opened System Messages panel in any case. But if the panel is closed, it does not open automatically with the

appeared corresponding message.

NOTE

If the System Messages panel is opened but inactive, all event messages appear in the background without

notifications.

Play Sound

Activates playback of a special tone when system messages appears.

You can select the desired audio file in the Sound File Selection window by clicking the Browse (   ) button.

Audio file must comply with the specific requirements and have the WAV format. For details, see “Audio File

Requirements” in SmartPTT Installation and Configuration Guide.

2.1.4.2.1 Configuring System Messages Processing

Follow the procedure to configure the system messages processing.

Prerequisites: 

(Optional) To process hardware events, ensure that Monitoring is activated. For details, see the “Configuring

Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → Notification Panels.

The Notification Panels window appears.

2. Open the System Messages tab.

3. Configure the system status messages processing in the Network events area:

To show error messages on the System Messages

panel,

select the Errors check box.

To show error messages  in separate windows, clear the Errors check box.

To show warning messages, select the Warnings check box.

To show information messages, select the Information Messages check box.

4. Configure the radio network functionality messages processing in the Hardware events area:

To show messages about the loss of a significant

part of the radio network functionality,

select the Critical problems check box.

To show messages about the loss of an insignificant

part of the radio network functionality,

select the Non-critical problems check box.
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5. Configure an emergency alarm:

To activate playback of the default audio file at

the emergency situation,

select the Play Sound check box.

To configure a sound notification at the

emergency situation,

perform the following actions:

1. Select the Play Sound check box.

2. Click Browse (   ) to specify a path to the desired

audio file.

6. Click Finish in the bottom part of the window to save changes and close the window.

2.1.4.3 Recent Incoming Calls

On the Recent Incoming Calls tab, you can configure the Recent Incoming Calls panel.

The Recent Incoming Calls tab provides the following elements:

Remember recent incoming calls

Select to display the latest radios which made a call in the radio network on the Recent Incoming Calls panel.

Number of recent calls

Enter the maximum number of radios displayed on the Recent Incoming Calls panel.
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2.1.5 Web Pages

In SmartPTT Dispatcher you can add web pages compatible with Internet Explorer 11.

You can open the panel with a web page from the Tools menu after you added it in the Web Pages window.

For information on web pages and their adding, see the sections below.
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2.1.5.1 Web Pages Window

In the Web Pages window, you can manage web pages.

You can open the Web Pages window by clicking Settings (   ) → Interface → Web Pages.

The Web Pages window provides the following elements:

Add

Adds a web page row to Web Pages table. The rows are used for adding web pages. You can add an unlimited

number of rows. For information on adding web pages, see Adding Web Pages.

Delete

Removes the selected page.

Web Pages table

Contains a list of added pages with addresses. The table provides the following elements:
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Page name

The column contains a name of a page. After adding the page, its name appears in the Tools menu. By clicking the

name in the menu, the tab with the web-page opens.

URL address

The column contains a URL address of a page. When the web page row is added, its part in the URL address

column contains no address and you should type it manually or paste.

2.1.5.2 Adding Web Pages

Follow the procedure to add a new web page to SmartPTT Dispatcher.

NOTE

To ensure stable performance, it is not recommended to add web pages containing audio or video materials.

Prerequisites: 

Obtain URL address of the desired page.

Procedure: 

1. Click Settings (   ) → Interface → Web Pages.

The Web Pages window appears.

2. In the Web Pages window, click Add.

A new row in the page table appears.

3. In the Page name column, type the desired page name.

4. In the URL address column, enter the address in one of the following ways:

• Type the address manually.

• Copy the URL address to clipboard and paste it.

5. Click Finish to save changes and close the window.

The added page appears in the Tools menu.

Postrequisites: 

• To edit the page name or address, double-click the desired value and change it.

• To delete the page, click the desired row in the table and click Delete.

2.1.6 SCADA

The SCADA Module window provides controls for activating the SCADA module in SmartPTT Dispatcher and

establishing a connection to the desired SCADA system.

Important

Access to the SCADA module functionality requires the SCADA license. For details, see Licenses.

For information on the SCADA module functionality in SmartPTT Dispatcher, see SCADA Module and the SCADA

Module embedded help.
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You can open the SCADA Module window by clicking Settings (   ) → Interface → SCADA on the menu bar.

NOTE

The SCADA option is available only if the SCADA module is activated in SmartPTT Dispatcher settings. For details,

see Activating SCADA Module.

The SCADA Module window provides the following elements:

Activate SCADA module

Activates the SCADA module in SmartPTT Dispatcher.

When the check box is selected, the URL address field located below becomes active.

URL address

URL address of the SCADA system that will be accessed through the SCADA module in SmartPTT Dispatcher.

Input format is http://<IP address or domain name of the SmartPTT SCADA host>:5000 where

5000 is the default port for SmartPTT SCADA.

NOTE

It is recommended to install the SCADA module on the same computer where SmartPTT Radioserver is installed.

NOTE

The SCADA module activation requires restart of SmartPTT Dispatcher.
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For information on activating the SCADA module in SmartPTT Dispatcher, see the section below.

2.1.6.1 Activating SCADA Module

Follow the procedure to activate the SCADA module in SmartPTT Dispatcher.

Prerequisites: 

• Ensure that the SCADA license is installed. For details, see Licenses.

• Obtain the URL address of the SCADA system that will be accessed through the SCADA module in SmartPTT

Dispatcher.

Procedure: 

1. On the menu bar, click Settings (   ) → Interface → SCADA.

The SCADA Module window appears.

2. Select the Activate SCADA module check box.

The URL address field becomes available.

3. In the URL address field, type the URL address of the desired SCADA module.

Input format is http://<IP address or domain name of the SmartPTT SCADA host>:5000.

4. Click Finish to save changes and close the window.

5. Restart SmartPTT Dispatcher to apply changes.

The SCADA option appears in the Tools menu on the menu bar.

2.2 Equipment

The Equipment submenu is available from the Settings (   ) menu on the SmartPTT Dispatcher menu bar. It

provides the following configuration options:

• Configuring control devices and keyboard shortcuts for quick access to the radio system objects and actions in

SmartPTT Dispatcher.

For details, see Control Devices.

• Configuring general sound settings and settings of connected audio output devices.

For details, see Sound.

• Configuring the Tipro console parameters.

For details, see Tipro Console.

2.2.1 Control Devices

In the Control Devices window you can perform the following actions:

• Configure actions on clicking or tapping the PTT button and other SmartPTT Dispatcher elements for

interaction with the radio objects using a mouse or a touchscreen.

• Assign the desired keys or buttons to the desired system objects and actions as hotkeys.
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The window is available by clicking Settings (   ) → Equipment → Control Devices on the menu bar.

The Control Devices window provides you the following tabs:

• The Pointing devices tab. For details, see Pointing Devices.

• The Keys tab. For details, see Keys.

For information on configuring control devices, see the sections below.

2.2.1.1 Pointing Devices

In the Pointing devices tab, you can configure actions on clicking or tapping the PTT button and other SmartPTT

Dispatcher elements for interaction with the radio object using a pointing device.

Two types of pointing devices are used in SmartPTT Dispatcher:

• Mouse

• Touchscreen
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For both types the following buttons are available:

Select

Affects the action on clicking or tapping. When selected, the call element becomes selected when you click it or

tap.

NOTE

Selected call element has a blue frame.

Call

Affects the action on clicking or tapping. When selected, you initiate a call when click or tap the call element.

The button also provides you access to the controls that affect a call initiating:

• If Hold is selected, the call element should be pressed/tapped and held to initiate and continue a call.

You can end the call by releasing the mouse button or releasing the call element on the touchscreen.

• If Single click/tap is selected, the call element should be clicked/tapped to initiate and continue a call.

You can end the call by clicking or tapping the call element.

2.2.1.2 Keys

In the Keys tab, you can add and assign hotkeys to system objects and actions.
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You can add any amount of hotkeys but each hotkey must have the unique key or key combination assigned.

If you use a keyboard as an input device, use the following information to assign hotkeys properly:

• Esc, Print Screen, and Windows keys cannot be assigned as hotkeys.

• F1 and Enter keys can be assigned only in Alt+Key or Shift+Alt+Key combinations.

Other keys can be used either separately or in the following combinations:

• Alt+Key

• Shift+Key

• Ctrl+Key

• Shift+Ctrl+Key

• Shift+Alt+Key

• Ctrl+Alt+Key

The Keys tab provides the following elements:

Hold

If selected, the hotkey should be pressed and held to initiate and continue a call, or perform an action.

You can end the call by releasing the hotkey.

Single click

If selected, the hotkey should be pressed to initiate and continue a call, or perform an action.

You can end the call by pressing the hotkey again.

Reset All

Deletes all hotkeys. The button does not delete the default hotkey of the PTT button, but reset the hotkey if it was

reassigned by the user.

Search field (   )

Provides the ability to search for an object or an action by entering its name or ID (for radios). When searching for

a radio, the nodes containing the desired radio appear in the list.

Objects and actions

Displays all objects and actions to which you can assign hotkeys. Almost all objects and actions are displayed as

nodes that can be expanded to assign them a hotkey. Radios, categories, and talkgroups and channels are

grouped under the corresponding titles. If the action is available only for one type of the selected objects (for

example, only for radios), the list of objects is displayed under the action or object title without categories.

You can assign a hotkey to any action from the radio object Actions menu. For details, see Actions.

Besides the actions from the radio object Actions menu, the following actions are available:

• Respond to Last Incoming Call (under the PTT node)

• Repeat Last Outgoing Call (under the PTT node)

• End call

You can assign hotkeys to the following objects:
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• PTT Key (by default, the hotkey for it is the Space key)

• Telephone Subscribers

• Dispatchers

NOTE

Hotkeys assigned to dispatchers open the Dispatchers window and automatically initiate a voice call to the

specified dispatcher.

Hotkeys assigned to a telephone subscriber open the Telephone Subscribers window from which you can

manually initiate a call.

Some actions can be activated only if you select the desired object (for example, a radio) before pressing the

assigned hotkey.

Some actions assigned to a hotkey can be applied to more than one object. After selecting the desired objects and

clicking the hotkey, the action is applied to all available objects. If the action is not available to a selected

object,pressing the hotkey brings no result.

The Keys area provides the following elements for configuring the hotkeys settings:

Add key

Adds a hotkey.

Input Devices List

Appears after the Add key button is pressed. Provides a list of input devices that can be used for assigning

hotkeys:

• Keyboard a standard keyboard connected to the computer.

• Input Device (DirectInput) provides the list of USB input devices connected to the computer.

Important

If you use a D-9 by Holmco microphone, do not select the Input Device (DirectInput) option.

• Input Device (HID) provides the list of USB HID input devices connected to the computer.

It is recommended that you select Input Device (HID) for assigning hotkeys using external devices.

• External Device COM Port provides the list of devices connected using a COM port.

Assign Hotkey Button

The blue button that appears after the Add key button is pressed.

When you click the button, three dots appear on it. After it you can assign a hotkey to the selected action or

object.

When the hotkey or hotkeys combination is already assigned to the selected action or object, its name is

displayed on the button.

Delete

Appears after the Add key button is pressed. Deletes the hotkey.

http://www.holmco.de/en/623/tischsprechstelle-mit-usb-anschluss.html


75

Settings Equipment

2.2.1.3 Configuring the Call Element Actions

Follow the procedure to configure actions on clicking or tapping the PTT button and other SmartPTT Dispatcher

elements for interaction with the radio object using a pointing device.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

2. Open the Pointing Devices tab.

3. Configure the desired pointing device. For details, see Pointing Devices.

4. Click Finish to save changes and close the window.

2.2.1.4 Assigning Hotkeys

Follow the procedure to assign a hotkey.

Prerequisites: 

Ensure the desired input device is connected to the computer and is active.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

2. Open the Keys tab.

3. In the top part of the window, select the desired call mode.

For information on call modes, see Keys.

4. In the Object and Actions area, select the desired object or action:

To add a hotkey for an action, click the desired action.

In the Keys area, the Add key button appears.

To add a hotkey for an action which is related to

the desired object (radio, channel, talkgroup, or

category),

expand the desired node, and then click the desired

object.

In the Keys area, the Add key button appears.

To add a hotkey for initiating a call to a

telephone subscriber or a dispatcher,

perform the following actions:

1. Expand the Telephone Subscribers or

Dispatchers node.

The list of available telephone subscribers or

dispatchers appears.

2. Click the desired object.

In the Keys area, the Add key button appears.
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5. In the Keys area, click the Add key button.

Controls for the hot key configuration appear in the Keys area.

6. From the Input Devices list, select the desired input device:

To use a keyboard, select Keyboard.

To use an external DirectInput device

connected using USB port,

perform the following actions:

1. Select Input Device (DirectInput).

The list of available devices appears next to the Input

Devices list.

2. From the list that appears, select the desired USB

device.

To use an external HID device connected

using USB port,

perform the following actions:

1. Select Input Device (HID).

The list of available devices appears next to the Input

Devices list.

2. From the list that appears, select the desired USB

device.

To use an external device connected using

COM port,

perform the following actions:

1. Select External Device COM Port.

The list of available pins of COM port appears next to

the Input Devices list.

2. From the list that appears, select the desired pin.

3. Perform step 9.
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7. Under the Input Devices list, click the Assign Hotkey button.

White dots appear on the button, and the Press desired key message appears next to it.

8. Press the key or key combination you want to assign to the object or action. For details, see Keys.

The key or key combination that you pressed is displayed on the Assign Hotkey button and the Press desired

key message disappears.

9. To save changes and close the window, click Finish.

Postrequisites: 

To edit or delete the assigned hotkey, see Editing and Deleting Hotkeys.

2.2.1.5 Editing and Deleting Hotkeys

Follow the procedure to edit or delete a hotkey.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Control Devices.

The Control Devices window appears.

2. Open the Keys tab.
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3. On the tab, perform one of the following actions:

To change the input device, see step 6 of the Assigning Hotkeys procedure.

To assign another hotkey to an action or

object,

see steps 7-8 of the Assigning Hotkeys procedure.

To delete a hotkey, perform the following actions:

1. In the Objects and Actions area, select the desired

object or action by expanding the desired node.

In the Keys area, the hotkey assigned to the object or

action appears.

2. To the right of the desired assigned hotkey, click

Delete.

The hotkey disappears from the Keys area.

To delete all added hotkeys, click Reset All.

All the hotkeys assigned to objects and actions in SmartPTT

Dispatcher are deleted.

NOTE

The Reset All button cannot delete the default hotkey

entry of the PTT button, but it can reset a hotkey assigned

by the user.

For information on the default PTT button hotkey, see

Keys.

4. To save changes and close the window, click Finish.

2.2.2 Sound

In the Sound window, you can perform the following actions:

• Configure general sound settings.

• Configure sound settings of a Tipro Phone Module.

• Configure output devices for system objects.

• Configure muting and dispatcher sound settings.

WARNING

Before configuring sound settings, ensure that all required sound devices are connected and enabled.
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The window is available by clicking Settings (   ) → Equipment → Sound on the menu bar and provides the

following tabs:

• The General Settings tab. For details, see General Settings.

• The Audio Output Devices tab. For details, see Audio Output Devices.

• The Other Settings tab. For details, see Other Settings.

For information on SmartPTT Dispatcher sound settings, see the sections below.

2.2.2.1 General Settings

In the General Settings tab of the Sound window, you can configure general sound settings of SmartPTT

Dispatcher.

WARNING

Before configuring sound settings, ensure that all required sound devices are connected and enabled.
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The Audio Input area provides the following elements:

Device

A list of audio device to which the microphone is connected.

By default the device used by the operating system is selected (Default).

It is strongly recommended to select the specific device from the list instead of Default.

Input Line

Audio mixer line used to connect a microphone.

Noise Reduction

Makes dispatcher sound clearer by reducing noises. Disabled by default.

You can select a level of noise reduction from 3 to 18 dB. If voice and noise levels are the same or close, do not

enable noise reduction.

Audio Input test

Provides buttons for checking a sound of the audio input device:

• The Record button initiates a microphone sound recording and unblocks Play and Save buttons after you

stop the recording.

• The Play button plays the recorded sound.
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• The Save button saves the recorded sound on the computer.

The Audio Output area provides the following elements:

Main device

The device that is used to play all sounds except for those for which personal audio output device is configured.

By default the device used by the operating system is selected (Default).

It is strongly recommended to select the specific device from the list instead of Default.

Check

Checks the sound of the selected audio output device. When pressed, changes to the Stop button.

The VoIP Parameters area provides the following elements:

Codec

Audio stream compression method.

Codec Format

Audio stream sampling frequency.

VoIP Port

The box in which you can specify a port for sound stream receiving.

Below the area the following elements are provided:

Automatic Gain Control

Enables feature that adjusts the volume of incoming calls. By default, the check box is selected.

TIPRO phone module: switching audio input and audio output when answer a call

The check box activates switching between main audio output/input devices and audio output/input devices of

the phone module when you lift or put down the handset.

The check box also provides areas and controls for specifying audio devices for a Tipro phone module. The

specified audio devices will be used after you lift the module handset.
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The Phone module audio input area provides the following elements:

Device

A list of audio devices of the Tipro Phone Module. It is recommended to select a specific audio input device instead

of Default.

If the selected device matches the device selected as general input device, it becomes red and either phone

module or general input device should be changed.

Input Line

Audio mixer line of the Tipro Phone Module handset.

Noise Reduction

Makes sound clearer by reducing noises. Disabled by default.

You can select a level of noise reduction from 3 to 18 dB. If voice and noise levels are the same or close, do not

enable noise reduction.

Audio Input test

Provides buttons for checking a sound of the audio input device:

• The Record button initiates a microphone sound recording and unblocks Play and Save buttons after you

stop the recording.
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• The Play button plays the recorded sound.

• The Save button saves the recorded sound on the computer.

The Phone module audio output area provides the following elements:

Main device

Audio device to which headsets or speakers are connected.

Check

Checks the sound of the selected audio output device. When pressed, changes to the Stop button.

2.2.2.2 Audio Output Devices

In the Audio Output Devices tab you can manage virtual audio output devices, and then assign them to the

desired system objects.

The Audio Output Devices tab provides the following elements:

Add

Adds a new virtual audio output device to the Virtual audio output devices box. This device is used only in

SmartPTT Dispatcher.
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Edit

Can be used for renaming a virtual audio output device in the Virtual audio output devices box. You cannot

rename the Main Device virtual device.

Delete

Deletes the selected virtual audio output device in the Virtual audio output devices box. You cannot delete the

Main Device virtual device.

Virtual audio output devices

The box contains virtual audio output devices that are used only in SmartPTT Dispatcher. By default has Main

Device virtual device that cannot be deleted and renamed.

You can use the Add, Edit, and Delete buttons to manage virtual devices in the box, and the Check button to

check the sound of the virtual device.

NOTE

To check the sound of an added virtual device, you should select the desired sound channel in the Channels of

virtual Audio Output devices box, and then press the Check button.

Sound channels of the virtual audio output device

The box contains audio channels of the virtual device selected in the Audio Output virtual devices box.

These channels can be selected for the virtual audio output device, using which the sound is played in the system.

All audio channels of the Main Device virtual device are selected by default and cannot be customized.

Objects

A box containing system objects to which you can assign a virtual audio output device.

The main objects in the Objects box are the following:

Selected objects

Objects that are selected or whose call window is open and active (the window has the blue title bar, and the PTT

button has the blue frame). The volume of the selected objects is adjusted in the Sound panel.

By default, the Main Device virtual device is selected as an audio output device for selected objects.

NOTE

Telephone subscribers, other dispatchers, and conferences cannot be selected objects.

Unselected objects

Objects that are unselected. The volume of the selected objects is adjusted in the Sound panel. For details, see

Sound.

By default, the Main Device virtual device is selected as an audio output device for unselected objects.

System sounds

All system sounds such as the following:

• Sound of a triggered rule

• Sound of the transmission initiating

• Notifications of dispatcher and telephone subscriber incoming calls

• Sound of call records played in the both dispatcher and radioserver Event Log

• Sound of system messages
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• Notification of private radio call request

• Sound of the Call Alert command

The volume of the system sounds is adjusted in the Sound panel. For details, see Sound.

By default, the Main Device virtual device is selected as an audio output device for system sounds.

Alarm

Sound of emergency and emergency calls.

You cannot change the volume of emergency sound or mute it.

For information on changing volume of emergency calls sound, see Channel Properties.

NOTE

If <No> is selected from the Personal audio output list, the device selected for selected/unselected objects is used

for emergency and emergency calls.

Other objects appear in the Objects box only when they are available in the system. These objects are:

• Radio servers (   )

• Channels (   )

• Talkgroups (   )

Personal audio output

The list from which you can select the desired audio output device for the object. Independently on the selected

device, the sound is also played using the main device. It is applicable to all objects except for system sounds.

You can select the following devices:

• If you select <No>, the sound of a channel or a talkgroups is played using the devices selected for the

selected/unselected objects, or using the main device. The sound of an alarm object or a radio server is played

only using the device selected for the selected/unselected objects.

Unavailable to selected/unselected objects and system sounds.

• If you select Main Device, the sound is played using the default virtual audio output device.

The Main Device is assigned to selected/unselected objects and system sounds by default.

• If you select any of the devices manually added to the Virtual audio output devices box, the sound is played

using this device.

Use the personal audio output only

If the check box is selected, main device and devices set for selected/unselected objects are ignored. The sound is

played only using the device selected from the Personal audio output list.

Unavailable to main objects such as selected/unselected objects, system sounds, and alarm.

Clear All

Resets all system objects to default state.
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2.2.2.3 Other Settings

In the Other Settings tab you can configure additional sound settings for SmartPTT Dispatcher.

The Incoming call volume area provides the following elements:

Set Minimum Volume

If selected, dispatcher cannot mute SmartPTT Dispatcher sound, but only turn down the volume to minimum. The

check box unblocks the slider for setting the minimum volume level in SmartPTT Dispatcher. The minimum value

is 10% of the general volume level.

NOTE

The specified level affects only SmartPTT Dispatcher and depends on the volume level of the operating system.

Disable muting of private calls to dispatcher

If selected, incoming transmissions are never muted in SmartPTT Dispatcher.For example, if the channel sound is

muted or the Mute incoming calls while transmitting check box is selected, dispatcher will still hear incoming

private calls. For information on incoming calls, see Voice Calls.

Mute incoming calls while transmitting

If selected, all incoming calls are muted while outgoing transmission.
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Mute other dispatcher voice

Activates muting of other dispatchers and unblocks the For all dispatchers and For dispatchers in this

location options.

For all dispatchers

Mutes transmissions of all dispatchers in the system.

For dispatchers in this location

Unblocks the field in which you can specify a name or a number of a location where dispatchers are located. All

dispatchers with the same value specified in the field will not hear each other's transmissions.

The location value must contain no more than 50 characters.

The Amplify dispatcher voice area provides the Amplification slider for increasing or decreasing the volume level

of the dispatcher voice in outgoing transmissions. The default value is 1 (amplification is not applied).

2.2.2.4 Configuring Sound Settings

In SmartPTT Dispatcher you can perform the following actions for configuring its sound settings:

• Configure general sound settings. For details, see Configuring General Sound Settings.

• Configure sound settings of a Tipro Phone Module. For details, see Configuring Sound Settings of Tipro Phone

Module.

• Configure muting settings. For details, see Configuring Muting Options.

• Configure dispatcher sound settings. For details, see Configuring Dispatcher Sound Options.

2.2.2.4.1 Configuring General Sound Settings

Follow the procedure to configure general sound settings.

Prerequisites: 

Ensure the required audio input/output devices are connected and enabled.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the General Settings tab.

3. In the Audio Input area, configure settings of the audio input device:

a. From the Device list, select the desired output device.

b. From the Input Line list, select the desired input line.

c. (Optional) From the Noise Reduction list, select the desired level of a noise reduction. For details, see

General Settings.

4. Check the selected audio input device:

a. Click the Record button and speak into the device.

The Record button changes to Stop.
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b. Click Stop to stop the recording.

The Stop button changes to Record and other buttons become unblocked.

c. Click Play to listen to the recorded voice.

The Play button changes to Stop and you will hear the voice if the input device works properly.

d. (Optional) Click Save to save the recorded voice sample.

5. In the Audio Output area, configure settings of the audio output device:

a. From the Main device list, select the desired output device.

b. Click Check to check the selected output device.

The Check button changes to Stop and you will hear the sound if the output device works properly.

c. Click Stop to stop the output device check.

6. In the VoIP Parameters area, configure settings of the voice transmitting:

a. From the Codec list, select the desired codec.

b. From the Codec Format list, select the codec sampling frequency.

c. In the VoIP Port box, enter the desired port using which the voice is transmitted.

7. (Optional) Select the Automatic Gain Control check box to adjust the volume of incoming calls.

8. To save changes and close the window, click Finish.

2.2.2.4.2 Configuring Sound Settings of Tipro Phone Module

Follow the procedure to configure sound settings of a Tipro Phone Module.

NOTE

Audio input/output devices of the Tipro Phone Module should differ from general sound input/output devices.

Prerequisites: 

Ensure the required audio input/output devices are connected and enabled.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the General Settings tab.

3. Configure the general sound settings of SmartPTT Dispatcher. For details, see Configuring General Sound

Settings.

4. Select the TIPRO phone module: switching audio input and audio output when answer a call check box.

5. In the Phone module audio input area, configure audio input device of the phone module:

a. From the Device list, select the desired output device.
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b. From the Input Line list, select the desired input line.

c. (Optional) From the Noise Reduction list, select the desired level of a noise reduction. For details,

see General Settings.

6. Check the selected audio input device:

a. Click the Record button and speak into the device.

The Record button changes to Stop.

b. Click Stop to stop the recording.

The Stop button changes to Record and other buttons become unblocked.

c. Click Play to listen to the recorded voice.

The Play button changes to Stop and you will hear the voice if the input device works properly.

d. (Optional) Click Save to save the recorded voice sample.

7. In the Phone module audio output area, configure audio output device of the phone module:

a. From the Main device list, select the desired output device.

b. Click Check to check the selected output device.

The Check button changes to Stop and you will hear the sound if the output device works properly.

c. Click Stop to stop the output device check.

8. To save changes and close the window, click Finish.

2.2.2.4.3 Configuring Muting Options

Follow the procedure to configure muting options.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the Other Settings tab.

3. In the Incoming call volume area, configure the mute settings:

To disable muting of incoming private

calls,

select the Disable muting of private calls to dispatcher

check box.

To mute incoming calls during outgoing

transmissions,

select the Mute incoming calls while transmitting check

box.

To activate muting of all dispatchers, perform the following actions:

1. Select the Mute other dispatcher voice check box.

2. Select the For all dispatchers option.



90

Settings Equipment

To activate muting of the desired

dispatchers,

perform the following actions:

1. Select the Mute other dispatcher voice check box.

The options below become available.

2. Select the For dispatchers in this location option.

3. In the filed to the right, type the location name or

number.

4. Using entered data, repeat the procedure for other

dispatchers that should not hear each other.

Dispatchers for whom in the For dispatchers in this

location field the identical data is set, are unable to

hear each other.

4. To save changes and close the window, click Finish.

2.2.2.4.4 Configuring Dispatcher Sound Options

Follow the procedure to configure dispatcher sound options.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the Other Settings tab.

3. On the Other Settings tab perform one of the following actions:

To set minimum volume in SmartPTT

Dispatcher,

perform the following actions:

1. In the Incoming call volume area, select the Set

minimum volume check box.

2. Move the slider to the desired volume level.

To adjust a dispatcher voice in outgoing

transmissions,

in the Amplify dispatcher voice area move the

Amplification slider to the desired volume level.

4. To save changes and close the window, click Finish.

2.2.2.5 Configuring Multichannel Sound

Configuring multichannel sound includes the following:

• Configuring virtual audio output devices. For details, see Configuring Audio Output Device.

• Assigning virtual audio output devices to system objects. For details, see Assigning Audio Output Devices to

System Objects.
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2.2.2.5.1 Configuring Audio Output Device

Follow the procedure to configure virtual audio output device.

Prerequisites: 

Ensure that audio input/output devices of SmartPTT Dispatcher are configured.

Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the Audio Output Devices tab.

3. Click Add.

A new audio output device appears in the Virtual audio output devices box.
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4. (Optional) Click Edit, to rename the added virtual device, and then press Enter.

5. In the Sound channels of virtual audio output devices box, select the desired sound channels for the added

audio output device.

6. In the Virtual audio output devices box, click Check to check the selected sound channels.

The Check button changes to Stop.

7. Click Stop to stop the sound check.

8. To save changes and close the window, click Finish.

Postrequisites: 

To assign the added device to the system objects, see Assigning Audio Output Devices to System Objects.

2.2.2.5.2 Assigning Audio Output Devices to System Objects

Follow the procedure to assign virtual audio output device to a system object.

Prerequisites: 

Ensure the desired virtual audio device is added to the Virtual audio output devices box and configured properly. For

details, see Configuring Audio Output Device.
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Procedure: 

1. On the menu bar, click Settings (   ) → Equipment → Sound.

The Sound Settings window appears.

2. In the Sound Settings window, open the Audio Output Devices tab.

3. In the Objects box of the Audio Output Devices tab, click the desired object.

4. From the Personal audio output list, select a virtual device for the object.

5. (Optional) Select the Use the personal audio output only check box to use for the system object only the

device selected from the Personal audio output list.

For details, see Audio Output Devices.

6. To save changes and close the window, click Finish.

Postrequisites: 

To reset all system objects to default state, click Clear All.

2.2.3 Tipro Console

SmartPTT system supports third-party equipment, for example, Tipro modular console with BeFREE touchcomputer

or without it.

To make the console work with SmartPTT system, perform the following actions:

1. For Tipro modular console with BeFREE touchcomputer, install additional applications: ChangeMe Utility,

Tipro OPOS (these are delivered together with Tipro console), Microsoft Point of Service for .NET (POS for

.NET) v1.14 (http://www.microsoft.com/en-us/download/details.aspx?id=42081).

2. For Tipro modular console without touchcomputer, connect Tipro console to the PC with SmartPTT Dispatcher

installed. Install other additional software, such as ChangeMe Utility, Tipro OPOS (these are delivered together

with Tipro console), Microsoft Point of Service for .NET (POS for .NET) v1.14 (http://www.microsoft.com/en-

us/download/details.aspx?id=42081).

3. Contact SmartPTT support team (http://support.smartptt.com/hc/en-us/requests/new) for Tipro configuration

file.

4. Apply the received Tipro configuration file using ChangeMe Utility.

For information on configuring sound settings of Tipro console, see Configuring General Sound Settings.

For information on configuring sound settings of Tipro Phone Module, see Configuring Sound Settings of Tipro

Phone Module.

For information on actions on tapping call elements or assigning hotkeys using Tipro console, see Configuring the

Call Element Actions.

http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://www.microsoft.com/en-us/download/details.aspx?id=42081
http://support.smartptt.com/hc/en-us/requests/new
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2.3 Telephone Interconnect

The Telephone Interconnect submenu is available from the Settings (   ) menu on the SmartPTT Dispatcher

menu bar. It provides the following configuration options:

• Configuring settings required for establishing connection to telephone subscribers.

For details, see Telephone Interconnect Settings.

• Configuring the list of telephone subscribers in SmartPTT Dispatcher

For details, see Telephone Subscribers Settings.

2.3.1 Telephone Interconnect Settings

The Telephone Interconnect feature provides the ability to establish connection between operators and telephone

subscribers. A call can be initiated both by operators and telephone subscribers. Voice between them is transmitted

in full-duplex mode and through the Real-time Transport Protocol (RTP). Connection and subscriber addressing are

performed over the Session Initiation Protocol (SIP). SmartPTT Dispatcher provides connection to telephone

subscribers using one of two modes: the client mode (SIP account) or the gateway mode (SIP trunk).

Important

Access to full functionality of the Telephone Interconnect feature requires installing the corresponding license and

having the corresponding permission (for operators). For details, see Licenses and Operators.

NOTE

The SIP protocol can be blocked by the Windows firewall. Contact your system administrator to check if your

firewall settings allow SIP.

SmartPTT Dispatcher Telephone Interconnect features

• Voice call from SmartPTT Dispatcher to a telephone subscriber

• Voice call from a telephone subscriber to SmartPTT Dispatcher

• Service tones playback (sound alert for incoming call, sound alert for outgoing call)

• Software-based volume gain for calls

Telephony Glossary

VoIP gateway is a device bridging conventional telephone networks and equipment to VoIP telephone networks.

Connection between SmartPTT Dispatcher and the PBX can be established with or without the VoIP gateway.

Private Branch eXchange (PBX) is a telephone exchange normally used in offices.

Public Switched Telephone Network (PSTN) is the wired phone system over which landline telephone calls are

made using circuit switching.

Establishing connection via SIP account

To establish a connection using SIP account, the following conditions must be met:



95

Settings Telephone Interconnect

• In the PBX settings, create a SIP account.

• Add the SIP account to SmartPTT Dispatcher.

• Allow calls to telephone subscribers in SmartPTT Dispatcher (by selecting the corresponding check box).

For information on establishing connection via SIP account, submit a request to the SmartPTT Technical Support

Center.

Establishing connection via SIP trunk

To establish a connection using SIP trunk, the following conditions must be met:

• In the PBX settings, create a SIP trunk connection for SmartPTT Dispatcher.

• Connect SmartPTT Dispatcher to the PBX.

• Allow calls to telephone subscribers in SmartPTT Dispatcher (by selecting the corresponding check box).

For information on establishing connection via SIP trunk, submit a request to the SmartPTT Technical Support

Center.

Important

If SIP trunk for SmartPTT Dispatcher is configured in the PBX settings, telephone calls will be established via

SIP trunk by default, even if the SIP account mode is configured in SmartPTT Dispatcher.

To provide correct functioning of the Telephone Interconnect feature, you need to configure parameters of

connection between SmartPTT Dispatcher and telephone subscribers in the Telephone Interconnect window.

You can open the window by clicking Settings (   ) → Telephone Interconnect → Telephone Interconnect on

the menu bar.

The Telephone Interconnect window consists of four tabs. They provide the following configuration options:

• General settings required for correct functioning of the Telephone Interconnect feature.

For details, see General Settings.

• Audio codecs used for processing incoming and outgoing audio.

For details, see Codec Settings.

• SIP trunk authentication.

For details, see SIP Trunk Authentication.

• SIP accounts.

For details, see SIP Accounts.

http://support.smartptt.com/hc/en-us
http://support.smartptt.com/hc/en-us
http://support.smartptt.com/hc/en-us
http://support.smartptt.com/hc/en-us
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2.3.1.1 General Settings

The General Settings tab provides controls for configuring general settings required for correct functioning of the

Telephone Interconnect feature.

The General Settings tab consists of two main areas:

• Dispatcher Settings

• VoIP Gateway Default Settings (for SIP trunk authentication)

The Dispatcher Settings area provides the following elements:

Allow Calls to Telephone Subscribers

Activates the Telephone Interconnect feature providing SmartPTT Dispatcher with the ability to establish

connection with telephone subscribers.

NOTE

If the Allow Calls to Telephone Subscribers check box is not selected, the Telephone Subscribers button on

the menu bar is unavailable.

Transport

The protocol (TCP or UDP) used for SIP commands transmit. Must match the corresponding parameter on the

PBX.
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SIP Port

The UDP or TCP port used for receiving and sending SIP data packets. The port specified in this box must be

available to incoming and outgoing traffic.

The default value is 5060.

Phone Number

Telephone number at which telephone subscribers can call SmartPTT Dispatcher. This number is also displayed on

the screen of the called device.

Interface

IP address of the local computer that is used for voice and commands transmit.

If the computer has only one IP address, the system selects it automatically. If the computer has more than one

IP address, the desired IP address must be manually specified and be available to the VoIP gateway. Otherwise, all

physical interfaces available on the computer will be used (the Automatically option).

RTP Ports

The ports used for connection to telephone subscribers.

Each connection to a telephone subscriber occupies two ports. Even port numbers are used by the RTP protocol.

Odd port numbers are used by the RTCP protocol. The ports you specify must be available both for incoming and

outgoing traffic.

The default range is from 18700 to 18748.

NOTE

If SmartPTT Dispatcher and SmartPTT Radioserver are installed on the same computer, they must be assigned

different RTP ports. For example, port 5060 for SmartPTT Radioserver and port 5061 for SmartPTT Dispatcher.

Displayed Subscriber Name

The SmartPTT Dispatcher name displayed on the screen of the device receiving the call.

The VoIP Gateway Default Settings area provides the following elements:

Dial Prefix for Outgoing Calls

Numeric prefix added to the subscriber's number by SmartPTT Dispatcher. The VoIP gateway uses the prefix to

determine the source of the call and the rules that must be applied to it.

For information on configuring rules in SmartPTT Dispatcher, see Custom Rules.

Dial Prefix for Incoming Calls

Numeric prefix added to the SmartPTT Dispatcher number that is displayed to telephone subscribers and must be

used for calling back. This prefix must match the corresponding parameter on the PBX.

Default VoIP Gateway Address

The VoIP gateway IP address.

SIP Port

Number of the VoIP gateway UDP or TCP port used for receiving and sending SIP data packets.

The default value is 5060.

The VoIP Gateway Default Settings parameters are used for establishing connection to telephone subscribers. If

they are specified, you need to dial only the subscriber's phone number, the rest will be substituted automatically.

Play sound alert for incoming call

Plays an alert sound when a telephone subscriber calls SmartPTT Dispatcher.
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Play sound alert for outgoing call

Plays an alert sound when SmartPTT Dispatcher calls a telephone subscriber.

Sound Level

Adjusts the volume level of the sound received from telephone subscribers in SmartPTT Dispatcher.

2.3.1.2 Codec Settings

On the Codec Settings tab you can activate/deactivate available audio codecs and change their priority. The codec

priority defines which codec will be used first for the audio processing.

Currently, the following audio codecs are supported:

• G711A

• G711U

• SPEEX

• G729

NOTE

The G729 codec reduces audio quality due to a higher data compression ratio, which makes it suitable for low-

capacity systems.
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The Codec Settings tab contains the Available codecs table with information on available audio codecs and their

priority.

The table consists of the following columns:

• The Active column contains the check box indicating the codec activation status.

By selecting or clearing the check box, you can activate or deactivate the codec. Inactive codecs will not be used

for the incoming audio processing.

Important

If the codecs supported by the PBX are deactivated in SmartPTT Dispatcher, voice data will not be transmitted.

• The Name column contains the audio codec name.

• The Priority column contains the number indicating the codec priority level. Audio codecs with higher priority

will be used for audio processing in SmartPTT Dispatcher in the first place.

The priority levels range from 1 to 4, from highest to lowest respectively. You can set the desired priority using

the Raise priority (   ) and Lower priority (   ) buttons located to the right of the table.

For information on managing audio codecs, see the section below.

2.3.1.2.1 Managing Audio Codecs

Follow the procedure to activate/deactivate an audio codec or change its priority level.

Procedure: 

1. Open the Codec Settings tab in the Telephone Interconnect window.

2. Perform the desired action:

To activate or deactivate the audio codec, in the Available codecs table, in the Active column, select

or clear the corresponding check box.

To change the audio codec priority, perform the following actions:

1. In the Available codecs table, click the desired audio

codec.

2. To the right of the Available codecs table, click Raise

priority (   ) or Lower priority (   ) to raise or lower

the codec priority respectively.

3. Click Finish to save changes and close the Telephone Interconnect window.
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2.3.1.3 SIP Trunk Authentication

SIP trunking is used in the radio systems where SmartPTT Dispatcher has a static IP address. In this case, it registers

on the PBX only once, without having to re-register on each session initiation. SIP trunking provides security by

means of password authentication for incoming and outgoing calls.

The SIP Trunk Authentication tab provides controls for setting authentication parameters for incoming and

outgoing calls. The tab consists of two main areas:

• Incoming Calls Authentication

• Outgoing Calls Authentication

The Incoming Calls Authentication area provides the following elements:

Enabled

Activates the incoming calls authentication.
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Realm

The parameter used for the incoming telephone calls authentication.

When SmartPTT Dispatcher receives a call, it requires the username and password valid for the specified realm. If

the caller replies with valid credentials, connection to the called radio or talkgroup will be established.

If the parameter is not specified, SmartPTT Dispatcher replies to all authentication requests with the specified

username and password.

User Name

The username required for authentication. Must be valid for the specified realm.

Password

The password required for authentication. Must be valid for the specified realm.

The Outgoing Calls Authentication area provides the following elements:

Enabled

Activates the outgoing calls authentication.

Realm

The parameter used for the outgoing telephone calls authentication.

If the parameter is specified, SmartPTT Dispatcher responds only to authentication requests with the username

and password valid for the specific realm.

If the parameter is not specified, authentication is based on the username and password only.

User Name

The username required for authentication. Must be valid for the specified realm.

Password

The password required for authentication. Must be valid for the specified realm.
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2.3.1.4 SIP Accounts

The SIP Accounts tab contains a table with information on SIP accounts added to SmartPTT Dispatcher. These

parameters are used for establishing connection with subscribers on these servers.

Connection is established through a PBX account. SmartPTT Dispatcher regularly sends its authentication data and

current IP address at defined intervals to re-register on the PBX and keep identification information on the server up-

to-date.

The table consists of the following columns:

Name

Displays the SIP account name.

SIP Account

Displays the full name of the SIP account.

Active

Displays the SIP account activation status. If the check box is selected, the account is active and can be used for

establishing connection to telephone subscribers.
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Status

Displays the account registration status on the PBX.

The following registration statuses are available:

• The Registered status indicates that the account is successfully registered on the PBX and is currently active.

• The Not registered status indicates that the account is not registered on the PBX and is currently inactive.

• The Processing status indicates that SmartPTT Dispatcher has sent a registration request and is currently

waiting for the PBX response.

• Error messages indicate the errors that occurred during the registration process.

The entries in the table can be managed using the following controls:

Add (   )

Opens the SIP Account window for adding a new account.

For information on adding SIP accounts, see Managing SIP Accounts.

Edit (   )

Opens the SIP Account window for editing an existing account.

For information on editing existing SIP accounts, see Managing SIP Accounts.

Delete (   )

Removes the selected account from the list.

For information on deleting SIP accounts, see Managing SIP Accounts.

For information on managing SIP accounts and the SIP Account window, see the sections below.

2.3.1.4.1 SIP Account Window

The SIP Account window provides the ability to add new or edit an existing SIP account.

You can open the SIP Account window from the SIP Accounts tab of the Telephone Interconnect window in one

of the following ways:

• By clicking the Add (   ) button in the top part of the window.
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• By clicking the desired account in the table and then clicking the Edit (   ) button in the top part of the

window.

• By double-clicking the desired account in the table.

The SIP Account window provides the following elements:

Active

Activates registration of the selected account on the PBX.

Display Name

The name that appears on the subscriber's device screen on receiving a call from SmartPTT Dispatcher.

Username

The account identifier on the PBX.

The required parameter.

SIP Server

The IP address of the remote PBX on which the account is registered.

The required parameter.

SIP Server Port

The PBX port used for receiving data.

The default value is 5060.

Proxy

The IP address of a proxy server that can be used by SmartPTT Dispatcher for access to the PBX.

Some providers require using proxy for sending requests to PBXs.
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Proxy Port

The proxy server port used for receiving data.

The default value is 5060.

Domain

The PBX parameter facilitating telephone subscriber addressing. It is used by some PBXs for account

authentication.

Login

Login for the account authentication on the PBX.

Password

Password for the account authentication on the PBX.

Registration Renewal Timer

The time period (in seconds) after which SmartPTT Dispatcher sends the SIP registration request and updates its

current IP address on the PBX.

The default value is 3600.

For information on managing SIP accounts, see the section below.

2.3.1.4.2 Managing SIP Accounts

Follow the procedure to add a new SIP account or activate/deactivate, edit, or delete an existing one.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. Open the SIP Accounts tab, and then perform the desired action:

To add a new account, perform the following actions:

1. In the top part of the tab, click Add (   ).

The SIP Account window appears.

2. In the SIP Account window, in the Username and

SIP Server fields, type your username and the desired

PBX IP address.

3. (Optional) Complete other fields with desired

information. For details, see SIP Account Window.

4. Click OK.

The new account appears in the table on the

SIP Accounts tab.

To activate or deactivate an existing

account,

in the table, select or clear the check box in the Active

column.
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To edit an existing account, perform the following actions:

1. In the table, click the desired account, and then

click Edit (   ), or double-click the desired account.

The SIP Account window appears.

2. In the SIP Account window, edit the desired

information, and then click OK.

To delete an existing account, perform the following actions:

1. In the table, click the desired account, and then click

Delete (   ).

The Confirmation window appears.

2. In the Confirmation window, click OK.

The selected account is removed from the table.

3. Click Finish to save changes and close the Telephone Interconnect window.

2.3.2 Telephone Subscribers

To facilitate interactions with telephone subscribers, you can configure the list of telephone subscribers in the

Telephone Subscribers window. It provides the ability to add new telephone subscribers and edit and delete the

telephone subscribers added earlier.

Connection to telephone subscribers not added to the list of telephone subscribers can be established by dialing

their number manually using the dial pad.

Important

To communicate with telephone subscribers, an operator needs to have the Make telephone calls permission.

For details, see Operators.



107

Settings Telephone Interconnect

You can open the Telephone Subscribers window by clicking Settings (   ) → Telephone Interconnect →

Telephone Subscribers on the menu bar.

The Telephone Subscribers window contains a table with information on all registered telephone subscribers. It

consists of the following columns:

• The Telephone Subscriber column contains the name of the telephone subscriber set in SmartPTT

Dispatcher.

• The Address column contains the SIP address of the telephone subscriber.

The entries in the table can be managed using the following controls:

Add (   )

Opens the Telephone Subscriber window for adding a new telephone subscriber.

For information on adding new telephone subscribers, see Adding and Editing Telephone Subscribers.

Edit (   )

Opens the Telephone Subscriber window for editing an existing telephone subscriber.

For information on this window, see Telephone Subscriber Window.
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Delete (   )

Removes the selected subscriber from the SmartPTT Dispatcher list of telephone subscribers.

For information on managing telephone subscribers and the Telephone Subscriber window, see the sections

below.

2.3.2.1 Telephone Subscriber Window

The Telephone Subscriber window provides the ability to add new and edit information on existing telephone

subscribers.

You can open the Telephone Subscriber window from the Telephone Subscribers window in one of the following

ways:

• By clicking the Add (   ) button in the top part of the window.

• By clicking the desired subscriber in the table and then clicking the Edit (   ) button in the top part of the

window.

• By double-clicking the desired subscriber in the table.

The Telephone Subscriber window provides the following elements:

Avatar

Area for configuring telephone subscriber's avatar. The area provides the following elements:

• Current avatar — subscriber’s photo or other graphic image.

• Select — opens the window for selecting the telephone subscriber's avatar.

• Delete Subscriber Photo (   ) — removes the selected avatar.

Subscriber

The telephone subscriber's name.
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The SIP-Address area provides controls for selecting the desired SIP addressing format:

Automatic

Activates automatic SIP addressing. After specifying the subscriber's phone number in the Number box below,

the outgoing and incoming addresses are generated automatically using default gateway settings.

Full Address

Activates manual SIP addressing. To call a subscriber, in the Outgoing and Incoming boxes, you will need to

enter their full SIP addresses for incoming and outgoing calls in the following format:

sip:prefix number@gateway:port

Enable SIP Account

Activates a specific SIP account for connection to the telephone subscriber. If selected, you need to select the

desired SIP account from the list to the right of the check box. For details, see SIP Accounts.

Sound for Incoming Call Alert

Provides the ability to configure an audio file that will play in SmartPTT Dispatcher on receiving a call from this

telephone subscriber:

• Use a system sound (   ) — clears the path to the selected audio file and resets the sound to default.

• Select a sound file for an incoming call (   ) — opens a window for selecting the desired audio file.

• Audio file path — field with a full path to the selected audio file.

For information on adding and editing telephone subscribers, see the section below.

2.3.2.2 Adding and Editing Telephone Subscribers

Follow the procedure to add a new subscriber to the list of telephone subscribers in SmartPTT Dispatcher or edit an

existing subscriber.

Prerequisites: 

• From PBX settings obtain numbers of the desired telephone subscribers.

• If you do not use SIP automatic addressing, from SmartPTT Radioserver Configurator obtain the following

information:

• Radioserver call number. For details, see “Configuring Incoming Calls” in SmartPTT Installation and

Configuration Guide.

• IP address and port number of the SIP server. For details, see “Configuring Outgoing Calls” in SmartPTT

Installation and Configuration Guide.

• If you want to use the automatic SIP addressing format, ensure that the VoIP gateway default settings are

specified in the Telephone Interconnect settings. For details, see General Settings.

• If you want to use SIP account for connection to the telephone subscriber, ensure that the desired account is

added to the SIP Accounts list in SmartPTT Dispatcher. For details, see SIP Accounts.

• (Optional) Prepare the following files:

• Telephone subscriber's avatar.

• Audio file that will play in SmartPTT Dispatcher on receiving a call from this telephone subscriber.
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Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Subscribers.

The Telephone Subscribers window appears.

2. Perform one of the desired actions:

To add a new telephone subscriber, in the top part of the window, click Add (   ).

To edit an existing telephone subscriber, perform the following actions:

1. Select the desired subscriber from the list.

2. In the top part of the window, click Edit (   ).

The Telephone Subscriber window appears.

3. In the Subscriber field, type the subscriber's name.

4. Select the desired SIP addressing format:

To use default gateway settings, perform the following actions:

1. In the SIP-Address area, select Automatic.

2. In the Number field, type the phone number of the

telephone subscriber.

To use the subscriber's full address, perform the following actions:

1. In the SIP-Address area, select Full Address.

2. In the Outgoing field, type the subscriber's

SIP address for outgoing calls in the following format:

sip:prefix number@gateway:port

3. In the Incoming field, type the subscriber's

SIP address for incoming calls in the following format:

sip:prefix number@gateway:port

5. (Optional) Select the Enable SIP Account check box, and then, from the list on the right, select the desired

SIP account.

6. Configure incoming call alert sound:

To restore default settings and use the standard

system sound,

next to Sound for Incoming Call Alert, click

Use a system sound (   ).

To use custom sound, perform the following actions:

1. Next to Sound for Incoming Call Alert, click

Select a sound file for an incoming call (   ).

2. In the window that appears select the desired

audio file.
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7. Configure telephone subscriber's avatar:

To select an image for the subscriber's avatar, perform the following actions:

1. In the upper-left corner of the window, click

Select.

2. In the window that appears select the desired

image.

To remove current subscriber avatar, in the upper-left corner of the window, click Delete

Subscriber Photo (   ).

8. In the Telephone Subscriber window, click OK.

Postrequisites: 

To delete an existing telephone subscriber, in the Telephone Subscribers window, click the name of the subscriber,

and then click Delete (   ).

2.3.3 Telephone Interconnect Configuration

To ensure correct functioning of the Telephone Interconnect feature, you need to configure minimum required

settings that provide access to its main functionality. This guide describes the recommended configuration settings

required for the feature operability:

• Configuration of the Telephone Interconnect feature (the corresponding license is required).

For details, see Configuring Telephone Interconnect Settings.

• Configuration of the conference call settings (the license is not required).

For details, see Configuring Conference Calls Settings.

For information on these settings see the sections below.

2.3.3.1 Configuring Telephone Interconnect Settings

Follow the procedure to configure minimum required Telephone Interconnect settings in SmartPTT Dispatcher.

Prerequisites: 

• Ensure you have the license required for access to the Telephone Interconnect functionality. For details,

see Licenses.

• Ensure at least one of the codecs activated in SmartPTT Dispatcher is supported by the PBX.

• Ensure the required settings are configured on SmartPTT Radioserver. For details, see “Connecting to PBX” in

SmartPTT Installation and Configuration Guide.

• For SIP trunk authentication, obtain the authentication parameters for incoming and outgoing calls (realm,

username, password).

• For SIP trunk authentication, obtain the VoIP gateway parameters (dial Prefix for outgoing calls, IP address,

SIP port).
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Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. On the General Settings tab, in the Dispatcher Settings area, configure the following settings:

a. Select the Allow Calls to Telephone Subscribers check box.

b. From the Interface list, select the IP address of the SmartPTT Dispatcher computer that must be used for

connection to telephone subscribers.

c. In the RTP ports fields, specify the ports that must be used for connection to telephone subscribers.

NOTE

Configuration of the SmartPTT Dispatcher parameters must match the corresponding settings on the PBX.

3. Configure the authentication parameters:

To use the SIP trunk authentication

format,

perform the following actions:

1. On the General Settings tab, in the VoIP Gateway

Default Settings area, perform the following actions:

a. In the Dial Prefix for Outgoing Calls box, specify

the prefix for outgoing calls matching the prefix

specified in the VoIP gateway settings.

b. In the Default VoIP Gateway Address box,

specify the VoIP gateway IP address.

c. In the SIP port field, specify the VoIP gateway port

used for the SIP data packets transmit.

2. (Optional) If the incoming calls authentication is

configured on SmartPTT Radioserver, perform the

following actions:

a. On the SIP Trunk Authentication tab, in the

Incoming Calls Authentication area, select the

Enabled check box.

b. In the Realm, User Name and Password fields,

specify the authentication parameters configured

on SmartPTT Radioserver.
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3. (Optional) If the outgoing calls authentication is

configured on the PBX, on the SIP Trunk

Authentication tab, in the Outgoing Calls

Authentication area, perform the following actions:

a. Select the Enabled check box.

b. In the Realm, User Name and Password fields,

specify the authentication parameters configured

on the PBX.

To use the SIP account authentication

format,

on the SIP Accounts tab, configure the desired account. For

details, see Managing SIP Accounts.

NOTE

The specified parameters must match the corresponding

settings on the PBX.

4. Click Finish to save changes and close the Telephone Interconnect window.

2.3.3.2 Configuring Conference Calls Settings

Follow the procedure to configure minimum required conference calls settings in SmartPTT Dispatcher.

Prerequisites: 

• Obtain the VoIP gateway parameters (dial prefix for outgoing calls, IP address and SIP port used for connection

to telephone subscribers).

• Ensure the required settings are configured on SmartPTT Radioserver. For details, see “SIP Telephony” in

SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Settings (   ) → Telephone Interconnect → Telephone Interconnect.

The Telephone Interconnect window appears.

2. On the General Settings tab, in the Dispatcher Settings area, perform the following actions:

a. Select the Allow Calls to Telephone Subscribers check box.

b. From the Interface list, select the IP address of the SmartPTT Dispatcher computer that must be used for

connection to telephone subscribers.

c. In the RTP ports field, specify the ports that must be used for connection to telephone subscribers.

3. In the VoIP Gateway Default Settings area, configure the following settings:

a. In the Dial Prefix for Outgoing Calls field, specify the prefix for outgoing calls matching the prefix

specified in the VoIP gateway settings.
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b. In the Default VoIP Gateway Address field, specify the IP address of the VoIP gateway.

c. In the SIP port field, specify the VoIP gateway port used for the SIP data packets transmit.

4. Click Finish to save changes and close the Telephone Interconnect window.

2.3.4 Interaction with Telephone Subscribers

The Telephone Interconnect feature provides the ability to interact with telephone subscribers. A call can be initiated

both by dispatchers and telephone subscribers. The voice between them is transmitted in full-duplex mode.

SmartPTT Dispatcher provides the following connection options:

• Calls from telephone subscribers to SmartPTT Dispatcher. For details, see Accepting Calls from Telephone

Subscribers.

• Calls from SmartPTT Dispatcher a telephone subscriber. For details, see Initiating Calls to Telephone

Subscribers.

• Connection of radios or talkgroups with telephone subscribers established by SmartPTT Dispatcher. For details,

see Connecting Radios with Telephone Subscribers.

• SmartPTT Dispatcher Conference calls initiated by SmartPTT Dispatcher for connection of telephone

subscribers, radios, talkgroups and/or dispatchers. For details, see Conference Calls.

If connection is established between a telephone subscriber and a talkgroup, the dispatcher who initiated the call can

participate in the conversation. If the established connection is private (between a telephone subscriber and a single

radio), the dispatcher can only hear the conversation, not take part in it.

If SmartPTT Dispatcher establishes connection between a telephone subscriber and a radio or a talkgroup, only the

call participants can finish it. SmartPTT Dispatcher cannot affect it in any way after the call initiation.

NOTE

A special tone indicates the end of the call on the radio. If the radio user initiates a new transmission before they

hear the tone, the transmission will be initiated incorrectly and may fail.

For information on establishing connection to telephone subscribers and the Telephone Subscribers window, see

the sections below.
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2.3.4.1 Telephone Subscribers Window

The Telephone Subscribers window provides the ability to call telephone subscribers added to the SmartPTT

Dispatcher list of telephone subscribers or dial a number manually to call subscribers not added to the list.

You can open the Telephone Subscribers window by clicking Telephone Subscribers (   ) on the menu bar.

The left part of the window consists of two tabs:

• Telephone Subscribers

• Dial Pad

The Telephone Subscribers tab is used for calling subscribers added to the SmartPTT Dispatcher list of telephone

subscribers. For details, see Initiating Calls to Telephone Subscribers.

The left pane contains the list of registered telephone subscribers from which you can select the desired subscriber.

After the call initiation the name of the called subscriber appears in the Recent Calls list located above separator line

on top of the telephone subscribers list. The Recent Calls list contains calls from registered and unregistered

telephone subscribers. The names of unregistered subscribers are in italic type.

NOTE

The Recent Calls list displays only the calls initiated by the dispatcher during the current session. The list is

automatically cleared on every SmartPTT Dispatcher restart.
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The Dial Pad tab is used for calling subscribers not added to the SmartPTT Dispatcher list of telephone subscribers.

The Dial Pad tab provides the following elements:

Number Box

Displays the number dialed on the keyboard or the dial pad below.

Phone (   )

Initiates a call to the dialed number.

Dial Pad

Provides controls for dialing the number of the desired telephone subscriber.
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Add (   )

Opens the Telephone Subscriber window for adding the dialed number to the list of telephone subscribers in

SmartPTT Dispatcher. Appears after you dial at least one digit.

The Extension Dialing tab appears instead of the Dial Pad tab after the call initiation. It contains the same elements

as the Dial Pad tab and can be used for navigation in the voice menu of the called subscriber.

The right part of the window provides the following elements:

Telephone Subscriber

Displays the name and the avatar of the selected telephone subscriber in the top part of the window.

Log box

Displays information on connections to the telephone subscriber established during the current SmartPTT

Dispatcher operation session.

Connect

Initiates a call to the dialed number. After the call initiation the Connect button changes to Disconnect that

finishes the call.

Make Conference Call (   )

Initiates a conference call by sending an invitation request to the selected subscriber. For details, see Initiating

Calls from the Telephone Subscribers Window.

For information on establishing connection to telephone subscribers, see the section below.
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2.3.4.2 Initiating Calls to Telephone Subscribers

Follow the procedure to initiate a call to a telephone subscriber.

Prerequisites: 

Ensure an operator has the right Make telephone calls. For information on the operator rights, see Operators.

Procedure: 

1. On the menu bar, click Telephone Subscribers (   ).

The Telephone Subscribers window appears.

2. Call the desired telephone subscriber:

To call a subscriber added to the SmartPTT

Dispatcher list of telephone subscribers,

perform the following actions:

1. On the Telephone Subscribers tab, select the desired

subscriber from the list.

The name and the avatar (if set) of the selected

subscriber appear in the upper-right corner of the

window.

2. In the lower-right corner of the window, click Connect.

To call a subscriber that is not added to the

SmartPTT Dispatcher list of telephone

subscribers,

perform the following actions:

1. On the Dial Pad tab, dial the desired subscriber's

number.

The Add (   ) button appears in the right part of the

window.

NOTE

If the VoIP gateway default settings are specified, you

need to dial only the subscriber's phone number. If default

settings are not specified, you need to dial the subscriber's

full address. For details, see General Settings.

2. (Optional) Add the subscriber to SmartPTT Dispatcher

by clicking the Add (   ) button and specifying

information on them in the Telephone Subscriber

window. For details, see Telephone Subscriber Window.

3. Click the Phone (   ) button to the right of the

number field or click the Connect button in the lower-

right corner of the window.

 The Connect button changes to Disconnect, the name of the called subscriber appears in the Recent Calls list

above the list of telephone subscribers.
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3. (Optional) On the Extension Dialing tab, dial the DTMF extension code for reaching the desired subscriber.

NOTE

After dialing the subscriber's number, apart from a private call, you can initiate a conference call by clicking the

Make Conference Call (   ) button. For details, see Conference Calls.

4. To finish the call, click Disconnect or wait until it finishes automatically after the subscriber hangs up.

2.3.4.3 Connecting Radios with Telephone Subscribers

Follow the procedure to establish connection between a radio or a talkgroup and a telephone subscriber.

Prerequisites: 

Ensure an operator has the right Make telephone calls. For information on the operator rights, see Operators.

Procedure: 

1. Open the window for selecting the desired telephone subscriber:

To open the window from the Radio Fleet

panel,

click the desired radio or talkgroup Actions (   ) button, and

then click Call Telephone Subscriber (   ).

To open the window from the Radios

panel or the Custom Console panel,

click the desired radio or talkgroup Actions (   ) button, and

then click Call Telephone Subscriber (   ).

To open the window from the Maps panel, on the map or in the expandable Radios panel, right-click the

desired radio, and then click Call Telephone Subscriber ( 

 ).

To open the window from the radio or

talkgroup Call Window,

in the Call Window of the desired radio or talkgroup, click Call

Telephone Subscriber (   ).

For information on Call Windows, see Radio Call Window and

Talkgroup Call Window.

 The window with the name of the selected radio or talkgroup appears.
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2. Establish the radio or talkgroup connection to the desired telephone subscriber:

To connect to a subscriber added to the

SmartPTT Dispatcher list of telephone

subscribers,

select the desired subscriber from the list of telephone

subscribers, and then click Connect, or double-click the

desired subscriber name.

To connect to a subscriber that is not

added to the SmartPTT Dispatcher list of

telephone subscribers,

perform the following actions:

1. Click the Dial Pad (   ) button.

The Dial Pad window appears.

2. Dial the desired subscriber's number, and then click the

Phone (   ) button.

NOTE

If the VoIP gateway default settings are specified, you

need to dial only the subscriber's phone number.

If default settings are not specified, you need to dial the

subscriber's full address. For details, see General Settings.

 The Call Window of the called radio or talkgroup and the Call Telephone Subscriber window with information

on the call participants and status appear.
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NOTE

Automatic appearance and disappearance of Call Windows in SmartPTT Dispatcher is configured in the Call

Window settings. For details, see Call Window Settings.

3. To close the Call Telephone Subscriber window, click Close (   ).

NOTE

Closing the window does not finish the call. Only the call participants can finish it.

2.3.4.4 Accepting Calls from Telephone Subscribers

Follow the procedure to accept an incoming call from a telephone subscriber.

Procedure: 

1. In the Incoming call window that appears when a telephone subscriber calls SmartPTT Dispatcher,

click Accept.

The Telephone Subscribers window appears. The call starts.

2. To finish the call, click Disconnect or wait until the call finishes automatically after the subscriber hangs up.

The Disconnect button changes to Connect.

3. (Optional) If the calling telephone subscriber is not added to the SmartPTT Dispatcher list of telephone

subscribers, you can add them by performing the following actions:

a. In the right part of the window, under the number of the calling subscriber, click Add (   ).

The Telephone Subscriber window appears.

b. Select the desired SIP addressing format:

To use default gateway settings, perform the following actions:

1. In the SIP-Address area, select Automatic.

2. In the Number field, type the subscriber's phone

number.
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To use the subscriber's full address, perform the following actions:

1. In the SIP-Address area, select Full Address.

2. In the Outgoing field, type the subscriber's

SIP address for outgoing calls in the following format:

sip:prefix number@gateway:port

3. In the Incoming field, type the subscriber's SIP

address for incoming calls in the following format:

sip:prefix number@gateway:port

c. (Optional) In the upper-left corner of the window, click Select, and then, in the window that appears, select

an image for the subscriber's avatar.

The selected avatar appears above the Select button.

d. (Optional) Select the Enable SIP Account check box, and then, from the list on the right, select the desired

SIP account.

e. (Optional) Click Select a sound file for an incoming call (   ), and then, in the window that appears,

select an audio file with the desired incoming call alert sound.

f. At the bottom of the window, click OK.

Postrequisites: 

• To remove the subscriber avatar, click Delete Subscriber Photo (   ).

• To restore the standard system sound, click Use a system sound (   ).

• For information on editing and deleting telephone subscribers, see Adding and Editing Telephone Subscribers.

2.4 Operators

In SmartPTT Dispatcher it is possible to work under the Administrator, or an operator account. The Administrator

account is created in the SmartPTT system by default.

Important

Upon logging in SmartPTT Dispatcher for the first time after installing the SmartPTT software, be sure to set a

password for the Administrator account. For details, see Operator Window.

The Administrator account suggests unlimited access rights to all functionality of the system, including the

possibility to add new operator accounts and provide operators with access to specific functionality of SmartPTT

Dispatcher. Accordingly, an operator account is limited by functionality that the Administrator determined. The

number of operator accounts in SmartPTT Dispatcher is not limited.

For information on operator access rights, see the sections below.
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2.4.1 Operators Window

You can manage operator account rights in the Operators window by clicking Settings (   ) → Operators on the

menu bar.

The Operators window provides the following elements:

Add

Opens the Operator window for adding a new operator account. For details, see Operator Window.

Edit

Opens the Operator window for editing the selected operator account.

Delete

Removes the selected operator account from SmartPTT Dispatcher.

The list of operators

Contains the list of all added operators.

You can sort operator accounts by clicking the column header.
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2.4.1.1 Operator Window

In the Operator window you can configure operator account rights, set the operator account password, or status.

The Operator window provides the following elements:

Name

An operator name.

If Windows authentication is selected, ensure that the new operator account name matches the name of the

Windows user or group. If Windows authentication is not selected, you can give any operator name.

For information on Windows authentication, see General Settings.

Important

If Windows authentication is selected, the name of the Windows user or group must not match the operator

account name with the Administrator status not to lose access to the account with the Administrator status.

Status

The operator status. Statuses can be as follows:

• The Administrator status is given to the account with the name Administrator that is created by default. The

account with the Administrator status has full access to SmartPTT functionality. You cannot delete the account

with the Administrator status. The Administrator status cannot be assigned to another operator account.

• The Active status is applied for operator accounts that are used currently.

• The Archive status is used for operators which are not used any longer, but cannot be removed from the system

as the Event Log contains entries referring to them.

Set/Change password

Sets a new operator password or changes the old one.
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Rights

A list of permissions that provides operators with the ability to perform the following actions in SmartPTT

Dispatcher:

Right Description

Edit radio lists

Allows/denies adding, editing, or deleting radios on the Radio Fleet panel and

in the Radios window.

For details, see Radio Fleet and List of Radios.

Manage unregistered radios

Shows/hides radios which were not added to SmartPTT Dispatcher.

For details, see Radios and List of Radios.

Make voice calls

Allows/denies initiating voice calls (except conference calls).

For information on voice calls, see Voice Calls.

Connect with external

dispatchers

Allows/denies communicating with other SmartPTT dispatchers.

For details, see Dispatchers.

Make telephone calls

Allows/denies communicating with telephone subscribers.

For details, see Telephone Subscribers Settings.

Change channel on control

station

Allows/denies selecting control station channels.

For details, see Channels and Systems and Channel Selector.

Block/Unblock radios

Allows/denies using Block Radio and Unblock Radio commands.

For details, see Radio Actions Menu.

NOTE

These commands are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT

Installation and Configuration Guide.

Remote monitor

Allows/denies using the Remote Monitor command (turning on the

microphone on the radio).

For details, see Radio Actions Menu.

Reboot control station

Allows/denies rebooting (restarting) control stations.

For details, see Channel Actions Menu.

Manage radio location

settings

Allow/denies configuring settings of radio location update.

For information on location settings see Radio Location Properties and List of

Radios.

Request radio location

Allows/denies performing the following actions related to the radio location:

• Set Location (   )
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Right Description

• Find on Map (   )

• Show Address (   )

• Remove from Map (   )

For details, see Radio Actions Menu.

Send text messages

Allows/denies sending text messages to radios, talkgroups, and radio

categories.

For details, see Text Messages.

Send telemetry commands

Allows/denies sending telemetry commands.

For details, see Telemetry Settings Window.

NOTE

This parameter does not relate to SmartPTT SCADA.

Manage bridging settings

Allows/denies configuring bridging service for SmartPTT Radioserver.

For details, see Bridging Service.

Manage routes

Allows/denies managing routes.

For details, see Routes.

Manage geofences

Allows/denies managing geofences on a map.

For details, see Geofences.

Manage points of interest

Allows/denies managing points of interest on a map.

For details, see Points of Interest.

Manage cameras

Allows/denies managing camera markers on a map.

For details, see Cameras.

Manage tracks

Allows/denies displaying tracks and the radio movement along the track on a

map.

For details, see Tracks.

View coverage map

Allows/denies working with a coverage map.

For details, see Coverage Map.

Build reports

Allows/denies build reports.

For details, see Reports.

Edit custom radio properties

Allows/denies managing parameters on the Others tab of the Radio

Properties window.

For details, see Radio Custom Properties.
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Right Description

Make conference calls

Allows/denies initiating conference calls.

For details, see Conference Calls.

View radioserver event log

Allows/denies showing the SmartPTT Radioserver Event Log.

For details, see SmartPTT Radioserver Event Log.

NOTE

You will keep access to the SmartPTT Dispatcher Event Log.

Create deferred actions

Allows/denies creating deferred actions for radios.

For details, see Deferred Actions.

Manage statuses

Allows/denies managing radio statuses.

For details, see Statuses.

Manage custom rules

Allows/denies managing custom rules.

For details, see Custom Rules.

Manage positioning rules

Allows/denies managing positioning rules.

For details, see Positioning Rules.

Manage lone worker rules

Allows/denies managing lone worker rules.

For details, see Lone Worker Rules.

2.4.2 Adding and Editing Operator Accounts

Follow the procedure to add a new operator, or edit an existing operator account.

Prerequisites: 

Ensure that you are logged in as the operator with the Administrator status.

Procedure: 

1. On the menu bar, click Settings (   ) → Operators.

The Operators window appears.

2. In the Operators window, perform one of the following actions:

To add a new operator, click Add.

To edit an existing operator account, perform the following actions:

1. In the Operators window, select the desired operator.

2. Click Edit.

 The Operator window appears.

3. In the Operator window, in the Name field, type the operator name.
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Important

If Windows authentication is selected, the name of the Windows user or group must match the operator account

name with the Administrator status not to lose access to the account with the Administrator status.

4. From the Status list, select the desired status:

To add a new operator account to the list

of operator accounts that are used

currently,

in the Operator window, from the list of available statuses,

select Active.

To add the operator account to the

archive,

in the Operator window, from the list of available statuses,

select Archive.

5. (Optional) To set/change a password, perform the following actions:

a. Click Set/Change Password.

The Enter/Change Password window appears.

b. In the Password field, type the desired password.

c. In the Confirmation field, type the desired password again.

d. Click OK to save the changes and close the window.

6. In the Rights area, select the desired check boxes for assigning rights to an operator. For details, see Operator

Window.

7. In the Operator window, click OK to apply changes and close the window.

A new or an edited operator account appears in the list of operators in the Operators window.

8. Close the Operators window.

Postrequisites: 

To delete an operator account, in the Operators window, select the desired operator, and then click Delete.

NOTE

An operator account cannot be deleted if Event Log has entries associated with it. For information on Event Log,

see Event Log.
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2.4.3 Changing Operator

Follow the procedure to to log over SmartPTT Dispatcher using other operator credentials.

Procedure: 

1. On the menu bar, click Change operator (   ).

The user logs off from SmartPTT Dispatcher, and the Authorization window appears.

2. In the Authorization window, from the Operator list, select the desired login.

3. Type a password if it is necessary.

4. Click OK to log in SmartPTT Dispatcher and get started.

2.5 Information Storage

The Information Storage submenu is available from the Settings (   ) menu on the SmartPTT Dispatcher menu

bar. It provides the following configuration options:

• Activating and configuring call recording in SmartPTT Dispatcher.

For details, see Records.

• Activating and configuring automatic backup of the SmartPTT Dispatcher database.

For details, see Database Auto Backup.
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2.5.1 Records

SmartPTT Dispatcher provides the ability to record incoming and outgoing calls and save them as audio files to a

local folder.

The audio recording settings can be configured in the Audio Record Settings window that you can open by clicking

Settings (   ) → Information Storage → Records on the menu bar.

The Audio Record Settings window provides controls for configuring the audio recording parameters distributed

into several areas.

The Records area provides the following elements:

Record calls

Activates recording of incoming and outgoing calls in SmartPTT Dispatcher.

Audio records folder

The folder to which call recordings are saved.

Audio file extension

The call recordings extension. The following options are available:

• MP3
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• OGG

• WAV

By default, call recordings are saved as .ogg audio files.

Fixed sample rate (8 kHz)

Sets the fixed audio sample rate of 8 kHz for all call recordings. Such sample rate reduces the size of the saved

audio files due to certain audio quality loss.

Recording volume of outgoing calls

The sound increase ratio applied to the current SmartPTT Dispatcher sound volume for recording voice calls.

You can select a value from the range of 1 to 10 by moving the slider to the left or to the right for decrease or

increase of the sound increase ratio respectively.

The default value is 5, which provides the optimal audibility of the call recordings.

The Audio Files Search Paths area contains the box for specifying additional folders where call recordings are

stored.

If SmartPTT Dispatcher cannot find the recording of a call in the main destination folder, it refers to the folders

specified in this box.

When you change the path to the main destination folder specified in the Audio records folder box, the replaced

folder is automatically added to the Audio Files Search Path box. This way, you can play call recordings and open

their location from Event Log even if they are stored in a folder different from the main one. For details, see Playing

Call Records and Opening Call Records Location.

The Audio Files Search Paths area provides the following elements:

Add (   )

Opens the window for selecting the folder in which call recordings are stored.

Edit (   )

Opens the window for changing the path selected in the box below.

Delete (   )

Deletes the path selected in the box below.

To delete the path, you need to confirm the action by clicking OK in the window prompting you for confirmation.

The Audio records cleanup settings area provides controls for configuring parameters of the call recordings

automatic cleanup.

The following options are available:

Do not delete audio records

If selected, call recordings are not deleted. Audio files are stored for as long as there is available disk space.

Records retention period (days)

If selected, call recordings are automatically deleted after the specified period of time. You can specify the desired

retention period in the box to the right.

Available values range from 1 to 999. The default retention period is 30 days.

If the retention period is 0 days, call recordings are deleted in 24 hours after their creation.

For information on configuring the call recording settings, see the section below.
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2.5.1.1 Configuring Audio Recording

Follow the procedure to configure the audio recording settings in SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Settings (   ) → Information Storage → Records.

The Audio Record Settings window appears.

2. In the Audio Record Settings window, in the Records area, click Record Calls.

3. To the right of the Audio records folder box, click Browse (   ), and then, in the window that appears, select a

folder for storing call recordings.

The path to the selected folder appears in the Audio records folder box.

4. In the Audio file extension box, select the desired audio file format from the list.

5. (Optional) Select or clear the Fixed sample rate check box to activate or deactivate application of the fixed

sample rate (8 kHz) for all call recordings.

6. (Optional) Increase or decrease the call recordings sound volume by moving the Recording volume of

outgoing calls slider to the left or right respectively.

7. (Optional) In the Audio files search paths area, specify additional call recordings locations:

To add a new folder, click Add (   ), and then, in the window that appears, select

the folder in which call recordings are stored.

The path to the selected folder appears in the table.

To edit a folder, perform the following actions:

1. In the Audio files search paths table, click the desired

path.

2. Click Edit (   ), and then, in the window that appears,

select the desired folder.

The path to the selected folder changes in the table.

To delete a folder, in the Audio files search paths table, click the desired path,

and then click Delete (   ).

The path to the selected folder disappears from the table.

8. In the Audio records cleanup settings area, select the desired cleanup option:

To keep call recordings for as long as there

is available disk space,

select Do not delete audio records.

To keep call recordings for a specified

period of time,

select Records retention period, and then, in the box to

the right, specify the desired retention period in days.

9. Click Finish to save changes and close the window.
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2.5.2 Database Auto Backup

The Database Auto Backup functionality provides the ability to perform automatic backup of the SmartPTT

Dispatcher database. Regular backups help to prevent data loss in case of the SmartPTT Radioserver hardware or

software failure. For security purposes, it is strongly recommended that you configure the database automatic

backup.

The automatic backup settings can be configured in the Database Auto Backup Settings window that you can

open by clicking Settings (   ) → Information Storage → Database Auto Backup on the menu bar.

The Database Auto Backup Settings window provides the following elements:

Allow Database Auto Backup

Activates automatic backup of the SmartPTT Dispatcher database.

Backup Folder

The folder for storing the generated database backup files. You can select the desired folder by clicking the

Browse (   ) button.

NOTE

The specified folder can store up to three backup files, after which the oldest one will be replaced with a new one.
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Daily

Activates regular automatic backup with a specified day interval.

When selected, to the right appears the Interval (days) box where you can set the desired interval in days.

Weekly

Activates regular automatic backup with a specified week interval.

When selected, to the right appear controls for selecting the desired days for performing the backup. You can

select one or multiple week days by selecting the corresponding check boxes. In the Interval (weeks) box you

can set the desired backup interval in weeks.

Monthly

Activates regular automatic backup with a specified month interval.

When selected, to the right appear the Day of month and Interval (month) boxes where you can set the desired

day of the month and interval in months for performing the backup.

Time

The time at which automatic backups are performed.

NOTE

The Time value is applied to all of the above-mentioned backup options.

Example

If you select the Daily option, set 4 in the Interval (days) box, and 9:00 in the Time box, the database is backed

up every fourth day at 9:00.

If you select the Weekly option, select Mo and We, set 3 in the Interval (weeks) box, and 11:00 in the Time box,

the database is backed up every third month on Monday and Wednesday at 11:00.

If you select the Monthly option, set 5 in the Day of month box, set 2 in the Interval (months) box, and 15:00

in the Time box, the database is backed up on every fifth day of every second month at 15:00.

The Backup Period area provides controls for specifying the period of time that will be covered by the backup. The

following parameters are available:

Start date

The first day of the backup period starting from which the database information will be backed up.

End date

The last day of the backup period starting from which the database information will not be backed up.

No end date

If selected, the database information will be backed up from the Start Date up to the moment of the performed

backup.

NOTE

You can back up both local and remote databases. The restoration of the backed up database can be performed

only from the backup file stored on the local computer.

For information on configuring the automatic database backup settings, see the section below.
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2.5.2.1 Configuring Database Auto Backup

Follow the procedure to configure the automatic database backup settings in SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Settings (   ) → Information Storage → Database Auto Backup.

The Database Auto Backup Settings window appears.

2. In the Database Auto Backup Settings window, select the Allow Database Auto Backup check box.

The areas below become available.

3. To the left of the Backup folder box, click Browse (   ), and then, in the window that appears, select a folder

for storing database backup files.

The path to the selected folder appears in the Backup folder box.

4. In the Backup Settings area, select the desired backup mode:

To perform regular backups on a daily

basis,

select Daily, and then, in the Interval box, type the desired

interval in days, or select it using the Up (   ) and Down (   )

buttons.

To perform regular backups on a weekly

basis,

perform the following actions:

1. Select Weekly.

2. On the right, select one or multiple days the week by

selecting the corresponding check boxes.

3. In the Interval box, type the desired interval in weeks,

or select it using the Up (   ) and Down (   ) buttons.

To perform regular backups on a monthly

basis,

perform the following actions:

1. Select Monthly.

2. In the Day of month and Interval boxes, type the

desired day of the month and interval in months, or

select them using the Up (   ) and Down (   ) buttons.

5. In the Time box, type the desired backup time, or select  using the Up (   ) and Down (   ) buttons.

6. In the Backup Period area, specify the desired period of time that will be covered by the backup:

a. In the Start Date box, type the desired start date, or select it from the calendar by clicking the Calendar ( 

 ) button.

b. Specify the desired end date:

To set a specific end date, in the End Date box, type the desired end date, or select

it from the calendar by clicking the Calendar (   ) button.

To back up the database up to the

moment of the performed backup,

select No End Date.
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7. Click Finish to save changes and close the window.

2.6 Radios

The Radios submenu is available from the Settings (   ) menu on the SmartPTT Dispatcher menu bar. It provides

the following configuration options:

• Configuring the list of radios, mobile clients, WAVE users and their properties.

For details, see List of Radios.

• Configuring categories of radios, talkgroups, mobile clients, and WAVE users.

For details, see Categories.

• Configuring radio, talkgroup, mobile client and WAVE user statuses displayed on the Radio Fleet panel.

For details, see Statuses.

• Configuring telemetry commands.

For details, see Telemetry Settings Window.

• Configuring the job ticket statuses.

For details, see Job Ticket Statuses.

• Configuring rules applied to radios and WAVE users in the Lone Worker mode.

For details, see Lone Worker Rules.

• Configuring additional parameters displayed in the radio, mobile clients and WAVE user Properties window.

For details, see Custom Radio Properties.

NOTE

WAVE users are users connected to a WAVE server. SmartPTT Radioserver gets information on WAVE users by

means of the WAVE Connector middleware.

For information on WAVE users, see “WAVE Systems” in SmartPTT Installation and Configuration Guide.

In this guide, the “radios” term also includes WAVE users, unless otherwise specified.

NOTE

Mobile clients are users registered on SmartPTT Radioserver and authorized in the SmartPTT Mobile application.

For information on mobile clients, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

In this guide, the “radios” term also includes mobile clients, unless otherwise specified.

2.6.1 List of Radios

The Radios window provides the ability to configure the list of radios and their properties in SmartPTT Dispatcher.

Important

To edit the SmartPTT Dispatcher list of radios and to manage radios that are not added to SmartPTT Dispatcher,

an operator needs to have the Edit radio lists and Manage unregistered radios permissions. For details, see

Operators.

In the Radios window, you can perform the following actions:

• Add one or multiple radios to the SmartPTT Dispatcher list of radios. For details, see Adding Radios.
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• Edit properties of one or multiple radios. For details, see Managing Radios.

• Delete one or multiple radios. For details, see Managing Radios.

You can open the Radios window by clicking Settings (   ) → Radios → List of Radios on the menu bar.

The Radios window consists of two areas:

• List of Radios

• Radio Properties

The List of Radios area is located in the left part of the window. It provides the following elements:

Multiple adding (   )

Provides the ability to add multiple radios at the same time by specifying the properties common to all of them.

For details, see Adding Radios.

In the Multiple Adding mode, the radio individual properties, such as name and avatar, are unavailable. You can

set them later for each radio individually in the editing mode. For details, see Managing Radios.

NOTE

The Multiple Adding mode is available only for the Radio ID input format. SmartPTT Mobile users and radios that

use analog signaling (MDC-1200 or 5 Tone) must be added individually.
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Add (   )

Provides the ability to add a new radio by specifying its properties in the Properties area in the right part of the

window. For details, see Adding Radios.

Delete (   )

Provides the ability to delete the radios selected in the Radios list below. For details, see Managing Radios.

Radios

The list of radios registered in SmartPTT Dispatcher.

The Properties area provides controls for setting and editing properties of the radios. The parameters you specify in

this area will be displayed and can be further edited in the radio Properties window. For details, see Radio Properties

Window.

NOTE

The list of available radio properties depends on the radio system in which the radio is registered (analog or

digital).

For information on working with the list of radios, see the sections below.

2.6.1.1 Adding Radios

Follow the procedure to add one or multiple radios to the SmartPTT Dispatcher list of radios.

Prerequisites: 

Ensure an operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → List of Radios.

The Radios window appears.

2. In the windows, perform one of the following actions:

To add a single radio, perform the following actions:

1. In the left part of the window, click Add (   ).

The new radio properties appear in the Properties

area on the right.

2. In the Properties area, under the Common

heading, specify the radio general parameters. For

details, see Common Radio Properties.

3. (Optional)  Under the Location heading, specify

the radio location parameters. For details, see

Radio Location Properties.

4. Click Save.

The added radio appears in the Radios list.

To add multiple radios, perform the following actions:
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1. In the left part of the window, click Multiple

Adding (   ).

Radio properties that are common to all of the

added radios appear in the Properties area on the

right.

2. In the Properties area, in the Radio ID box,

specify the added radio IDs using hyphens and/or

commas. For example, 1-99, 150

NOTE

The Multiple Adding mode is available only for the

Radio ID input format. Radios that use analog

signaling (MDC-1200 or 5 Tone), SmartPTT Mobile

users must be added individually.

3. In the Properties area, under the Common

heading, specify the desired properties of the

added radios. For details, see Common Radio

Properties.

4. Under the Location heading, specify the desired

location properties of the added radios. For details,

see Radio Location Properties.

5. Click Save.

The added radios appear in the Radios list.

Postrequisites: 

• To edit properties of one or multiple radios, see Managing Radios.

• To delete one or multiple radios, see Managing Radios.

2.6.1.2 Managing Radios

Follow the procedure to edit properties or delete one or multiple radios.

Prerequisites: 

Ensure an operator has the Edit radio lists right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → List of Radios.

The Radios window appears.

2. In the Radios window, perform one of the following actions:

To edit properties of a single radio, perform the following actions:
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1. In the left part of the window, select the desired

radio from the Radios list.

The properties of the selected radio appear in the

Properties area on the right.

2. In the Properties area, edit the desired properties,

and then click Save.

To edit properties of multiple radios, perform the following actions:

1. In the left part of the window, select the desired

radios from the Radios list in one of the following

ways:

• Press and hold Ctrl, and then click the desired

radios.

• Press and hold Shift, and then click the first and

the last radio in the desired part of the list.

Radio properties common to all of the added radios

appear in the Properties area on the right.

2. In the Properties area, edit the desired radio

properties, and then click Save.

NOTE

If the property values differ among the selected radios,

the value in the corresponding box is cleared. The

check boxes of such properties are filled with solid

gray (   ). By changing the common property value,

you will change it for each of the selected radios.

To delete a single radio, perform the following actions:

1. In the left part of the window, select the desired

radio from the Radios list, and then click Delete ( 

 ).

2. In the window that appears, click OK.

The radio is removed from the Radios list.

To delete multiple radios, perform the following actions:

1. In the left part of the window, select the desired

radios from the Radios list in one of the following

ways:

• Press and hold Ctrl, and then click the desired

radios.
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• Press and hold Shift, and then click the first and

the last radio in the desired part of the list.

2. Click Delete (   ), and then, in the window that

appears, click OK.

The selected radios are removed from the Radios

list.

2.6.2 Categories

You can use categories for grouping radios and talkgroups, and for applying certain actions to all category objects

(for example, assigning a status, sending a message).

Categories include the following objects:

• Radios registered in SmartPTT Dispatcher

• Talkgroups

• Dynamic groups

• Other categories (subcategories)
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You can open the Categories window by clicking Settings (   ) → Radios → Categories on the menu bar.

The Categories window provides the following elements:

Add

Opens the Category window for adding a new category. For details, see Managing Categories.

Edit

Opens the Category window for editing the selected category.

Delete

Removes the selected category. If the selected category has nested categories, these categories will also be

deleted.

Categories area

Contains all categories. You can set a structure for categories that will be displayed in the Radio Fleet panel using

the following methods:

• You can change category nesting by dragging the desired category to another one. When you drag a category

to the default CATEGORIES folder, the category becomes a first-level category.
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• You can change the sequence of categories using the Up (   ) and Down (   ) buttons located to the right of

the area. You can change sequence for categories of one level (first-level categories or subcategories of one

category).

Show "No Category" Folder

Shows objects not included in any category on the Radio Fleet panel under the No Category folder. For

information on categories on the Radio Fleet panel, see Categories.

For information on configuring and managing categories, see the sections below.

2.6.2.1 Category

The Category window provides the ability to configure or edit category settings.

The Category window contains three tabs:

• The Common tab provides general category settings.

• The Radios tab provides a list of available radios that can be added to the category.

• The Talkgroups tab provides a list of talkgroups that can be added to the category.

The Common tab provides the following elements:

Name

Category name.

Status

Provides a list of available statuses in SmartPTT Dispatcher. The selected status will be assigned to all radios of the

category. For information on radio statuses, see Statuses.
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Update location

Provides updating location parameters of all radios in the category.

For information on parameters available in the area, see Radio Location Properties.

NOTE

Configuring of location parameters is unavailable if no radios are added to the category.

Check boxes in the Update location area have three different states:

• Solid gray (   ) — the parameter that is set in the individual settings of radios is applied.

• Selected (   ) — the selected parameter is applied to all radios of the category.

• Clear (   ) — the parameter is not applied to all radios of the category.

2.6.2.2 Managing Categories

Follow the procedure to add new, or edit/delete an existing category, or configure category settings.

Prerequisites: 

• Ensure the desired radios are registered in SmartPTT Dispatcher.

For details, see Radios.

• If you need to assign a status to all radios of the category, ensure the desired status is created in SmartPTT

Dispatcher.

For details, see Managing Statuses.

• Ensure that GPS is activated in the radio properties to receive outdoor coordinates of the radios included in the

category. For details, see Radio Location Properties.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Categories.

The Categories window appears.

1. In the Categories window, perform one of the following actions:

To add a new category, click Add.

The Category window appears.

To edit an existing category, select the desired category, and then click Edit.

The Category window appears.

To delete an existing category, perform the following actions:

1. Select the desired category, and then click

Delete.

Important

If the selected category has nested categories, these

categories will also be deleted.

2. In the confirmation window, click ОК.
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3. Proceed to the last step of the procedure.

To change sequence of categories, perform the following actions:

1. Select the desired category, and then change its

position using the Up (   ) and Down (   )

buttons.

2. Proceed to the last step of the procedure.

To change nesting of categories, perform the following actions:

1. Drag the desired category to another one.

2. Proceed to the last step of the procedure.

To show objects not included in categories, on

the Radio Fleet panel,

perform the following actions:

1. Select the Show "No Category" Folder check

box.

2. Proceed to the last step of the procedure.

2. In the Category window, in the Name field, type the category name.

3. From the Status list, select the status that will be assigned to all radios of the category.

4. Set the category objects:

To add radios to the category, perform the following actions:

1. Open the Radios tab.

2. Select the check boxes of the desired radios.

NOTE

You can add several radios simultaneously by

selecting them using Shift or Ctrl, and then pressing

the Space key.

To add talkgroups to the category, perform the following actions:

1. Open the Talkgroups tab.

2. Expand nodes of the desired radio systems, and

then select the check boxes of the desired

talkgroups.

To delete a radio or talkgroup from the category, perform the following actions:

1. Open the tab with the desired radios or

talkgroups.

2. Clear the check boxes of the desired objects.
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5. If radios are added to the category, configure the update rules of their outdoor coordinates:

To apply the selected parameter to all radios in

the category,

perform the following actions:

1. Select the check box (   ) next to the desired

parameter.

2. If available, select the desired option or, in the

field to the right of the check box, enter the

desired value.

To apply parameters that are set in individual

settings of each radio in the category,

leave the check box filled with solid gray (   ).

To not apply the selected parameter to all radios

in the category,

clear the check box (   ) next to the desired parameter.

6. In the Category window, click ОК to save changes and close the window.

7. In the Categories window, click Finish.

2.6.3 Statuses

Statuses provide the ability to specify current condition of radios.

Statuses can be displayed:

• On the Radio Fleet panel to track and assign statuses, as well as filter radios by their statuses. For details, see

Radios.

• On the Radios panel to filter radios by their statuses. For details, see Radios.

• On the map panel to track current radio statuses (a frame of a status color around radio icon). For details, see

Map Control Panel.

• In the radio Call Window to view the current radio status. For details, see Radio Call Window.

Important

Managing statuses is available to the Administrator, or to operators with the corresponding permission. For

details, see Operators.

You can open the Statuses window by clicking Settings (   ) → Radios → Statuses on the menu bar.

The Statuses window contains two tabs:

• The Active tab. For details, see Active Tab.

• The Archive tab. For details, see Archive Tab.

For information on configuring and managing statuses, see the sections below.
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2.6.3.1 Active Tab

On the Active tab, you can manage all active radio statuses or add new statuses.

The tab provides the following elements:

Add

Opens the Radio Status window for adding a new radio status. For details, see Managing Statuses.

Edit

Opens the Radio Status window for editing the selected radio status. For details, see Managing Statuses.

Delete

Removes the selected status. If the status is currently assigned or was assigned to a radio, it cannot be deleted.

You can move it to the archive, and, if needed, restore the archived status later. For details, see Managing

Statuses.

Table with statuses

Provides a list of active statuses. The table consists of the following columns:

• Name — status name that is displayed with a color set for the status.
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• Text Message — text message that is set for automatic status change. Message is displayed with a color that is

set for the status.

• Sound On — displays whether a sound notification for status assignment is turned on or off.

2.6.3.2 Archive Tab

The Archive tab contains archived statuses that cannot be removed because they are currently assigned or were

assigned to a radio.

On the tab, you can restore statuses that were moved to archive and make them active again.

Archived statuses cannot be assigned to radios and cannot be used when you configure alerts for dispatchers in

rules. However, the statuses remain valid if they were assigned to radios before moving the status to the archive. For

information on rules, see Rules.

Archived statuses are also displayed in the Event Log. For details, see Dispatcher Event Log Table.

The tab provides the following elements:

Restore

Restores the selected status. The restored status will appear on the Active tab.
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Table with statuses

Provides a list of archived statuses. The table consists of the following columns:

• Name — status name that is displayed with a color set for the status.

• System Message — text message that is set for automatic status change. Message is displayed with a color

that is set for the status.

• Sound On — displays whether a sound notification for status assignment is turned on or off.

2.6.3.3 Radio Status

The Radio Status window provides the ability to configure settings of a new or existing radio status.

The Radio Status window provides the following elements:

Name

Status name.

Color

Color assigned to the status.

Text message for automatic status change

Message that initiates status assignment. When a radio sends the message to the dispatcher or to any other

addressee, the status is assigned to the radio. Text messages cannot be the same for different statuses. If the text

message is already specified for another status, the corresponding warning window appears.

Play Sound

Sound notification of automatic status assignment. The check box becomes available when a text message for

status changing is set. You can select the desired audio file in the Sound File Selection window by clicking the

Browse (   ) button.

Audio file must comply with the specific requirements. For details, see “Audio File Requirements” in SmartPTT

Installation and Configuration Guide.
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2.6.3.4 Managing Statuses

Follow the procedure to add, edit, delete, or restore radio statuses.

Prerequisites: 

Ensure an operator has the Manage statuses right. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Statuses.

The Statuses window appears.

2. In the Statuses window, perform one of the following actions:

To add a status, click Add.

The Radio Status window appears.

To edit an existing status, select the desired status, and then click Edit.

The Radio Status window appears.

To delete an existing status, perform the following actions:

1. Select the desired status, and then click Delete.

NOTE

If the status is currently assigned or was assigned to a radio, it cannot

be deleted. You can move it to the archive.

2. In the confirmation window, click ОК.

3. Proceed to step 5 of the procedure.

To restore the archived status, perform the following actions:

1. Open the Archive tab.

2. Select the desired status, and then click Restore.

3. Proceed to step 5 of the procedure.

3. In the Radio Status window, perform the desired actions:

To set a name for a status, in the Name field, type the status name.

To set a color for a status, from the Color list, select the desired status color.

To set a message that will initiate status

assignment,

in the Text message for automatic status change

field, type the desired text.

NOTE

Text messages cannot be the same for different

statuses.
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To set a sound for status assignment, perform the following actions:

1. Select the Play Sound check box.

2. Click Browse (   ), and then, in the window that

appears, select the desired audio file.

4. In the Radio Status window, click OK.

5. In the Statuses window, click Finish.

2.6.4 Telemetry

The telemetry feature provides the ability to use radio GPIO pins to transmit signals to connected devices and

receive signals from them. You can use this feature to operate mechanisms at a distance and collect data about the

state of different systems.

NOTE

The telemetry feature is available only to DMR radios.

SmartPTT Dispatcher provides the following features:

• Receive dry (volt-free) contacts data

• Notify if the signal is changed to active preconfigured level

• Send telecommands

To configure telemetry features, the following actions must be performed:

• The desired radio codeplug must be configured to perform telemetry functions.

• The desired devices must be connected to the GPIO (General-purpose Input/Output) pins of the radio.

• The telemetry feature must be activated in SmartPTT Radioserver Configurator. For details, see “Activating TMS

and Telemetry” in SmartPTT Installation and Configuration Guide.

• Telemetry settings must be configured in SmartPTT Dispatcher.

NOTE

You can send preconfigured telemetry commands and monitor the current status of GPIO pins in a custom

console if you set the Incoming Telemetry and Outgoing Telemetry elements in the Console Configuration

window. For details, see Incoming Telemetry and Outgoing Telemetry.

For information on the telemetry settings in SmartPTT Dispatcher, see the sections below.



152

Settings Radios

2.6.4.1 Telemetry Settings Window

The Telemetry Settings window provides the ability to manage telemetry actions.

You can open the Telemetry Settings window by clicking Settings (   ) → Radios → Telemetry on the menu bar.

Important

Telemetry actions are available to the operators with the corresponding permission. For details, see Operators.

Important

Telemetry features can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

The Telemetry Settings window provides the following elements:

Add (   )

Opens the Telemetry Settings window for adding a new action. For details, see Telemetry Command Settings

Window.

Edit (   )

Opens the Telemetry Settings window for editing the selected action.
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Delete (   )

Deletes the selected action from SmartPTT Dispatcher.

Telemetry Action Table

Provides the list of all added telemetry actions. The table consists of the following columns:

• The Telemetry Description column contains the telemetry action name.

• The Contact column contains the number of the radio contact which is used to send and receive telemetry

data.

• The Direction column contains the direction of the telemetry data.

• The Action column contains the type of the action to be executed.

You can sort content of the table by clicking the desired column header.

2.6.4.2 Telemetry Command Settings Window

The Telemetry Settings window provides the ability to configure telemetry commands.

You can open this window by clicking Add or Edit in the Telemetry Settings window. For details, see Telemetry

Settings Window.

The Telemetry Settings window provides the following elements:

Description

The telemetry action name.

GPIO Pin

Provides the list of the radio GPIO pin numbers which are used to send and receive telemetry data.

NOTE

Ensure the selected contact or VIO (Virtual Input/Output) is mapped to a physical GPIO line in the radio codeplug.

Direction

Provides the list of telemetry event directions:

• The Incoming event implies that telemetry data is received.

• The Outgoing event implies that a telemetry command is sent.
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Action

Provides the list of telemetry action types:

• The Impulse option sends an impulse with configured length.

• The High Level option sends/receives a high level signal when GPIO pin voltage is high.

• The Low Level option sends/receives a low level signal when GPIO pin voltage is low.

• The Toggle Level option sends command to change the signal to either level or receives data about the change.

2.6.4.3 Telemetry for Radio Window

The Telemetry for - <radio name> window provides the ability to assign telemetry actions to radios.

You can open the Telemetry for - <radio name> window by clicking Telemetry (   ) in the Radio Properties

window. For details, see Radio Properties Window.

NOTE

The telemetry action can be assigned only to a registered radio. If the radio is not registered, the Telemetry

button is unavailable.

The Telemetry for - <radio name> window provides the following elements:

Telemetry Actions Table

Provides the list of all configured telemetry actions. The table consists of the following columns:

• The Description column contains the name of configured telemetry action.

• The Select column provides the ability to assign telemetry actions.
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NOTE

The telemetry actions must be configured in the Telemetry Settings window. For details, see Managing

Telemetry Actions.

Update GPIO pins' status

Provides the ability to configure automatic updates of GPIO pins' status. This area provides the following

elements:

• The Interval, s field is an interval to update pin signal data in seconds.

• The GPIO Pin check boxes provide the ability to select the desired GPIO pins of the radio to set automatic

status updates.

NOTE

The automatic GPIO pins' status update is applied only to incoming telemetry data.

2.6.4.4 Telemetry for Talkgroup Window

The Telemetry for - <talkgroup name> window provides the ability to assign telemetry actions.

You can open the Telemetry for - <talkgroup name> window by clicking Telemetry (   ) in the talkgroup

properties window. For details, see Talkgroup Properties.

NOTE

The Telemetry button is missing from the All Call properties window.

The Telemetry for - <talkgroup name> window contains the Telemetry Action Table which provides the list of all

configured telemetry actions. The table consists of the following columns:
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• The Description column contains the name of configured telemetry action.

• The Select column provides the ability to assign telemetry actions.

NOTE

The telemetry actions must be configured in the Telemetry Settings window. For details, see Managing

Telemetry Actions.

2.6.4.5 Managing Telemetry Actions

Follow the procedure to add, edit, or delete telemetry actions.

Prerequisites: 

Ensure the operator has the Send telemetry commands right. For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Telemetry.

The Telemetry Settings window appears.

2. In the Telemetry Settings window, perform one of the following actions:

To add a new telemetry action, at the top of the window, click Add (   ).

The Telemetry Settings window appears.

To edit an existing telemetry action, in the table, select the desired action, and then click

Edit (   ).

The Telemetry Settings window appears.

To delete an existing telemetry action, perform the following actions:

1. In the table, select the desired telemetry action,

and then click Delete (   ).

2. In the Confirmation window, click OK.

The action is deleted from the table.

3. Proceed to step 8.

3. In the opened window, in the Description field, type the name of the telemetry action.

4. From the GPIO Pin list, select the number of the radio contact or VIO (Virtual Input/Output) to assign the

telemetry action.

NOTE

Ensure the selected contact or VIO is mapped to a physical GPIO (General-purpose Input/Output) line in the radio

codeplug.

5. From the Direction list, select the desired telemetry event direction:

To configure an outgoing telemetry event, select Outgoing
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To configure an incoming telemetry event, select Incoming.

6. From the Action list, select the desired telemetry action type:

To make a telemetry event happen when an

impulse with configured length was sent,

select Impulse.

Important

The Impulse action can only be used in

combination with the Outgoing direction.

NOTE

The length of an impulse can be configured in the

radio codeplug.

To make a telemetry event happen when GPIO pin

voltage level is high,

select High Level.

To make a telemetry event happen when GPIO pin

voltage level is low,

select Low Level.

To make a telemetry event happen when GPIO pin

voltage level is changed,

select Toggle Level.

7. Click OK to save changes and close the window.

8. Click Finish to close the Telemetry Settings window.

Postrequisites: 

 Assign the telemetry action to radios or talkgroups. For details, see Assigning Telemetry to Radios and Assigning

Telemetry to Talkgroups.

2.6.4.5.1 Assigning Telemetry to Radios

Follow the procedure to assign telemetry actions to a radio.

Prerequisites: 

• Configure telemetry actions in the Telemetry Settings window. For details, see Managing Telemetry Actions.

• Ensure the desired radio is registered in the radio system.

• Ensure the radioserver is online.

Procedure: 

1. On the Radio Fleet panel, right-click the desired radio.

The Radio Properties window appears. For details, see Common Radio Properties.

2. Click Telemetry (   ) to open the Telemetry for - <radio name> window where you can assign available

telemetry actions to the radio.

3. Select the desired actions to assign them to the radio.



158

Settings Radios

4. (Optional) To set the automatic GPIO pins' status updates, in the Update GPIO pins' status area, perform the

following actions:

a. In the Interval, s field, specify the interval to update pin signal data in seconds.

b. Select the desired GPIO Pin check boxes.

NOTE

The automatic GPIO pins' status update is applied only to incoming telemetry data.

5. Click OK to save changes and close the window.

The corresponding telemetry messages will be displayed in the Event Log, the selected actions become

available in custom consoles, and outgoing actions can be executed from the Call Window of the radio.

6. Click Save to close the Radio Properties window.

Postrequisites: 

 Execute an outgoing telemetry action from the radio Call Window. For details, see Executing Telemetry Actions from

Radio Call Window.

2.6.4.5.2 Executing Telemetry Actions from Radio Call Window

Follow the procedure to execute an outgoing telemetry action from the radio Call Window.

Prerequisites: 

• Assign the desired telemetry actions to the radio. For details, see Assigning Telemetry to Radios.

• Ensure the radioserver is online.

Procedure: 

1. To open the radio Call Window, perform one of the following actions:

• Double-click the desired radio on the Radio Fleet panel.

• Right-click the desired radio on the Radios panel or in the custom console.
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The radio Call Window appears. For information on the radio Call Window, see Radio Call Window.

2. From the Outgoing Telemetry (   ) menu, select the desired telemetry action to execute.

Important

To execute telemetry actions, the radio contacts or VIO must be mapped to a physical GPIO line in the radio

codeplug.

3. (Optional) To receive the current telemetry status, click Get Status of Telemetry Contact (   ).

The updated status will be displayed in the radio Call Window log.

2.6.4.5.3 Assigning Telemetry to Talkgroups

Follow the procedure to assign telemetry actions to a talkgroup.

Prerequisites: 

• Configure telemetry actions in the Telemetry Settings window. For details, see Managing Telemetry Actions.

• Ensure the radioserver is online.

Procedure: 

1. On the Radio Fleet panel, right-click the desired talkgroup or select the Properties (   ) in the Actions (   )

menu of the talkgroup.

The talkgroup properties window appears. For details, see Talkgroup Properties.

2. Click Telemetry (   ) to open the Telemetry for - <talkgroup name> window where you can assign available

telemetry actions to the talkgroup.

3. Select the desired actions to assign them to radios in the talkgroup.

4. Click OK to save changes and close the window.

Outgoing actions become available in the talkgroup Call Window.
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5. Click Save to close the talkgroup properties window.

Postrequisites: 

 Execute an outgoing telemetry action from the talkgroup Call Window. For details, see Executing Telemetry Actions

from Talkgroup Call Window.

2.6.4.5.4 Executing Telemetry Actions from Talkgroup Call Window

Follow the procedure to execute an outgoing telemetry action from the talkgroup Call Window.

Prerequisites: 

• Assign the desired telemetry actions to the talkgroup. For details, see Assigning Telemetry to Talkgroups.

• Ensure the radioserver is online.

Procedure: 

1. On the Radio Fleet panel, double-click the desired talkgroup.

The talkgroup Call Window appears. For information on the talkgroup Call Window, see Talkgroup Call Window.

2. From the Outgoing Telemetry (   ) menu, select the desired telemetry action to execute. This action will be

executed by the radios that listen to this talkgroup.

Important

To execute telemetry actions, the radio contacts or VIO must be mapped to a physical GPIO line in the radio

codeplug.
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2.6.5 Job Ticket Statuses

SmartPTT Dispatcher provides the ability to create job ticket statuses and configure their settings (for example,

assign a color to a status or add a sound notification which will be played when the status is changed). When a job

ticket is sent to a radio, the radio user can change its status to notify the dispatcher about the job implementation

phase.

For information on job ticketing, see Job Tickets Panel.

NOTE

Job tickets are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

You can open the window for managing job ticket statuses by clicking Settings (   ) → Radios → Job Ticket

Statuses on the menu bar.

The Job Tickets window provides the following elements:

Enable Automatic Numbering

If selected, a unique number is assigned to each new job ticket. Unique numbers help to distinguish job tickets

with the same names and job tickets which were resent.
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Send notification to radio when uncompleted job ticket was deleted by dispatcher

If selected, when the dispatcher deletes a job ticket without the completion status, a text message with

information on the job ticket cancellation is sent to the radio which is the assignee of this job ticket.

Default Status

The name of the job ticket status which is displayed when the operator creates a new job ticket. The status is not

changed until the radio user modifies it.

NOTE

You do not need to set this status in the radio codeplug. It is used only in SmartPTT Dispatcher, therefore you can

specify any name and color for it.

Color

Provides a palette with colors for a default status.

Add (   )

Opens the Job Ticket Status window for adding a new status. For details, see Job Ticket Status.

Edit (   )

Opens the Job Ticket Status window for editing the selected status.

Delete (   )

Deletes the selected status from SmartPTT Dispatcher.

Job Ticket Status Table

Displays all added job ticket statuses. The table consists of the following columns:

• The Name column contains the job ticket status name.

• The Completion Status column contains the check box indicating whether the job ticket with this status is

considered as completed.

The selected check box indicates that the job ticket with this status will be hidden from the Job Tickets Table on

the Job Tickets panel if, in the Management area, the Show completed tickets check box is cleared. For

details, see Management Area.

• The Sound On column contains the check box indicating a sound notification of changing job ticket status. The

selected check box indicates that a notification sound is played when a radio user assigns this status to a job

ticket.

For information on configuring and managing job ticket statuses, see the sections below.

2.6.5.1 Job Ticket Status

The Job Ticket Status window provides the ability to configure or edit a job ticket status.

Important

Added statuses must match the statuses set in radio codeplugs, otherwise the color, sound signal, and status

completion settings will not be applied to display these statuses in SmartPTT Dispatcher.
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The window appears when clicking Add or Edit in the Job Tickets window. For details, see Job Ticket Statuses.

The Job Ticket Status window provides the following elements:

Name

The name of the status.

Color

Provides a palette with colors that can be used for highlighting the status name in the Job Tickets Table on the Job

Tickets panel. For details, see Management Area.

Completion Status

If selected, the job ticket with this status is considered as completed. It will be hidden from the Job Tickets Table on

the Job Tickets panel if, in the Management area, the Show completed tickets check box is cleared.

NOTE

The Completion Status check box can also be selected in the window for managing job ticket statuses.

Play Sound

Activates playback of a special tone when a radio user assigns the status to a job ticket.

You can select the desired audio file in the Sound File Selection window by clicking Select Sound File (   ).

The audio file must comply with the specific requirements and have the WAV format. For details, see “Audio File

Requirements” in SmartPTT Installation and Configuration Guide.
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2.6.5.2 Managing Job Ticket Statuses

Follow the procedure to add, edit, or delete job ticket statuses.

Prerequisites: 

Before adding statuses in SmartPTT Dispatcher, ensure the corresponding statuses are set in radio codeplugs.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Job Ticket Statuses.

The Job Tickets window appears.

2. (Optional) Configure additional job ticket parameters:

To assign a unique number to each new job

ticket,

select the Enable Automatic Numbering check box.

To send notifications to radios when the

dispatcher deletes uncompleted job tickets,

select the Send notification to radio when

uncompleted job ticket was deleted by dispatcher

check box.

To configure the status which will be used for

each new job ticket by default,

perform the following actions:

1. In the Default Status field, type the desired

status name.

2. From the expandable Color palette, select the

desired default status color.

3. Perform one of the following actions:

To add a new status, click Add (   ).

The Job Ticket Status window appears.

To edit an existing status, in the Job Ticket Status Table, double-click the desired

status or select the status, and then click Edit (   ).

The Job Ticket Status window appears.

To delete a status, perform the following actions:

1. In the Job Ticket Status Table, select the desired

status, and then click Delete (   ).

2. In the Confirmation window, click OK.

The status is deleted from the table.

3. Proceed to step 7.

4. In the Job Ticket Status window, in the Name field, type the status name.
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5. (Optional) Configure additional job ticket status parameters:

To specify a color other than the default for

highlighting the status name,

from the expandable Color palette, select the desired

color.

To hide job tickets with the status from the

Job Tickets Table on the Job Tickets panel if, in

the Management area, the Show completed

tickets check box is cleared,

select the Completion Status check box.

To configure the sound notification which will be

played when the status is assigned to a job

ticket,

perform the following actions:

1. Select the Play Sound check box.

2. Click Select Sound File (   ).

The Sound File Selection window appears.

3. In the opened window, select the desired audio

file and click Open.

6. Click OK to apply changes and close the window.

7. Click Finish to close the Job Tickets window.

Postrequisites: 

 Add the desired job tickets and send them to a single or multiple radios or talkgroups. For details, see Managing Job

Tickets.

2.6.6 Lone Worker Rules

SmartPTT Dispatcher supports the Lone Worker mode for radios. For details, see Radios.

NOTE

The Lone Worker mode is available to DMR radios only.

The Lone Worker mode provides the ability to automatically track the following conditions:

• Absence of calls from a radio during the specified period

• Absence of GPS coordinates from a radio during the specified period

• No change in location of a radio during the specified period

When one of the conditions triggers, SmartPTT Dispatcher sends alerts to the radio or performs preconfigured

actions.

Important

Lone Worker profiles are available to the Administrator or to operators with the corresponding permission. For

details, see Operators.

Lone Worker profiles are sets of conditions that triggers preconfigured actions when fulfilled. SmartPTT Dispatcher

supports multiple profiles, so it is possible to create a Lone Worker profile for each radio.
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All radios with assigned Lone Worker profiles are displayed on the Lone Workers panel. For details, see Lone

Workers.

For information on the Lone Worker profiles functionality, see the sections below.

2.6.6.1 Lone Worker Window

The Lone Worker window provides the ability to manage Lone Worker profiles.

You can open the window by clicking Settings (   ) → Radios → Lone Worker Rules on the menu bar.

The Lone Worker window provides the following elements:

Add

Opens the Profile Settings window for adding a new profile. For details, see Profile Settings.

Edit

Opens the Profile Settings window for editing the profile selected in the Profiles Table below.

Delete

Deletes the selected profile from SmartPTT Dispatcher.
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NOTE

The button is unavailable if the default profile is selected.

Lone Worker Profiles Table

Provides the list of all added Lone Worker profiles and the default profile.

2.6.6.2 Profile Settings

The Profile Settings window provides the ability to configure Lone Worker profiles. A Lone Worker profile is a set of

conditions that triggers preconfigured actions when met.

The window appears when clicking Add or Edit in the Lone Worker window. For details, see Lone Worker Window.

The Profile Settings window provides the following elements:

Name

The name of the profile which is used when you assign the profile to a radio.

General

Contains rule conditions to trigger an alert. The tab provides the following elements::

• If the No calls (min) check box is selected, the actions configured for the profile are executed when the radio

does not make a call during the period (in minutes) specified in the field on the right.
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• If the No location data received (min) check box is selected, the actions configured for the profile are

executed when the radio does not send GPS or Indoor data during the period (in minutes) specified in the field

on the right.

• If the No change in location data (min) check box is selected, the actions configured for the profile are

executed when the radio GPS data or Indoor data do not change or GPS data show that the traveled distance is

less than 5 meters during the period (in minutes) specified in the field on the right.

NOTE

The No change in location data condition triggers only if the dispatcher receives radio GPS or Indoor data.

Therefore, the No change in location data condition must be used with the No location data received

condition.

NOTE

A WAVE user can send only GPS data.

For information on WAVE users, see “WAVE Systems” in SmartPTT Installation and Configuration Guide.

Tallysman

Provides the ability to specify the profile condition related to the Tallysman option board.

If the No heartbeat messages (s) check box is selected on the tab, the actions configured for the profile are

executed when the radio built-in option board does not send information on the radio presence in the network

during the period (in seconds) specified in the field on the right.

NOTE

For the condition to be triggered, the radio must have the built-in Tallysman option board which is configured

properly, and the Tallysman feature must be enabled in SmartPTT Radioserver Configurator. For details, see

“Location with Option Boards” in SmartPTT Installation and Configuration Guide.

Radio Alert

Provides the ability to configure the sending of alerts to the radio after the conditions are met. The area provides

the following elements:

• If the Text Message check box is selected, when the event which meets the specified conditions is registered,

the text message typed in the field on the right is sent to the radio.

NOTE

This action is unavailable to WAVE users.

• If the Audio Message check box is selected, when the event which meets the specified conditions is registered,

an audio message is sent to the radio.

• The Record button starts voice message recording. When clicked, changes to the Stop button.

• The Play button plays the recorded voice message. When clicked, changes to the Stop button.

• The Delete button deletes the recorded voice message.

• If the Call Alert check box is selected, when the event which meets the specified conditions is registered, the

Call Alert command is sent to the radio.

NOTE

This action is unavailable to WAVE users.
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Actions

Contains settings for SmartPTT Dispatcher responding to fulfillment of conditions. The area provides the following

elements:

• The Actions delay (min) field provides the ability to type the time period (in minutes) after sending an alert

during which a radio must make a call, send location data, or move, depending on the selected conditions. If

the radio does not perform any of these actions during the specified period or the period value is 0, the system

executes actions set on the Actions area tabs.

NOTE

The field is available if any check box is selected in the Radio Alert area.

• The Actions area tabs provide the ability to configure SmartPTT Dispatcher actions after registration of the

events which meet the specified conditions. For details, see Actions Triggered by Rules.

2.6.6.3 Managing Lone Worker Profiles

Follow the procedure to add a new Lone Worker profile or edit an existing one.

Prerequisites: 

• To configure the No heartbeat messages condition, ensure that the radio has the built-in Tallysman option

board which is configured properly. Also ensure that the Tallysman feature is enabled in SmartPTT Radioserver

Configurator. For details, see “Location with Option Boards” in SmartPTT Installation and Configuration Guide.

• Ensure the operator has the Manage lone worker rules right. For information on operator rights, see

Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radios → Lone Worker Rules.

The Lone Worker window appears.

2. In the Lone Worker window perform one of the following actions:

To add a new profile, in the top part of the window, click Add (   ).

The Profile Settings window appears.

To edit an existing profile, in the Lone Worker Profiles Table, select the desired

profile, and then click Edit (   ).

The Profile Settings window appears.

To delete an added profile, perform the following actions:

1. In the table, select the desired profile, and then

click Delete (   ).

NOTE

The default profile cannot be deleted.

2. In the confirmation window, click OK.

The profile is deleted from the table.
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3. Proceed to the last step of the procedure.

3. In the Profile Settings window, in the Name field, type the profile name.

4. In the Conditions area, configure the desired conditions to perform actions:

To perform actions when SmartPTT

Dispatcher does not receive any calls from

the radio,

perform the following actions:

1. On the General tab, select the No calls (min) check

box.

2. In the field to the right of the check box, specify the

desired time in minutes. If the radio does not make a

call during this time, the profile actions will be

performed.

To perform actions when SmartPTT

Dispatcher does not receive any location

data from the radio,

perform the following actions:

1. On the General tab, select the No location data

received (min) check box.

2. In the field to the right of the check box, specify the

desired time in minutes. If the radio does not send its

GPS or Indoor data during this time, the profile actions

will be performed.

To perform actions when location data do

not change,

perform the following actions:

1. On the General tab, select the No change in

location data (min) check box.

2. In the field to the right of the check box, specify the

desired time in minutes. If the radio does not change

its GPS or Indoor data during this time, the profile

actions will be performed.

NOTE

The No change in location data condition must be

used together with the No location data received

condition.

To perform actions when SmartPTT

Dispatcher does not receive any heartbeat

messages from the radio,

perform the following actions:

1. Open the Tallysman tab, and then select the No

heartbeat messages (s) check box.

2. In the field to the right of the check box, specify the

desired time in seconds. If the radio does not send

heartbeat messages during this time, the profile

actions will be performed.
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5. (Optional) Configure sending alerts to the radio:

a. In the Radio Alert area, configure the alerts that will be sent to the radio after one of the conditions is met:

To send a text message to the radio, perform the following actions:

1. Select the Text Message check box.

2. In the field to the right of the check box, type the

message text.

To send an audio message to the radio, perform the following actions:

1. Select the Audio Message check box.

2. Click Record and speak into the microphone.

3. Click Stop after you finished speaking.

4. (Optional) Click Play to listen to the recorded

message.

5. (Optional) Click Delete to delete the added

message and record a new one.

To send the Call Alert command to the radio, select the Call Alert check box.

b. In the Actions delay (min) field, specify the time in minutes after sending an alert when actions will be

performed if the radio is still inactive.

6. In the Actions area, configure actions that will be performed when one of the conditions is met:

To configure alerts addressed to the event initiator, see Configuring Initiator Alerts.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of

recipients,

see Configuring Radio Alerts.

To configure sending messages using web, SMS, or

e-mail services,

see Configuring Other Services.

7. Click OK to save changes and close the window.

The configured profile appears in the Lone Worker window.

8. Click Finish to close the Lone Worker window.
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2.6.7 Custom Radio Properties

SmartPTT Dispatcher provides the ability to add custom properties of a radio that can be used for giving additional

information. Custom radio properties have the following four types:

• Text

• Numeric

• Date

• List

To create custom properties, on the menu bar of the SmartPTT Dispatcher window, click Settings (   ) → Radios →

Custom Radio Properties.

The Custom Radio Properties window appears.

The top list contains custom property groups.

To add a custom property group, click Add at the top. To delete the group, click Delete. Arrows on the right allow

moving groups inside the list.

The bottom list contains the properties of the created groups.
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Property Name

Custom name of the property which will be displayed in the Properties window.

Type

Property type (Text, Numeric, Data or List).

Description

Text description added when creating a property.

Active

Select the check box, to have the property displayed in the Properties window.

To add a property into the property group, select the created property group in the top list and then click Add above

the bottom list.

The Radio Property window appears:

Fill all the boxes required.

• Text — you can enter a text;

• Numeric — you can enter data in numerical format;

• Date — you can enter data as a number;

• List — you can select a value from the list provided.

Select the Type and click OK. 

NOTE

If you want to select List in the Type list, before that you need to create the list. Otherwise, the list will be empty.
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To create the list, click the Create/Edit Lists (   ) button. The window appears:
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In the top box add list names by clicking Add.

Select the created list and add elements of the list. To do it, go to the bottom box and click Add just above it.

To view the active custom properties go to the radio Properties window, Custom tab.

For details, see Radio Custom Properties.
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2.7 Positioning Systems

The Positioning Systems window provides the ability to configure GPS and Indoor settings.

You can open the window by clicking Settings (   ) → Positioning Systems on the menu bar.

The Positioning Settings window provides the following elements:

Validity of GPS coordinates (min)

GPS data validity period in minutes. If new GPS coordinates are not received during this period, the radio label is

removed from the map.

Validity of beacon signals (min)

Beacon signals validity period in minutes. If new beacon signals are not received during this period, the radio label

is removed from the building plan.

Time interval for GPS coordinates update (s)

The default time interval for updating radio location data. The value in this field will be applied to all unregistered

radios and will be displayed in the Properties window of a radio on the Location tab in the with time interval

field. For details, see Radio Location Properties.
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Accuracy Radius

The required accuracy for received coordinates. If the received coordinate is less accurate than the value specified

in this field, the coordinate is considered invalid.

Address data provider

Activates a map service to determine an object address according to the current GPS coordinates of a radio

(reverse geocoding). If the check box is selected, the list with the following address services is available:

• The Google option provides the ability to use Google as the address data provider. If selected, the Google API

Key field appears where you must type an API key to allow usage of Google service. If the API key is already

typed in the map settings, you do not need to enter it in this field. For details, see Map Settings.

NOTE

To use the Google map service, activate the address module in the settings of the account which was used to

generate the API key.

• The OpenStreetMap Nominatim option provides the ability to use the official OpenStreetMap server as the

address data provider. If selected, the Address field with the server address appears. The field is unavailable for

editing.

• The Dedicated OpenStreetMap Nominatim server option provides the ability to use a private or public

OpenStreetMap Nominatim server. If selected, the Address field where you can type the server address

appears. For details, see Map Settings.

Data Format

Provides the ability to configure the format of radio location data to display. The area provides the following

elements:

• The Coordinates list provides the ability to select the format of GPS coordinates:

• If the Decimal Degrees format is selected, GPS coordinates are displayed as in the following example: lat:

56,47568, long: 84,98779.

• If the Degrees, Minutes, Seconds format is selected, GPS coordinates are displayed as in the following

example: lat: 56°28'32", long: 84°59'16".

• If the Universal Transverse Mercator Coordinate System format is selected, GPS coordinates are displayed as in

the following example: 45V 376108 B 6260913 C.

• The System of Units list provides the ability to select the measurement system (Metric or Imperial) for distance

and speed.

NOTE

When changing measurement system, the data previously logged will not be converted into the new

measurement system.

• The Speed list provides the ability to select the format of a radio speed. Available formats depend on the

selected system of units:

• For the Metric system: Meters per second, Kilometers per hour, Knots.

• For the Imperial system: Feet per second, Miles per hour, Knots.
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Save GPS Locations in Database

If selected, GPS coordinates received from radios are stored in the SmartPTT Dispatcher database.

Database cleanup settings

Provides the ability to configure the scheme of deleting coordinates from the database.The area provides the

following elements:

• If the Do not delete GPS locations option is selected, the coordinates are never deleted from the database.

• If the Coordinates retention period (days) option is selected, the coordinates are stored in the database for

the period in days specified in the field on the right. When the retention period is over, the coordinates will be

deleted from the database.

2.7.1 Configuring Positioning Settings

Follow the procedure to configure GPS and Indoor settings.

Prerequisites: 

• (Optional) To use Google as the address data provider, obtain the Google API key. For details, see “Google Map

Keys” in SmartPTT Installation and Configuration Guide.

• (Optional) To use the dedicated OpenStreetMap Nominatim server as the address data provider, obtain the

server address.

Procedure: 

1. On the menu bar, click Settings (   ) → Positioning Systems.

The Positioning Systems window appears.

2. In the Validity of GPS coordinates (min) field, specify the period in minutes after which the radio label is

removed from the map if new GPS coordinates were not received from the radio.

3. In the Validity of beacon signals (min) field, specify the period in minutes after which the radio label is

removed from the building plan if new beacon signals were not received from the radio.

4. In the Time interval for GPS coordinates update (s) field, specify the interval for updating radio location

data in seconds which will be applied to all unregistered radios.

5. In the Accuracy Radius field, specify the maximum coordinate error margin required to consider received

coordinates valid.

6. (Optional) To use the address service (reverse geocoding), perform the following actions:

a. Select the Address data provider check box.

b. Configure the desired provider:

To use Google, perform the following actions:

1. From the list to the right of the Address data

provider check box, select Google.

2. In the Google API Key field, type an API key.
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To use the official OpenStreetMap Nominatum

server,

from the list to the right of the Address data provider

check box, select OpenStreetMap Nominatum.

To use a private or public OpenStreetMap

Nominatim server,

perform the following actions:

1. From the list to the right of the Address data

provider check box, select Dedicated

OpenStreetMap Nominatim server.

2. In the Address field, type the desired server

address.

7. In the Data Format area, configure the format of radio location data to display:

a. From the Coordinates list, select the format for displaying GPS coordinates: Decimal Degrees, Universal

Transverse Mercator Coordinate System, or Degrees, Minutes, Seconds.

b. From the System of Units list, select the measurement system for configuring, displaying and saving

location data: Metric or Imperial.

c. From the Speed list, select the units in which radio speed will be displayed.

8. (Optional) To save radio GPS data in the SmartPTT Dispatcher database, perform the following actions:

a. Select the Save GPS Locations in Database check box.

b. In the Database cleanup settings area, perform one of the following actions:

To prevent coordinates from deletion by

SmartPTT Dispatcher,

select Do not delete GPS locations.

To delete outdated coordinates, perform the following actions:

1. Select Coordinates retention period (days).

2. In the field on the right, type the desired

retention period in days.

9. Click Finish to save changes and close the window.

2.8 Dispatchers

In SmartPTT Dispatcher you can communicate with other dispatchers of SmartPTT system in the following ways:

• Initiate and receive voice calls

• Exchange text messages

Important

To communicate with external dispatchers, an operator needs to have the corresponding permission. For details,

see Operators.

For information on configuring dispatcher settings and establishing communication with external dispatchers, see

the sections below.
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2.8.1 Dispatchers Settings

In the Dispatchers window you can perform the following actions:

• Configure SmartPTT Dispatcher settings for communication with external dispatchers

• Add external dispatchers

• Manage added external dispatchers

You can open the window by clicking Settings (   ) → Dispatchers on the menu bar.

The Dispatchers window provides the following elements:

VoIP Port

UDP port of the dispatcher computer for the voice transmission. The default value is 18501.

Session Port

TCP port of the dispatcher computer for the commands and text messages transmission. The default value

is 18501.

Play Sound Alert for Incoming Call

When selected, a tone is played at incoming dispatcher calls.
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Play Sound Alert for Outgoing Call

When selected, a tone is played at outgoing dispatcher calls.

Add

Opens the Dispatcher window for adding a new external dispatcher. For details, see Dispatcher Window.

Edit

Opens the Dispatcher window for editing the added dispatcher parameters.

Delete

Deletes the selected dispatcher.

Dispatchers Table

Displays all added external dispatchers. The table consists of the following columns:

• The Name column contains the dispatcher name.

• The IP address column contains the dispatcher IP address.

• The VoIP Port column contains the UDP port which is selected for the voice transmission.

• The Session Port column contains the TCP port which is selected for the commands and text messages

transmission.

You can sort the dispatchers in the table by columns and arrange the entries in ascending or descending order by

clicking the name of the desired column. You can sort entries only by one column. Clicking the name of another

column automatically discards the sorting order applied earlier.

2.8.2 Dispatcher Window

In the Dispatcher window you can configure external dispatcher parameters.

The window opens when you add a new external dispatcher, or edit an existing external dispatcher.

The Dispatcher window provides the following elements:

Name

The external dispatcher name.
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Address

IP address of the external dispatcher computer (DNS name can be used).

VoIP Port

UDP port of the external dispatcher computer for voice transmission.

Session Port

TCP port of the external dispatcher computer for transmission of commands and text messages.

Select

Opens the window for selecting the dispatcher avatar.

You can remove the selected avatar by clicking Clear the image of the dispatcher (   ) next to the Select

button.

Sound for Incoming call alert

The path to the audio file that is played in SmartPTT Dispatcher on receiving a call from this dispatcher.

By default, a standard system sound is used. You can replace it with the desired audio file by clicking the Select a

sound file for an incoming call (   ) button.

You can clear the path to the selected audio file and reset the sound to default by clicking the Use a system

sound (   ) button.

2.8.3 Dispatchers Window

In the Dispatchers window you can communicate with other dispatchers by initiating and receiving voice calls or

exchanging text messages.

You can open the Dispatchers window by clicking the Dispatchers (   ) button on the menu bar.

NOTE

The Dispatchers (   ) button is unavailable if no external dispatchers are added to SmartPTT Dispatcher or you

have no corresponding permission to communicate with them. For details, see Dispatchers Settings and

Operators.
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The Dispatchers window provides the following elements:

Dispatchers List

Contains a list of dispatchers added in the Dispatcher Settings window.

On the right of the dispatcher name a status is displayed. The statuses can be the following:

• The Offline status indicates that the dispatcher is unavailable (SmartPTT Dispatcher has not been started or

dispatcher has no corresponding permission to communicate with external dispatchers).

• The Online status indicates that the dispatcher is available for communication.

• The Ringing status indicates that voice communication with the dispatcher is establishing.

• The Call Voice status indicates that communication is established.

Dispatcher Name and Avatar

The name and avatar set in the Dispatcher window. For details, see Dispatcher Window.

The following elements are available only if the selected dispatcher is online:

Chat box

Contains the messages log. The green text indicates incoming messages, and the red text indicates outgoing

messages.

Send (   )

Sends the typed message to the selected dispatcher. After sending, the text message appears in the chat box

above, and in the SmartPTT Dispatcher Event Log.

Mute (   ) / Sound On (   )

Mutes or unmutes your voice transmission. The button becomes available when the call is started. When your

transmission is muted, you can still hear the other dispatcher.
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Connect

Initiates a call to the selected dispatcher. During a call, the button changes to Disconnect.

Make Conference Call (   )

Opens the Conference Calls window and adds the selected dispatcher to a conference call. For details, see

Conference Calls.

2.8.4 Configuring Dispatcher

For communicating with external dispatchers in SmartPTT Dispatcher you need to perform the following actions:

• Configure SmartPTT Dispatcher settings for communication with external dispatchers. For details, see

Configuring Dispatcher Settings.

• Add external dispatchers. For details, see Adding Dispatchers.

2.8.4.1 Configuring Dispatcher Settings

Follow the procedure to configure the SmartPTT Dispatcher settings for communicating with external dispatchers.

Prerequisites: 

Obtain UDP and TCP ports of your SmartPTT Dispatcher computer.

Procedure: 

1. On the menu bar, click Settings (   ) → Dispatchers.

The Dispatchers window appears.

2. In the Dispatchers window, in the VoIP port box, type the UDP port of the current dispatcher computer.

3. In the Session port box, type the TCP port of the current dispatcher computer.

4. (Optional) Select the Play sound alert for incoming call check box for playing a tone at incoming dispatcher

calls.

5. (Optional) Select the Play sound alert for outgoing call check box for playing a tone at outgoing dispatcher

calls.

6. Add the desired external dispatchers.

For details, see Adding Dispatchers.

7. Click Finish to close the window.

Postrequisites: 

• To edit the desired dispatcher, select the entry in the Dispatchers Table, and then click Edit.

• To delete the desired dispatcher, select the entry in the Dispatchers Table, and then click Delete.
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2.8.4.2 Adding Dispatchers

Follow the procedure to add a new dispatcher.

Prerequisites: 

Obtain the external dispatcher IP address, UDP, and TCP ports.

Procedure: 

1. On the menu bar, click Settings (   ) → Dispatchers.

The Dispatchers window appears.

2. In the Dispatchers window, click the Add button.

The Dispatcher window appears.

3. In the Dispatcher window, in the Name box, type the dispatcher name.

4. In the Address box, specify the dispatcher IP address.

5. In the VoIP port box, specify the UDP port of the external dispatcher's computer.

6. In the Session port box, specify the TCP port of the external dispatcher's computer.

7. (Optional) In the left part of the window, click Select, and then in the window that appears, select the avatar for

the dispatcher.

8. (Optional) Click Browse (   ), and then in the window that appears, select a tone for incoming dispatcher calls.

9. Click OK to save the changes and close the window.

The added dispatcher appears in the Dispatchers Table.

Postrequisites: 

• To delete the dispatcher avatar, click Clear the image of the dispatcher.

• To set the default call alert, click Use a system sound.

2.8.5 Communicating with External Dispatchers

In SmartPTT Dispatcher you can communicate with external dispatchers in the following ways:

• By initiating and accepting voice calls. For details, see Initiating Voice Calls to Dispatchers and Accepting

External Dispatcher Calls.

• By sending text messages. For details, see Sending Messages to Dispatchers.
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2.8.5.1 Initiating Voice Calls to Dispatchers

Follow the procedure to initiate a voice call to an external dispatcher.

Prerequisites: 

Ensure the following conditions are met:

• The Dispatchers (   ) button on the menu bar is available. If not, ensure an operator has the corresponding

permission or at least one dispatcher is added.

For details, see Operators and Dispatchers Settings.

• The desired dispatcher is online.

For details, see Dispatchers Window.

Procedure: 

1. On the menu bar, click the Dispatchers (   ) button.

The Dispatchers window appears.

2. In the Dispatchers window, from the list of dispatchers on the left, select the desired dispatcher.

3. Click the Connect button.

The Connect button changes to Disconnect. The Online status changes to Ringing.

4. Wait until the dispatcher accepts the call.

After the dispatcher accepts the call, and the status changes to Call, speak into your microphone.

5. Click Disconnect to end the call.

The Disconnect button changes to Connect.

2.8.5.2 Sending Messages to Dispatchers

Follow the procedure to send a text message to an external dispatcher.

Prerequisites: 

Ensure the following conditions are met:

• The Dispatchers (   ) button on the menu bar is available. If not, ensure an operator has the corresponding

permission or at least one dispatcher is added.

For details, see Operators and Dispatchers Settings.

• The desired dispatcher is online.

For details, see Dispatchers Window.
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Procedure: 

1. On the menu bar, click the Dispatchers (   ) button.

The Dispatchers window appears.

2. In the Dispatchers window, from the list of dispatchers on the left, select the desired dispatcher.

3. In the text box on the right, type the message, and then press Enter or click the Send (   ) button.

The sent message appears in the chat box above the text box.

Postrequisites: 

You can view the sent message details in the Event Log. For details, see SmartPTT Dispatcher Event Log.

2.8.5.3 Accepting External Dispatcher Calls

Follow the procedure to accept an incoming call from an external dispatcher.

Procedure: 

1. In the Incoming call window, click the Accept button.

The Dispatchers window appears. The call starts.
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2. Click Disconnect to finish the call.

The Disconnect button changes to Connect.

3. (Optional)  If the incoming call is made by by a dispatcher that is not added to SmartPTT Dispatcher, you can

add a new dispatcher to the list by performing the following actions:

a. Under the dispatcher IP address, click the Add button.

The Dispatcher window appears.

b. In the Dispatcher window, in the Name box, type the dispatcher name.

c. (Optional) In the left part of the window, click Select, and then in the open window, select the avatar for the

dispatcher.

d. (Optional) Click Browse (   ), and in the open window select a tone for incoming dispatcher calls.

e. In the Dispatcher window, click OK to save the changes and close the window.

The dispatcher IP address changes to the dispatcher name.

2.9 Rules

The Rules submenu is available in the Settings (   ) menu on the SmartPTT Dispatcher menu bar. It provides the

following options:

• Configuring SmartPTT Dispatcher behavior in response to general radio system event types.

For details, see Custom Rules.

• Configuring SmartPTT Dispatcher behavior in response to the radio system events related to the GPS and

Indoor data.

For details, see Positioning Rules.
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2.9.1 Custom Rules

Custom rules are used to automatically notify dispatchers, radios, and other preset recipients. Custom rules provide

the ability to send messages, play alert sounds in SmartPTT Dispatcher and on the radio, change the radio status, etc.

Important

Custom rules are available to the Administrator or to operators with the corresponding permission. For details,

see Operators.

NOTE

Custom rules are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

A custom rule is a combination of preconfigured conditions and actions. When the system has registered an event

matching the specified rule, the rule is considered as triggered, and the system performs preconfigured actions.

Rules can also be configured in SmartPTT Radioserver Configurator. For information on rule configuring in the

SmartPTT system, see “Rules” in SmartPTT Installation and Configuration Guide.

For information on the Custom Rules functionality, see the sections below.
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2.9.1.1 Custom Rules Window

The Custom Rules window provides the ability to manage custom rules.

You can open the Custom Rules window by clicking Settings (   ) → Rules → Custom Rules on the menu bar.

The Custom Rules window provides the following elements:

Add

Opens the Rule Settings window to add a new rule. For details, see Rule Settings.

Edit

Opens the Rule Settings window to edit the rule selected in the Custom Rules Table below.

Delete

Deletes the selected rule from SmartPTT Dispatcher.

Custom Rules Table

Provides the list of all added rules. The table consists of the following columns:

• The Name column contains the custom rule name.

• The Active column contains the check box for activating or deactivating the selected rule.
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You can sort content of the table by clicking the desired column header.

2.9.1.2 Rule Settings

The Rule Settings window provides the ability to configure custom rules.

The window appears when clicking Add or Edit in the Custom Rules window. For details, see Custom Rules Window.

The Rule Settings window provides the following elements:

Active

Activates/deactivates a rule.

Name

The name of a rule.

Conditions

The table that provides the ability to configure rule conditions. The table consists of the following columns:

• The Attribute column contains a list of available condition attributes.

• The Operation column determines how the attribute is compared with the set values.

• The Value 1, Value 2, and Value 3 columns become available after selecting conditions in the Operation

column and provide the possibility to set the values corresponding to the selected operation.
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A rule condition is a combination of an attribute, operation and value. One rule can contain more than one such

combination. Conditions description is available in the following table:

Attribute Description

Direction The event direction can be Incoming (events are addressed to SmartPTT

Dispatcher) or Outgoing (events are initiated by SmartPTT Dispatcher).

To select the desired direction, you need to set the Equal to value in the

Operation column.

The No value causes the attribute to be ignored.

Event type The list of available event types.

To select the desired event type, you need to set the Equal to value, or the Not

Equal to value in the Operation column.

The No value causes the attribute to be ignored. For information on event types,

see Event Types.

Date/Time The date interval, when the rule can be triggered.

To select the desired date period, you need to set the Between value in the

Operation column.

If the dates are not selected, the rule will be triggered without reference to

dates.

The No value causes the attribute to be ignored.

Important

For the Date/Time attribute it is possible to select only date without time.

Additional information You can type the information corresponding to the event type, or leave the box

empty. For example:

• Alarm — the date and time when the alarm was received and the

operator name who received it.

For SCADA points, the parameter that reported the alarm state.

• Call — the identifiers of call initiators, or operator name.

• Job Ticket — the job ticket number, name, and description.

• Message — the message text.

• Status — changing of the radio status.

• Telemetry — the description of telemetry action set in telemetry settings.

Additional information is displayed in the Event Log in the Additional

Information column. For details, see Additional Information Column.

To type information, you need to set the Equal to value, or the Contains value in

the Operation column.

The No value causes the attribute to be ignored.
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Attribute Description

Not read The message status: Read, or Not read that triggered the rule.

To select the desired message status, you need to set the Equal to value in the

Operation column.

The No value causes the attribute to be ignored.

Operator The name of the operator who participates in the event.

To select the desired name, you need to set the Equal to value, or the Not Equal

to value in the Operation column.

The No value causes the attribute to be ignored.

Radioserver The radioserver name where the rule is triggered.

To select the desired radioserver, you need to set the Equal to value, or the Not

equal to value in the Operation column.

The No value causes the attribute to be ignored.

Channel The channel name where the rule is triggered.

To select the desired channel, you need to set the Equal to value, or the Not

equal to value in the Operation column.

The No value causes the attribute to be ignored.

Radio The name of the radio that participates in the event.

To select the desired radio, you need to set the Equal to value, or the Not equal to

value in the Operation column.

The No value causes the attribute to be ignored.

Talkgroup The name of the talkgroup that receives a voice or another transmission.

To select the desired talkgroup, you need to set the Equal to value, or the Not

equal to value in the Operation column.

The No value causes the attribute to be ignored.

Status The event status from the list of statuses. For details, see Status Column.

To select the desired status, you need to set the Equal to value, or the Not equal

to value in the Operation column.

The No value causes the attribute to be ignored.

Duration The event duration in seconds.

To type the desired duration, you need to set one of the values in the

Operation column.

The No value causes the attribute to be ignored.

Connection Type The list of available connection types:

• DMR: Over-the-air connection made via repeaters and control stations.
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Attribute Description

• IP: Dispatcher-Dispatcher connection.

• PBX: Telephone connection.

To select the desired connection type, you need to set the Equal to value, or the

Not equal to value in the Operation column.

The No value causes the attribute to be ignored.

Destination The name of the recipient that participates in the event.

To select the desired connection type, you need to set the Equal to value, or the

Not equal to value in the Operation column.

The No value causes the attribute to be ignored.

Record The call record availability: Recorded, or Not recorded.

To select the desired value, you need to set the Equal to value in the Operation

column.

The No value causes the attribute to be ignored.

User The name of the authorized radio user that participates in the event.

To select the desired user, you need to set the Equal to value, or the Not equal to

value in the Operation column.

The No value causes the attribute to be ignored.

SCADA point The SCADA point from the list of SCADA points added to SmartPTT Dispatcher.

To select the desired SCADA point, you need to set the Equal to value in the

Operation column.

The No value causes the attribute to be ignored.

NOTE

If a SCADA point is deleted from the SmartPTT Dispatcher list of SCADA points,

or if it is currently unavailable, the rules that affect the point are not deleted.

SCADA Alarm The SCADA point parameter capable of indicating alarm states.

To select the desired SCADA alarm, you need to set the Equal to value in the

Operation column.

The No value causes the attribute to be ignored.

NOTE

This attribute is not set without selecting a SCADA point.

Actions

Provides the ability to configure SmartPTT Dispatcher actions after registration of the events which meet the

specified conditions. For details, see Actions Triggered by Rules.



195

Settings Rules

2.9.1.3 Adding and Editing Custom Rules

Follow the procedure to add a new custom rule or edit an existing one.

Prerequisites: 

Ensure the operator has the Manage Custom Rules right. For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Rules → Custom Rules.

The Custom Rules window appears.

2. In the Custom Rules window, perform one of the following actions:

To add a new custom rule, in the top part of the window, click Add (   ).

To edit an existing rule, in the Custom Rules Table, select the desired rule,

and then click Edit (   ).

 The Rule Settings window appears.

3. (Optional) In the opened window, select or clear the Active check box for activating or deactivating an existing

rule.

4. In the Name field, type the rule name.

5. In the Conditions table, set the desired rule conditions:

a. In the Attribute column, select the desired attribute.

b. In the Operations column, select the desired operation.

c. In the Value 1 column, set the desired value.

d. If required, set the desired values in the Value 2 and Value 3 columns.

NOTE

Some fields in the Value 2 and Value 3 columns are impossible to fill.

6. In the Actions area, configure actions that will be performed when the rule is triggered:

To configure alerts addressed to the event initiator, see Configuring Initiator Alerts.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of

recipients,

see Configuring Radio Alerts.

To configure sending messages using web, SMS, or

E-mail services,

see Configuring Other Services.

7. Click OK to save changes and close the window.

The configured rule appears in the Custom Rules window.
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8. Click Finish to close the Custom Rules window.

Postrequisites: 

For information on subsequent activating, deactivating, or deleting a rule, see Managing Custom Rules and

Positioning Rules.

2.9.1.4 Message Format

In the Rule Settings window, on the Message Format tab, you can configure the format of messages (text

message, SMS, or e-mail) sent when the rule is triggered. These messages are sent to the recipients set on the

Initiator Alert, Radio Alert or the Other tab. For details, see Initiator Alert, Radio Alert, and Other.

The Message Format tab provides two areas:

• The Event Information area provides the ability to include in a message information about the event that

triggered message sending.

• The Radio Information area provides the ability to include in a message information about the radio that

triggered message sending.

The Event Information provides the following elements:

Event Type

If the check box is selected, the message will include the type of the event that triggered the rule.

Date/Time

If the check box is selected, the message will include the date and time or only time of the event that triggered the

rule. You can select the date format (Date/Time or Time) in the list.

Time Zone

If the check box is selected, the message will include the time zone.

Coordinates

If the check box is selected, the latest radio GPS coordinates will be added to the message. You can select the

coordinates format (Decimal Degrees or Degrees, Minutes, Seconds) in the list.

The Radio Information provides the following elements:
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Radio ID

If the check box is selected, the message will include the ID of the radio that triggered the rule.

Radio Name

If the check box is selected, the message will include the name of the radio that triggered the rule.

2.9.2 Positioning Rules

You can set response rules for GPS and Indoor events registered in SmartPTT system. GPS events include receiving or

not receiving radio GPS coordinates, and Indoor events include receiving or not receiving positioning data from

special beacons. Response rules may include automatic sending of messages, playing alerts in SmartPTT Dispatcher

and on the radio, changing radio statuses, and other.

Important

Positioning rules are available to the Administrator or to operators with the corresponding permission. For details,

see Operators.

A positioning rule is a combination of preconfigured conditions and actions. When the system has registered an

event matching the specified rule, the rule triggers, and the system performs preconfigured actions.

For information on the positioning rules functionality, see the sections below.
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2.9.2.1 Positioning Rules Window

The Positioning Rules window provides the ability to manage positioning rules.

You can open the Positioning Rules window by clicking Settings (   ) → Rules → Positioning Rules on the menu

bar.

The Positioning Rules window provides the following elements:

Add

Opens the Positioning Rule window for adding a new rule. For details, see Positioning Rule Window.

Edit

Opens the Positioning Rule window for editing the rule selected in the Positioning Rules Table below.

Delete

Deletes the selected rule from SmartPTT Dispatcher.

Positioning Rules Table

Provides the list of all added rules. The table consists of the following columns:

• The Rule column contains the rule name.
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• The GPS/Indoor column contains the data type used for the rule.

• The Type column contains the rule type information.

• The Active column contains the check box for activating or deactivating the selected rule.

You can sort content of the table by clicking the desired column header.

2.9.2.2 Positioning Rule Window

The Positioning Rule window provides the ability to configure a positioning rule.

The window appears when clicking Add or Edit in the Positioning Rules window. For details, see Positioning Rules

Window.

The Positioning Rule window provides the following elements:

Active

Activates/deactivates the rule.
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Name

The name of the rule.

GPS and Indoor

The data type used for the rule.

NOTE

You can configure only GPS positioning rules for WAVE and SmartPTT Mobile users.

For information on WAVE users and the mobile application, see “WAVE Systems” and “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

Type

The list of rule types:

• The No radio/mobile client movement rule type triggers when the radio or SmartPTT Mobile user coordinates do

not change for a specified time.

• The Location data received rule type triggers if the radio sends its coordinates after a specified time without

coordinates updates.

• The No location data rule type triggers when SmartPTT Dispatcher does not receive valid radio coordinates for a

period longer than the specified one.

• The Zone/route entry rule type triggers when the radio enters the specified zone or route, i.e. the previous radio

coordinates were outside this zone or route, and the current coordinates are within it.

• The Zone/route exit rule type triggers when the radio leaves the specified zone or route.

• The Speeding rule type triggers when the specified speed is exceeded based on the received GPS data.

NOTE

The rule type is only available for GPS rules. It is not applicable to SmartPTT Mobile users.

• The Number of radios/mobile clients in geofences / on routes rule type triggers when the number of radios or

SmartPTT Mobile users in geofences / on routes meets the specified condition.

Conditions

Provides the ability to set specific parameters to trigger a rule. Conditions may vary depending on the selected

rule type. The table contains descriptions of the conditions used for positioning rules:

Condition Value

All Radios

Select Radios

Select Users

Select Categories

Select Mobile Clients

This condition provides the ability to select all radios,

specific radios, authorized users, categories, or mobile

clients to apply the rule.

NOTE

When selecting the All Radios, Select Radios, Select

Users, Select Categories conditions, SmartPTT Mobile

users are not taken into account.
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Condition Value

NOTE

If the Select Mobile Clients condition is selected, the

Initiator Alert and Radio Alert tabs are not available.

Time period with no motion detected (min) The period during which a radio stays in one place (min).

Time period before receiving location data (min) The period after which radio coordinates are received

again (min).

Time period with no location data received (min) The period when no radio coordinates are received (min).

Geofences

Routes

This condition provides the ability to select geofences or

routes.

Speeding This condition provides the ability to specify maximum

speed. The rule triggers when the speed is exceeded. It is

possible to select such units as meters per second,

kilometers per hour, and knots.

NOTE

If you select the Select Area check box and specify

geofences or routes, the rule will only apply when the

speed is exceeded in the specified geofences or on the

routes.

Number of radios/mobile clients in geofences/on

routes

This condition provides the ability to specify the number

of radios or SmartPTT Mobile users in geofences or on

routs and select a condition under which the rule will be

triggered. The number of radios or SmartPTT Mobile users

can be less than, less than or equal to, greater than,

greater than or equal to a given value.

Notify constantly When this check box is selected, the dispatcher will

constantly receive notifications as long as the rule is

triggered. If the check box is cleared, the dispatcher will be

notified once.

Notify about new location When this check box is selected, the dispatcher will be

notified If the radio moves to a new location.

Actions

Provides the ability to configure SmartPTT Dispatcher actions after registration of the events which meet the

specified conditions. For details, see Actions Triggered by Rules.
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2.9.2.3 Adding and Editing Positioning Rules

Follow the procedure to add a new positioning rule or edit an existing one.

Prerequisites: 

Ensure the operator has the Manage Positioning Rules right. For information on operator rights, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Rules → Positioning Rules.

The Positioning Rules window appears.

2. In the Positioning Rules window, perform one of the following actions:

To add a new positioning rule, in the top part of the window, click Add (   ).

To edit an existing positioning rule, in the Positioning Rules Table, click the desired rule,

and then click Edit (   ).

 The Positioning Rule window appears.

3. (Optional) In the opened window, select or clear the Active check box to activate or deactivate an existing rule.

4. In the Name field, type the rule name.

5. Select GPS or Indoor for using the corresponding data.

6. From the Type list, select the type of the rule.

7. In the Conditions area, set the desired rule conditions.

To configure conditions for the No

radio/mobile client movement rule

type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.

2. In the Time period with no motion detected (min)

field, set a time period in minutes during which a radio

stays in one place.

3. (Optional) Select the Notify constantly or Notify

about new location check box to receive the

corresponding notifications.

To configure conditions for the Location

data received rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.

2. In the Time period before receiving location data

(min) field, set a time period in minutes after which

radio coordinates are received again.
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To configure conditions for the No

location data rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.

2. In the Time period with no location data received

(min) field, set a time period in minutes when no

coordinates are received.

3. (Optional) Select the Notify constantly or Notify

about new location check box to receive the

corresponding notifications.

To configure conditions for the

Zone/route entry rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.

2. Select Geofences or Routes.

3. Click Select geofences/routes (   ) and select

objects. The rule triggers when the radio enters the

specified zone or route.

To configure conditions for the

Zone/route exit rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.

2. Select Geofences or Routes.

3. Click Select geofences/routes (   ) and select

objects. The rule triggers when the radio exits the

specified zone or route.

To configure conditions for the Speeding

rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users, or

categories.

2. In the Speeding field, set maximum speed. The rule

triggers if the speed is exceeded. It is possible to select

such units as meters per second, kilometers per hour,

and knots.

3. (Optional) Select Select Area check box and specify

geofences or routes where the rule triggers.

To configure conditions for the Number

of radios/mobile clients in geofences /

on routes rule type,

perform the following actions:

1. Select All radios or specific radios, authorized users,

SmartPTT Mobile users, or categories.
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2. For the Number of radios/mobile clients in

geofences/on routes condition, set the number of

radios in geofences / on routes and select a condition

under which the rule will be triggered.

3. Select Geofences or Routes.

4. Click Select geofences/routes (   ) and select the

desired objects.

8. In the Actions area, configure actions that will be performed when the rule is triggered:

To configure alerts addressed to the event

initiator,

see Configuring Initiator Alerts.

NOTE

This action is not available to SmartPTT Mobile

users. For information on the mobile application,

see “SmartPTT Mobile” in SmartPTT Installation

and Configuration Guide.

To configure alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

To configure sending messages to a list of

recipients,

see Configuring Radio Alerts.

NOTE

This action is not available to SmartPTT Mobile

users.

To configure sending messages using web, SMS,

or e-mail services,

see Configuring Other Services.

9. Click OK to save changes and close the window.

The configured rule appears in the Positioning Rules window.

10. Click Finish to close the Positioning Rules window.

Postrequisites: 

For information on subsequent activating, deactivating, or deleting a rule, see Managing Custom Rules and

Positioning Rules.

2.9.3 Actions Triggered by Rules

You can find the Actions area at the bottom of the Rule Settings, Positioning Rule, and Profile Settings

windows. It is used to configure SmartPTT Dispatcher actions after registration of the events which meet the

specified conditions. For details, see Rule Settings, Positioning Rule Window, and Profile Settings.

The Actions area consists of the following tabs:

• The Initiator Alert tab provides the ability to block a radio, assign the Lone Worker profile or Man Down

mode, and send a message. For details, see Initiator Alert.
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NOTE

The tab is unavailable in the Positioning Rule window if the Select Mobile Clients condition is selected.

• The Dispatcher Alert tab provides the ability to play sound, show radio or point of interest on a map, change

the radio status, or send alerts. For details, see Dispatcher Alert.

• The Radio Alert tab provides the ability to send massages to radios, users, talkgroups, and categories in the

SmartPTT system. For details, see Radio Alert.

NOTE

The tab is unavailable in the Positioning Rule window if the Select Mobile Clients condition is selected.

• The Other tab provides the ability to send HTTP request, e-mails, or SMS. For details, see Other.

• The Message Format tab provides the ability to configure the format of messages that will be sent when the

rule triggers. For details, see Message Format.

NOTE

The tab is only available in the Rule Settings window.

2.9.3.1 Initiator Alert

On the Initiator Alert tab, you can configure actions addressed to the event initiator that will be performed when

the rule is triggered.

NOTE

If the Select Mobile Clients condition is selected when configuring a positioning rule, the Initiator Alert tab is

not available.

The Initiator Alert tab provides the following elements:

Block Radio

If selected, the Block Radio command is sent to the event initiator. The Block Radio command is a CSBK command

which uses a voice channel. It will not work if SmartPTT can not perform voice calls for some reason. The Block

Radio command is also unavailable for analog channels, I/O and APX control stations.

Lone Worker

If selected, the Lone Worker mode will be activated/deactivated for the radio that triggered the rule. You can

select one of the following options:
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• The On option activates the Lone Worker mode and assigns a profile from the list to the right.

• The Off option deactivates the Lone Worker mode.

For information on the Lone Worker mode, see Lone Worker Rules.

Man Down

If selected, the Man Down mode will be activated/deactivated for the radio that triggered the rule. You can select

one of the following options:

• The On option activates the Man Down mode.

• The Off option deactivates the Man Down mode.

For information on the Man Down mode, see SmartPTT Man Down Configuration Guide.

Message

If selected, a text message will be sent to the event initiator when the rule is triggered. You can type the message

text in the field to the right of the check box.

You can specify message format settings on the Message Format tab. This tab is only available in the Rule

Settings window. For details, see Message Format.

NOTE

The Block Radio, Man Down, and Message actions are unavailable to WAVE users.

For information on WAVE users, see “WAVE Systems” in SmartPTT Installation and Configuration Guide.

For information on configuring alerts addressed to the event initiator, see Configuring Initiator Alerts.

2.9.3.2 Dispatcher Alert

On the Dispatcher Alert tab, you can configure actions addressed to the dispatcher that will be performed when

the rule is triggered.

The Dispatcher Alert tab provides the following elements:

Play Sound

If selected, a sound will be played when the rule is triggered. You can select the desired audio file in the Sound File

Selection window by clicking Select Sound File (   ).

Audio file must comply with the specific requirements. For details, see “Audio File Requirements” in SmartPTT

Installation and Configuration Guide.
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Show on Map

If selected, unblocks the two options:

• If the radio/mobile client option is selected, the radio or mobile client appears on the map in a red frame

when the rule is triggered, and the map is centered on it.

NOTE

Displaying a mobile client on the map can only be configured for positioning rules.

NOTE

If the SmartPTT database has no actual radio GPS coordinates, the action will not be performed.

• If the point of interest option is selected, the desired point of interest appears on the map when the rule is

triggered, and the map is centered on it. You can select the desired point of interest from the list of points of

interest to the right of the option. For details, see Points of Interest.

Important

The object will not be displayed on the map if the map is not open in SmartPTT Dispatcher.

Set Radio/Mobile Client Status

If selected, the desired status will be assigned to the radio or SmartPTT Mobile user when the rule is triggered. The

desired status is selected from the list of statuses to the right of the check box. For details, see Statuses.

The selected status will be displayed on the Radio Fleet panel when the rule is triggered. For details, see Radios.

NOTE

The mobile client status can only be configured for positioning rules.

Alert

If selected, the Notifications panel with the configured message will appear when the rule is triggered. You can

type an alert header in the Alert Caption field, and an alert text in the Alert Text field to the right of the check

box. For information on the Notifications panel, see Notifications.

For information on configuring alerts addressed to the dispatcher, see Configuring Dispatcher Alerts.

2.9.3.3 Radio Alert

On the Radio Alert tab, you can configure message sending to the desired recipients in SmartPTT including radios,

users, talkgroups, and categories when the rule is triggered.

NOTE

This action is unavailable to WAVE users.

For information on WAVE users, see “WAVE Systems” in SmartPTT Installation and Configuration Guide.

NOTE

If the Select Mobile Clients condition is selected when configuring a positioning rule, the Radio Alert tab is not

available.
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The Radio Alert tab provides the following elements:

Send Message

If selected, unblocks the four options (the Radios, Users, Talkgroups, and Categories options) and the Message

field.

The check box provides the following options:

Radios

If selected, provides the ability to add radios to the list of message recipients. You can select the desired radios in

the Radios window by clicking Open Radio List (   ).

Users

If selected, provides the ability to add authorized users to the list of message recipients. You can select the desired

users in the Users window by clicking Select From List (   ).

Talkgroups

If selected, provides the ability to add talkgroups to the list of message recipients. You can select the desired

talkgroups in the Talkgroups window by clicking Select From List (   ).

Categories

If selected, provides the ability to add radios that belong to the specified category in the list of message recipients.

You can select the desired categories in the Categories window by clicking View List of Categories (   ).

The list of selected recipients is displayed in the field to the right of the selected option.

Message

Provides the ability to type a text message.

You can specify message format settings on the Message Format tab. This tab is only available in the Rule

Settings window. For details, see Message Format.

For information on configuring alerts addressed to a preconfigured list of recipients, see Configuring Radio Alerts.
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2.9.3.4 Other

On the Other tab, you can configure sending messages using web, SMS, or e-mail services when the rule is triggered.

The Other tab provides the following elements:

HTTP Request

If the check box is selected and an HTTP request is typed, a third-party server will be notified about changing the

radio status when the rule is triggered. The HTTP request is typed in the field to the right of the check box.

NOTE

To send the HTTP request to the third-party server, set the radio status on the Dispatcher Alert tab. For details,

see Dispatcher Alert.

The HTTP request has the following format: http://192.168.0.124:11235/loneworker?rid=55&status=unavailable

NOTE

Ensure that you specified the correct radio ID and status. They must correspond to the values expected by the

third-party server.

E-mail

If selected, the message will be sent to the specified e-mail address when the rule is triggered. When the check box

is selected, the following elements become available:

• The Radioserver list provides the ability to select the desired SmartPTT Radioserver which is configured for e-

mail sending.

• The E-mail field provides the ability to type one or several electronic addresses for message sending.

Use semicolons to separate multiple e-mail addresses.

• The Message field provides the ability to type the message text.

NOTE

For information on configuring e-mail messages, see “E-mail Services” in SmartPTT Installation and Configuration

Guide.

SMS

If selected, SMS will be sent to the specified phone number when the rule is triggered. When the check box is

selected, the following elements become available:
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• The Radioserver list provides the ability to select the desired SmartPTT Radioserver which is configured for

SMS sending.

• The Phone Numbers field provides the ability to type one or several telephone numbers for sending SMS.

The preferred number format is International Number Format: <+><country code><mobile code><phone

number>.

Use semicolons to separate multiple phone numbers.

• The Message field provides the ability to type the message text.

NOTE

For information on configuring SMS messages, see “Mobile Phone Networks” in SmartPTT Installation and

Configuration Guide.

You can set the message format on the Message Format tab. This tab is only available in the Rule Settings window.

For details, see Message Format.

For information on configuring sending messages using web, SMS, or E-mail services, see Configuring Other Services.

2.9.4 Managing Rules

Managing rules includes the following actions:

• Configuring alerts addressed to the event initiator. For details, see Configuring Initiator Alerts.

• Configuring alerts addressed to the dispatcher. For details, see Configuring Dispatcher Alerts.

• Configuring sending messages to the desired recipients in SmartPTT. For details, see Configuring Radio Alerts.

• Configuring sending messages using web, SMS, or E-mail services. For details, see Configuring Other Services.

• Activating, deactivating, and deleting the existing custom and positioning rules. For details, see Managing

Custom Rules and Positioning Rules.

2.9.4.1 Configuring Initiator Alerts

Follow the procedure to configure alerts addressed to the event initiator and performed when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• If required, ensure that the Lone Worker profile is configured.

For information on the Lone Worker mode, see Lone Worker Rules.

Procedure: 

1. In the Rules Settings or Positioning Rule window, in the Actions area, open the Initiator Alert tab.

2. On the Initiator Alert tab, perform one of the following actions:

To block the radio when the rule is triggered, select the Block Radio check box.
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To activate/deactivate the Lone Worker mode

for the radio when the rule is triggered,

perform the following actions:

1. Select the Lone Worker check box.

2. Select On or Off to activate or deactivate the

mode.

3. If the On option is selected, select the desired

Lone Worker profile from the list to the right of

the option.

To activate/deactivate the Man Down mode for

the radio when the rule is triggered,

perform the following actions:

1. Select the Man Down check box.

2. Select On or Off to activate or deactivate the

mode.

To send a message to the event initiator when

the rule is triggered,

perform the following actions:

1. Select the Message check box.

2. To the right of the check box, in the Message

field, type a message text.

3. (Optional) Configure the message format on the

Message Format tab. For details, see Message

Format.

NOTE

The Message Format tab is only available in the

Rule Setting window.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Dispatcher Alerts, Configuring

Radio Alerts, Configuring Other Services.

2.9.4.2 Configuring Dispatcher Alerts

Follow the procedure to configure alerts addressed to the dispatcher and performed when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• If required, ensure that the desired audio files are available on your PC.

• If required, ensure that the desired points of interests are added to SmartPTT Dispatcher.

• If required, ensure that the desired statuses are added to SmartPTT Dispatcher.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Dispatcher Alert tab.
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2. In the Dispatcher Alert tab, perform one of the following actions:

To select an audio file to play when the

rule is triggered,

perform the following actions:

1. Select the Play Sound check box.

2. To the right of the check box, click Select Sound File ( 

 ).

The Sound File Selection window appears.

3. In the Sound File Selection window, select the

desired audio file, and then click Open.

The path to the audio file appears in the field to the

right of the Select Sound File (   ) button.

To show the event initiator on the

currently open map when the rule is

triggered,

perform the following actions:

1. Select the Show on Map check box.

2. Select one of the following options:

• Select radio/mobile client to show the radio or

SmartPTT Mobile user on the map.

NOTE

Displaying a mobile client on the map can only be

configured for positioning rules.

• Select point of interest to show the point of

interest on the map.

3. If the point of interest option is selected, select the

desired point of interest from the list to the right of

the option.

Important

The object will not be displayed on a map if the map is not

open in SmartPTT Dispatcher.

To assign status to the event initiator

when the rule is triggered,

perform the following actions:

1. Select the Set Radio/Mobile Client Status check box.

NOTE

The mobile client status can only be configured for

positioning rules.

2. To the right of the check box, select the desired status

from the list of statuses.

To display the notification on the

Notifications panel when the rule is

triggered,

perform the following actions:

1. Select the Alert check box.
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2. To the right of the check box, in the Alert Caption

field, type an alert title.

3. To the right of the check box, in the Alert Text field,

type an alert text.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring Radio

Alerts, Configuring Other Services.

2.9.4.3 Configuring Radio Alerts

Follow the procedure to configure sending messages to a preconfigured list of recipients when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• Ensure that the desired recipients are available in SmartPTT Dispatcher.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Radio Alert tab.

2. On the Radio Alert tab, select the Send Message check box.

3. Specify a list of desired recipients:

To send a message to radios when the rule is

triggered,

perform the following actions:

1. To the right of the Radios option, click Open

Radio List (   ).

The Radios window appears.

2. Select the desired radios from the list.

3. Click OK to save the changes and close the

window.

To send a message to authorized users when

the rule is triggered,

perform the following actions:

1. To the right of the Users option, click Select

From List (   ).

The Users window appears.

2. Select the desired users from the list.

3. Click OK to save the changes and close the

window.

To send a message to talkgroups when the rule

is triggered,

perform the following actions:
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1. To the right of the Talkgroups option, click

Select From List (   ).

The Talkgroups window appears.

2. Select the desired talkgroups from the list.

3. Click OK to save the changes and close the

window.

To send a message to radios that belong to the

specified category when the rule is triggered,

perform the following actions:

1. To the right of the Categories option, click View

List of Categories (   ).

The Categories window appears.

2. Select the desired categories from the list.

3. Click OK to save the changes and close the

window.

 The selected recipients appear in the field to the right of the options.

4. Type a message text in the Message field.

5. (Optional) Configure the message format on the Message Format tab. For details, see Message Format.

NOTE

The Message Format tab is only available in the Rule Setting window.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring

Dispatcher Alerts, Configuring Other Services.

2.9.4.4 Configuring Other Services

Follow the procedure to configure sending messages using web, SMS, or E-mail services when the rule is triggered.

Prerequisites: 

• Set the desired conditions that will trigger the rule.

• If required, obtain the third-party server address to send HTTP request to.

• If required, ensure that the desired statuses are added to SmartPTT Dispatcher.

• If required, obtain the e-mail addresses or phone numbers to send a message to.

• If required, obtain the desired radioserver name.

Procedure: 

1. In the Rule Settings or Positioning Rule window, in the Actions area, open the Other tab.

2. On the Other tab, perform one of the following actions:
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To notify a third-party server about changing

the radio status when the rule is triggered,

perform the following actions:

1. Select the HTTP Request check box.

2. In the field to the right of the check box, type

the desired request.

To send an e-mail when the rule is triggered, perform the following actions:

1. Select the E-mail check box.

2. To the right of the check box, from the

Radioserver list, select the desired SmartPTT

Radioserver.

3. In the E-mail field, type one or several electronic

addresses for sending messages.

Use semicolons to separate multiple e-mail

addresses.

4. In the Message field, type a message text.

To send SMS when the rule is triggered, perform the following actions:

1. Select the SMS check box.

2. To the right of the check box, from the

Radioserver list, select the desired SmartPTT

Radioserver.

3. In the Phone Numbers field, type one or

several telephone numbers for sending SMS.

Use semicolons to separate multiple phone

numbers.

4. In the Message text field, type a message text.

3. (Optional) Configure the message format on the Message Format tab. For details, see Message Format.

NOTE

The Message Format tab is only available in the Rule Setting window.

Postrequisites: 

For information on configuring other actions in the Actions area, see Configuring Initiator Alerts, Configuring

Dispatcher Alerts, Configuring Radio Alerts.
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2.9.4.5 Managing Custom Rules and Positioning Rules

Follow the procedure to to activate, deactivate, or delete an existing rule.

Prerequisites: 

Ensure an operator has the Manage Custom Rules or Manage Positioning Rules right. For information on

operator rights, see Operators.

Procedure: 

1. To open the desired rule configuration window, perform one of the following actions:.

To open the Custom Rules window, on the menu bar, click Settings (   ) → Rules →

Custom Rules.

To open the Positioning Rules window, on the menu bar, click Settings (   ) → Rules →

Positioning Rules.

2. In the window that appears, perform one of the following actions:

To activate an existing rule, perform the following actions:

1. In the table, select the desired rule.

2. Select the Active check box.

NOTE

You can also activate the desired rule by selecting

the Active check box in the upper-left corner of the

Rule Settings or Positioning Rule window.

To deactivate an existing positioning rule, perform the following actions:

1. In the table, select the desired rule.

2. Clear the Active check box.

NOTE

You can also deactivate the desired rule by clearing

the Active check box in the upper-left corner of the

Rule Settings or Positioning Rule window.

To delete an existing positioning rule, perform the following actions:

1. In the table, select the desired rule, and then click

Delete (   ).

2. In the confirmation window, click OK.

The rule is deleted from the table.
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Postrequisites: 

For information on adding a new rule or editing an existing one, see Adding and Editing Custom Rules and Adding

and Editing Positioning Rules.

2.9.5 Custom Rule Example

Assume that you need to configure a rule that is triggered by an incoming alarm from the radio named John. When

the rule triggers, the radio must change its status, the alarm sound must be played, and the Notifications panel

with a specified text must display.

For this, set conditions in the following way:

Then, set actions in the following way:

After clicking OK the changes will be saved, the Alarm rule will be configured and added to the rule table, where you

can activate, deactivate, or delete it. The rule will be triggered when SmartPTT Dispatcher receives an incoming alarm

signal from the radio named John. The alarm sound will be played, the radio status will change to Alarm, and the

dispatcher will get the Urgently contact the foreman!!! message.
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2.9.6 Positioning Rule Example

Assume that you need to configure a rule that triggers when data show that the radio named John has exceeded the

specified speed limit in the selected geofence. When the rule triggers, the radio must change its status, the special

sound must be played, and the radio must be displayed on a map.

For this, set conditions in the following way:

Then, set actions in the following way:

After clicking OK the changes will be saved, the rule Speeding in a danger zone will be configured and added to the

rule table, where you can activate, deactivate, or delete it. The rule will be triggered when SmartPTT Dispatcher

receives incoming data that show the specified speed limit was exceeded by the radio named John. The sound will be

played, the radio status will change to Alarm, and the radio will be displayed on a map.
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2.10 Licenses

The Licenses window provides the ability to manage licenses required to use SmartPTT Dispatcher.

NOTE

If SmartPTT Radioserver and the dispatch console are installed on the same computer, you can install licenses

either in SmartPTT Radioserver Configurator or in SmartPTT Dispatcher. If SmartPTT Radioserver and the dispatch

console are installed on different computers, you must install licenses in both applications.

You can open the Licenses window by clicking Settings (   ) → Licenses on the menu bar.

The Licenses window provides the following elements:

Install License

Opens the file selection window that provides the ability to select and install a license file.

Restore License

Reverts to the previous license. The button appears after successful installation of a license.

Licensed to

The name of the organization to which the license is issued.
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License key ID

The unique identifier of the license.

Contacts

The contact information of the organization to which the license is issued.

Address

The address of the organization to which the license is issued.

Support expiration date

The date on which free SmartPTT update expires. Versions of SmartPTT software released after this date will be

inoperable. Your software will continue to function normally as long as license expiration dates allow. You will also

be able to receive technical support.

License Table

Provides information about installed licenses, including their type, number, expiration date, and functions.

Cancel

Closes The Licenses window without saving.

Finish

Applies the latest displayed license.

2.10.1 Installing License

Follow the procedure to install a SmartPTT license.

Prerequisites: 

• Obtain the SmartPTT license file. For details, see “Licensing” in SmartPTT Installation and Configuration Guide.

• Run SmartPTT Dispatcher as administrator.

Procedure: 

1. On the menu bar, click Settings (   ) → Licenses.

The Licenses window appears.

2. In the Licenses window, click Install License.

The file selection window appears.

3. In the opened window, select the desired license file and click Open.

4. Ensure that the licensed services and their expiration dates are correct. Otherwise, click Restore License, and

then click Install License to select a different license file or submit a request to the SmartPTT Technical

Support Center.

5. Click Finish.

Postrequisites: 

Restart SmartPTT Dispatcher to apply the new licenses.

http://support.smartptt.com/
http://support.smartptt.com/
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2.10.2 Viewing License Items

Follow the procedure to view items of the installed license file. The procedure may be required to determine if specific

features are available or unavailable in SmartPTT.

Prerequisites: 

Install the SmartPTT license file. For details, see Installing License.

Procedure: 

1. On the menu bar, click Settings (   ) → Licenses.

The Licenses window appears.

2. At the top of the window, perform the desired actions:

To view the licensee name, in the Licensed to entry, view the name.

To view the license ID, in the License key ID entry, view the ID.

To view the contact information written to the

license,

in the Contacts entry, view the contact information.

To view the licensee address, in the Address entry, view the address.

To view the last date of the SmartPTT upgrade

installation,

in the Support expiration date entry, view the

date.

3. In the License Table below, view the functionality, types, quantity, and last dates of the feature provision for the

available license items. Use scrollbar if required.
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2.11 Database

The Database window provides the ability to connect to the database for using SmartPTT Dispatcher.

WARNING

Only one dispatch console can be connected to the same database.

You can open the Database window by clicking Settings (   ) → Database on the menu bar.

The Database window provides the following elements:

Database server name

The network path and name of the database management system (DBMS). The DBMS name has the following

format: <host name or IP address>\<DBMS service name>.

Authorization mode

Provides the list to select the type of authorization in the DBMS:

• Windows NT Authorization is an authorization mode that requires your Windows user account to be in the SQL

server user list.

• SQL Server Authorization is an authorization mode that requires a login and password of the DBMS user account

to be typed in order to connect to the database.
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Account name

The SQL Server account login. The field is available if the SQL Server Authorization option is selected from the

Authorization mode list.

Password

The SQL Server account password. The field is available if the SQL Server Authorization option is selected from the

Authorization mode list.

Establish Connection

Attempts to connect and authorize in SQL Server. Depending on the result, displays either a success or an error

message that includes possible reasons for the error.

Create database

Opens the Create Database window to create a new database. For details, see Create Database.

Restore database

Opens the Restore Database window to restore the current database from an automatic backup file. For details,

see Restore Database.

Current database

Provides the list of created databases to select the current database.

For information on working with databases, see the sections below.

2.11.1 Create Database

The Create Database window provides the ability to create a new SmartPTT Dispatcher database.

The window appears when clicking Create database in the Database window. For details, see Database.

The Create Database window provides the following elements:

Database name

Provides the ability to type the name of the new database.

Save

Creates a database with the specified name.

The button is unavailable if the Database name field is left empty or contains the name of the existing database.

Cancel

Closes the Create Database window without creating a database.
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2.11.2 Restore Database

The Restore Database window provides the ability to restore the current database from an automatic backup file.

You can configure database auto backups in the Database Auto Backup Settings window. For details, see

Database Auto Backup.

For information on restoring the database from a manually created archive file, see Restore Dispatcher Settings.

NOTE

If SmartPTT Dispatcher is connected to a remote database, by default you cannot restore it from a backup file

located on a remote database computer.

The Restore Database window appears when clicking Restore database in the Database window. For details, see

Database.

The window provides the following elements:

Latest automatic backup file

Provides the ability to restore the database from the latest automatic backup file.

The name of the backup file and path to it are displayed in the text field below.

NOTE

The option is unavailable if automatic backup files have not yet been created.

Other automatic backup file

Provides the ability to specify the path and name for the desired database backup file in the BAK format by clicking

the Browse (   ) button.

2.11.3 Configuring Database Server Connection

Follow the procedure to configure the SmartPTT Dispatcher connection to the database management system

(DBMS).

Prerequisites: 

• Obtain the IP address / domain name of the DBMS host.

• Obtain the DBMS process name.

• To use SQL Server authorization, obtain the corresponding credentials. For details, see “Adding SQL Server

Users” in SmartPTT Installation and Configuration Guide.
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Procedure: 

1. On the menu bar, click Settings (   ) → Database.

The Database window appears.

2. In the opened window, in the Database server name field, type the DBMS address.

NOTE

For the database server installed with the SmartPTT Dispatcher application, type the address using the following

format: PC_Name\SQLExpress (for example, MYCOMP\SQLExpress).

3. Configure authorization:

To use Windows authorization, from the Authorization mode list, select Windows NT

Authorization.

To use DBMS authorization, perform the following actions:

1. From the Authorization Mode list, select SQL

Server Authorization.

2. In the Account name field, type the SQL Server

account login.

3. In the Password field, type the SQL Server

account password.

4. Click Establish Connection to connect to SQL Server.

If connection is successful, in the Database area, the Connection to the database server is established message

appears. Otherwise, at the bottom of the window, a message with an error description appears.

5. Click Finish to save changes.

Postrequisites: 

Configure the current database. For details, see Managing Databases.

2.11.4 Managing Databases

Follow the procedure to create a new, use the existing, or restore the current SmartPTT Dispatcher database.

Prerequisites: 

• Configure the database management system (DBMS) connection. For details, see Configuring Database Server

Connection.

• To restore the current database from an automatic backup file, configure the automatic database backup. For

details, see Configuring Database Auto Backup.

Procedure: 

1. On the menu bar, click Settings (   ) → Database.

The Database window appears.

2. In the opened window, in the Database area, perform one of the following actions:
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To create a new database, perform the following actions:

1. Click Create database.

The Create Database window appears.

2. In the opened window, in the Database name field,

type the name of a new database, and then

click Save.

If creation is successful, in the Database area of the

Database window, the Database <database name>

was successfully created! message appears.

To use an existing database, from the Current database list, select the desired

database.

To restore the current database from an

automatic backup file,

perform the following actions:

1. Click Restore database.

The Restore Database window appears.

2. In the opened window, perform one of the following

actions:

• To restore the database from the latest

automatic backup file, select Latest automatic

backup file.

• To restore the database from any other backup

file, select Other automatic backup file, click

Browse (   ), and then select the desired

database backup file in the BAK format.

3. Click Save.

4. In the Confirmation window, click OK.

If restoration is successful, in the Database area of

the Database window, the Database <database

name> is restored successfully message appears.

NOTE

To restore a remote database from a backup file

located on a remote computer, use DBMS tools.

3. Click Finish to save changes and close the Database window.

Postrequisites: 

Restart SmartPTT Dispatcher to apply the changes.
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2.12 Radioservers

The Radioservers window provides the ability to add new radioservers, and manage the existing ones.

The window is available by clicking Settings (   ) → Radioservers on the menu bar.

By default, the list of radioservers is empty.

The Radioservers window provides the following elements:

Add

Opens the Radioserver window for configuring settings of a new radioserver. For details, see Radioserver

Window.

For information on adding radioservers, see Managing Radioservers.

Important

If a redundant radioserver is used in the system, you must add both primary and redundant radioservers to

SmartPTT Dispatcher.

When the redundant radioserver is added, it is displayed in the Radio Fleet panel as active with no objects

belonging to it. When the connection with primary server is lost, all objects from the primary radioserver appear

under the redundant radioserver. Primary radioserver can have only one redundant radioserver.
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Edit

Opens the Radioserver window for configuring settings of the radioserver already added to SmartPTT

Dispatcher.

Delete

Removes the selected radioserver.

Search

Can be used for searching all running radioservers in the network. The searched radioservers appear in the

Radioservers table.

Radioservers Table

Contains radioservers added to SmartPTT Dispatcher. The table consists of the following columns:

• Server Name — contains the radioserver name.

• Address — contains the radioserver IP address and port number.

• Active — contains a check box for activating or deactivating the radioserver.

You can sort the column content by clicking the desired column header.

For information on configuring and managing radioservers, see the sections below.

2.12.1 Radioserver Window

The Radioserver window provides the ability to configure or edit radioserver settings.

The window contains two tabs:

• The General tab. For details, see Radioserver General Tab.

• The IPMI tab. For details, see Radioserver IPMI Tab.



229

Settings Radioservers

2.12.1.1 Radioserver General Tab

On the General tab, the radioserver settings are configured.

The tab provides the following elements:

Name

The radioserver name which is displayed in SmartPTT Dispatcher.

IP address

IPv4 address (in dot-decimal notation) or domain name of a computer with installed radioserver for establishing

connection between the radioserver and SmartPTT Dispatcher.

Port

The WCF (TCP) port number of SmartPTT Radioserver that is used for establishing connection between the

radioserver and SmartPTT Dispatcher. The default port number is 8888.

Establish Connection

Establishes connection between the radioserver and SmartPTT Dispatcher.

If authentication of clients is enabled on SmartPTT Radioserver, in the lower part of the window the table with

operators and client accounts appears. For information on clients and their authentication, see the “Clients

connection” section of SmartPTT Installation and Configuration Guide.

NOTE

If no client account is assigned, an operator can manage all radios, talkgroups, and services provided by the

radioserver. In this case, the operator actions are limited only by the operator rights that are set in SmartPTT

Dispatcher. For details, see Operators.
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List of operators

Provides the list of operator accounts added to SmartPTT Dispatcher. In this table, it is required to set the client

accounts, registered in SmartPTT Radioserver Configurator, for operators. This allows the radioserver to send to

SmartPTT Dispatcher operators only information that is permitted for the client account. The table consists of the

following columns:

• Operator — contains a list of all active operators added to SmartPTT Dispatcher. For details, see Operators.

• Client Name — contains the name of the desktop client registered in SmartPTT Radioserver Configurator.

• Password — contains the password of the desktop client registered in SmartPTT Radioserver Configurator.

Important

The same client account can be used for different operator accounts.

NOTE

The table with operators appears after clicking the Establish Connection button.

NOTE

It is not necessary to type client credentials for all operators in the table. It is enough to type the client name and

password for the desired operator. If the client’s name and password are not set for an operator, he or she will not

be able to connect to the radioserver.
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2.12.1.2 Radioserver IPMI Tab

IPMI (Intelligent Platform Management Interface) is a standardized computer system interface that is used for out-

of-band management of computer systems, and monitoring system operation.

SmartPTT system uses IPMI for managing and monitoring remote radioservers. You can use IMPI for viewing the

hardware characteristics of the radioserver machine, and turning it on or off remotely.

On the IPMI tab, you can configure IPMI settings for the radioserver.

The tab provides the following elements:

Address

IP address of the SmartPTT Radioserver host that is used for establishing IPMI connection.

Port

The port number of the radioserver computer that is used for establishing IPMI connection.

Login and Password

Obligatory fields for filling. They must match the login and password set in IPMI configuration settings on the

SmartPTT Radioserver host.

Authentication

Provides the list of authentication types. It is recommended to use MD5 as default authentication type.

Privilege

Provides the list of the privileges with different permissions for the dispatcher. It is recommended to use Operator

as default.

For information on the privileges, see the official IPMI documentation.
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Ciphers

Provides the list of ciphers to be used. It is recommended to use the default cipher.

For information on the ciphers, see the official IPMI documentation.

Active

Activates IPMI functionality for the radioserver.

NOTE

For information on managing the radioserver with using of IPMI, see Radioserver Remote Controlling.

2.12.2 Managing Radioservers

Follow the procedure to to add a new radioserver connection or to edit the existing one.

Prerequisites: 

• Obtain IP address or domain name of a computer with installed radioserver.

• Obtain radioserver port set in SmartPTT Radioserver Configurator.

• If authentication for desktop clients is used in SmartPTT Radioserver Configurator, obtain the client name and

password.

• Add the desired operator accounts. For details, see Operators.

Procedure: 

1. On the menu bar, click Settings (   ) → Radioservers.

2. In the Radioservers window, perform one of the following actions:

To add a new connection to a radioserver, perform the following actions:

1. In the Radioservers window, click Add.

The Radioserver window appears.

2. Proceed to the following step.

To edit an existing connection to a radioserver, perform the following actions:

1. In the Radioservers window, click the desired

radioserver, and then click Edit.

The Radioserver window appears.

2. Proceed to the following step.

To delete a connection to a radioserver, perform the following actions:

1. In the Radioservers window, click the radioserver

name connection to which you want to delete.

2. Click the Delete button.

3. Proceed to the last step.
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3. In the Radioserver window, open the General tab.

4. (Optional) In the Name field, type the desired radioserver name.

5. In the IP Address field, type the IP address of the radioserver or domain name of the computer with installed

radioserver.

6. In the Port field, enter the radioserver WCF port number.

7. Click the Establish Connection button to establish connection to the specified radioserver.

8. If in SmartPTT Dispatcher the table with operators appears, perform the following actions:

a. In the Client Name column, in the entry next to the desired operator, type the client account name.

b. In the Password column, in the entry next to the desired operator, type the client account password.

9. (Optional) Repeat the previous step for other operator accounts.

10. Click OK to apply changes and close the window.

11. In the Radioservers window, click Finish.

2.12.3 Configuring IPMI Settings

Follow the procedure to to configure the radioserver IPMI settings.

Prerequisites: 

Ensure at least one radioserver is added. For details, see Managing Radioservers.

Procedure: 

1. On the menu bar, click Settings (   ) → Radioservers.
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2. In the Radioservers window, double-click the desired radioserver.

The Radioserver window appears.

3. In the Radioserver window, open the IPMI tab.

4. On the IPMI tab, perform the following actions:

a. In the Address and Port fields, type the IP address and port number of the SmartPTT Radioserver host

that is used for establishing IPMI connection.

b. In the Login and Password fields, type the login and password set in IPMI configuration settings on the

SmartPTT Radioserver host.

c. From the Authentication list, select the desired authentication type.

d. From the Privilege list, select the desired privilege for the dispatcher.

e. From the Ciphers list, select the desired cipher.

NOTE

In the Authentication, Privilege, and Ciphers lists, it is recommended to use the default values.

f. Select the Active check box to activate the IPMI for the radioserver.

5. In the Radioservers window, click Finish.

Postrequisites: 

• To deactivate IPMI on the radioserver, in the IPMI tab, clear the Active check box.

• To edit the IPMI settings of the radioserver, in the Radioservers window, select it, and then click Edit → IPMI.
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3 Tools

The Tools menu provides access to the main SmartPTT Dispatcher panels from which you can monitor and control

the dispatched radio system.

NOTE

The Tools menu elements are unavailable if the layout is locked.

For details, see Lock UI Layout.

The following panels are available:

• Calls panel provides the abilities to see the ongoing calls activity, to answer the incoming call or initiate a call,

and to see information about the registered calls.

For details, see Calls.

• Sound panel provides controls for adjusting the volume settings.

For details, see Sound.

• Cross Patches panel provides controls for establishing and controlling connection between talkgroups from

different bandwidths or network types.

For details, see Cross Patches.

• Radio Fleet panel provides information on the radio system objects.

For details, see Radio Fleet.

• SCADA panel provides access to the SCADA module where you can monitor and control the SCADA points

added to SmartPTT Dispatcher.

For details, see SCADA Module.

NOTE

The SCADA option appears in the Tools menu only after the SCADA module activation in SmartPTT Dispatcher

settings.

For details, see Activating SCADA Module.

• Channels panel displays information and provides controls for working with control stations and repeater

system channels.

For details, see Channels.

• Radios panel provides controls for monitoring and interacting with radios.

For details, see Radios.

• Job Tickets panel provides controls for sending job tickets to radios and talkgroups and monitoring their

status.

For details, see Job Tickets Panel.

• Monitoring panels provide tools for graphical representation and real-time analysis of the radio system

operation.

For details, see Monitoring.

• Lone Workers panel provides information on the radios that are currently in the Lone Worker mode.

For details, see Lone Workers.
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• Recent Incoming Calls panel displays the latest radios which made a call in the radio network.

For details, see Recent Incoming Calls.

• Notifications panel displays alerts configured for specific rules.

For details, see Notifications.

• System Messages panel provides information on events related to the radio system operation, such as errors

and connection status changes.

For details, see System Messages.

• Server Tasks panel provides information on SmartPTT Dispatcher commands that are currently processed by

SmartPTT Radioserver.

For details, see Server Tasks .

• Custom Console panel provides quick access to the radio system objects and functionality in the

preconfigured workspace.

For details, see Custom Consoles.

NOTE

Custom consoles appear in the Tools menu only if they were added.

For details, see Custom Consoles.

• Web pages panel opens a web page that was added to SmartPTT Dispatcher. Each added web page has a

corresponding separate panel.

For details, see Web Pages.

3.1 Calls

The Calls panel provides the ability to perform the following actions:

• Make a call to the recipient radio or into the recipient talkgroup by clicking the call entry

• Answer the incoming call for the dispatcher by clicking the call entry

• See the ongoing calls activity

• See history of all calls in the radio network, time of call and its duration (during the current session only)

• Initiate a call by clicking the button with the initiator or recipient name

The panel displays only calls that occur in the radio system.

The first time you install SmartPTT, the Calls panel opens automatically. The panel can also be opened or closed

manually. To do this, expand the Tools menu on the menu bar of the SmartPTT Dispatcher window and click Calls.

Important

To initiate voice calls, an operator needs the Make voice calls permission. For information on the operator rights,

see Operators.

Important

The ability to initiate and receive voice calls can be limited by the client registered in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.
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A call entry on the Calls panel can be of two types:

• Ongoing call entry

• Finished call entry

The ongoing call entry displays current transmission, including the hang time, and provide the dispatcher the ability

to answer the incoming call or make a call to the recipient radio or into the recipient talkgroup by clicking anywhere

on the call entry.

A call status is determined by the color of the call entry. For information on the color indication of voice calls, see

Color Indication of Voice Calls.

The ongoing call entry provides the following information and elements:

Call Type

The icon has the following indications depending on the call type:

• Private call to a radio (   )

• Private call to a SmartPTT Mobile user (   )

• Private telephone call or private conference call (   )

• Group call or All Call (   )

• Group call to a dynamic group (   )

• Group telephone call or telephone All Call, or group conference call or conference All Call (   )

• Emergency call (   )

• Remote monitoring (   )

Call Channel

A channel that is used for the voice transmission. For details, see Channels and Systems.

Call Initiator

A radio, a telephone subscriber or a dispatcher that has initiated the ongoing call.

Talker

An object that is currently transmitting voice.



238

Tools Calls

NOTE

During remote monitoring, the monitored radio is displayed as Call Initiator and Talker.

If a call can not be initiated and call attempts continue, the cause of a holding can be displayed on the call entry

instead of the talker name.

Call Recipient

A party that is receiving the ongoing call.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

PTT icon

Displays the possibility to interact with the ongoing call entry. When selecting the call recipient or, if the dispatcher

himself is the call recipient, the call initiator, the blue frame appears.

Key (   ) icon

Appears next to the talker name when a secured call is initiated.

The finished call entry provide the abilities to see information about the registered call and to initiate a call by clicking

the Call Initiator or the Call Recipient name.

For information on initiating Voice Calls using the finished call entry, see Initiating Voice Calls on Calls Panel.

3.1.1 Initiating Voice Calls on Calls Panel

Follow the procedure to initiate a private or a group call using the finished call entry on the Calls panel.

NOTE

Call can also be initiated using hotkeys. For information on hotkeys, see Keys.

Prerequisites: 

• Check the current settings of the pointing devices. For details, see Pointing Devices.
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• Ensure the Calls panel is open. For details, see Calls.

Procedure: 

1. Initiate a call by clicking the Call Initiator or the Call Recipient name.

A new ongoing call entry appears at the top of the Calls panel. The call entry becomes light-orange ( ⬛ ), and

the button with three dots appears on it.

2. When the call entry becomes orange ( ⬛ ), speak into your microphone.

3. To end the transmission, click the ongoing call entry.

The call entry becomes blue ( ⬛ ).

4. When the blue color indication ( ⬛ ) appears, perform one of the following actions:

To transmit again, click the ongoing call entry.

To listen to the radio transmission, wait until the ongoing call entry becomes green ( ⬛ ), and

audio is heard from the speakers or headsets.

To end the call, wait until the blue indication ( ⬛ ) disappears.



240

Tools Sound

3.2 Sound

The Sound panel is used for performing volume control of system objects and system sounds.

The panel is open by default. If it is closed, you can open it on the menu bar, by clicking Tools → Sound.

The Sound panel provides the following elements:

• The audio visualizer shows the volume of incoming and outgoing sound (voice, audio, tones) on audio

frequencies supported by the codec.

• The Speakers (   ) button toggles sliders of speakers volume.

• The Microphone (   ) button toggles sliders of microphone volume.

After you click the Speakers (   ) button, the following sliders appear:

Selected objects

Adjusts the volume level of all selected objects.

Selected objects are objects that are selected, have a blue frame, or whose call window is open and active (the

window has the blue title bar, and the PTT button has the blue frame).

NOTE

You can see a name of the selected object on the Information Bar in green.

If you select several objects, the Multiselect caption appears.

Unselected objects

Adjusts the volume level of all unselected objects.

Unselected objects are objects that do not have a blue frame or open and active.

System sounds

Adjusts the volume level of system sounds.

System sounds include the following sounds:
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• Sound of a triggered rule

• Sound of the transmission initiating

• Notifications of dispatcher and telephone subscriber incoming calls

• Sound of call records played in the both Dispatcher and Radioserver Event Log

• Sound of system messages

• FOACSU call notification

• Sound of the Call Alert command

After you click the Microphone (   ) button, a slider for adjusting the microphone volume appears.

For information on adjusting volume of selected/unselected objects and microphone, see the sections below.

3.2.1 Adjusting Volume of Objects and System Sounds

Follow the procedure to adjust the volume of selected/unselected objects or system sounds.

Procedure: 

1. If the Sound panel is closed, on the menu bar, click Tools → Sound.

The Sound panel appears.

2. In the Sound panel, click the Speakers (   ) button.

The volume sliders appear.

3. Adjust the volume of selected/unselected objects or system sounds:

To increase the volume, move the desired volume slider right, or click the

Increase Volume (   ) button.

To decrease the volume, move the desired volume slider left, or click the

Decrease Volume (   ) button.

To mute the sound, click the Mute (   ) button next to the desired slider.

The slider becomes inactive, and the button changes to

Unmute (   ).

Postrequisites: 

To unmute selected/unselected objects or system sounds, click the Unmute (   ) button.

3.2.2 Adjusting Microphone Volume

Follow the procedure to adjust the microphone volume.

Procedure: 

1. If the Sound panel is closed, on the menu bar, click Tools → Sound.

The Sound panel appears.
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2. In the Sound panel, click the Microphone (   ) button.

The volume slider appears.

3. Adjust the volume of the microphone:

To increase the volume, move the volume slider right, or click the Increase Volume ( 

 ) button.

To decrease the volume, move the volume slider left, or click the Decrease Volume ( 

 ) button.

To mute the microphone, click the Mute (   ) button next to the slider.

The slider becomes inactive, and the button changes to

Unmute (   ).

Postrequisites: 

To unmute the microphone, click the Unmute (   ) button.

3.3 Cross Patches

You can use cross patches for establishing connection between talkgroups from different bandwidths or network

types within the one radioserver.

All participants of the cross patch hear a call made to it. A call made to a talkgroup included in the cross patch is

heard by all participants of the cross patch. It is also true for a call made by a dispatcher or a telephone subscriber.

Cross patches are created in SmartPTT Dispatcher by an operator. After creating the cross patch, all operators in the

SmartPTT system get the opportunity to see this cross patch, edit, enable or disable it (if they have a permission). If

an operator who created the cross patch logs off or closes the application, the cross patch will remain available to

other operators.

Important

When all operators log off or closes the applications, the cross patch will remain enabled and will continue to

operate.

Important

Access to cross patches can be limited by the client registered in SmartPTT Radioserver Configurator. For details,

see “Profiles” in SmartPTT Installation and Configuration Guide.

Cross patches between talkgroups and dynamic groups

Virtual groups consisting of SmartPTT Mobile users and talkgroups are presented in SmartPTT Dispatcher as cross

patches between talkgroups and dynamic groups and are called multigroups.

For information on dynamic groups and SmartPTT Mobile users, see Dynamic Groups in this guide and “SmartPTT

Mobile” in SmartPTT Installation and Configuration Guide.

A multigroup can have at least two members (dynamic groups and talkgroups). If a multigroup was created in the

SmartPTT Mobile application, a cross patch with the same name and members will be displayed in SmartPTT
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Dispatcher. And vice versa, if a cross patch with dynamic groups was created in SmartPTT Dispatcher, a multigroup

with the same name and members will be displayed in the SmartPTT Mobile application.

NOTE

Cross patches between talkgroups and individual SmartPTT Mobile users are not supported.

NOTE

SmartPTT Mobile users cannot edit or delete cross patches with dynamic groups created in SmartPTT Dispatcher.

Dispatchers can edit and delete any cross patch, no matter where it was created.

For information on configuring and using cross patches, see the sections below.

3.3.1 Cross Patches Panel

The Cross Patches panel is used for creating and managing cross patches.

You can open the Cross Patches panel by clicking Tools → Cross Patches on the menu bar.

NOTE

If SmartPTT Radioserver is inactive, the added cross patches are not displayed on the Cross Patches panel.

On default, the Cross Patches panel provides the following elements:

• All shows all existing cross patches.

• Active shows only active cross patches.

• Add cross patch (   ) opens the Cross Patch window where you can configure new cross patches. For details,

see Cross Patch Window.

Added cross patches appear below as entries. A cross patch entry provides the following elements:

• Expand (   ) / Collapse (   ) buttons that show or hide the cross patch details.

• Name of the cross patch.
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• PTT button that initiates a call to the cross patch.

• The Actions (   ) button that opens the Actions menu for managing the cross patch. For information on the

actions, see Cross Patch Actions Menu.

3.3.1.1 Cross Patch Actions Menu

The Actions (   ) menu of the cross patch provides the ability to perform the following actions:

Action Description

Disable (   ) /

Enable (   )

Activates or deactivates the cross patch.

Inactive cross patch is displayed in grey and unavailable for initiating calls.

Mute (   ) /

Unmute (   )

Turns on or off the sound for all parties of the cross patch.

If the cross patch is muted, the dispatcher cannot hear participants, but all the cross patch

participants can hear the dispatcher.

If the cross patch is unmuted, but one of the talkgroups is muted, the dispatcher can hear

all participants except this talkgroup.

NOTE

If the cross patch contains groups from network topologies based on control stations

and direct connection, and you can hear hoarse voice, select DMR Vocoder as a codec in

the sound settings in the dispatch console (see General Settings) and in the audio

settings of the control station in SmartPTT Radioserver Configurator.

Properties (   ) Opens the Cross Patch window for editing the cross patch.

For details, see Cross Patch Window.

Delete (   ) Deletes the cross patch.

Clear Element (   ) Removes the assigned cross patch from the element.

NOTE

Available only for cross patches on a custom console. For details, see Assigning Cross

Patches.
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3.3.2 Cross Patch Window

In the Cross Patch window, you can configure a new, and edit an existing cross patch.

The Cross Patch window provides the following elements:

Name

Contains the name of the cross patch. You can leave the default name, or type the desired name.

Cross Patch Objects

Displays elements that are included in the cross patch in the <participant  name>|<channel name>|

<radioserver name> format.

Search field (   )

Field that provides the ability to find the desired group by typing its name.

Radio Fleet

Displays objects of the Radio Fleet panel that can be added to the cross patch. You cannot add radioservers,

control stations, and channels to the cross patch.

Add (   ) / Remove (   )

Adds or removes the selected object to or from the Cross Patch Objects box. You can also double-click or drag

the desired object to add it to or remove from the box.
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Create

Creates the cross patch and enables it. If you edit a cross patch, the button is replaced by the OK button.

3.3.3 Managing Cross Patches

You can use the Cross Patches feature to perform the following actions:

• Create and edit cross patches. For details, see Creating Cross Patches and Editing Cross Patches.

• Disable, enable and mute cross patches. For details, see Disabling and Enabling Cross Patches and Muting

Cross Patches.

• Initiate calls to cross patches. For details, see Initiating Cross Patch Calls.

3.3.3.1 Creating Cross Patches

Follow the procedure to create a cross patch.

Prerequisites: 

Ensure cross patches are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.

2. In the Cross Patches panel, click Add cross patch (   ).

The Cross Patch window appears.

3. Add the desired object to the Cross Patch Objects box in one of the following ways:

• Double-click the desired object.

• Drag the desired object to the box.

• Select the desired object, and then click Add (   ).

4. Click the Create button.

A new cross patch appears in the Cross Patches panel, and becomes enabled.

3.3.3.2 Disabling and Enabling Cross Patches

Follow the procedure to disable or enable a cross patch.

Prerequisites: 

Ensure cross patches are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.
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2. In the Cross Patches panel, in the right part of the desired cross patch entry, click the Actions (   ) button.

The cross patch Actions menu appears.

3. In the Actions menu, depending on the cross patch state, perform one of the following actions:

To disable the cross patch, click the Disable (   ) button.

The button changes to Enable (   ); the cross patch entry

becomes shaded.

To enable the cross patch, click the Enable (   ) button.

The button changes to Disable (   ).

3.3.3.3 Muting Cross Patches

Follow the procedure to to mute a cross patch.

Prerequisites: 

Ensure cross patches are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.

2. In the Cross Patches panel, click the Actions (   ) button of the desired cross patch, and then click Mute (   ).

Postrequisites: 

To unmute the cross patch, click the Actions (   ) button of the cross patch, and then click Unmute (   ).

3.3.3.4 Editing Cross Patches

Follow the procedure to edit a cross patch.

Prerequisites: 

Ensure cross patches are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. If the Cross Patches panel is closed, on the menu bar, click Tools → Cross Patches.

The Cross Patches panel appears.

2. Open the properties of the existing cross patch in one of the following ways:

• On the Cross Patches panel, double-click the desired cross patch.

• On the Cross Patches panel, in the right part of the desired cross patch entry, click the Actions (   )

button, and then select Properties (   ).

 The Cross Patch window appears.
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3. In the Cross Patch window, perform the desired changes.

4. Click OK to apply changes and close the window.

3.3.3.5 Initiating Cross Patch Calls

Follow the procedure to initiate a cross patch call.

Prerequisites: 

• Ensure the Cross Patches panel is opened. For details, see Cross Patches Panel.

• Ensure the desired cross patch is added and enabled. For details, see Creating Cross Patches.

• Obtain the current settings of the pointing devices and hotkeys from the Administrator.

Procedure: 

Initiate the cross patch call in one of the following ways:

• Depending on the settings of the pointing devices, press and hold, or click the PTT button of the desired cross

patch.

• Select the cross patch, and then depending on the PTT button hotkey settings, press and hold, or press the

hotkey.

3.4 Radio Fleet

The Radio Fleet panel provides communication objects in the dispatched radio systems. These objects are:

• Radios.

For details, see Radios.

Important

To edit the SmartPTT Dispatcher list of radios, an operator needs to have the Edit radio lists permission that can

be assigned in the operator's account settings. For information on the operator rights, see Operators.

• Talkgroups and site-specific group of radios.

For details, see Talkgroups and All Calls.

• Dynamic groups.

For details, see Dynamic Groups.

• Channels which include the following objects:

• Control stations

• Virtual control stations

• System wide and local channels of conventional radio systems

• Single and multisite trunked radio systems

For details, see Channels and Systems.
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• SmartPTT Radioservers

For details, see Radioservers.

The panel does not show non-radio objects like other SmartPTT dispatchers, phone users, SmartPTT Web Client, and

third-party dispatch applications.

If the panel is closed, you can open it by clicking Tools → Radio Fleet on the menu bar.

The Radio Fleet panel provides the following elements:

Hide talkgroups (   )

Shows or hides talkgroups. Other objects and categories remain visible in the Object Table.

Hide online radios (   )

Shows or hides radios that appear registered in the Object Table. Other objects and categories remain visible.
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Hide offline radios (   )

Shows or hides radios that appear unregistered or unavailable in the Object Table. Other objects and categories

remain visible.

Important

Radios that use MDC-1200 or 5 Tone signaling always appear offline on the Radio Fleet panel.

Search field (   )

Can be used for searching a radio or talkgroup by typing its name or ID.

List of statuses

Provides a list of statuses for filtering radios.

Filter by channel (   )

Shows objects organized according to the dispatch system configuration and based on the radio presence

information.

Filter by category (   )

Shows objects organized according to the categories and sub-categories created in SmartPTT Dispatcher.

For information on categories, see Categories.

NOTE

If you click Filter by category, you cannot access channels, systems, and SmartPTT Radioservers.

Add radio (   )

Opens the Radio Properties window for adding a radio.

Delete radio (   )

Deletes the selected radio.

Removed online radios automatically deregister in SmartPTT dispatch system.

Object Table

The table consists of the following columns:

Object

The column contains the name and the icon of objects or categories.

Status

The column contains statuses of radios, or channel selection controls of the corresponding control stations. The

statuses are related to SmartPTT statuses of radios, not the statuses provided by MOTOTRBO radio system. For

information on radio statuses, see Statuses.

NOTE

If no statuses added in SmartPTT Dispatcher, the Status column disappears from the Object Table, and the

channel selection control will be available only in the custom console.

Unnamed column

In the column, you can see the PTT button of the corresponding object and the Actions (   ) button. The color of

the PTT button refers to the call status. For details, see Color Indication of Voice Calls. The button is unavailable to

SmartPTT Radioservers, channels, categories, and radios from analog radio systems that use MDC-1200 or 5 Tone

signaling.
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NOTE

The PTT button is available even if the specific type of voice calls is forbidden to the dispatch console user.

For information on the Radio Fleet objects, see the sections below.

3.4.1 Actions

SmartPTT Dispatcher provides various actions for interacting with system objects.

The actions can be performed either from the Actions menu or a Call Window of the corresponding object.

For information on Call Windows, see Radios or Talkgroup Call Window.

You can open the Actions menu in one of the following ways:

• By clicking the Actions (   ) button to the right of the object name on the Radio Fleet panel.

• By clicking the Actions (   ) button on the desired radio element on the Radios or custom console panel.

• By right-clicking the radio on a map or on the expendable Radios panel of the open map control panel.

For information on map control panel, see Map Control Panel.

For information on actions for interacting with system objects, see the corresponding sections below.

3.4.2 Radioservers

In the Radio Fleet panel, radioserver entries represent radioservers available to a dispatcher.

For information on managing radioservers in SmartPTT Dispatcher, see Radioservers.

The radioserver entries are displayed only when the Filter by channel (   ) view is active.

Each radioserver entry provides the following elements:

Expand (   ) / Collapse (   )

Shows or hides the objects that belong to the radioserver.

If the radioserver has no objects belonging to it or they are hidden due to profile settings, the element is

unavailable.

Radioserver Icon (   )

Displays the state of the radioserver:

• The blue color (   ) indicates that the server is online.
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• The gray color (   ) indicates that the server is offline.

Radioserver Name

The name that is set in the Radioserver window.

For information on the window, see Radioserver Window.

Actions (   )

Opens the Actions menu of the radioserver.

For information on the actions, see Radioserver Actions Menu.

3.4.2.1 Radioserver Actions Menu

The Actions (   ) menu of the radioserver provides the ability to perform the following actions:

Action Description

Show Radioserver Event Log (   ) Displays the event log of a radioserver for the specified period of

time.

For information on the radioserver Event Log, see SmartPTT

Radioserver Event Log.

NOTE

The action is available if the radioserver event log is activated in

SmartPTT Radioserver Configurator. For details, see “Configuring

Event Log Database Connection” in SmartPTT Installation and

Configuration Guide.

The action is unavailable if the operator does not have the

corresponding permission.

For information on the operator rights, see Operators.

Configure Call Bridging Table (   ) Opens the Bridging Configuration window in which you can

configure the bridging service.

For information on bridging, see Bridging Service.

NOTE

The action is available if bridging is activated in SmartPTT

Radioserver Configurator. For details, see “Managing Bridging” in

SmartPTT Installation and Configuration Guide.

The action is unavailable if the operator does not have the

corresponding permission.

Selection of Audio Output Device (   )

Provides a list of audio output devices using which the sound of the

radioserver is played. By default, <No> and Main device values are

available.

For information on audio output devices configuring and assigning

procedures, see Configuring Audio Output Device and Assigning

Audio Output Devices to System Objects.
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Action Description

View Properties (   ) Opens the radioserver properties window.

For details, see Radioserver Properties.

3.4.2.2 Radioserver Properties

In the properties window of the radioserver, you can obtain information on its current version and leave comments

for other users of SmartPTT Dispatcher.

You can open the window by double-clicking the entry of the desired radioserver or selecting the View Properties ( 

 ) from the Actions menu of the radioserver.

The properties window provides the following elements:

Server Version

The current version of SmartPTT Radioserver. If the version does not match the version of SmartPTT Dispatcher, it

is displayed in red color.

Comment

A box in which you can type any additional information about the radioserver. For example, that the radioserver is

redundant.

Save

Save the comment which is typed in the box above.
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3.4.3 Radios

Radios are the most important objects of the Radio Fleet panel and the whole dispatch system.

Each radio entry provides the following elements:

Object Icon

The icon of a radio (   ) , mobile client (   ), or a WAVE user (   ) that appears on the left of the object name.

While the object is online, its icon is blue. If the registered object is offline, the icon is gray (appears dimmed).

Radios, SmartPTT Mobile and WAVE users are the only objects that may have a custom icon.

For information on WAVE users and the mobile application, see “WAVE Systems” and “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

Important

To manage radios that are not added to SmartPTT Dispatcher, an operator needs to have the Manage

unregistered radios permission. For information on operator rights, see Operator Window.

NOTE

Radios with the ID in the MDC-1200 or 5 Tone format always appear offline since they does not provide

registration information.

Object Name

Object name set manually by the dispatcher. It can be changed when the radio user sends a message in the profile

%name:<new name> format to SmartPTT Dispatcher. If no name is set, the radio ID or IP address appears.

The name of the radio user can be displayed next to the radio name. For details, see General Settings.

The radio name color and type indicates the radio state:

• Regular black indicates registered online radios.

• Regular gray (dimmed) indicates registered offline radios.

• Italic indicates unregistered online radios.
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• Dark red indicates radios in the emergency mode.

Location Indicator

The icon that appears if geotracking is turned on for the radio. Depending on the status, the Valid Coordinates ( 

 ) or Outdated Coordinates (   ) icon is displayed.

For information on radio geotracking, see Radio Location Properties.

Status

The text that appears in the Status column of the Object Table. It is the status provided by SmartPTT to the

dispatcher, not the MOTOTRBO Radio Status. The status can be set to the radio by a dispatcher or changed

manually when a radio sends a specific text message.

For information on statuses for radios, see Statuses.

PTT Button

Initiates a call to the radio.

The button always appears for MOTOTRBO radios, even if voice calls are turned off for these objects. The button is

unavailable to non-MOTOTRBO radios (those with MDC ID or 5 Tone ID).

The button provides the standard indication of the call status. For details, see Color Indication of Voice Calls.

Actions (   )

Opens the radio Actions menu.

For information on actions, see Radio Actions Menu.

3.4.3.1 Radio Actions Menu

The Actions (   ) menu of the radio provides the ability to perform the following actions:

Action Description

Send Message (   ) Opens the Send Message window in which you can type and send

messages or manage message templates.

For details, see Send Message Window.

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.

For information on the operator rights, see Operators.

Call Alert (   ) Sends the Call Alert command to the desired radio.

Available to DMR radios only.

Radio Check (   ) Sends the Radio Check command to the desired radio.

Available to DMR radios only.

Monitoring (   ) Initiates remote monitoring of the desired radio during which you can listen

to the radio without notifying it.

While the remote monitoring is active, the radio cannot initiate calls.
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Action Description

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.

The action is unavailable if the client registered in SmartPTT Radioserver

Configurator does not have the corresponding permission. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Set Location (   ) Provides the ability to set the location of a radio on a map manually. If no

map panel is open in the main area, the action opens the Select Map

window from which you can select the map to set the radio location.

For information on the radio location setting, see Setting Radio Location.

The action is unavailable if the operator does not have the corresponding

permission.

Show Track (   ) Shows the track of the radio for a specific period of time.

You can select the following periods to show the track:

• For the last hour

• For today

• Specify a time range (a custom period)

Period selection is unavailable if the operator does not have the

corresponding permission.

If no map is open in the main area, the action opens the Select Map

window, from which you can select the map to show the track.

If the Specify a time range is selected, you should manually set the Start date

and End date in the open Track panel of the map control panel, and then

click Show.

For information on the track showing, see Displaying Tracks.

Available to DMR radios and SmartPTT Mobile users only.

For information on the mobile application, see “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

Find on Map (   ) Shows a radio on a map.

The action is unavailable if the operator does not have the corresponding

permission.

The action is unavailable if the client registered in SmartPTT Radioserver

Configurator does not have the corresponding permission.
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Action Description

Show Address (   ) Shows the radio address in the log box of the open radio Call Window.

Opens the window if it is closed.

The radio address is based on the current GPS coordinates. If the address is

unavailable, the No Coordinates entry appears in the log box.

If you reopen the Call Window, the address disappears from the log box.

Important

The action is available only when the service of address data provider is

active in SmartPTT Dispatcher. For details, see Positioning Systems.

The action is unavailable if the operator does not have the corresponding

permission.

The action is unavailable if the client registered in SmartPTT Radioserver

Configurator does not have the corresponding permission.

Remove from Map (   ) Hides a radio on a map.

The action is unavailable if the operator does not have the corresponding

permission.

Find on Indoor Map (   ) Shows the radio on the open building map.

If the building map is closed, the action opens the Select building plan

window in which you can specify a path to the desired map.

NOTE

Available only if the Indoor tracking check box is selected in the radio

properties. For details, see Radio Location Properties.

The action is unavailable if the operator does not have the corresponding

permission.

Not available to SmartPTT Mobile users.

Block Radio (   ) Depending on SmartPTT Radioserver settings, the action denies access to a

trunked system, or remotely switches the radio off.

For information on blocking settings, see “Configuring Radioserver” in

SmartPTT Installation and Configuration Guide.

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.

The action is unavailable if the client registered in SmartPTT Radioserver

Configurator does not have the corresponding permission.
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Action Description

Unblock Radio (   ) Sends the command to the radio which is opposite to the Block Radio (   )

command.

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.

The action is unavailable if the client registered in SmartPTT Radioserver

Configurator does not have the corresponding permission.

Make Conference Call (   ) Opens the Conference Calls window from which the conference call can be

initiated.

For information on the window, see Conference Calls.

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.

Call Telephone Subscriber (   ) Opens the Telephone Subscribers window, from which the call between

the selected radio and a telephone subscriber can be initiated.

Important

The call is possible if the required settings are configured on SmartPTT

Radioserver. For details, see “Connecting to SIP Server” in SmartPTT

Installation and Configuration Guide.

Available to DMR radios only.

Create Point of Interest (   ) Opens the Point of interest window in which you can set the parameters of

the point of interest and create it.

By default the last radio coordinates are used.

NOTE

The action is unavailable if SmartPTT cannot request coordinates from a

radio. For details, see Radio Location Properties.

The action is unavailable if the operator does not have the corresponding

permission.

Create Deferred Action (   ) Opens the Create Deferred Action window in which you can create a

deferred action.

For information on the window, see Create Deferred Action Window.

Available to DMR radios only.

The action is unavailable if the operator does not have the corresponding

permission.
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Action Description

Properties (   ) Opens the Radio Properties window.

For details, see Radio Properties Window.

Exit Emergency Mode (   ) Acknowledges an incoming emergency alarm. It turns off the emergency

tone and the emergency indication.

NOTE

The action is available when a radio sends an emergency alarm.

Available to DMR radios only.

3.4.3.2 Radio Call Window

The radio Call Window provides information on a radio and the ability to interact with it in various ways.

Depending on the settings, the Call Window appears automatically when events connected with the radio occur. For

details, see Call Window Settings.

If the Call Window does not appear automatically, you can open it in one of the following ways:

• By double-clicking the desired radio entry on the Radio Fleet panel.

• By right-clicking the desired radio element on the Radios panel or Custom Console.

The radio Call Window provides the following elements:

Pin/Unpin (   )

Pins the window on top of other windows and panels. When the window is pinned, it does not close after the

timeout expires. For details, see Call Window Settings.

Avatar

The radio avatar image.
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NOTE

If, in the Call Windows settings, the Show Photo in Call Window check box is cleared, no avatar is displayed. For

details, see Call Window Settings.

Channel Name

The name of the current channel.

Status

The current radio status. For details, see Statuses.

Coordinates

Displays the radio coordinates if the GPS positioning is activated in the radio properties.

For details, see Radio Location Properties.

Beacons

Displays available beacons if the Indoor tracking is activated in the radio properties.

For details, see Radio Location Properties.

PTT Button

Initiates a private call and indicates its status. The button always appears in the window, even if voice calls are

unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.

Log

Displays all events connected with the radio.

Actions

The set of action buttons that you can use to perform the corresponding actions involving the radio.

For information on actions, see Radio Actions Menu.

Get Status of Telemetry Contact (   )

Provides the ability to receive the current status of radio GPIO pins used to send telemetry data. The updated

status is displayed in the Call Window log. For details, see Executing Telemetry Actions from Radio Call Window.

Outgoing Telemetry (   )

Provides the list of outgoing telemetry actions configured in the Telemetry Settings window and selected in the

Telemetry for - <radio name> window.

For details, see Managing Telemetry Actions and Assigning Telemetry to Radios.

Quick Message Field

Provides the ability to type the quick message text and send it to the radio by clicking Send (   ) or pressing the

Enter key. For details, see Sending Messages from the Call Window.

Message (   )

Opens the Send Message window for creating and sending messages.

For details, see Send Message Window and Sending Messages from the Send Message Window.
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3.4.3.3 Radio Properties Window

The Radio Properties window provides the ability to configure the general radio parameters, radio location update

rules, and custom properties.

You can open the Radio Properties window in one of the following ways:

• By right-clicking the existing radio on the Radio Fleet panel.

• By clicking Properties (   ) in the Actions menu of the desired radio.

For information on the Actions menu, see Radio Actions Menu.

• By clicking Add radio (   ) on the Radio Fleet panel. For details, see Adding Radios.

The Radio Properties window provides the following tabs:

• The Common tab. For details, see Common Radio Properties.

• The Location tab. For details, see Radio Location Properties.

• The Other tab. For details, see Radio Custom Properties.

NOTE

The Other tab appears only if custom properties were created for radios. For details, see Custom Radio Properties.

3.4.3.3.1 Common Radio Properties

The Common tab of the Radio Properties window provides general parameters of a radio.
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The Common tab provides the following elements:

Radio Identifier

Unique identification number of the radio. The radio ID type and value are editable only if you are adding the

radio. For details, see Adding Radios.

Possible types of radio identifiers are as follows:

• The Radio ID is the identifier of the MOTOTRBO radios used in digital radio systems.

• The SmartPTT ID is the mobile client identifier.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration

Guide.

• The MDC ID is the identifier of radios with the MDC-1200 signaling used in analog radio systems.

NOTE

If the first digits of the ID are zeros (0), SmartPTT Dispatcher omits them when shows MDC ID.

• The 5 Tone ID is the identifier of radios with the 5 Tone signaling used in analog radio systems.

Name

The name of the radio given by the dispatcher. If the field is empty, the radio ID is used instead of the name.

Status

Provides the list of radio statuses added by the dispatcher. For details, see Statuses.

Lone Worker

If selected, additional rules are applied to the radio depending on its activity or inactivity in the network. The rules

are configured separately in the Lone Worker profiles which the dispatcher selects from the list below.

For information on the Lone Worker mode, see Lone Worker Rules.

NOTE

Available to DMR radios only.

Avatar

Area for configuring radio user avatar.

The avatar also appears in the radio Call Window if, in the Call Windows settings, the Show Photo in Call Window

check box is selected. For details, see Call Window Settings.

Supported image formats are JPG/JPEG, BMP, PNG, and GIF.

The area provides the following elements:

• The current avatar is the radio user photo or other graphic image.

• The Select button opens the window for selecting the radio user avatar.

• The Delete the current radio image (   ) button deletes the selected avatar.

Radio Icon

Shows the icon of the radio and provides a set of icons to replace the default one.
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NOTE

You cannot upload your own icon to the set.

Pre-configured icons of the radio available to dispatch console users in the \AbonentIcons directory of the installed

SmartPTT Dispatcher application. If you want to add your own (custom) icon, upload it to this directory.

Custom icon files must have the ICO format and 48 × 48 px resolution.

Telemetry ( )

Opens the Telemetry for - <radio name> window where you can assign the telemetry actions to the radio. For

details, see Telemetry for Radio Window.

NOTE

The button is available to DMR radios only.

For information on configuring the general radio settings, see Configuring General Radio Parameters.

3.4.3.3.2 Radio Location Properties

The Location tab of the Radio Properties window contains settings for updating the radio location on a map.

Important

Access to the radio location settings can be limited by the client registered in SmartPTT Radioserver Configurator.

For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

NOTE

The Location tab is not available in the mobile client properties window.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.
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The Location tab provides the following elements:

GPS

Activates the GPS feature for the radio and unlocks the radio-specific update rules of outdoor coordinates. To

apply changes, SmartPTT Radioserver must be configured to accept them.

For details, see “Configuring GPS” in SmartPTT Installation and Configuration Guide.

Important

The GPS settings are unavailable if the operator does not have the Manage radio location settings and

Request radio location permissions.

For information on the operator rights, see Operators.

With time interval (sec)

If selected, the radio provides its coordinates with a time interval (in seconds) specified in the field on the right.

With distance interval

If selected, the radio provides its coordinates when it passes a distance specified in the field on the right.

NOTE

Distance units depend on the measurement system selected in the positioning settings. For details, see

Positioning Systems.

On GPIO pin status change

If selected, the radio provides its coordinates along with the telemetry signal. For details, see Telemetry.

On emergency

If selected, the radio provides its coordinates along with the emergency alarm.

On pressing PTT

Unlocks the update rules of outdoor coordinates for pressing the PTT button on the radio:

• If the always option is selected, the radio provides its coordinates each time the PTT button is pressed on it.

• If the only in emergency mode option is selected, the radio provides its coordinates only when the PTT

button is pressed on it to make the emergency call.

NOTE

For information on the algorithm for choosing between the conditions for requesting/receiving location data

configured in SmartPTT Radioserver Configurator for radio groups and the update rules of outdoor coordinates

configured in SmartPTT Dispatcher for specific radios, see “Location” in SmartPTT Installation and Configuration

Guide.

For information on configuring the radio GPS settings, see Configuring Radio GPS Settings.

Indoor tracking

Activates Indoor support for the radio and unlocks the radio-specific update interval of indoor coordinates. For

details, see Indoor Tracking.

Important

The update parameters of radio indoor coordinates are unavailable if the operator does not have the Manage

radio location settings permission.
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Update interval (sec)

If selected, the radio updates its indoor position with a time interval (in seconds) specified in the field on the right.

This parameter should not be smaller than its equivalent in the beacon settings. Contact your system

administrator to receive the minimum update interval.

For information on configuring the radio Indoor settings, see Configuring Radio GPS Settings.

3.4.3.3.3 Radio Custom Properties

The Other tab includes only custom properties which were created in the Custom Radio Properties window. If no

properties were created, the tab is unavailable.

Important

To manage parameters specified on the Other tab, an operator needs to have the Edit custom radio properties

right. For information on the operator rights, see Operators.

All the properties appear grouped as designed in the Custom Radio Properties window. For details, see Custom

Radio Properties. Each group can be expanded and collapsed.

Properties appear in the two-column table without headings. Left column of the table provides the property name.

Right column of the table provides one of the following controls:

Text field

Provides the place for text input or number-only input.

Date field

Shows the date in the Windows short date format. The Calendar Icon (   ) in the right corner of the field opens the

calendar for selecting the date.

List

Provides a number of preconfigured values of the parameter.
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When you click the parameter name or the field next to it, the detailed description of the parameter appears at the

bottom of the Radio Properties window.

3.4.3.4 Managing Radios

In SmartPTT Dispatcher, you can perform the following actions with radios:

• Manually add new radios to SmartPTT Dispatcher on the Radio Fleet panel. For details, see Adding Radios.

• Configure general radio settings, including assigning a Lone Worker profile, customizing a radio avatar and

icon, selecting a radio status, etc. For details, see Configuring General Radio Parameters.

• Configure radio outdoor location. For details, see Configuring Radio GPS Settings.

• Configure radio indoor location. For details, see Configuring Indoor Radio Tracking.

• Configure custom radio properties. For details, see Configuring Custom Radio Properties.

3.4.3.4.1 Adding Radios

Follow the procedure to add a new radio to the dispatch system manually using the Radio Fleet panel.

Prerequisites: 

Ensure that an operator has the Edit radio lists right. For details, see Operator Window.

Procedure: 

1. If the Radio Fleet panel is closed, on the menu bar, click Tools → Radio Fleet.

2. On the Radio Fleet panel, click Add radio (   ).

The Radio Properties window appears.

3. In the opened window, open the Common tab.
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4. In the upper-left corner of the tab, click the underlined Radio ID.

The Radio ID type window appears.

5. In the opened window, select the desired ID format:

To add a DMR radio, select Radio ID.

To add a SmartPTT Mobile user, select SmartPTT ID.

To add an MDC radio, select MDC ID.

To add a 5 Tone radio, select 5 Tone ID.
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6. Click OK to close the Radio ID type window.

7. In the field next to the selected ID format, type the desired radio ID.

8. Configure the general radio parameters. For details, see Configuring General Radio Parameters.

9. Configure the radio outdoor and indoor location settings. For details, see Configuring Radio GPS Settings and

Configuring Indoor Radio Tracking.

10. Configure the custom radio properties. For details, see Configuring Custom Radio Properties.

Postrequisites: 

To delete the radio, on the Radio Fleet panel, select the desired radio, click Delete radio(   ), and then, in the

confirmation window, click OK.

3.4.3.4.2 Configuring General Radio Parameters

Follow the procedure to configure or edit the general radio settings.

Prerequisites: 

• (Optional) Add the radio status. For details, see Managing Statuses.

• (Optional) Add the Lone Worker profile. For details, see Managing Lone Worker Profiles.

• (Optional) Add the custom radio icon. For details, see Common Radio Properties.

Procedure: 

1. Open the Radio Properties window. For details, see Radio Properties Window.

2. In the Radio Properties window, open the Common tab.

3. In the Name field, type the radio name.

4. (Optional) Perform the desired actions:

To assign the status to a radio, from the Status list, select the desired status.

To configure a radio user avatar, perform the following actions:

1. Click Select.

2. In the opened window, select the desired image

file and click Open.

To delete the selected radio avatar and set the

default avatar image,

click Delete the current radio image (   ).

To set the radio icon, perform the following actions:

1. Under the Select button, click the current radio

icon.

2. From the list that appears, select the desired

image.
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5. (Optional) For the DMR radio, perform one of the following actions:

To assign the Lone Worker profile to a radio, perform the following actions:

1. Select the Lone Worker check box.

2. From the list below, select the desired profile.

To assign telemetry actions to a radio, see Assigning Telemetry to Radios.

6. In the Radio Properties window, click Save.

3.4.3.4.3 Configuring Radio GPS Settings

Follow the procedure to configure determination of the radio location using outdoor coordinates received from

SmartPTT Radioserver.

Prerequisites: 

• Ensure the GPS location service is configured in SmartPTT Radioserver Configurator.

For details, see “Configuring GPS” in SmartPTT Installation and Configuration Guide.

• Ensure an operator has the Manage radio location settings and Request radio location permissions. For

details, see Operator Window.

Procedure: 

1. Open the Radio Properties window. For details, see Radio Properties Window.

2. In the Radio Properties window, open the Location tab.

3. Select the GPS check box to enable the GPS feature for the radio.

4. (Optional) Configure the radio-specific update rules of outdoor coordinates:

To update the outdoor position of the radio with

a specific time interval,

perform the following actions:

1. Select the with time interval (sec) check box.

2. In the field next to the with time interval (sec)

check box, type the desired update interval.

To update the outdoor position when the radio

moves too far from the current position on a

map,

perform the following actions:

1. Select the with distance interval check box.

2. In the field next to the with distance interval

check box, type the desired distance.

To update the outdoor position when the radio

sends the telemetry signal,

select the on GPIO pin status change check box.

To update the outdoor position when the radio

sends the emergency alarm,

select the on emergency check box.
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To update the outdoor position each time the

PTT button is pressed on the radio,

perform the following actions:

1. Select the on pressing PTT check box.

2. Select always.

To update the outdoor position only when the

PTT button is pressed on the radio to make the

emergency call,

perform the following actions:

1. Select the on pressing PTT check box.

2. Select only in emergency mode.

5. In the Radio Properties window, click Save.

3.4.3.4.4 Configuring Indoor Radio Tracking

Follow the procedure to configure Indoor support for a radio in SmartPTT Dispatcher.

Prerequisites: 

• Ensure the beacon-based location service is configured in SmartPTT Radioserver Configurator.

For details, see “Configuring Beacons in SmartPTT” in SmartPTT Installation and Configuration Guide.

• Ensure an operator has the Manage radio location settings right. For details, see Operator Window.

Procedure: 

1. Open the Radio Properties window. For details, see Radio Properties Window.

2. In the Radio Properties window, open the Location tab.

3. Select the Indoor tracking check box to enable the Indoor Tracking feature for the radio.

4. If the iBeacon technology is used, configure the radio indoor position update:

a. Select the Update interval (sec) check box.

b. In the field next to the check box, type the position update interval value in seconds.

5. In the Radio Properties window, click Save.

3.4.3.4.5 Configuring Custom Radio Properties

Follow the procedure to configure the custom radio properties.

Prerequisites: 

• Ensure the additional properties of a radio are created in the Custom Radio Properties window. For details,

see Custom Radio Properties.

• Ensure an operator has the Edit custom radio properties right. For details, see Operator Window.

Procedure: 

1. Open the Radio Properties window. For details, see Radio Properties Window.

2. In the Radio Properties window, open the Other tab.
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3. On the Other tab, click Expand (   ) on the left of property group name.

A list of properties appears.

4. With each of required property in the group, perform the following actions:

a. In the left column, click the property name.

Property description appears at the bottom of the Radio Properties window.

b. In the right column, perform one of the following actions:

If the field appears, type the relevant information.

If the Select a date text appears, click the Calendar (   ) icon, and then select the date.

If the list appears, from the list, select the desired option.

5. Repeat step 2, and then step 3 for the remaining custom groups and properties.

6. To save changes, in the Radio Properties window, click Save.

3.4.4 Talkgroups

In the Radio Fleet panel, talkgroup entries represent talkgroups available to a dispatcher.

Each talkgroup entry provides the following elements:

Talkgroup Icon (   )

Displays a talkgroup in the Objects Table. If the group sound is muted, the Mute (   ) icon is displayed.

For information on All Calls, see All Calls.

Talkgroup Name

The name that is set in SmartPTT Radioserver Configurator. You cannot change the name of the talkgroup in

SmartPTT Dispatcher.

PTT Button

Initiates a talkgroup call, and indicates call status. PTT button always appears in the panel, even if voice calls are

unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.
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Actions (   )

Opens the Actions menu of a talkgroup.

For information on actions, see Talkgroup Actions Menu.

3.4.4.1 Talkgroup Actions Menu

The Actions (   ) menu of the talkgroup provides the ability to perform the following actions:

Action Description

Send Message (   ) Opens the Send Message window in which you can type and send

messages or manage message templates.

For details, see Send Message Window.

The action is unavailable if the operator does not have the

corresponding permission.

For information on the operator rights, see Operators.

Make Conference Call (   ) Opens the Conference Calls window from which the conference call

can be initiated.

For information on the window, see Conference Calls.

The action is unavailable if the operator does not have the

corresponding permission.

Call Telephone Subscriber (   ) Opens the Telephone Subscribers window, from which the call

between the selected talkgroup and a telephone subscriber can be

initiated.

Important

The call is possible if the required settings are configured on

SmartPTT Radioserver. For details, see “Connecting to SIP Server”

in SmartPTT Installation and Configuration Guide.

Mute (   ) / Unmute (   )

Mutes or unmutes the talkgroup.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound

muting. For information on the sound settings, see Other

Settings.

Selection of Audio Output Device (   )

Provides a list of audio output devices using which the sound of the

talkgroup is played. By default, <No> and Main device values are

available.

For information on audio output devices configuring and assigning

procedures, see Configuring Audio Output Device and Assigning

Audio Output Devices to System Objects.
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Action Description

Properties (   ) Opens the talkgroup properties window.

For details, see Talkgroup Properties.

Exit Emergency Mode (   ) Acknowledges an incoming emergency alarm. It turns off the

emergency tone and the emergency indication.

NOTE

The action is available when a radio sends an emergency alarm.

3.4.4.2 Talkgroup Call Window

The talkgroup Call Window provides various controls for interacting with the talkgroup and obtaining information

on events connected with it.

Depending on the settings, the Call Window appears automatically when events connected with the talkgroup occur.

For details, see Call Window Settings.

If the Call Window does not appear automatically, you can open it manually on the Radio Fleet panel by double-

clicking the desired talkgroup entry.

The talkgroup Call Window provides the following elements:

Pin/Unpin (   )

Pins the window on top of other windows and panels. When the window is pinned, it does not close after the

timeout expires. For details, see Call Window Settings.

Avatar

The default avatar image that cannot be changed.

NOTE

If, in the Call Windows settings, the Show Photo in Call Window check box is cleared, no avatar is displayed. For

details, see Call Window Settings.
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PTT Button

Initiates a talkgroup call and indicates its status. The button always appears in the window, even if voice calls are

unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.

Log

Displays all events connected with the talkgroup.

Outgoing Telemetry (   )

Provides the list of outgoing telemetry actions configured in the Telemetry Settings window and selected in the

Telemetry for - <talkgroup name> window.

For details, see Managing Telemetry Actions and Managing Telemetry Actions.

Actions

The set of action buttons that you can use to perform the corresponding actions involving the talkgroup.

For information on actions, see Talkgroup Actions Menu.

Quick Message Field

Provides the ability to type the quick message text and send it to the talkgroup by clicking Send (   ) or pressing

the Enter key. For details, see Sending Messages from the Call Window.

Message (   )

Opens the Send Message window for creating and sending messages.

For details, see Send Message Window and Sending Messages from the Send Message Window.

3.4.4.3 Talkgroup Properties

In the properties window of a talkgroup, you can assign telemetry actions to the talkgroup, and leave comments for

other users of SmartPTT Dispatcher.

You can open the window by double-clicking the desired talkgroup entry or selecting the View Properties (   ) form

the Actions menu of the talkgroup.

The talkgroup properties window provides the following elements:

Comment

A box in which you can type comments for other users of SmartPTT Dispatcher.
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Telemetry (   )

Opens the Telemetry for window in which you can assign a telemetry action to the talkgroup.

For details, see Telemetry Settings Window.

Save

Saves the comment typed in the Comment box.

3.4.5 Dynamic Groups

SmartPTT Dispatcher allows to display virtual groups created in the SmartPTT Mobile application. In SmartPTT

Dispatcher, virtual groups that consist only of SmartPTT Mobile users are called dynamic groups.

NOTE

Dynamic groups management is unavailable if the client registered in SmartPTT Radioserver Configurator does

not have the corresponding permission. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Virtual groups consisting of talkgroups and SmartPTT Mobile users appear in SmartPTT Dispatcher as cross patches

between talkgroups and dynamic groups and are called multigroups. For details, see Cross Patches.

Dynamic groups can also be created in SmartPTT Dispatcher. The group must have at least two SmartPTT Mobile

users. The dispatcher can add only registered users of the SmartPTT Mobile application (active or not) to the group.

NOTE

When creating a dynamic group in SmartPTT Dispatcher, a virtual group with the same members is created in the

SmartPTT Mobile application.

The dispatcher can also edit the name or participants of dynamic groups, as well as delete them. The dispatcher can

edit and delete dynamic groups both created in SmartPTT Dispatcher and created in the SmartPTT Mobile

application.

NOTE

SmartPTT Mobile users cannot edit or delete dynamic groups created in SmartPTT Dispatcher.

The dynamic groups available in SmartPTT Dispatcher are displayed under the SmartPTT Mobile entry on the Radio

Fleet panel.



276

Tools Radio Fleet

Each dynamic group entry provides the following elements:

Dynamic Group Icon (   )

Displays a dynamic group and its state in the Objects Table:

• The blue color (   ) indicates that the group is active. If the group sound is muted, the Mute (   ) icon is

displayed.

• The gray color (   ) indicates that the group is inactive. If the group sound was muted, the Mute (   ) icon is

displayed.

Dynamic Group Name

Dynamic group name is displayed in italics. The name is set in the dynamic group creation window. For details, see

Dynamic Group Window.

PTT Button

Initiates a call to the dynamic group, and indicates call status. PTT button always appears on the panel, even if

voice calls are unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.

Actions (   )

Opens the Actions menu of the dynamic group.

For information on actions, see Dynamic Group Actions Menu.

3.4.5.1 Dynamic Group Actions Menu

The Actions (   ) menu of the dynamic group provides the ability to perform the following actions:

Action Description

Mute (   ) / Unmute (   ) Mutes or unmutes the dynamic group.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound

muting. For information on the sound settings, see Other

Settings.

Delete (   ) Removes the selected dynamic group from the system.

Properties (   ) Opens the group creation window for editing the selected dynamic

group.

For details, see Dynamic Group Window.

3.4.5.2 Dynamic Group Window

The Dynamic group window provides the ability to create a new or edit the existing dynamic group.

You can open the Dynamic group window in one of the following ways:

• From the Actions (   ) menu of the SmartPTT Mobile virtual control station by selecting the Create dynamic

group (   ) option.
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• From the Actions (   ) menu of the dynamic group by selecting the Properties (   ) option.

The Dynamic group window provides the following elements:

Name

Name of the dynamic group.

Temporary Talkgroup Members

Contains a list of SmartPTT Mobile users that are added to the dynamic group. The group must contain at least

two SmartPTT Mobile users. If no SmartPTT Mobile users are added, the area is empty.

Search field (   )

Field that provides the ability to find the desired SmartPTT Mobile user by typing its name.

Mobile devices

Contains a list of all available SmartPTT Mobile users registered in the system that can be added to the dynamic

group.

Add (   ) / Remove (   )

Add or remove the selected SmartPTT Mobile user to or from the Temporary Talkgroup Members area. You can

also double-click or drag the SmartPTT Mobile user to the area.
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Create/OK

Creates a dynamic group. The created group will appear on the Radio Fleet panel under the SmartPTT Mobile

entry. If you are editing an existing group, the button name changes to OK. After a dynamic group is created, all

its participants will receive a notification about group creation.

NOTE

If you edit the group, group participants will receive a notification about changes in group objects. For removed

participants, access to the group will be blocked.

3.4.5.3 Adding and Editing Dynamic Groups

Follow the procedure to add a new or edit the existing dynamic group on the Radio Fleet panel.

Procedure: 

1. On the Radio Fleet panel, perform the desired action:

To add a new dynamic group, open the Actions (   ) menu of the SmartPTT Mobile

virtual control station, and then select Create

dynamic group (   ).

To edit an existing dynamic group, open the Actions (   ) menu of the desired group,

and then select Properties (   ).

The Dynamic group window appears.

2. (Optional) In the opened window, in the Name field, type the dynamic group name.

3. Edit the dynamic group member list:

To add the SmartPTT Mobile user to the

dynamic group,

select the desired mobile client in the Mobile devices area,

and then click the Add (   ) button.

The selected mobile client appears in the Temporary

Talkgroup Members area.

To remove the SmartPTT Mobile user from

the dynamic group,

select the desired mobile client in the Temporary

Talkgroup Members area, and then click the Remove (   )

button.

The selected mobile client disappears from the Temporary

Talkgroup Members area.

NOTE

You can also add or remove SmartPTT Mobile users by double-clicking or dragging them to the desired area.

4. To complete configuration, click Create/OK.

Postrequisites: 

To delete a dynamic group, in the Actions (   ) menu of the desired group, click Delete (   ), and then, in the

Confirmation window, click OK. After a dynamic group is deleted, its members will receive a notification about

group removing.
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NOTE

If a dynamic group is participating in a cross patch or voice call, when clicking Delete, a warning window indicating

the impossibility of deleting the group appears.

3.4.6 Channels and Systems

Objects that visually group radios, talkgroups, dynamic groups, and All Calls are access points to radio systems or

radio channels.

Technically, these objects are control stations or virtual control stations, system wide and local channels of

conventional radio systems, trunked radio systems, and WAVE Server access points.

These objects are available only if you click Filter by channel (   ) on the Radio Fleet panel.

Each channel entry provides the following elements:

Expand (   ) / Collapse (   )

The control appears on the left of the entry and provides the dispatcher with capability to show or hide relevant

radios, talkgroups, dynamic groups, and All Calls. If the connection to the system is lost, the control disappears

and all sub-entries are hidden.

Channel Icon (   )

All channels have the same icon that cannot be changed. The icon displays the state of the channel:

• The blue color (   ) indicates that the channel is active. If the channel sound is muted, the Mute (   ) icon is

displayed.

• The gray color (   ) indicates that the channel is inactive (the device is turned off or out of the network

coverage). If the channel sound was muted, the Mute (   ) icon is displayed.

Object Name

Object name is received from SmartPTT Radioserver and it cannot be changed. You may contact your system

administrator to request the object rename.



280

Tools Radio Fleet

Channel Selector (control stations only)

Provides the ability to change (select) the channel on the control station. The selector appears in the Status

column of the Object Table.

Important

To switch between the control station channels, an operator needs to have the Change channel on control

station right. For information on the operator rights, see Operators.

NOTE

If no statuses added in SmartPTT Dispatcher, the Status column disappears from the Object Table, and the

channel selection control will be available only in the custom console.

Actions button

The button opens the channel Actions menu.

For information on actions, see Channel Actions Menu.

3.4.6.1 Channel Actions Menu

The Actions (   ) menu of the channel provides the ability to perform the following actions:

Action Description

Radio Dekey (   )

Interrupts all calls that are being made on the channel of a control

station.

Available to MOTOTRBO control stations only.

Reset Control Station (   ) Resets the control station.

Available to MOTOTRBO control stations only.

The action is unavailable if the operator does not have the

corresponding permission.

For information on the operator rights, see Operators.

Mute (   ) / Unmute (   )

Mutes or unmutes the channel.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound

muting. For information on the sound settings, see Other

Settings.

Mute Others (   ) Mutes other objects except for the channel from whose Actions

menu the action was selected.

Create dynamic group (   ) Opens the Dynamic group window where you can add a new

dynamic group.

For information on the window, see Dynamic Group Window.

Available to the SmartPTT Mobile virtual control station only.
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Action Description

Selection of Audio Output Device (   )

Provides a list of audio output devices using which the sound of the

talkgroup is played. By default, <No> and Main device values are

available.

For information on audio output devices configuring and assigning

procedures, see Configuring Audio Output Device and Assigning

Audio Output Devices to System Objects.

Properties (   ) Opens the channel properties window.

For details, see Channel Properties.

Exit Emergency Mode (   ) Acknowledges an incoming emergency alarm. It turns off the

emergency tone and the emergency indication.

NOTE

The action is available when a radio sends an emergency alarm.

Available to control stations only.

3.4.6.2 Channel Properties

The Control Station window provides information on the channel that is received from the radio devices used by

SmartPTT Radioserver as an access point to radio systems. The information can be used for quick monitoring

purposes.

The window consists of two tabs. Primary information is presented in the Common tab. The Other tab contains

user-entered information which is represented in the multiline text box.
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The Common tab provides the following elements:

Channel Selector

The channel selection control is available only for control stations with particular connection and configuration.

The control includes the list of channels and the Next (   ) and Previous (   ) buttons for selecting next or

previous radio channel.

Volume

The volume slider adjusts the volume of the radio channel. It affects volume of radios and talkgroups which are

associated with this channel.

Under the controls, the information about the radio device is provided. The information is different for control

stations and repeater-based systems:

• Channels shows number of detected channels in the trunked radio system.

• Display type provides information on the display type and resolution of the control station.

• Firmware shows the firmware version of the control station.

• Firmware version shows the serial number of the control station.

• Model number shows the full model number of the control station.

• Radio Id provides SmartPTT Radioserver identification information used by the associated radios to call

dispatchers.

• Range provides the frequency range of the control station.

• Slot shows the channel number (1 or 2) for IP Site Connect.

• System provides information on the MOTOTRBO radio system or connection type of the control station.

• Type provides the control station type (mobile or portable).

3.4.7 All Calls

In the Radio Fleet panel, All Call entries represent All Calls that were added on SmartPTT Radioserver.

The All Call entries are displayed only when the Filter by channel (   ) view is active.
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Each All Call entry provides the following elements:

All Call Icon (   )

The icon that is used to display an All Call in the Objects Table. If the All Call sound is muted, the Mute (   ) icon is

displayed.

The same icon is used for talkgroups.

For information on talkgroups, see Talkgroups.

All Call Name

The name that is set on SmartPTT Radioserver. You cannot change the name of All Call in SmartPTT Dispatcher.

PTT Button

Initiates a call, and indicates call status. PTT button always appears in the window, even if voice calls are

unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.

Actions (   )

Opens the actions list of a All Call.

For information on actions, see All Call Actions Menu.

3.4.7.1 All Call Actions Menu

The Actions (   ) menu of the All Call provides the ability to perform the following actions:

Action Description

Mute (   ) / Unmute (   )

Mutes or unmutes the All Call.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound

muting. For information on the sound settings, see Other

Settings.

Selection of Audio Output Device (   )

Provides a list of audio output devices using which the sound of the

All Call is played. By default, <No> and Main device values are

available.

For information on audio output devices configuring and assigning

procedures, see Configuring Audio Output Device and Assigning

Audio Output Devices to System Objects.

Properties (   ) Opens the All Call properties window.

For details, see All Call Properties.
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3.4.7.2 All Call Window

The All Call window provides information on the All Call, and controls for interacting with it.

Depending on the settings, the Call Window appears automatically when events connected with the All Call occur.

For details, see Call Window Settings.

If the Call Window does not appear automatically, you can open it manually on the Radio Fleet panel by double-

clicking the desired All Call entry.

The window provides the following elements:

Pin/Unpin (   )

Pins the window on top of other windows and panels. When the window is pinned, it does not close after the

timeout expires. For details, see Call Window Settings.

Avatar

The default avatar image that cannot be changed.

NOTE

If, in the Call Windows settings, the Show Photo in Call Window check box is cleared, no avatar is displayed. For

details, see Call Window Settings.

PTT Button

Initiates the All Call and indicates its status. The button always appears in the All Call window, even if voice calls are

unavailable.

For information on voice call statuses, see Color Indication of Voice Calls.

Log

Displays all events connected with the All Call.

Exit Emergency Mode (   )

Confirms the reception/resolution of incoming emergency alarms on the channel or in the system. Confirmation

turns off the emergency tone in SmartPTT Dispatcher and stops the emergency indication.
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3.4.7.3 All Call Properties

In the properties window of All Call, you can leave comments for other users of SmartPTT Dispatcher.

You can open the window by right-clicking the desired All Call entry or selecting the View Properties (   ) from the

Actions menu of the All Call.

The window provides the following elements:

Comment

A box in which you can type comments for other users of SmartPTT Dispatcher.

Save

Saves the comment typed in the Comment box.
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3.4.8 Categories

You can use categories to organize radios and talkgroups. The organization includes both the representation and

advanced functionality.

For details, see Categories.

Categories appear when you click Filter by category (   ) on the Radio Fleet panel.

At this view, categories appear as folders with the Category (   ) icon and include talkgroups, dynamic groups,

radios, and other categories (sub-categories).

Categories do not include control stations, virtual control stations, channels, trunked radio systems or SmartPTT

Radioservers. Therefore, All Calls are unavailable in this view.

Any category can be expanded and collapsed. When collapsed, the Expand (   ) icon appears on the left of the

Category (   ) icon. When expanded, the Collapse (   ) icon appears instead.

The Actions (   ) button, available to each category, opens the Actions menu for managing the category. For

information on the actions, see Category Actions Menu.
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3.4.8.1 Category Actions Menu

The Actions (   ) menu of the radio provides the ability to perform the following actions:

Action Description

Send Message (   ) Opens the Send Message window in which you can type and send messages or

manage message templates.

For details, see Send Message Window.

The action is unavailable if the operator does not have the corresponding

permission.

For information on the operator rights, see Operators.

Find on Map (   ) Shows members of the category on a map.

The action is unavailable if the operator does not have the corresponding

permission.

Remove from Map (   ) Hides members of the category on a map.

The action is unavailable if the operator does not have the corresponding

permission.

View Properties (   ) Opens the Category window for editing the category.

For details, see Category.

NOTE

The action is unavailable to the No Category folder on the Radio Fleet panel.
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3.4.9 Working with Objects Table

Follow the procedure to perform actions with the objects in the Objects Table.

Procedure: 

Perform the desired action:

• To hide or show radios, or talkgroups in the Objects Table, perform the following actions:

To hide or show all talkgroups, click the Hide talkgroups (   ) or Show

talkgroups (   ) button.

To hide or show online radios, click the Hide online radios (   ) or Show online

radios (   ) button.

To hide or show offline radios, click the Hide offline radios (   ) or Show offline

radios (   ) button.

• To change the view of the Object Table, perform the following actions:

To activate the channel view, click Filter by channel (   ).

To activate the category view, click Filter by category (   ).

• To search the desired radio in the Objects Table by name or ID, in the search box, type the name or ID of the

radio.

• To filter radios by status, from the Filter radios by status list, select the desired status.

3.5 SCADA Module

SCADA (Supervisory Control And Data Acquisition) is an automation control system for monitoring and controlling

parameters of remote equipment in real time.

In SmartPTT, telemetry data collection and processing is performed through AdapTel interface adapters. For details,

see AdapTel on the SmartPTT website.

Important

Access to the SCADA module functionality requires installing the SCADA license. For details, see Licenses.

https://smartptt.com/products/adaptel/
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You can open the SCADA panel by clicking Tools → SCADA on the menu bar.

Important

The SCADA option appears in the Tools menu only after the SCADA module activation in SmartPTT Dispatcher

settings. For details, see Activating SCADA Module.

The SCADA module in SmartPTT Dispatcher provides the ability to perform the following actions:

• Monitor, gather, and process real-time telemetry data.

• Control parameters of SCADA points.

• Configure response rules for events registered in the connected SCADA system.

For information on setting rules, see Custom Rules.

For information on the SCADA module functionality in SmartPTT Dispatcher, see the SCADA Module embedded help.

3.6 Channels

The Channels panel displays information and provides controls for working with the control stations and IP Site

Connect channels available in the radio system.

You can perform the following actions in the Channels panel:

• Initiate an All Call on the desired channel. For details, see Initiating Group Voice Calls and All Calls.

• Initiate a group call on the desired channel. For details, see Initiating Group Voice Calls and All Calls.

• Open the control station or IP Site Connect channels Actions menu by clicking the Actions (   ) button on the

channel element.

• Mute/Unmute the channel sound by clicking the Mute (   ) / Unmute (   ) button on the channel element.
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You can open the Channels panel by clicking Tools → Channels on the menu bar.

Depending on the type, the Channels panel provides the following elements:

Font Size (   )

Provides the ability to change the font size of element text on the panel. You can change the size to small,

medium, or large. The default font size is Small.

Element Width (   )

Provides the ability to change the width of all elements on the panel. You can change the element width to

narrow, medium, or wide. The default width is Narrow.

Show Icon (   )

Provides the ability to show or hide channel icons on all elements on the panel.

Channel Element

The element provide the ability to interact with available control stations and IP Site Connect channels. The

element provides the following information and controls:

Channel Icon (   )

The standard icon indicating the radio object type. It is used for all the objects in the panel and cannot be

changed.

Mute (   ) / Unmute (   )

The Mute (   ) button provides the ability to mute the channel sound. The dispatcher stops hearing the sound of

the voice calls made on the muted channel. To unmute the channel, you need to click the Unmute (   ) button

which appears instead of Mute (   ) on the element of the muted channel.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.
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Name

The name of the control station or repeater system channel that is set in SmartPTT Radioserver Configurator.

Channel Selector (   /   )

Available to control stations only. Provides the ability to switch the control station channels.

Call Target

The list of available All Call and group call options on the channel.

During an incoming group call, the selected group name changes to the group name to which the call is initiated.

To make All Calls or group calls, groups must be created and configured in the channel settings in SmartPTT

Radioserver Configurator. For details, see “Talkgroups” in the corresponding network settings description in

SmartPTT Installation and Configuration Guide.

NOTE

For control stations, available call options depend on the channel that is currently selected on it. You can select the

desired channel in the Radio Fleet panel. For details, see Channels and Systems.

Actions Menu (   )

Opens the channel Actions menu. The list of available actions depends on the channel type (control station or

repeater system channel).

For information on the Actions menu, see Channel Actions Menu.

Call Initiator

Name of a current call initiator on the channel.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

The element color indicates the current state of the call on the channel. For information on call statuses and their

color indication, see Color Indication of Voice Calls.

If there are no active calls on the channel, the color of its element indicates its current state:

• The blue element color indicates that the channel is currently active but there are no active transmissions on it.

• The gray element color indicates that the channel is currently inactive (the device is turned off or out of the

network coverage).

3.7 Radios

The Radios panel provides controls for monitoring and interacting with radios registered in SmartPTT Dispatcher.

The Radios panel provides the ability to perform the following actions with the radio objects located in it:

• Open the radio Actions menu by clicking the Actions (   ) button in the bottom right corner of the element.

• Open the radio Call Window by right-clicking the element. For details, see Radio Call Window.

• Initiate a private voice call to the radio. For details, see Initiating Private Voice Calls.

• Initiate a multiselect call to multiple radios. For details, see Multicalls.
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You can open the Radios panel by clicking Tools → Radios on the menu bar.

The Radios panel provides the following elements:

Filters

Provide the ability to filter the radios displayed on the Radios panel by default and customizable criteria. The

following filtering options are available:

• All Radios displays all radios registered in SmartPTT Dispatcher (both online and offline).

• Online displays the radios that are currently online.

• Manual selection displays the radios manually added there by dragging and dropping the desired objects

from the Radio Fleet panel. To remove the added objects from the Radios panel, you need to select the

desired object or objects, and then press the Delete key.

• If there are radio categories configured in SmartPTT Dispatcher, controls with the names of existing categories

appear next to the Manual selection option. By selecting a category option you can display all the radios that

belong to it. For details, see Categories.

NOTE

If no categories are configured in SmartPTT Dispatcher, filtering by category is not available, and the

corresponding controls are not displayed.

By default, the All Radios option is selected.

The number in the parentheses after the filtering option name corresponds to the number of radios that will be

displayed after selecting this filtering option.

Search field (   )

Provides the ability to display only the radios whose name or ID contains the characters specified in the field.

The search is performed only among the objects that are currently displayed on the panel after applying one or

multiple filters (by default, the All Radios option). You can clear the search field by clicking Clear (   ) in the right

part of the field.
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Statuses

Provides the ability to display only the radios with the status selected from the list. For details, see Statuses.

The filtering is performed only among the objects that are currently displayed on the panel after applying one or

multiple filters (by default, the All Radios option).

The (empty) option displays the radios whose status is not currently specified. By default, the All statuses option

is selected.

NOTE

If no statuses are configured in SmartPTT Dispatcher, filtering by status is not available, and the corresponding

controls are not displayed.

Font Size (   )

Provides the ability to change the font size for all element names on the panel. You can change the size to small,

medium, or large. The default font size is Small.

Element Width (   )

Provides the ability to change the width of all elements on the panel. You can change the element width to

narrow, medium, or wide. The default width is Narrow.

Show Icon (   )

Provides the ability to show or hide radio icons on all elements on the panel.

Radio Object Element

The element representing a radio registered in the radio system. The element provides the following information

and controls:

• Name or ID of the radio object specified in the radio properties. For details, see Radio Properties Window.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

• The Actions (   ) button opens the radio Actions menu. For details, see Radio Actions Menu.

The radio elements provide the following indication:

• The Missed Call (   ) icon indicates that there are missed calls from the radio. Next to the icon, the number of

missed calls is displayed.

• The Valid Coordinates (   ) / Outdated Coordinates (   ) icon. Depending on the update status of the radio

location data, the icon indicates that the radio GPS coordinates are valid or outdated/missing. The icon appears

only if the GPS service is activated and the coordinates update parameters are specified in the radio location

settings. For details, see Radio Location Properties.

• The Man Down label indicates that the radio is currently in the Man Down state. For details, see Initiator Alert

and SmartPTT Man Down Configuration Guide.

• The Emergency label on the element indicates that the radio activated the emergency mode. You can manage

the reported emergency from the Emergencies panel or using the Exit Emergency Mode option of the radio

Actions menu. For details, see Emergencies and Radio Actions Menu.
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NOTE

The emergency and the Man Down modes are unavailable to WAVE and SmartPTT Mobile users.

For information on WAVE users and the mobile application, see “WAVE Systems” and “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

• A notification about the cause of a holding, when a call cannot be initiated and call attempts continue, at

pointing to the element.

• The color of the element indicates the current status of a radio (blue color means that a radio is online, gray

color means that a radio is offline). For information on color indication of voice calls to and from radios, see

Color Indication of Voice Calls.

3.8 Job Tickets

You can send special assignments to radios and track their execution. These job tickets can be sent both to individual

radios and to talkgroups.

Important

The Job Tickets feature is not available in the Capacity Max systems.

NOTE

Job tickets are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

Only radios equipped with a display can receive job tickets. The radios that do not support the Job Tickets

functionality but have a display receive job tickets as messages, for example, <JTS> Job Ticket №1 Create weekly report.

To check whether the radio supports this functionality, contact your system administrator.

For information on managing job tickets, see the sections below.
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3.8.1 Job Tickets Panel

The Job Tickets panel provides the ability to manage job tickets and monitor their implementation.

You can open the panel by clicking Tools → Job Tickets on the menu bar.

The Job Tickets panel consists of the following areas and elements:

Filters

Provides the ability to filter job tickets in the Job Tickets Table of the Management area. For details, see Filters.

Management

Contains controls for managing job tickets and the table displaying sent job tickets. For details, see Management

Area.

Status Change Log

Displays information on status updates of the job ticket selected in the Job Tickets Table.

The table consists of the following columns:

• The Date/Time column contains the date and time of the selected job ticket status update.

• The Status column contains the status assigned to the job ticket by the radio or the default status.

For information on the default status, see Job Ticket Statuses.
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3.8.1.1 Filters

In the Filters area, you can filter the job tickets displayed in the Job Tickets Table by one or multiple parameters.

For information on the Job Tickets Table, see Management Area.

By default, the Filters area is collapsed. You can expand it by clicking the Expand (   ) button located in the upper-left

corner of the panel, to the left of the area name.

The Filters area provides the following elements:

Job ticket

Unlocks the list for selecting the job ticket name.

Assignee

Unlocks the list for selecting the job ticket assignee (radio or talkgroup).

Status

Unlocks the list for selecting the job ticket status.

For information on statuses, see Job Ticket Statuses.

Created

Unlocks the fields for setting the start and end dates and time of the period during which the job ticket was

created.

Updated

Unlocks the fields for setting the start and end dates and time of the period during which the job ticket status was

updated.

Apply (   )

Applies the selected filters to the job tickets in the Job Tickets Table.

Clear (   )

Cancels all filters set in the Filters area and applied to the Job Tickets Table.

For information on applying filters, see Filtering Job Tickets.
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3.8.1.2 Management Area

The Management area includes a list of job tickets and controls for managing them.

The area provides the following elements:

Show completed tickets

If selected, displays all job tickets in the Job Tickets Table below irrespective of their status.

If cleared, hides the job tickets with the completion statuses from the table. The job ticket assigned to a talkgroup

will be hidden if the latest radio status received from the group is the completion status.

For information on completion statuses, see Job Ticket Status.

Add (   )

Opens the Job ticket window for adding a new job ticket. For details, see Job Ticket Window.

Delete ticket (   )

Cancels the selected job tickets and deletes them from the Job Tickets Table.

If the Send notification to radio when uncompleted job ticket was deleted by dispatcher check box is

selected in the window for managing job ticket statuses, the assignees of the deleted job tickets receive a text

message with information on the job ticket cancellation. For details, see Job Ticket Statuses.

Resend (   )

Opens the Job ticket window for editing the selected job ticket before resending. This function can be useful in

case of a delivery failure, if the assignee does not react to the job ticket for a long time, or if you want to check if a

specific participant of the talkgroup received it.

NOTE

Before resending a job ticket, ensure that automatic numbering is enabled and each new job ticket is assigned a

unique number. For details, see Job Ticket Statuses.

If automatic numbering is disabled, radios do not receive job tickets with the same name even though they are

displayed as separate entries in the Job Tickets Table.

Update statuses (   )

Updates job ticket statuses after a period of the dispatch console inactivity (for example, if the computer was

turned off or lost connection to the server).

If no changes occurred during the inactivity period, when clicking the button, the Information window with the

No status updates message appears.
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Job Tickets Table

By default, displays all job tickets sent from the current dispatch console.

If filtering is applied, the table displays only the entries that meet the filter criteria. For details, see Filtering Job

Tickets.

The table consists of the following columns:

Column Name Description

Job ticket The number assigned to the job ticket by the automatic numbering functionality, if

enabled, and the job ticket name that is set during ticket creation.

Description The job ticket description that is set during ticket creation.

Assigned The radio or talkgroup to which the job ticket was sent. The parameter is set during

ticket creation.

Status The status indicating the execution of the job ticket by the assignee.

When the assigned radio changes the job ticket status, the status in the Job Tickets

Table changes accordingly. If the job ticket is assigned to a talkgroup, the status in

the table shows the latest status update and the name of the radio that updated it.

All status updates performed by participants of the talkgroup are available in the

Status Change Log table.

For information on the table, see Job Tickets Panel.

You can configure job ticket statuses in the window for managing job ticket

statuses. For details, see Job Ticket Statuses.

Created The date and time when the job ticket was created.

Expires The date and time when the job ticket becomes invalid. The expiration time is

calculated automatically and depends on the expiration period that is set during

ticket creation.

When the period expires, the delivery status of the job ticket in the Job Tickets

Table changes to Ticket outdated.

Updated The date and time when the job ticket status was last updated by the assignee.

Delivery status

The status indicating if the job ticket was sent and received by the assignee. The

following delivery statuses are available both for radios and talkgroups:

• The Sent status appears if the job ticket was sent but no information on its

delivery is available.

• The Not Delivered status appears if the job ticket was not sent (for example,

due to issues with SmartPTT Dispatcher connection to the radioserver).

The job tickets with the Sent and Not Delivered delivery statuses are

highlighted in the Job Tickets Table with a fading dark orange color ( ⬛ ).
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Column Name Description

• The Ticket outdated status appears if the set job ticket expiration period

ended but the assignee can still update its status. The job tickets with this

delivery status are highlighted in the Job Tickets Table with a pink color ( ⬛ ).

If the job ticket assignee is offline and the set period expires before the

assignee appears online, the job ticket will not be sent. Until the set period

expires, assignees will receive job tickets as soon as they appear online.

NOTE

The expired job tickets are not hidden when the Show completed tickets check

box is cleared.

Job tickets sent to individual radios may also have the following statuses:

• The Delivered status appears if the job ticket was received by the assignee.

• The No status status appears if the assignee is transmitting and its receiving

channel is busy. As soon as the transmission finishes, the status changes to

Delivered.

SmartPTT Dispatcher does not provide information on which of the radios in the

talkgroup received the job ticket. To check the job ticket delivery status for a

specific radio, you can resend this ticket to the desired radio individually.

You can sort the job tickets displayed in the table by columns and arrange the entries in ascending or descending

order by clicking the name of the desired column. You can sort entries only by one column, clicking the name of

another column automatically discards the sorting order applied earlier.
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3.8.2 Job Ticket Window

The Job ticket window provides the ability to add a new or resend the added job ticket.

The window appears when clicking Add or Resend on the Job Tickets panel. For details, see Management Area.

The Job ticket window provides the following elements:

Job ticket

The name of the job ticket.

Description

A short description of the job ticket.

The maximum description length is 200 symbols.

Expiration period (hr)

The amount of time (in hours) during which the job ticket will be valid.

The default value is 24 hours. The minimum value is 1 hour.

Assignees

The list of radios and talkgroups to which the job ticket will be assigned.

Radios and talkgroups are added to this area by dragging and dropping from the Radio Fleet panel.

3.8.3 Managing Job Tickets

Follow the procedure to add, resend, or delete a job ticket as well as update all job ticket statuses or view the status

change log of an individual job ticket.

Prerequisites: 

(Optional) In the window for managing job ticket statuses, configure additional job ticket parameters:

• Automatic numbering

• Sending notifications when a dispatcher deletes an uncompleted job ticket
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• Default status

• For job ticket statuses, the color, sound signal, and status completion settings

For details, see Managing Job Ticket Statuses.

Procedure: 

1. On the menu bar, click Tools → Job Tickets.

The Job Tickets panel appears.

2. (Optional) To resend, delete, or view information about a job ticket with the completion status, select the Show

completed tickets check box.

3. In the Management area, perform one of the following actions:

To add a new job ticket and send it to a single or

multiple radios or talkgroups,

click Add (   ).

The Job ticket window appears.

To edit a job ticket before resending, in the Job Tickets Table, select the desired job ticket, and

then click Resend (   ).

The Job ticket window appears.

To delete a job ticket, perform the following actions:

1. In the Job Tickets Table, select the desired job

ticket, and then click Delete ticket (   ).

2. In the Deleting ticket window, click OK.

The job ticket is deleted from the table.

3. Proceed to step 9.

To update job ticket statuses after a period of

the dispatch console inactivity,

perform the following actions:

1. Click Update statuses (   ).

2. (Optional) If no changes occurred during the

inactivity period, in the Information window,

click OK.

3. Proceed to step 9.

To view information on status updates of a job

ticket,

perform the following actions:

1. In the Job Tickets Table, select the desired job

ticket.

In the Status Change Log table, all statuses of

the selected job ticket are displayed with the date

and time of their assignment.

2. Proceed to step 9.



302

Tools Job Tickets

4. In the Job ticket window, in the Job ticket field, type the name of the job ticket.

5. In the Description field, type a short description of the job ticket.

6. In the Expiration period (hr) field, enter the amount of time in hours for which the job ticket will be valid.

NOTE

Assignees do not receive information about the job ticket validity period and cannot see if it has already expired.

To ensure the job ticket task is not performed after its expiration time, you can delete it from the Job Tickets Table

(if, in the window for managing job ticket statuses, the Send notification to radio when uncompleted job

ticket was deleted by dispatcher check box is selected), send another job ticket indicating the cancellation or

specify the job ticket expiration period in the Description field before sending it.

7. Drag and drop the desired radios or talkgroups from the Radio Fleet panel to the Assignees area.

NOTE

If you want to remove an assignee, select it in the Assignees area, and then press the Delete key. You can remove

several assignees simultaneously by selecting them using the Shift or Ctrl key.

8. Click OK to send the job ticket.

The new job ticket entry appears in the Job Tickets Table.

9. (Optional) If necessary, close the Job Tickets panel by clicking Close (   ).

NOTE

The panel cannot be closed if the layout is locked.

Postrequisites: 

Configure the desired parameters to filter the job tickets displayed in the Job Tickets Table. For details, see Filtering

Job Tickets.

3.8.4 Filtering Job Tickets

Follow the procedure to filter the job tickets in the Job Tickets Table.

Prerequisites: 

Ensure that the Job Tickets panel is open. For details, see Job Tickets Panel.

Procedure: 

1. In the upper-left corner of the Job Tickets panel, click the Expand (   ) button to expand the Filters area.

2. Set the desired filter parameters:

To filter job tickets by name, perform the following actions:

1. Select the Job ticket check box.

2. From the unlocked list on the right, select the

desired job ticket name.

To filter job tickets by the radio or talkgroup

which is the assignee of job tickets,

perform the following actions:

1. Select the Assignee check box.
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2. From the unlocked list on the right, select the

desired radio or talkgroup name.

To filter job tickets by status, perform the following actions:

1. Select the Status check box.

2. From the unlocked list on the right, select the

desired job ticket status.

To filter job tickets by creation date and time, perform the following actions:

1. Select the Created check box.

2. In the unlocked fields on the right, enter the start

and end points of the desired job ticket creation

time range.

To filter job tickets by status update date and

time,

perform the following actions:

1. Select the Updated check box.

2. In the unlocked fields on the right, enter the start

and end points of the desired job ticket status

update time range.

Example

If, in the Updated fields, you set the start point at 01.04.2020 00:00:00 and the end point at 07.04.2020 23:59:59,

only the job tickets that were updated no earlier than 1 April 2020 and no later than 7 April 2020 will appear in the

Job Tickets Table.

3. Click Apply (   ) to apply selected filters to the Job Tickets Table entries.

Postrequisites: 

To clear the applied filters and display all entries in the Job Tickets Table, click Clear (   ).

3.9 Monitoring

The Monitoring submenu is available from the Tools menu on the SmartPTT Dispatcher menu bar. It provides the

following tools for the radio system monitoring:

• Air Monitoring panel provides graphical representation of the voice and data received from MOTOTRBO

repeaters.

For details, see Air Monitoring.

• Topology panel provides graphical representation of the radio system configuration and the connection status

of its elements.

For details, see Topology.



304

Tools Monitoring

• Diagnostics panel provides information on the current state and alarms on MOTOTRBO repeaters.

For details, see Diagnostics.

• Event Log panel provides information on the current state and alarms on the radio system devices, such as

repeaters, routers, and UPS.

For details, see Event Log.

NOTE

Monitoring is not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration

Guide.For information on these features, see the corresponding sections below.

3.9.1 Air Monitoring

The Air Monitoring panel graphically represents receiving data and voice from MOTOTRBO repeaters, which is

necessary for monitoring current system operations.

Important

To display monitoring in SmartPTT Dispatcher, the corresponding license is required, and the feature must be

activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

You can open the Air Monitoring panel by clicking Tools → Monitoring → Air Monitoring on the menu bar.
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This panel provides the following elements:

List of networks

List of networks located in the left part of the panel. It contains only active networks of SmartPTT Radioserver. If

the network becomes inactive, it disappears from the list. Selecting the check box near the desired network

provides the ability to represent graphically data packets of the network next to which the check box is selected.

Important

The Air Monitoring feature is not available to Capacity Max and Connect Plus.

Legend

Contains a list of conventions for events displayed in the air monitoring diagram. Provides the ability to determine

by color which event is currently happening on the air. The following events are available:

• Call — All Call, private, group and emergency calls. For details, see Voice Calls.

• Telephone call — telephone private and telephone group calls. For details, see Telephone Subscribers

Settings.

• ARS — information about the presence/absence of a radio in the network.

• GPS — requesting and receiving information about the radio location that supports GPS. For details, see Radio

Actions Menu.

• TMS — receiving and sending text messages, job tickets and job ticket statuses.  For details, see Text Messages.

• Telemetry — sending and processing of telemetry signals. For details, see Telemetry Settings Window.

• Indoor — requesting and receiving information about the radio location inside buildings transmitted by

beacons. For details, see Indoor Tracking.
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• System — system events from/to MOTOTRBO equipment (data confirmation, confirmation of private calls, and

other system events).

Show Summary

Provides the ability to display events from different slots or networks in one block.

Show Details

Provides the ability to display events from different slots or networks in separate blocks.

Air Monitoring Diagram

Displays voice and data packets transmitted on a logical channel as colored vertical bars. The bar height

corresponds to the signal level, and the bar color corresponds to the event type according to the Legend.

Based on the height of the bar, the signal level can vary from low to high. Levels corresponding to the received

signal strength indicator (RSSI) in decibels are displayed to the right of each block:

• High — from 80 and below.

• Medium — from 80 to 100.

• Low — from 100 and higher.

To the left of the monitoring diagram the server name, network name, slot name and repeater name are

displayed. For the summary diagram the Summary value is displayed.

Air Monitoring Table

Displays additional information on network events. It consists of the following columns:

• Event Type — type of transmitted data.

• Date/Time — date and time of the event.

• Duration (ms) — duration of the event.

• Sender — event initiator ID.

• Receiver — event receiver ID.

• RSSI (dBm) — RSSI level in decibels.

• Repeater — name of a repeater.

• Site ID — site identifier (applied only for Linked Capacity Plus networks).

• Network — name of the network.

You can sort the column by clicking on its header.

3.9.1.1 Configuring Air Monitoring

Follow the procedure to configure displaying of air monitoring.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.
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• Ensure monitoring is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Tools → Monitoring → Air Monitoring.

The Air Monitoring panel appears.

2. Select the check box next to the name of the desired network.

3. Configure air monitoring diagrams:

To display events from different slots or networks in

one block,

select the Show Summary check box.

To display events from different slots or networks in

separated blocks,

select the Show Details check box.

To display all three blocks simultaneously, select both Show Summary and Show Details

check boxes.

3.9.2 Topology

The Topology panel is a schematic representation of active networks connected to SmartPTT Radioserver.

Important

To display the Topology panel in SmartPTT Dispatcher, the monitoring license is required, and the monitoring

feature must be activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.
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To display the Topology panel, on the menu bar, click Tools → Monitoring → Topology.

A topology diagram can be built in two ways:

• Using the data specified during network configuration. For details, see “Network Monitoring” in SmartPTT

Installation and Configuration Guide.

• Automatically, based on the information received from the available network repeaters. In this case, the

diagram will not display supplemental network devices (power supplies, routers, etc.).

NOTE

In order to see SmartPTT Radioserver and its networks on the Topology panel, ensure that the Monitoring

service is enabled for this radioserver in SmartPTT Radioserver Configurator. For details, see “Configuring

Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

Important

Topology diagram building is unavailable to Capacity Max.

Important

To correctly display repeaters of a backhaul chain on the Topology panel, you should first update topology in

SmartPTT Radioserver Configurator. For details, see “Updating Topology” in SmartPTT Installation and

Configuration Guide.

The Topology panel provides the following elements:

Legend

Contains a list of conventions used in the network topology diagram with an explanation of their meaning.
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Layout

Provides the ability to place topology objects on the diagram vertically (Vertical) or horizontally (Horizontal).

Scale

Set the size of the icons and the font size in the network topology diagram.

Network Topology Diagram

The main area of the panel that displays objects of a network depending on their type and condition, and

indicates links between them.

Topology Elements

The following elements may appear in a network topology diagram:

Topology Object Description

SmartPTT Radioserver. For details, see Radioserver Information and Server

Control.

Network in a folded state

Slave hardware repeater. For details, see Repeater.

Master hardware repeater

Connect Plus Master Peer

Virtual repeater (SmartPTT Radioserver or MNIS)

Master virtual repeater

Location

Uninterruptible Power Supply (UPS). For details, see Uninterruptible Power

Supply Information.

Router. For details, see Router Information.

Control station. For details, see Control Station Information.
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Topology Object Description

Remote control station connected over RG. For details, see Radio Gateway

Information.

Unknown device (any other device). For details, see Unknown Device

Information.

At right-clicking topology element, the following options can be available:

Unfold

Available for SmartPTT Radioserver, networks, and locations:

• For SmartPTT Radioserver, it unfolds SmartPTT Radioserver and all its nodes.

To unfold a single radioserver node, click Unfold (   ) next to the desired node.

• For networks, it unfolds the desired network.

• For locations, it displays which devices, repeaters, and routers are used in this location:

Fold

Available for SmartPTT Radioserver, networks, and locations:

• For SmartPTT Radioserver, it folds SmartPTT Radioserver and all its nodes.

To fold a single radioserver node, click Fold (   ) next to the desired node.

• For networks, it folds the desired network.

• For locations, it displays a location as an image inside a box:

Select new image

The option is available only for locations and provides the ability to upload your own image of a location.
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Set default image

The option is available only for locations and provides the ability to return the default image of a location.

Information

Provides the ability to view parameters and statistics of the desired object.

In the event of an alarm on a device (except for routers and UPS), the Alarm area appears in the device

information window. It contains information about the cause and time of the alarm.

The option is unavailable for networks and locations.

Control

Provides the ability to operate the desired object remotely.

The option is available only for SmartPTT Radioserver and hardware repeaters connected to SmartPTT

Radioserver. For details, see Server Control and Repeater Control.

Reset Control Station

Sends the command for the control station to turn off and then turn on automatically.

The option is available for the MOTOTRBO control stations only.

Important

The option is unavailable if the operator does not have the corresponding permission. For details, see Operators.

Link Types and Statuses

To indicate the connection of objects in a topology diagram, the following elements are used:

Link Type Description Visual Element Example

Wireline connection Connection to the repeater is

wireline

Solid line

Wireless connection Connection to the repeater is

wireless

Dashed line

Control station connection to

a radio gateway

Control station (MOTOTRBO or

I/O) connection over the RG-

1000e gateway

Double line
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To characterize the connection, the following color coding is used:

Link Status Description Visual Element Example

Normal link (no alarms) Device is connected and no

alarms registered on a device

Green line

Minor alarms Minor alarm is registered on a

device or there are more than 5

packets lost or corrupted

Yellow line

Major alarms Major alarm on a device or no

connection

Red line

Dead link Repeater is turned off using IPMI Gray line
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3.9.2.1 Radioserver Information

The radioserver information window displays radioserver computer parameters and ongoing performance

information.

To open the window, right-click the radioserver element, and then select Information.

The radioserver information window consists of the following areas:

Operating System

Provides information on the version and edition of the operating system used on the radioserver computer.
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Processor Load

Displays current load of the volatile components of the radioserver host. This section contains the following

parameters:

• CPU — cumulative load of all central processor cores (in percent).

• Free Memory — amount of free computer RAM (in megabytes).

• Total Memory — amount of RAM installed in the computer (in megabytes).

• Used Memory — share of RAM used by computing (in percent).

Hard Disks

Provides information on all available hard disks of the computer and their characteristics. This section contains the

following parameters:

• Disk — list of logical partitions of physical drives connected to the computer.

• Free — amount of free space on the drive (in gigabytes).

• Total — total drive size (in gigabytes).

• Used — share of the drive used by data (in percent).

Databases

Provides information on available databases. This area contains the following parameters:

• Name — list of the available monitoring, metadata, and event log databases.

• Current Size — amount of space on the drive used by the database (in megabytes).

• Max Size — database drive space limit (in megabytes).

Audio records

In this area, the Folder size parameter is available, which provides information on size of the folder with audio

records on the server computer.

Network Interfaces

Provides information on the network interfaces of the computer. This area contains the following parameters:

• Network Interface — list of IPv4 and IPv6 addresses of computer network interfaces.

• Subnet Mask — subnet mask that corresponds to the selected address.

Sensors

Displays information from various hardware detectors and regulators installed on the computer (temperature of

the central processor, rotational speed of radiator fans, etc.). Information is provided in the form of a table

consisting of the following columns:

• Name — detector name.

• Description — detector description.

• Value — current value of the measured parameter.
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3.9.2.2 Server Control

The Server Control window provides the ability to operate the SmartPTT Radioserver computer remotely using

IPMI. To be able to control the computer remotely, make sure that IPMI parameters are set in the settings of

SmartPTT Radioserver. For details, see Radioserver IPMI Tab and Configuring IPMI Settings.

To open the window, right-click the radioserver element and select Control.

NOTE

If IPMI is configured incorrectly, the Information window with the Radio server IPMI settings are not active message

appears.

The Server Control window contains the following areas:

Power status

Provides information on the power status of the radioserver computer. The area provides the following elements:

• Value — displays the current power status (Switched on, Switched off, N/A Unknown).

Important

If the power status is detected as N/A Unknown, check that IPMI settings are correct.

• Refresh — sends a request to update the power status.

Power management (OS)

Contains the Turn off button. At clicking the button, a shutdown signal is sent to the computer operating system.

NOTE

If the radioserver computer is blocked, the shutdown signal will be ignored.

Power management (hardware)

Allows to send signals to the computer motherboard bypassing the operating system. The area provides the

following elements:

• Turn on — sends a signal to turn on the computer.

• Turn off — sends a signal to turn off the computer.
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NOTE

If the radioserver computer is blocked, you can turn it off only at the hardware level.

• Reset — sends a signal to immediately reboot the computer.

WARNING

Turning off and/or rebooting the computer can cause irreversible damage and/or data loss.

3.9.2.2.1 Radioserver Remote Controlling

Follow the procedure to control the SmartPTT Radioserver computer remotely.

Prerequisites: 

• Add and configure the desired radioserver. For details, see Managing Radioservers.

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the monitoring service is enabled for the desired radioserver in SmartPTT Radioserver Configurator. For

details, see “Configuring Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure monitoring is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

• Configure the radioserver IPMI settings. For details, see Configuring IPMI Settings.

• Ensure that the Topology panel is open. For details, see Topology.

Procedure: 

1. On the Topology panel, right-click the desired radioserver element and select Control.

The Server Control window appears.

NOTE

If the Information window appears instead of the Server Control window, reconfigure IPMI.

2. In the Server Control window, perform one or more of the following actions:

To update the power status, click Refresh.

Important

If the power status is detected as N/A Unknown, check that IPMI

settings are correct.

To turn on the radioserver

computer,

in the Power management (hardware) area, click Turn on.

To reboot the radioserver

computer,

in the Power management (hardware) area, click Reset.

WARNING

Rebooting the computer can cause irreversible damage and/or data

loss.
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To turn off the radioserver

computer,

perform one of the following actions:

• In the Power management (OS) area, click Turn off.

• In the Power management (hardware) area, click Turn off.

WARNING

Turning off the computer can cause irreversible damage and/or data

loss.

NOTE

If the radioserver computer is blocked, you can turn it off only in the

Power management (hardware) area.

3. Click Close (   ).

3.9.2.3 Repeater

Repeaters are displayed in the topology diagram as follows:

Next to the repeater element, the following information is displayed:

Name

Repeater name that is set in SmartPTT Radioserver Configurator on the Network Configuration tab. For details,

see “Adding and Configuring Repeaters” in SmartPTT Installation and Configuration Guide.

If a name is not set, the topology diagram displays the peer repeater identifier specified in SmartPTT Radioserver

Configurator (Peer ID), or the repeater name specified in the configuration file.

Loading

Repeater loading on a radio channel for a minute (in percent).

If you use a repeater to link one site to another site in a backhaul chain, the Link or Drop text (depending on the

repeater role) appears instead of the load percentage.

Loading grows steadily, not sharply, until the maximum value. When both logical channels are used or in ERDM,

the maximum value is 100%. When only one logical channel is used, the maximum value is 50%.

EXAMPLE

If the repeater loading in the IP Site Connect radio system is 50%, the following variations are possible:

• A voice call is in progress on one of the logical channels.

• On both logical channels, a voice call ended about 30 seconds ago.

If the repeater loading is 25%, a voice call lasting more than 30 seconds ended approximately 30 seconds ago

on one of the repeater logical channels.
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Depending on the presence/absence of a connection to the repeater, the repeater element may look like this:

Connection Status Description

Connection to the repeater is present.

Connection to the repeater is absent.

Repeaters, which are added but not active, are marked red. When the repeater is not added to the network topology,

and the connection with the repeater is lost, it disappears from the network topology.

A busy channel is represented by a yellow LED on the repeater.

3.9.2.3.1 Repeater Information

The repeater information window displays repeater parameters and summary information about the reception

and/or transmission of data.

To open the window, right-click the repeater element, and then select Information.
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The repeater information window consists of the following areas:

Properties

Displays information on the repeater parameters. The parameters displayed in this area depend on the repeater

model and type.

For information on parameters available in this area, see Properties.

Statistics

Provides information on various parameters related to the reception and/or transmission of data in the last

60 seconds (1 min).

For information on parameters available in this area, see Statistics.

NOTE

This area is absent from the information window of Connect Plus Master Peer.

3.9.2.3.2 Repeater Control

The Repeater Control window provides the ability to control the repeater remotely.

To open the window, right-click the repeater element and select Control.

NOTE

You cannot operate virtual repeaters and Connect Plus Master Peers remotely.

The Server Control window provides the following elements:

Current Channel

List of duplex channels that can be used in a repeater. Channels are set in the repeater configuration file. Each list

item contains the following attributes:

• RX — receiving radio frequency (in MHz).

• TX — transmitting radio frequency (in MHz).



320

Tools Monitoring

Power, TX

List of modes that provide the ability to adjust the transmitter power of a repeater. Bands for the modes are

specified in the repeater configuration file. In the list, the following options are available:

• High — high power mode specified in the repeater configuration file.

• Low — low power mode specified in the repeater configuration file.

State

List of repeater operation modes. In the list, the following options are available:

• On — repeater receiver and transmitter are active.

• Off — repeater receiver and transmitter are inactive.

Block

List of repeater path modes.

NOTE

The element becomes available if an analog channel is selected from the Current Channel list.

In the list, the following options are available:

• Block — disables the repeat functionality of a repeater.

If selected, a dispatch console or an external device controls when the repeater keys-up, hence turning the

repeater into a control station. It allows an operator to decide when to key-up the repeater's transmitter and,

therefore, fully control the repeater's outbound traffic.

NOTE

If the Block option is applied, the repeater operation mode is displayed in the State list as Off. The On mode will

be unavailable for applying.

• Retransmission — enables the repeat functionality of a repeater.

Restart

Provides the ability to restart a repeater remotely.

Apply

Provides the ability to apply settings specified in the Repeater Control window.

After clicking Restart or Apply, one of the following operation statuses appears in the window:
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Status Restart Apply

Waiting for response The Restart command is sent to the

repeater, a response signal has not

yet been received.

The Change Settings command is

sent to the repeater, a response

signal has not yet been received.

The operation completed

successfully

The repeater is restarted. Configuration changes are applied.

The operation completed with

errors

The repeater can not be restarted

(for example, if the repeater is

unavailable).

Configuration changes can not be

applied (for example, if SmartPTT

Radioserver is inactive).

Timeout was exceeded A response signal is not received

from the repeater within 10 seconds,

the repeater is not restarted.

A response signal is not received

from a repeater within 10 seconds,

settings changes are not applied.

No data changed N/A No changes were made to the

settings available in the window.

3.9.2.3.3 Repeater Remote Controlling

Follow the procedure to remotely control the hardware repeater connected to SmartPTT Radioserver.

Prerequisites: 

• Ensure that the Topology panel is open. For details, see Topology.

• Ensure that the status of connection to the desired repeater is displayed in green or yellow in the network

topology diagram.

Procedure: 

1. On the Topology panel, right-click the desired repeater element and select Control.

The Repeater Control window appears.
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NOTE

If the Warning window with the No connection message appears instead of the Repeater Control window, check

connection to the repeater.

If the Warning window with the Application peer control is not supported message appears instead of the

Repeater Control window, it means that you try to control a virtual repeater. You cannot operate virtual

repeaters remotely.

2. In the Repeater Control window, perform one of the following actions:

To restart a repeater, click Restart.

To configure a repeater, perform the following actions:

1. Perform one or more of the following actions:

• From the Current Channel list, select the desired

duplex channel used for the reception and

transmission of data.

NOTE

If the Current Channel list contains no items, ensure that

you do not try to control a Connect Plus Master Peer. You

cannot operate Connect Plus Master Peers remotely.

• From the Power, Tx list, select the desired transmitter

power mode of a repeater, bands for which are

specified in the repeater configuration file.

• From the State list, select the activity or inactivity

mode of the repeater receiver and transmitter.

• (Optional) If the Block list is available in the window,

select the desired repeater path mode from it.

2. Click Apply.

3. Wait until the Waiting for response status changes.

View the operation status:

If the The operation completed

successfully status is displayed,

perform one of the following actions:

• If the repeater is restarted, perform step 5.

• If you selected an analog channel instead of a digital

channel from the Current Channel list in step 2, perform

step 4.

• If other configuration changes are applied, perform step 5.

If the Timeout was exceeded status is

displayed,

perform the following actions:

1. Check connection to the repeater.
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2. Repeat step 2.

If the The operation completed with errors

status is displayed,

perform the following actions:

1. Check connection to the repeater and SmartPTT

Radioserver.

2. Repeat step 2.

4. (Optional) If you selected an analog channel instead of a digital channel from the Current Channel list in

step 2, perform the following actions:

a. Click Close (   ).

b. Reopen the Repeater Control window by right-clicking the desired repeater element and selecting

Control.

c. From the Block list, select the desired repeater path mode.

d. Click Apply.

e. Repeat step 3.

5. Click Close (   ).
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3.9.2.4 Uninterruptible Power Supply Information

The uninterruptible power supply (UPS) information window displays parameters and status information of a UPS.

For information on adding a UPS and configuring its monitoring, see “Adding and Configuring Devices” in SmartPTT

Installation and Configuration Guide.

To open the window, right-click the UPS element, and then select Information.

The UPS information window consists of the following areas:

Identification

Displays the UPS identification parameters. This area contains the following parameters:

Name Description

Model number UPS model number specified by the manufacturer

Serial number Device serial number specified by the manufacturer

Firmware Version of firmware used in a UPS

IP address Device IP address

Network mask Subnet mask that corresponds to the IP address

State

Provides information on the UPS power status. This area contains the following parameters:

Name Description

Signaling State Description Informs about issues in UPS operation. Includes the expandable list with issue

details.

Input Power Source Source of device input power

Output Power Source Source of device output power

Date of Last Battery

Replacement

Date and time when battery was replaced last time

Parameters

Provides information on the UPS energy indicators. This area contains the following parameters:

Name Description

Input Voltage Input voltage level (in volts)

Input Frequency Input frequency level (in hertz)

Output Voltage Output voltage level (in volts)
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Name Description

Output Frequency Output frequency level (in hertz)

Output Current Output current level (in amperes)

Output Power Output power level (in watts)

Load UPS loading (in percent)

Battery Charge Battery charge left in percent

Battery Usage Timeout Battery charge left in hours and minutes

3.9.2.5 Router Information

The router information window displays parameters and other information of the router. For information on adding

a router and configuring its monitoring, see “Adding and Configuring Devices” in SmartPTT Installation and

Configuration Guide.

To open the window, right-click the router element, and then select Information.

The router information window consists of the following areas:

Identification

Displays the router identification parameters. This section contains the following parameters:

• Model number — router model number specified by the manufacturer.

• Serial number — device serial number specified by the manufacturer.

Interfaces

Provides information on the router interfaces. This area contains the following parameters:

Name Description

Interface List of available physical connectors in the router

Index Unique identifying number associated with a router interface

Status Physical state of the interface

Address IP address of the router interface

Subnet Mask Subnet mask that corresponds to the router interface address

Input Rate Interface data download rate (in kilobits per second)

Output Rate Interface data upload rate (in kilobits per second)
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CPU

Provides information on the router central processing unit. This area contains the following parameters:

• Load Percent — router CPU usage (in percent).

• Temperature — router CPU temperature (in degrees Celsius).

Alarms

Gives information about issues in the router operation. Includes the expandable list with issue details.

3.9.2.6 Control Station Information

The control station information window displays control station statistics and properties.

To open the window, right-click the control station element, and then select Information.
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The control station information window consists of the following areas:

Properties

Provides information on the control station parameters. The parameters displayed in this area depend on the

control station model.

For information on MOTOTRBO control stations, see “MOTOTRBO Control Stations” in SmartPTT Installation and

Configuration Guide.

This area contains the following parameters:

Name Description

Description Supplemental information on the control station that is set in SmartPTT

Radioserver Configurator on the Network Configuration tab. For details,

see “Configuring Local Stations Monitoring” and “Configuring Remote

Control Stations Monitoring” in SmartPTT Installation and Configuration Guide.

Name Name of the control station

Address IP address of the control station

Connection type Type of the control station connection to SmartPTT Radioserver

Model number Control station model number specified by the manufacturer, or SoftwarePeer

if the control station is connected over the gateway

Serial number Control station serial number specified by the manufacturer, or 0000000000 if

the control station is connected over the gateway

Radio ID ID of the control station in the radio system

Firmware version Version of the software used on the control station

Statistics

Provides information on the control station operation. This area contains the following parameters:

Name Description

Transmissions Number of transmissions processed by the control station

Registrations Number of transmitted registration packets

Coordinates Number of transmitted location data packets

Text messages Number of transmitted text messages

Telemetry Number of transmitted telemetry packets

System Number of system events registered on the control station
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Name Description

Load Amount of the control station uptime during which it was busy with data

transmit (in percent)

Lost packets Number of packets lost during the audio data transmit

3.9.2.7 Radio Gateway Information

The radio gateway information window displays RG-1000e parameters on SmartPTT Radioserver.

NOTE

The RG element appears if the control station (MOTOTRBO or I/O) is connected over the RG-1000e gateway. For

details, see “Configuring Remote Gateway Monitoring” in SmartPTT Installation and Configuration Guide.

To open the window, right-click the gateway element, and then select Information.

The radio gateway information window contains the Properties area, in which the following parameters are

available:

• Description — supplemental information on the gateway that is set in SmartPTT Radioserver Configurator on

the Network Configuration tab.

• Name — name of the gateway.

• Address — IP address of the gateway.
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3.9.2.8 Unknown Device Information

The unknown device information window displays parameters of any kind of device other than those in the list of

devices in SmartPTT Radioserver Configurator. For details, see “Adding and Configuring Devices” in SmartPTT

Installation and Configuration Guide.

To open the window, right-click the device element, and then select Information.

The unknown device information window contains the Properties area, in which the following parameters are

available:

Name Description

Name Name of the device

Description Supplemental information on the device that is set in SmartPTT Radioserver

Configurator on the Network Configuration tab

Connection Presence/absence of a connection to the device

Location ID of the location to which the device is added

Network ID Unique radio network ID in the SmartPTT Radioserver database

3.9.3 Diagnostics

The Diagnostics panel provides a list of devices to which SmartPTT Radioserver is connected and detailed

information about their current status.

Important

To display the Diagnostics panel in SmartPTT Dispatcher, the monitoring license is required, and the monitoring

feature must be activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.
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Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

The panel provides the following elements:

Table with a list of devices

Contains information about all devices connected to SmartPTT Radioserver. For information on this table, see

Diagnostics Table.

The table view can be changed as follows:

• Columns in the table can be hidden and displayed.

• The order of the columns in the table can be changed.

• The list of devices can be sorted by the desired column.

• The list of devices can be grouped by the desired column. Device grouping can be multi-level.

NOTE

The table view of the Diagnostics panel changes in a similar way to the Event Log table. For details, see Managing

Event Log Elements.

NOTE

Right-clicking on those columns of the table that are directly related to repeaters opens the Control button, which

opens the Repeater Control window for managing a repeater.

Alarms

List in the right part of the panel contains current alarms on a device, in case of any. For details, see Alarms.

Diagnostics

List in the right part of the panel contains technical information about the device state. In the expanded list the

Refresh button is displayed. Clicking this button displays updated information about the current device or

current information about the newly selected device.
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NOTE

The Diagnostics list is displayed only for definite types of devices.

Statistics

List in the right part of the panel provides information on various parameters related to the reception or

transmission of data. For details, see Statistics.

Properties

List in the right part of the panel provides various information on the selected device. For details, see Properties.

Supported alarms

List in the right part of the panel contains alarms that are monitored for the selected device.

3.9.3.1 Diagnostics Table

Diagnostics table сontains information about all devices connected to SmartPTT Radioserver. It contains the

following columns:

Column name Description

Name Device name set in SmartPTT Radioserver Configurator

Peer ID Device identifier

Device Type Type of the supported device

Address IP address and port number used for connection to the supported device

Alarm List of current alarms on a device including the alarm severity indicator. For details,

see Alarms.

Description Device description set in SmartPTT Radioserver Configurator

Model number Device model number

NOTE

For SmartPTT Radioserver, the SoftwarePeer value is displayed in the column.

Firmware version Current version of software used on a device

Codeplug version Current version of codeplug used on a device

NOTE

For SmartPTT Radioserver, the 00.00.00 value is displayed in the column.

Serial number Device serial number specified by the manufacturer

NOTE

For SmartPTT Radioserver, the 0000000000 value is displayed in the column.
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Signaling mode Channel type used by a device: DigitalOnly, Analog, LinkedCapacity and Capacity.

Status Physical state of a device. Off or On.

Lock Repeat functionality of a repeater. The repeater path mode can be changed in the

Repeater Control window. For details, see Repeater Control.

NOTE

The value in the column is displayed only for hardware-connected repeaters.

Power level Transmitter power mode of a repeater. It can be changed in the Repeater Control

window. For details, see Repeater Control.

NOTE

The value in the column is displayed only for hardware-connected repeaters.

Channel Name Name of the channel that can be used on a device

NOTE

For SmartPTT Radioserver, the SoftwarePeer value is displayed in the column.

Rx Frequency Transmitting frequency of a device (in megahertz)

NOTE

For SmartPTT Radioserver, the 0.0000 value is displayed in the column.

Tx Frequency Receiving radio frequency of a device (in megahertz)

NOTE

For SmartPTT Radioserver, the 0.0000 value is displayed in the column.

Online Indicator for displaying a device on the network

Master Indicator for displaying the name of the main repeater

Controller Indicator for displaying SmartPTT Radioserver

Application peer Indicator for displaying a program peer

Voice calls Indicator for displaying voice transmission

Data Indicator for displaying data transmission

Slot-1 WAC Slot operation mode: Local or Wide

Slot-2 WAC Slot operation mode: Local or Wide

Role in backhaul chain Indicator for displaying the repeater role on the site of the backhaul chain:

• Link repeater (to communicate with other sites).
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• Drop repeater (to control radio transmissions in the backhaul chain).

• Proxy repeater (to ensure connection of SmartPTT to the IP Site Connect network).

• Normal (if the backhaul chain is not connected).

Proxy relay Indicator for displaying the name of the proxy repeater in the backhaul chain.

Columns whose values are represented as check boxes have three different states:

• The check box is colored with solid gray (   ) — no information about a device.

• The check box is selected (   ) — corresponds to the value Yes.

• The check box is cleared (   ) — corresponds to the value No.

3.9.3.2 Alarms

The Alarm list is available in the right part of the Diagnostics panel. It provides information on current alarms on a

device.

The notification about each alarm consists of the following elements:

Severity indicator

Color indicator of the alarm severity. The following indicators are available:

• Red (   ) — indicator of a critical alarm on a device.

• Yellow (   ) — indicator of a non-critical alarm on a device.

• Blue (   ) — indicator of a noises on a device.

Date and time

Date and time of the alarm registration in the format specified in the operating system settings.

Name

Name of the alarm. Full list of alarms is available on the Network Configuration tab of SmartPTT Radioserver

Configurator.
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3.9.3.3 Statistics

The Statistics list is available in the right part of the Diagnostics panel. It provides information on various

parameters related to the reception and/or transmission of data over the past 60 seconds (1 min). For each

parameter, two values are provided, they correspond to receiving/transmitting of data on the repeater time slots.

NOTE

These parameters are also available in the repeater information window and control station information window

on the Topology panel. For details, see Repeater Information and Control Station Information.

The following parameters are displayed in the list:

Name Description

Transmissions Number of times the PTT button was pressed

Registrations Number of registration packets transmitted

Coordinates Number of GPS coordinates transmitted

Text messages Number of text messages transmitted

Telemetry Number of telemetry packets transmitted

System Number of requests and/or radio commands processed by a repeater

Load (%) Channel load of a repeater

Broken packets (RX) Number of packets (Rx) with errors received

Max. number of consecutive

broken packets (RX)

Maximum number of broken packets (Rx) in a row

Lost packets Number of packets lost in the process of voice receiving and transmitting

Packet collisions (TX) Number of not transmitted packets due to collisions on the channel

3.9.3.4 Properties

The Properties list is available in the right part of the Diagnostics panel. It provides various information about the

selected device.

The following parameters are available not only in the Properties list, but also in the repeater information window,

control station information window, radio gateway information window, unknown device information window and in

the table with a list of devices. For details, see Repeater Information, Control Station Information, Radio Gateway

Information, Unknown Device Information and Diagnostics Table.

The following parameters are displayed in the list:
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Name Description

Description Supplemental information on a device

Name Name of a device set in SmartPTT Radioserver Configurator.

Address Device IP address and UDP port to which SmartPTT Radioserver is connected

Connection Presence/absence of a connection to a device

Connection type Type of a control station connection to SmartPTT Radioserver: Local or Remote

Location ID of the location to which a device is added

Voice calls Ability to transmit voice (Yes/No)

Data Ability to transmit data (Yes/No)

On Activity of the repeater receiver and transmitter (Yes/No)

Model number Device model number set by the manufacturer

Serial number Device serial number set by the manufacturer

Radio ID Device identifier

Network ID Unique radio network ID in the SmartPTT Radioserver database

Firmware version Version of the software used on a device

Role in backhaul chain Repeater role on the site of the backhaul chain.

3.9.4 Event Log

The Event Log panel provides an operator with information on the state of device connection to SmartPTT

Radioserver.

Important

To display the Event Log panel in SmartPTT Dispatcher, the monitoring license is required, and the monitoring

feature must be activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.
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This panel provides the following elements:

Show Current Events

Provides the ability to display the events on the current moment.

Show Logged Events

Provides the ability to display logged events for a specified period of time. For this, in the calendar next to this

parameter, the start and end dates of the desired period must be set.

Radioserver

Provides the ability to select the desired radioserver or All radioservers from the list to display the devices

connected to.

Apply

Provides the ability to apply the above mentioned settings to display events for a specified period in the event

table.

Event Log Table

Displays information about events on the current moment or for a specified period. It consists of the following

columns:

• Radioserver — name of SmartPTT Radioserver where the event is registered.

• Network — name of the network where the event is registered.

Important

The Monitoring feature is not available to Capacity Max.

• Site — site identifier (only for the Linked Capacity Plus network).

• Event Time — date and time of the event.

• Device Type — type of connected to SmartPTT Radioserver device.

• Repeater — repeater identifier.

• Device Name — name of a device.
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• Device Address — IP address of a device.

• Alarm Severity — degree of alarm severity, such as Critical, Major, Minor.

Depending on the device alarm severity the entry in the table is colored in red, pink, or yellow respectively.

• Description — information about device state.

3.9.4.1 Configuring Event Log Displaying

Follow the procedure to configure displaying of the event log.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure monitoring is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Tools → Monitoring → Event Log.

The Event Log panel appears.

2. Configure event displaying:

To display events in the monitoring log at the

current moment,

select the Show Current Events parameter.

To display events in the monitoring log for a

specified period,

perform the following actions:

1. Select the Show Logged Events parameter.

2. In the calendar next to the parameter select the

desired period.

3. Set SmartPTT Radioserver for displaying of events:

To display connected devices on the desired

radioserver,

from the Radioserver list select the desired

radioserver.

To display connected devices on all radioservers, from the Radioserver list select All radioservers.

4. Click the Apply button.
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3.10 Lone Workers

The Lone Workers panel displays the list of radios which are in the Lone Worker mode and their current status for a

better supervision over lone workers.

For information on configuring rules for lone workers, see Lone Worker Rules.

NOTE

Only DMR radios are displayed on the Lone Workers panel.

You can open the panel by clicking Tools → Lone Workers on the menu bar.

The Lone Workers panel displays radios working in the Lone Worker mode marked with a specific color. The color

shows if the radio meets the requirements set for the Lone Worker profile the radio belongs to:

• The light gray color shows that the radio does not violate the rule.

• The yellow color shows rule violation by the radio. The timer which is set in the Actions delay (min) field starts.

For details, see Profile Settings.

• The red color shows that the radio did not react in a specified way after the timer set in the Actions delay

(min) field expired.

A lone worker entry provides the following information and elements:

• Icon set in Radio Properties. For details, see Common Radio Properties.

• Name of the radio.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

• Name of the Lone Worker profile assigned to the radio.

• The Delete (   ) button to turn off the Lone Worker mode for the radio and delete the entry.
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3.11 Recent Incoming Calls

The Recent Incoming Calls panel shows the latest radios which made a call in the radio network. It also provides

quick access to the call window of the radios.

To display the panel, on the Tools menu click Recent Incoming Calls.

To set the number of radios in the panel, change the recent incoming calls settings. For details, see Recent Incoming

Calls.

An incoming call radio notification provides the following information and elements:

• Icon set in Radio Properties. For details, see Common Radio Properties.

• Name of the radio.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

• Date and time of the last incoming call displayed at pointing to the notification.

NOTE

The first radio to display on the panel is the radio made the most recent call.

• The Delete (   ) button to delete the radio notification.

Clicking a radio opens the radio Call Window. For information on the Call Window, see Radio Call Window.

3.12 Notifications

The Notifications panel displays alerts configured for the following rules:

• Custom rules. For details, see Custom Rules.

• Positioning rules. For details, see Positioning Rules.

• Lone Worker rules. For details, see Lone Worker Rules.

For information on alerts, see Dispatcher Alert.

The Notifications panel opens in the following cases:

• When the rule, for which the alert is configured, triggers.
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• When you select Notifications from the Tools menu on the menu bar.

When an alert notification appears, it starts blinking in red for a while. After you click the message or the PTT button,

the notification stops blinking and changes its background color to gray.

An alert notification provides the following information and elements:

• Alert caption.

• Radio name, date and time of the alarm.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

• Alert text.

• The PTT button to make a call to the event initiator.

For information on color indication of the PTT button, see Color Indication of Voice Calls.

For information on the call initiation settings, see Pointing Devices.

• The Delete (   ) button to delete the alert notification.

3.13 Emergencies

The Emergencies panel appears in SmartPTT Dispatcher when a radio sends an emergency alarm.

To make the Emergencies panel appear automatically upon receipt of an incoming alarm signal from the radio,

enable the emergency situation processing. For details, see Configuring Emergency Situation Processing.

When an emergency notification appears, it starts blinking in red for a while. After the emergency mode is turned off

on the radio, the notification stops blinking and changes its background color to gray.

An emergency notification provides the following information and elements:

• Time of receiving an incoming alarm signal.

NOTE

All emergency notifications are automatically logged in the Event Log. For details, see Event Log.

• Radio name.
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• The PTT button to make a call to the radio talkgroup.

For information on color indication of the PTT button, see Color Indication of Voice Calls.

For information on the call initiation settings, see Pointing Devices.

• The Turn off sound alert (   ) button to mute an emergency alarm.

NOTE

The Turn off sound alert button is inactive, if a sound notification at the emergency situation is not activated.

For details, see Configuring Emergency Situation Processing.

• The Resolve emergency (   ) button to confirm the emergency situation resolution and close the

notification.

If the Emergencies panel displays only one notification, clicking the button closes the panel.

3.14 System Messages

The System Messages panel displays event messages related to the radio network functionality. The messages

provide information on the status of radio network and its components, status of connection to the server, and

database status.

The System Messages panel opens in the following cases:

• When events selected in the Notifications Panels window occur.

For details, see System Messages.

• When you select System Messages from the Tools menu on the menu bar.

You can see three types of system messages:

• Error messages (   ) indicating major functionality failures, which can lead to the system breakdown.

NOTE

When an error message appears, it starts blinking in red for a while. After you click the message, it stops blinking

and changes its background color to gray.

• Warning messages (   ) indicating minor functionality failures, which are not critical for the current system

operation.

• Information messages (   ) indicating functionality restoration after its failure.

A system message provides the following information and elements:

• Icon which specifies the system message type

• Time when the event was registered
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NOTE

At pointing to the message, the date and time of the event registration are displayed.

• Name or type of the event source (a server, a database, or a radio network and its components)

• Commentary on the event

3.15 Server Tasks

The Server Tasks panel displays the radioserver Event Log queries from SmartPTT Dispatcher to the radioserver that

are being processed at the moment.

To display the Server Tasks panel, click Tools → Server Tasks on the menu bar.

3.16 Custom Consoles

Custom consoles are fully customizable SmartPTT Dispatcher panels that provide access to the objects and

functionality available in the dispatched radio system.

NOTE

Custom consoles are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.
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Most of the console elements are interactive and provide controls for working with the radio object or functionality

that they represent.

NOTE

Access to some of the elements may require the corresponding operator permission and/or license. For details,

see description of the desired element below.

Custom consoles must be created and configured in SmartPTT Dispatcher settings. For details, see Custom Consoles.

You can open the configured custom console by clicking Tools → <name of the custom console> on the menu bar.

If no custom console is created, the option is unavailable.

You can work with more than one custom console at the same time.

SmartPTT Dispatcher provides the following custom console elements (listed in alphabetical order):

• Broadcast Call

• Channel Selector

• Channels

• Cross Patches

• Dispatchers

• Image

• Incoming Events

• Incoming Telemetry

• Multiselect

• Outgoing Telemetry

• Panel

• PTT

• Radios

• SCADA Points

• Talkgroups

• Telephone Subscribers

• TMS

• Voice Notifications
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3.16.1 Broadcast Call

The Broadcast Call element provides the ability to initiate a group call or an All Call on all available channels of the

dispatched radio system at the same time. The element is unavailable in the analog radio systems.

NOTE

To make broadcast calls, talkgroups must be configured in the radio system settings in SmartPTT Radioserver

Configurator. For details, see “Adding and Editing Talkgroups” in the corresponding network settings description

in SmartPTT Installation and Configuration Guide.

 

The Broadcast Call element provides the following information and controls:

Broadcast Call Icon

Default icon indicating the element type.

Broadcast Call Name

Name of the Broadcast Call element (if it is set in the element settings in the Properties area).

Active Channels

Counter that provides information on how many channels SmartPTT Dispatcher is currently broadcasting and

how many channels are available in total. For example, 2 out of 3 means that SmartPTT Dispatcher is currently

broadcasting on two out of three available channels. Detailed information on the initiated calls is available in

SmartPTT Dispatcher Event Log. For details, see SmartPTT Dispatcher Event Log.

You can initiate a call to the talkgroups configured for the element using the preferred method of the call initiation.

For information on the call initiation settings, see Pointing Devices.

You can obtain information on which talkgroups are configured for the element from your system administrator.

3.16.2 Channel Selector

The Channel Selector elements provide the ability to switch between the channels of the connected control station.

Each element corresponds to one control station channel.

 

The Channel Selector element provides the following information and controls:
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Indicator of the Control Station Channel Status

Depending on the color of the indicator, the Channel Selector element may exist in two states:

• Gray color indicates inactive channels.

• Green color indicates active channels.

Channel Name

The channel name that is set in SmartPTT Radioserver Configurator.

Color Indication

The color of the Channel Selector element indicates the current status of a control station (blue color means that a

control station is online, gray color means that a control station is offline).

You can switch between the channels by clicking the desired element on the custom console.

3.16.3 Channels

The Channel element provides the ability to work with the control stations and IP Site Connect channels available in

the radio system.

  

The Channel element provides the following information and controls:

Channel Icon

Default channel icon indicating the element type.

Channel Name

Name of the channel that is set in SmartPTT Radioserver Configurator and, if configured, the radio server name.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the channel sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Channel Selector (   /   )

Available to control stations only. Provides the ability to switch the control station channels.
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Missed Calls (   )

Counter that appears if the corresponding check box is selected in the custom console settings. The counter

provides information on the number of missed private calls (the figure in red) and the total number of missed calls

on the channel (the number in blue). The call is treated as missed until the operator calls back the radio, or

talkgroup, that initiated the call. You can view detailed information on all missed calls on the channel in the Missed

Calls window by clicking the Missed Calls (   ) button. For details, see Missed Calls Window.

Call Target

Talkgroup or All Call that is currently selected on the channel. During an incoming group call, the selected group

name changes to the group name to which the call is initiated.

You can select the desired call target by clicking the name of the currently selected option and selecting the

desired option from the list. You can initiate a call using the preferred method of the call initiation. For information

on on the PTT button configuration, see Control Devices.

To make an All Call or a group call, groups must be created and configured in the channel settings in SmartPTT

Radioserver Configurator. For details, see “Adding and Editing Talkgroups” in the corresponding network settings

description in SmartPTT Installation and Configuration Guide.

NOTE

For control stations, available call options depend on the channel that is currently selected on it. You can select the

desired channel in the Radio Fleet panel. For details, see Channels and Systems.

Actions (   )

Button that opens the channel Actions menu. The list of available actions depends on the channel type (control

station or repeater system channel).

For information on the Actions menu, see Channel Actions Menu.

Color Indication

Color of the call entry in the Active Calls box that indicates the call current status. For information on call statuses

and their color indication, see Color Indication of Voice Calls.

The main color of the Channel element corresponds to the status color of the earliest active call on the channel.

You can initiate a call to the channel configured for the element using the preferred method of the call initiation. For

information on the call initiation settings, see Pointing Devices.

If there are no active calls on the channel, the color of the element indicates the channel current state:

• The blue color indicates that the channel is currently active but there are no active transmissions on it.

• The gray color indicates that the channel is currently inactive (the device is turned off or out of the network

coverage).
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3.16.3.1 Missed Calls Window

The Missed Calls window provides detailed information on missed private and group calls on the channel.

You can open the Missed Calls window by clicking the Missed Calls (   ) button on the custom console

element representing the desired channel. For information on the Channel element, see Channels.

The Missed Calls window provides the following elements:

Filters

You can filter the calls displayed in the window by selecting one of the following options in the top part of the

window: 

• The Missed (Dispatcher) option displays only private missed calls.

• The Missed (All) option displays both private and group missed calls.

• The All option clears the applied filter (if any ) and displays the list of all available radios, and talkgroups and

their individual missed calls counters.

Clear All

Resets the call statistics, after which both individual and general call counts start from zero.

Individual Missed Calls Counter

Information on missed calls for all available radios and talkgroups. Each entry in the table provides the following

information:

• Name or ID of the radio object.

• Call counter that shows one (talkgroups) or two (radios) figures. For talkgroups, the figure indicates the

number of missed group calls. For radios, the figure in red indicates the number of missed private calls, the

figure in blue indicates the total number of missed calls (private and group calls).

• The Clear call statistics (   ) button resets the individual missed calls counter of the radio object.

• The PTT button initiates a call to the radio object (a radio or talkgroup).
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3.16.4 Cross Patches

The Cross Patch element provides the ability to interact with cross patches. For details, see Cross Patches in the

“Tools” section.

New Cross Patch elements contain only the default Cross Patch icon indicating the element type.

You can assign the desired cross patch to the element in the Cross Patches window by clicking the new Cross Patch

element on the custom console. For information on the window, see Cross Patches Window.

If a cross patch is assigned to the element, the following information and controls appear on the Cross Patch

element:

Cross Patch Icon

The default cross patch icon in the upper-left corner of the element. The default icon cannot be changed.

Cross Patch Name

Name of the cross patch which is set in the Cross Patch window. For details, see Cross Patch Window.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the cross patch sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Cross Patch Members

Names of the cross patch members.

Actions (   )

Button that opens the cross patch Actions menu.

For information on actions, see Cross Patch Actions Menu.
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Color Indication

Color of the Cross Patch element indicates the current status of the cross patch. For information on call statuses

and their color indication, see Color Indication of Voice Calls.

A call to a cross patch can be initiated by the preferred method of the call initiation. For information on the call

initiation settings, see Pointing Devices.

If there are no active calls in a cross patch, the color of the element indicates the cross patch current state:

• The blue color indicates that the cross patch is active.

• The gray color indicates that the cross patch is inactive (the cross patch is deactivated, or the radioserver is

offline).

3.16.4.1 Cross Patches Window

The Cross Patches window provides the ability to assign the existing cross patch to the element or create a new

cross patch and assign it to the element.

You can open the window by clicking an empty cross patch element on the custom console in operation mode.
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The Cross Patches window provides the following elements:

Create

Opens the Cross Patch window for creating a new cross patch and assigning it to the element. For details, see

Cross Patch Window.

Cross Patch List

Provides a list of existing cross patches which you can assign to the selected element. For information on

assigning cross patches, see Assigning Cross Patches.

3.16.4.2 Adding and Editing Cross Patch Elements

Follow the procedure to add a new or edit an existing cross patch element on the custom console.

Prerequisites: 

Ensure that the cross patch element is added to the custom console.

For information on the custom consoles configuration, see Custom Consoles.

Procedure: 

1. On the custom console, perform one of the following actions:

To add a new cross patch that will be assigned to

the element,

perform the following actions:

1. Click the desired empty element.

The Cross Patches window appears.

2. In the Cross Patches window, click the Create

button.

To edit the existing cross patch assigned to the

element,

open the Actions (   ) menu of the desired element,

and then click Properties (   ).

The Cross Patch window appears.

2. (Optional) In the Cross Patch window, in the Name field, type the cross patch name.

3. Edit the cross patch member list:

To add a group to the cross patch, select the desired group in the Radio Fleet box, and

then click the Add (   ) button.

The selected group appears in the Cross Patch

Objects box.

To remove a group from the cross patch, select the desired group in the Cross Patch Objects

box, and then click the Remove (   ) button.

The selected radio disappears from the Cross Patch

Objects box.

NOTE

You can also add or remove groups by double-clicking or dragging them to the desired box.
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4. To complete configuration, click Create/OK.

3.16.4.3 Assigning Cross Patches

Follow the procedure to assign the cross patch to the element on the custom console.

Prerequisites: 

• Ensure that the Cross Patch element is added to the custom console.

For information on the custom consoles configuration, see Custom Consoles.

• Ensure an operator has at least one created cross patch.

For details, see Adding and Editing Cross Patch Elements or Creating Cross Patches.

Procedure: 

1. Click the desired empty element.

The Cross Patches window appears.

2. In the Cross Patches window, select the desired cross patch from the list, and then click OK.

The selected cross patch is assigned to the element.

Postrequisites: 

To clear the element, in the Actions (   ) menu of the cross patch, click Clear Element (   ).

The selected element becomes empty.

3.16.5 Dispatchers

The Dispatcher element provides the ability to interact with other SmartPTT dispatchers.

 

The Dispatcher element provides the following information and controls:

• Avatar that is set in the dispatcher settings. If no custom avatar is set, the default icon is used. For details, see

Dispatcher Window.

• Name of the dispatcher. Depending on the element settings, it may be a fixed dispatcher or the dispatcher

currently selected from the expandable list that you can open by clicking the box with the dispatchers's name.

You can initiate a call to the assigned dispatcher by double-clicking the corresponding element on the custom

console. After that, the Dispatchers window appears and the call starts automatically. For information on the

window, see Dispatchers Window.

Important

To interact with other dispatchers, you need to have the Connect with external dispatchers operator

permission. For details, see Operators.
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The color of the element indicates the current status of the assigned dispatcher (blue color means that the

dispatcher is available for communication, gray color means that the dispatcher is unavailable).

3.16.6 Image

The Image element is a non-interactive element that contains an image that can be set in the custom console

settings.

If no image is assigned to the element, it is displayed as a blank element of the default color.

3.16.7 Incoming Events

The Incoming Events element provides information on incoming events in SmartPTT Dispatcher, such as missed

private calls, messages, and call alert commands received during the current operation session.

When a new missed event is registered in SmartPTT Dispatcher, its entry appears in the Incoming Events element

with the red background. The event is considered as new until you click its entry. After that, the event entry regains

its default color.

Each entry in the Incoming Events element contains the following information on the event:

• Time when the event was registered.

NOTE

At pointing to the time stamp, the date and time of the event registration are displayed.

• Event initiator (name of the radio).

• Event type (call alert command or private call). For messages, instead of the event type, the text of the message

is displayed.

• Number of events of the same type from the same initiator, if more than one such event was registered.

NOTE

The number is displayed only on the new event entry.

You can open the radio Call Window by double-clicking the event entry on the element. For details, see Radio Call

Window.
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3.16.8 Incoming Telemetry

The Incoming Telemetry element provides the ability to monitor the current telemetry status of the radios in the

dispatched radio system. For information on the current telemetry settings, contact the administrator of your radio

system.

The Incoming Telemetry element provides the following information and controls:

Name

Name or ID of the radio on which the telemetry sensor is installed.

Update Status (   )

Button that sends a request for the radio telemetry status update.

NOTE

On clicking the Update status (   ) button on the element, the status will be automatically updated for all

telemetry sensors installed on the radio.

Last Update Time

Time of the last telemetry status update. The status can be updated manually using the Update Status (   )

button or automatically with the interval that is set in the radio settings. The last update time appears on the

element after the first update received from the radio. For details, see Telemetry for Radio Window.

Status Indicator

Square indicator filled with the color assigned to the current telemetry status in the element settings. If telemetry

actions of the High Level and Low Level types are assigned to the same radio sensor, next to the square indicator,

the text description of the current status is displayed.

Color Indication

The color of the element indicates the current status of a radio on which the telemetry sensor is installed (blue

color means that a radio is online, gray color means that a radio is offline).

3.16.9 Multiselect

The Multiselect element provides the ability to create multiselect groups consisting of radios, and/or talkgroups.

Multiselect groups can be used for the following purposes:

• Making calls to multiple radio objects at the same time (multiselect calls). All participants of a multiselect call can

hear the operator and cannot hear other members of their multiselect group.
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• Sending messages to multiple radio objects at the same time using the TMS element. For details, see Sending

Messages.

• Performing other actions available to multiple radio objects using the hot keys assigned in SmartPTT

Dispatcher settings. For details, see Keys.

New Multiselect elements contain only the default Multiselect icon indicating the element type.

You can configure the list of desired members of the multiselect group in the Multiselect window by clicking the

new Multiselect element on the custom console. For details, see Multiselect Window.

After adding members to the multiselect group, the default icon disappears and the following information and

controls appear on the Multiselect element:

Multiselect Group Name

Name of the multiselect group (if specified).

Multiselect Group Member

Names of the multiselect group members.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the sound of talkgroups added to the multiselect group.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Actions (   )

Button that opens the multiselect group Actions menu.

For information on actions, see Multiselect Group Actions Menu.

Color Indication

Color of the Multiselect element indicates the current status of the multiselect group. For information on call

statuses and their color indication, see Color Indication of Voice Calls.

A call to the multiselect group members can be initiated by the preferred method of the call initiation. For

information on the call initiation settings, see Pointing Devices.

For information on configuration of the multiselect group, see the sections below.
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3.16.9.1 Multiselect Group Actions Menu

The Actions (   ) menu of the multiselect group provides the ability to perform the following actions:

Action Description

Mute (   ) / Unmute (   )

Mutes or unmutes talkgroups added to the multiselect group.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For

information on the sound settings, see Other Settings.

Properties (   ) Opens the Multiselect window for editing the multiselect group members.

For details, see Multiselect Window.

Clear Element (   ) Clears the element and also removes the multiselect group from SmartPTT

Dispatcher.
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3.16.9.2 Multiselect Window

The Multiselect window provides the ability to configure the list of the multiselect group members using the

Multiselect element on the custom console. For information on the element, see Multiselect.

Depending on the current group state, you can open the Multiselect window in one of the following ways:

• For new multiselect groups (without any members added to it), by clicking any part of the Multiselect element.

• For existing multiselect groups (with at least one member added to it), by clicking Properties (   ) in the

Actions (   ) menu.

The Multiselect window provides the following elements:

Name

Contains the name of the multiselect group. You can leave the field empty, or type the desired name.

Clear All (   )

Removes all members from the multiselect group.

Multiselect objects

The list that contains the radio objects added to the multiselect group.

Radio Fleet

The box provides two tabs that contain all available objects in the dispatched radio system:

• The Radios (   ) tab contains all available radios.
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• The Talkgroups (   ) tab contains all available talkgroups.

The icons of the objects that are already added to the multiselect group change their color from blue to gray.

Search field (   )

Field that provides the ability to find the desired object by typing its name.

Add (   )

Adds the radio or talkgroup that is currently selected in the Radio Fleet list to the Multiselect objects list. The

button becomes active only if an object that has not been added to the multiselect group is selected in the Radio

Fleet list.

Remove (   )

Removes the radio or talkgroup that is currently selected in the Multiselect objects list from the multiselect

group members. The button becomes active only if an object is selected in the Multiselect objects list.

Create/OK

Creates the multiselect group. If you edit a multiselect group, the button is replaced by the OK button

For information on adding and removing members of the multiselect group, see the section below.

3.16.9.3 Configuring Multiselect Group

Follow the procedure to add, edit, or remove a radio, or talkgroup to a multiselect group using the Multiselect

element on the custom console.

For information on the element, see Multiselect.

Prerequisites: 

Ensure that the Multiselect element is added to the custom console.

For information on the custom consoles configuration, see Custom Consoles.

Procedure: 

1. Open the Multiselect window by clicking the multiselect group icon (   ) on the element.

The Multiselect window appears.

2. (Optional) In the Multiselect window, type the multiselect group name.

3. In Radio Fleet box, select the Radios (   ) or Talkgroups (   ) tab to show the desired objects.

4. Perform the desired action:

To add a new member to the multiselect

group,

perform one of the following actions:

• Select the desired radio object in the Radio Fleet

box, and then click the Add (   ) button.

• Double-click the desired radio object in the Radio

Fleet box.

• Drag the desired radio object from the Radio

Fleet box to the Multiselect objects box.

The selected object appears in the Multiselect objects box.
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To remove a member from the multiselect

group,

perform one of the following actions:

• Select the desired radio object in the Multiselect

objects box, and then click the Remove (   ) button.

• Double-click the desired radio object in the

Multiselect objects box.

• Drag the desired radio object from the Multiselect

objects box to the Radio Fleet box.

The selected object disappears from the Multiselect

objects box.

5. Click OK/Create to save changes.

3.16.10 Outgoing Telemetry

The Outgoing Telemetry element provides the ability to send preconfigured telemetry commands and monitor the

telemetry status of the radios in the dispatched radio system. For information on the current telemetry settings,

contact the administrator of your radio system.

The Outgoing Telemetry element provides the following information and controls:

Name

Name or ID of the radio on which the telemetry sensor is installed.

Update Status (   )

Button that sends a request for the radio telemetry status update.

NOTE

On clicking the Update status (   ) button on the element, the status will be automatically updated for all

telemetry sensors installed on the radio.

Last Update Time

Time of the last telemetry status update. The status can be updated manually using the Update status (   )

button or automatically with the interval that is set in the radio properties. The last update time appears on the

element after the first update received from the radio. For details, see Telemetry for Radio Window.

Status Indicator

Square indicator filled with the color assigned to the current telemetry status in the element settings.
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Telemetry Command

Button that sends the preconfigured telemetry command to the radio. For details, see Telemetry Command

Settings Window.

Color Indication

The color of the element indicates the current status of a radio on which the telemetry sensor is installed (blue

color means that a radio is online, gray color means that a radio is offline).

3.16.11 Panel

The Panel element provides the ability to interact with multiple custom console elements at the same time. Panels

may hold all types of custom console elements except another Panel element.

Actions applied using functional elements, such as the PTT, TMS and Voice Notification elements, will be applied to all

available elements located within the same Panel element. The elements located on the border of the panel are

treated as located outside of it and will not be affected by the actions applied to it.

3.16.12 PTT

The PTT element provides the ability to initiate a call to all available radios and talkgroups that are located within the

same Panel element as PTT.

If the PTT element is located outside any panel, or if there are no available radio objects added to it, the element

becomes inactive.

You can initiate a call to the radio object added to the Panel element using the preferred method of the call initiation.

For information on the call initiation settings, see Pointing Devices.
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3.16.13 Radios

The Radio element provides the ability to interact with radios added to the SmartPTT Dispatcher list of radios. Using

the element, you can perform the following actions:

• Initiate a private voice call to the radio using the preferred method of the call initiation. For information on the

PTT button configuration, see Control Devices.

• Initiate a group call to multiple radios by clicking the desired radios while pressing and holding the Ctrl key, and

then using the preferred method of the call initiation. For information on the PTT button configuration, see

Control Devices.

• Open the radio Actions menu by clicking the Actions (   ) button on the element.

• Open the radio Call Window by right-clicking the element. For details, see Radio Call Window.

There are two types of the Radio element in custom consoles:

• Element assigned to a specific (fixed or reassignable) radio.

• Element with a number pad for calling radios by entering their ID or selecting them from the SmartPTT

Dispatcher list of radios.

 

The assigned type of the Radio element provides the following information and controls:

Radio Icon

Icon that is set in the radio settings. For details, see Common Radio Properties.

Radio Name

Name or ID of the radio. Depending on the settings, it may be a fixed subscriber or a subscriber currently selected

from the expandable list of radios that you can open by clicking the box with the radio.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

Actions (   )

Button that opens the radio Actions menu.

For information on the Actions menu, see Radio Actions Menu.
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The Radio element with a number pad may exist in two states: default (no radio is selected) and active (a radio is

selected).

  

In the default state, this type of the Radio element provides the following information and controls:

Radio Icon

Default radio icon.

Actions (   )

Button that opens the radio Actions menu. The button becomes available when you enter the ID or select from

the list a radio added to SmartPTT Dispatcher list of radios.

Search field (   )

Field that provides the ability to find the desired radio by entering its ID on the keyboard or the number pad

below. You can clear the box by clicking the Delete (   ) button in the right part of the field that appears after you

type at least one digit in the field.

Number Pad

Panel that provides controls for entering the desired radio ID. Instead of the number pad, you can use a keyboard.

Number Pad (   )

Button that switches the element to the manual dialing mode by opening the number pad.

List of Radios (   )

Button that switches the element to the selection mode by opening the SmartPTT Dispatcher list of radios.

You can switch between the number pad and selection modes by clicking the corresponding controls.

After you select the desired radio, the Radio element switches to the active mode. In this mode, the top part of the

element functions as the assigned type of the Radio element and provides the same information, controls, and

indication options.
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The Radio element provides the following indication options:

Missed Calls (   )

Icon that indicates that there are missed calls from the radio. The number of missed calls is displayed next to the

icon.

Location Indicator

The Valid Coordinates (   ) / Outdated Coordinates (   ) icon. Depending on the update status of the radio

location data, the icon indicates that the radio GPS coordinates are valid or outdated/missing. The icon appears

only if the GPS service is activated and the coordinates update parameters are specified in the radio location

settings. For details, see Radio Location Properties.

Man Down Mode

The Man Down label that indicates that the radio is currently in the Man Down state. For details, see Initiator Alert

and SmartPTT Man Down Configuration Guide.

Emergency Mode

The Emergency label that indicates that the radio activated the emergency mode. You can manage the reported

emergency from the Emergencies panel or using the Exit Emergency Mode option of the Actions menu. For

details, see Emergencies and Radio Actions Menu.

NOTE

The emergency and the Man Down modes are unavailable to WAVE and SmartPTT Mobile users.

For information on WAVE users and the mobile application, see “WAVE Systems” and “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

Color Indication

Color of the element that indicates the current status of the radio. For information on the color indication applied

to the radio elements, see Color Indication of Voice Calls.

If there is no active call to or from a radio, the color of the element indicates the radio current state (blue color

means that a radio is online, gray color means that a radio is offline).

You can initiate a call to the selected radio using the preferred method of the call initiation. For information on the

call initiation settings, see Pointing Devices.

NOTE

When a call can not be initiated and call attempts continue, the cause of a holding can be displayed at pointing to

the element.

3.16.14 SCADA Points

The SCADA point element provides information on the SCADA point parameters in the real time and can be used for

quick access to the SCADA point dashboard in SmartPTT Dispatcher SCADA panel.

NOTE

The SCADA point element is available only if the SCADA module is activated in SmartPTT Dispatcher settings. For

details, see Activating SCADA Module.
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The SCADA element contains the icon and the name of the SCADA point that are set in the SCADA system and cannot

be changed in SmartPTT Dispatcher.

When you point to the SCADA point element, a tooltip with all its parameters appears. Alternatively, you can view

them in the SCADA point dashboard by double-clicking the desired element. For details, see "SCADA Module" in

SCADA Module Setup and User Guide.

The SCADA point element provides the following indication:

• Gray color of the element background indicates that either the SCADA point is currently not available, or the

SCADA module is deactivated in SmartPTT Dispatcher settings. For details, see Activating SCADA Module.

• Flashing red frame around the element indicates the alarm state of one of the SCADA point parameters.

• Red frame around the element indicates that one of the SCADA point parameters reported an alarm that was

acknowledged by one of the dispatchers but the problem is not yet resolved.

NOTE

If a point is deleted from the SCADA system, it is not automatically deleted from SmartPTT Dispatcher. The name of

the deleted SCADA point is displayed in gray color. The rules that affect the point are not deleted, and the point

settings remain editable.

3.16.15 Talkgroups

The Talkgroups element provides the ability to interact with talkgroups and initiate All Calls.

The custom console provides two types of the Talkgroup element:

• Element for interacting with talkgroups

• Element for initiating All Calls on the preconfigured channel

 

Depending on the type, the element may provide the following information and controls:

Talkgroup Icon

Default icon indicating the element type.

Name

Name the of All Call, or talkgroup. The All Call and talkgroup name is set in SmartPTT Radioserver Configurator.
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Channel Name

Name of the channel that corresponds to the network or slot name. The network and slot names are set in

SmartPTT Radioserver Configurator.

Radioserver Name

Name of SmartPTT Radioserver that is set in the radioserver settings in SmartPTT Dispatcher.

Mute (   ) / Unmute (   )

Button that provides the ability to mute/unmute the group sound.

NOTE

Some SmartPTT Dispatcher settings may prevent complete sound muting. For information on the sound settings,

see Other Settings.

Actions (   )

The button opens the element Actions menu.

For information on actions, see Talkgroup Actions Menu and All Call Actions Menu.

The Talkgroup element provides the following indication options:

• Color of the element indicates the current status of the talkgroup. For information on the color indication

applied to the talkgroup, see Color Indication of Voice Calls.

If there are no active calls in a talkgroup, the color of the element indicates the group current state (blue color

means that a group is active, gray color means that a group is inactive).

• The Emergency label on the element indicates that one of the group or channel participants activated the

emergency mode. You can manage the reported emergency from the Emergencies panel or using the Exit

Emergency Mode option of the Actions menu. For details, see Emergencies and Radio Actions Menu.

You can initiate a call to the selected group using the preferred method of the call initiation. For information on the

call initiation settings, see Pointing Devices.

3.16.16 Telephone Subscribers

The Telephone Subscriber element provides the ability to interact with telephone subscribers added to SmartPTT

Dispatcher.

Important

The Telephone Subscriber element is available only if the Telephone Interconnect license is installed and an

operator has the Make telephone calls right. For details, see Licenses and Operators.
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The Telephone Subscriber element provides the following information and controls:

• Avatar that is set in the telephone subscriber's settings. If no custom avatar is set, the default icon is used. For

details, see Telephone Subscriber Window.

• Name of the telephone subscriber.

If the ability to select the desired telephone subscriber from the element is configured, instead of the telephone

subscriber's name, the name of the currently selected subscriber is displayed. You can change the subscriber by

clicking the box with the subscriber's name and selecting the desired subscriber from the list.

You can initiate a call to the assigned telephone subscriber by double-clicking the corresponding element on the

custom console. After that, the Telephone Subscribers window appears and the call starts automatically. For

information on the window, see Telephone Subscribers Window.

3.16.17 TMS

The TMS element provides the ability to send text messages to a single or multiple radios and/or talkgroups in the

dispatched radio system.

Using the TMS element, you can perform the following actions:

• Send a custom message or a message template.

• Send a custom message or a message template by opening the Send Message window that provides

extended functionality for sending messages. For details, see Send Message Window.

The TMS element provides the following information and controls:

Message (   )

Button that expands the list of preconfigured message templates. For information on message templates, see

Managing Message Templates.

Text Box

Box for typing the text of the message.

Send (   )

Button that sends the message from the text box.

Send Message (   )

Button that opens the Send Message window. For details, see Send Message Window.

Selected Object Name

If the operator selects a Radio or a Talkgroup element in the custom console, the name of the selected object is

displayed at the top of the element. If more than one radio object is selected, instead of the object name, the

Selected heading is displayed.
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Location of the TMS element affects the way the messages are sent in the following way:

• If the TMS element is located within a Panel element, the message will be sent to all the radios and talkgroups

located within the same Panel element. For details, see Panel.

• If the TMS element is located outside any Panel element, the message will be sent to the radios and/or

talkgroups that you select in the custom console.

For information on sending messages using the TMS element, see the section below.

3.16.17.1 Sending Messages

Follow the procedure to to send a text message to a single or multiple radios and/or talkgroups using the

TMS element.

Prerequisites: 

Ensure that the TMS element and the desired radios and talkgroups are added to the custom console.

For information on the Custom Consoles configuration, see Custom Consoles.

Procedure: 

1. Select one or multiple radios and/or talkgroups to which you want to send the message.

NOTE

If the TMS element is located within a Panel element, you do not need to select the addressee. The message will be

sent to all the radios and talkgroups located within the same Panel element.

2. Depending on the type of the message that you want to send, perform one of the following actions:

To type a new message and send it from

the TMS element,

in the text box, type your message, and then click the Send ( 

 ) button.

To send a message template from the

TMS element,

to the left of the text box, click the Message (   ) button,

and then, from the Templates list, select the name of the

desired template.

To type a new message or edit a message

template before sending it from the

Message window,

perform the following actions:

1. Click the Message (   ) button to the right of the text

box.

The Message window appears.

2. In the Message window, type your message in the text

box or use a message template, and then click Send.

For information on working with the Message window,

see Send Message Window.

 The message is sent. The information on it appears in the radio and/or talkgroup Call Window and in SmartPTT

Dispatcher Event Log.

For details, see Radio Call Window, Talkgroup Call Window, and Dispatcher Event Log Table.
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3.16.18 Voice Notifications

The Voice Notification element provides the ability to play a preconfigured voice notification for a selected talkgroup

or channel.

For information on voice notifications, see Voice Notifications.

 

The Voice Notification element provides the following information and controls:

Notification Name

The voice notification name that is set in SmartPTT Radioserver Configurator.

Play (   ) / Stop (   )

The button that starts or stops the voice notification playback.

Playbacks

The counter which shows the number of successful voice notification playbacks.

Color Indication

Color of the element that indicates the current status of the notification:

• The blue color indicates the possibility to interact with the Voice Notification element.

• The orange color indicates that the voice notification playback is started.

• The gray color indicates that the voice notification is inactive (for example, if the corresponding notification was

deleted or the Voice Notifications feature is disabled in SmartPTT Radioserver Configurator).
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4 Maps

SmartPTT supports different maps, like Google Maps, OpenStreetMap, Baidu Maps, raster maps, maps in Polish

format, and vector maps in various formats.

Together with many useful tools like showing and animating a track, defining points of interest, maps provide the

dispatcher with a better control over radios. You can also open the Call Window by double-clicking on a radio

displayed on the map, or open the Actions menu by clicking with the right mouse button.

Important

For maps using, you must have the license supporting GPS. For details, see Licenses.

You can open maps from the Map menu on the menu bar of SmartPTT Dispatcher. You can configure types of maps

to display on the menu. For details, see Map Settings.

The Map menu also provides the following elements:

• Indoor Tracking option provides the ability to create a building plan or to open an existing plan. For details,

see Indoor Tracking.

For this option the corresponding license is required. For details, see Licenses.

NOTE

Indoor Tracking is not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

• Map Settings option provides access to the Map Settings window.

For details, see Map Settings.

• Coverage map option provides the abilities to build, to clean, and to set a coverage map.

For details, see Coverage Map.

This option requires the corresponding license. For details, see Licenses.

NOTE

Map selection and the Indoor Tracking option are unavailable in the Maps menu if the layout is locked.

For details, see Lock UI Layout.

Maps also provide the ability to set camera markers and SCADA point coordinates, display them on a map and

monitor SCADA point alarm states in real time.

NOTE

To interact with cameras and SCADA points, you must instal the corresponding licenses. For details, see Licenses.

For SCADA points the SCADA module in SmartPTT Dispatcher settings must be activated.

For information on configuring different maps, see the sections below.
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4.1 Map Settings

The Map Settings window provides the ability to add the desired maps to the Map menu, and to configure some

settings of showing radios on a map.

You can open the Map Settings window by clicking Map → Map Settings on the menu bar.

The Map Settings window consists of two areas:

• The Maps in Use area

• The Radios on Map area

The Maps in Use area provides the ability to add the desired maps to the Map menu. The area provides the

following elements:

Google Maps

Allows to use Google Maps. The check box activates the Google API Key field for typing Google API key to permit

usage of Google maps. To obtain the key, contact your system administrator. When you select the check box and

type the key, the Google Maps option will appear on the Map menu.

OpenStreetMap

Allows to use OpenStreetMap maps at a set URL address. The check box activates the Address field for typing the

server address. The default server address is http://b.tile.openstreetmap.org/. If needed, you can set additional

attributes in the ?<attribute 1>=<value 1>&<attribute 2>=<value 2> format in the server address field. When you

select the check box, the OpenStreetMap option will appear on the Map menu.

Important

SmartPTT does not support HTTP basic authentication, therefore, it must be disabled on a server.
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NOTE

You can restore the default address by clearing the Address field, and then clicking OK.

OpenStreetMap (file)

Allows to use OpenStreetMap maps from files in formats OSM or TILESURL. When you select the check box, the

OpenStreetMap (file) option will appear on the Map menu.

NOTE

When you click OpenStreetMap (file) on the Map menu, an explorer window for setting the path for a file with a

map appears.

Baidu Maps

Allows to use Baidu Maps. The check box activates the API Key field for typing Baidu API key to permit usage of

Baidu maps. To obtain the key, contact your system administrator. When you select the check box and type the

key, the Baidu Maps option will appear on the Map menu.

Map in Polish Format

Allows to use maps from a file in MP format (polish format). When you select the check box, the Map in Polish

Format option will appear on the Map menu.

NOTE

When you click Map in Polish Format on the Map menu, an explorer window for setting the path for a file with a

map appears.

MapInfo

Allows to use MapInfo maps. When you select the check box, the MapInfo option will appear on the Map menu.

For details, see MapInfo.

Raster Maps

Allows to use raster maps. When you select the check box, the Raster Map option will appear on the Map menu

where you can create a new or open an existing map. For details, see Raster Map.

Raster Maps from Database

Allows to use large raster offline maps from databases. When you select the check box, the Raster Maps from

Database option will appear on the Map menu where you can create a new database for a map. For details, see

Maps from Database Window.

The Radios on Map area provides the ability to configure radios that are displayed on maps. The area provides the

following elements:

Hide radios with outdated coordinates

Enables the mode that hides radios with outdated GPS coordinates. For information on outdated coordinates, see

the section Positioning Systems.

Hide offline radios

Enables the mode that hides offline radios.

Information displayed on radio map label

Provides the ability to select the information which is displayed on radio labels:

• Radio Name and Location Time — displays radio names and time of receiving of their coordinates on a map.

• Radio Name — displays only radio names on a map.
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• None — displays only radio icons on a map without any information.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.

Radio icon size

Provides the ability to change size of radio icons on a map. You can select 16х16 pixels and 24х24 pixels.

4.2 Configuring Maps in Use

Follow the procedure to configure maps in use and add the desired maps to the Map menu.

Prerequisites: 

• Obtain a valid API key for Google or Baidu maps for using Google or Baidu maps. To obtain the key, contact

your system administrator.

• Obtain URL address with OpenStreetMap maps for using OpenStreetMap maps. To obtain the address, contact

your system administrator.

Procedure: 

1. On the menu bar, click Map → Map Settings.

The Map Settings window appears.

In the Maps in Use area, select the desired maps:

To allow using of Google maps, perform the following actions:

1. Select the Google Maps check box.

2. In the Google API Key field, type the API key for

Google maps.

To allow using of OpenStreetMap maps located

on a server,

perform the following actions:

1. Select the OpenStreetMap check box.

2. In the Address field, type the map server

address.

To allow using of OpenStreetMap from files, select the OpenStreetMap (file) check box.

To allow using of Baidu maps, perform the following actions:

1. Select the Baidu Maps check box.

2. In the Baidu API Key field, type the API key for

Baidu maps.

To allow using of maps in polish format, select the Maps in Polish Format check box.

To allow using of MapInfo maps, select the MapInfo check box.



372

Maps Configuring Maps in Use

To allow using of raster maps, select the Raster Maps check box.

To allow using of maps from databases, select the Maps from Database check box.

2. Click ОК to save changes and close the window.

4.3 Configuring Map Settings

Follow the procedure to configure the settings of showing radios on a map.

Procedure: 

1. On the menu bar, click Map → Map Settings.

The Map Settings window appears.

In the Radios on Map field, set the desired settings of showing radios:

To hide radios with outdated coordinates, select the Hide radios with outdated

coordinates check box.

To hide offline radios, select the Hide offline radios check box.

2. From the Information displayed on Radio Map Label list, select the information that is displayed on the

radio label:

To display radio name and time of received

coordinates,

select Radio Name and Location Time.

To display only radio name, select Radio Name.

To display only radio icons, select None.

3. From the Radio icon size list, select the desired size for radio icons on a map:

To set the icon size to 16х16 pixels, select 16х16.

To set the icon size to 24х24 pixels, select 24х24.

4. Click ОК to save changes and close the window.

4.4 MapInfo

To use the MapInfo maps, configure settings in the Map Settings window.

NOTE

Before you start, add MapInfo to the Map menu by selecting the corresponding check box in the Map Settings

window. For details, see Map Settings.
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You can open the Map Settings window by clicking Map → MapInfo → New Map on the menu bar.

Map Description File

Provides the ability to specify the desired path and name for the map description file by clicking the Browse (   )

button. The file must have the SPMAP format.

Add (   )

Adds a new layer.

Delete (   )

Deletes the selected layer.

Move Layer Up

Moves the selected layer up in the list.

Move Layer Down

Moves the selected layer down in the list.

Min. Object Size to Show on Map (pixels)

Minimum size of the object on the map in pixels. Affects the level of detail on the displayed map.

Scale to Draw Layer

Scale factor of the layer. The layer objects will not appear on the map when you are zoomed in or out beyond the

specified scale.

Save and Open

Saves changes and opens the map.
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Save

Saves changes in the map description file and closes the Map Settings window.

4.4.1 Configuring MapInfo Map

Follow the procedure to create or edit the MapInfo map in SmartPTT Dispatcher.

Prerequisites: 

Ensure that the MapInfo check box is selected in the Map Settings window. For details, see Map Settings.

Procedure: 

1. On the menu bar, click Map → MapInfo → New Map.

The Map Settings window appears.

2. To the right of the Map Description File field, click the Browse (   ) button, and then specify the path to the

desired SPMAP file or enter a new file name and click Open.

3. In the Map Settings window, perform one of the following actions:

To add a new map layer, perform the following actions:

1. Click Add (   ).

The Select Map Layer File window appears.

2. In the opened window, select the desired file with

a map layer in the TAB format.

3. Click Open.

To edit a layer, perform the following actions:

1. Select the desired layer.

2. In the Min. Object Size to Show on Map (pixels)

field, specify the minimum size of the object on

the map.

3. In the Scale to Draw Layer field, specify the scale

factor beyond which the elements of the layer will

not be displayed on the map.

To change an order of the layers, select the desired layer and change its position using

the Move Layer Up (   ) and Move Layer Down (   )

buttons.

To delete a layer, select the desired layer and click Delete (   ).

4. Click Save to save changes and close the window.

5. (Optional) To open the MapInfo map, perform the following actions:
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a. On the menu bar, click Map → MapInfo → Open Map.

The Select map file window appears.

b. In the opened window, select the desired file in the SPMAP or TTKGP format and click Open.

The selected map appears in the SmartPTT Dispatcher main area.

NOTE

You can create a map in the TTKGP format using the free TatukGIS Viewer.

Postrequisites: 

To open the map after saving it, click Save and Open.

4.5 Raster Map

The Raster Map window provides the ability to create a map from a raster image.

NOTE

Before you start, add Raster Maps to the Map menu by selecting corresponding check box in the Map Settings

window. For details, see Map Settings.

You can open the Raster Map window by clicking Map → Raster Maps → New Map on the menu bar.

http://www.tatukgis.com/Products/EditorViewer/Editions/Viewer.aspx
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The Raster Map window provides the following elements:

Select Image of Map

Provides the ability to specify the desired path and name for the image file by clicking the Browse (   ) button.

The file must have the BMP, JPEG, or PNG format.

Map Parameters

Selected image width and height in pixels.

Points

Matches image points with geographical coordinates. The area provides the following elements:

• The Point column contains the numbers of four selected points. For information on selecting points to match,

see Obtaining Coordinates for Raster Map Configuration.

• The Longitude column contains the selected point longitude obtained from a geographical map.

• The Latitude column contains the selected point latitude obtained from a geographical map.

• The X column contains the selected point coordinate on the X axis in pixels obtained from an image.

• The Y column contains the selected point coordinate on the Y axis in pixels obtained from an image.

Open

Provides the ability to open an existing raster map to modify.

4.5.1 Obtaining Coordinates for Raster Map Configuration

Follow the procedure to obtain coordinates for raster map configuration.

Prerequisites: 

Select an image of the desired area in the BMP, JPEG, or PNG format.

Procedure: 

1. Open an image of the desired area using an image editing program.

2. On the image, select four points using the following guidelines:

• Point 1 must be located as close as possible to the upper-left corner of the image.

• Point 2 must be located as close as possible to the upper-right corner of the image.

• Point 3 must be located as close as possible to the lower-left corner of the image.
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• Point 4 must be located as close as possible to the lower-right corner of the image.

NOTE

It is recommended to use points that are easy to identify on a map (crossroads, tourist attractions, etc.).

3. For each point, note X and Y coordinates in pixels. Coordinates are usually displayed in the lower pane of an

image editing program.

4. Find the same points on Google Maps or in a similar service. Note longitudes and latitudes in decimal format.

NOTE

If coordinates are displayed in degrees, minutes, and seconds, convert them to the decimal format using the

following formula: Decimal Degrees = Degrees + Minutes/60 + Seconds/3600.

Postrequisites: 

In the Points area of the Raster Map window, enter the obtained values for each point. For details, see Configuring

Raster Map.

4.5.2 Configuring Raster Map

Follow the procedure to create or edit a raster map in SmartPTT Dispatcher.

Prerequisites: 

• Obtain point coordinates to match. For details, see Obtaining Coordinates for Raster Map Configuration.

• Ensure that the Raster Maps check box is selected in the Map Settings window. For details, see Map Settings.

Procedure: 

1. On the menu bar, click Map → Raster Maps → New Map.

The Raster Map window appears.

2. In the Raster Map window, perform one of the following actions:

To create a new map, perform the following actions:
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1. To the right of the Select Image of Map field,

click the Browse (   ) button.

2. In the window that appears, select the desired

BMP, JPEG, or PNG file and click Open.

3. In the Points area, specify the coordinates of four

guiding points which will be used to draw a map.

To modify an existing raster map, perform the following actions:

1. Click Open.

2. In the window that appears, select the desired

MAP file and click Open.

3. In the Points area, make the desired changes.

3. Once all necessary changes are made, click Finish.

4. In the window that appears, enter the map name, specify the path, and then click Save.

Important

The created raster map file and the raster map image must be in the same folder.

5. (Optional) To open the raster map, perform the following actions:

a. On the menu bar, click Map → Raster Maps → Open Map.

The Select map file window appears.

b. In the opened window, select a file in the MAP format.

The selected map appears in the SmartPTT Dispatcher main area.

4.6 Maps from Database

SmartPTT Dispatcher provides the ability to work with large offline maps, the size of which is bigger than

5000 х 5000 pixels. The functionality is used for displaying SmartPTT system objects located far from each other. This

is achieved by dividing the original raster image into pieces and storing them in the database.

To create a raster map database, send your request to SmartPTT Technical Support Center and attach the raster map

image in the JPEG format with the list of coordinates on the map, for example, in the TXT or MAP format.

Geographical positions are necessary to anchor image points to the geographical coordinates. You need to provide

the coordinates of four points at the corners of the map. After your request, our technical support specialist will

provide you the database backup of the map in the BAK format.

NOTE

If the attachment(s) size exceeds the limit of 50 MB, split the file to several small files using an archiver or file

manager, or upload it to the file hosting service and include the link to the file in your query message.

Then, restore the database from the received backup. For details, see Managing Databases.

For information on using a map from a database, see the sections below.

https://support.smartptt.com/hc/en-us
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4.6.1 Maps from Database Window

The Maps from Database window provides the ability to create a map from a large raster image stored in a

database.

NOTE

Before you start, add Maps from Database to the Map menu by selecting the corresponding check box in the

Map Settings window. For details, see Map Settings.

You can open the Maps from Database window by clicking Map → Maps from Database → Settings on the menu

bar.

The Maps from Database window provides the following elements:

Delete (   )

Deletes the selected map.

Maps from Database Table

Contains maps from databases. The table consists of the following columns:

• The Name column contains the names of maps stored in the database. To change the name of the map,

double-click the name and type a new name.

• The Database column contains the names of databases.

• The Show column contains check boxes to make the map available/unavailable in the Map menu.

Scan Databases

Scans all available databases of SmartPTT Dispatcher and displays maps stored inside them.



380

Maps Maps from Database

4.6.2 Managing Maps from Database

Follow the procedure to configure the raster maps from a database.

Prerequisites: 

• Ensure that the Maps from Database check box is selected in the Map Settings window. For details, see Map

Settings.

• Request a raster map database, and then restore it from the received backup. For details, see Maps from

Database.

Procedure: 

1. On the menu bar, click Map → Maps from Database → Settings.

The Maps from Database window appears.

2. Click Scan Databases to display all maps from the SmartPTT Dispatcher databases.

3. In the Maps from Database window, perform one of the following actions:

To configure a map, in the Maps from Database Table, perform the

following actions:

1. To change the map name, in the Name column,

double-click the current map name, and then

type the desired name.

2. To display a map in the Map menu, in the Show

column, select the check box for the desired map.

To delete a map from the list, in the Maps from Database Table, select the desired

map, and then click Delete (   ).

4. Click Save to confirm changes and close the window.

Postrequisites: 

To open the map, select the desired map in Map → Maps from Database.

4.7 Indoor Tracking

Big organizations with huge premises require constant control over their employees' displacement inside buildings.

For this purpose Indoor Tracking system was implemented. Indoor Tracking system allows getting data from special

beacons and transmitting it to SmartPTT Dispatcher or any other client application using API. Contact our technical

support (http://support.smartptt.com/hc/en-us) for SmartPTT Client API documentation.

Currently, SmartPTT system supports the following technologies and products:

• iBeacon technology: With the use of MOTOTRBO radios with the firmware version 2.6 and above and the

beacons that support iBeacon technology

• Blufi option boards (RF800): With special beacons (Connect-RTLS RF800)

http://support.smartptt.com/hc/en-us
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• Kilchherr option boards (K-TERM 44): With special beacons (K-TERM 70IC Beacon Transmitter)

Important

This functionality requires the corresponding license. For details, see Licenses.

NOTE

The Indoor Tracking feature is available only for MOTOTRBO radios with the firmware version 2.6 and above or

for radios with special option boards (see above). Also, it is necessary to configure special settings in SmartPTT

Radioserver Configurator and SmartPTT Dispatcher. The desired settings for SmartPTT Radioserver are described

in the Indoor Tracking section of the SmartPTT Radioserver Configurator help file.

NOTE

If the user authorization service is activated, the name of the currently authorized user is displayed next to the

radio name in the parentheses. For details, see General Settings.
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To enable Indoor support for a radio in SmartPTT Dispatcher, open the Properties window of the radio and in the

Location tab select Indoor Tracking. For details, see Radio Location Properties.

NOTE

If you use the Motorola source (iBeacon technology), the Update Interval check box must be selected and

specified together with the Indoor Tracking check box for enabling Indoor support for a radio.

To create a building plan, expand the Map menu on the menu bar of the SmartPTT Dispatcher window and click

Indoor Tracking → New Building Map. In the Floor Plan window you can create a plan of the building floor or of a

multi-store building.
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Building Name

A name of the building plan.

To add a floor of a building, click the Add button. To remove a floor of a building, select it from the list and click

Delete. To change the floor order inside the building, use the Up and Down buttons.

Floor

A name or an ordinal number of a floor in a building. To change the name of the floor, click the old name in the

Floor field and type a new value.

File Path

A path to the floor plan file. You can use a floor plan in the .dwg format or a raster image. To attach a plan to the

floor, click the   button and select the desired file.

NOTE

.dwg (drawing) is a binary file format used for storing two and three dimensional design data and metadata. It is

the native format for several CAD packages including nanoCAD, AutoCAD, IntelliCAD.

Save

You can save the floor or the building plan changes to the .splanx (archive) format.

To open a building plan, expand the Map menu on the menu bar of the SmartPTT Dispatcher window and click

Indoor Tracking → Open Indoor Map. To control more than one building at the same time in SmartPTT Dispatcher,

you can open several Indoor Tracking panels.

Building Floor Plan

Save

You can save the building plan changes to a .splanx file.

Save As

You can save a copy of the building plan with another name.

View Mode (2D or 3D)

A mapping of the building plan in a two- or three-dimensional form. This feature is available only for floor plans in

the .dwg format.

Add Beacon

You can add a beacon to the building plan.

For that, in the Beacon Settings window specify the beacon number and name in the corresponding fields and click

OK. The beacon icon (   ) appears instead of the mouse cursor. Place it on the map where the beacon is located and

left click. If you use the Motorola source, specify the number of the beacon in the Beacon Number field in the

Major.Minor format, where the Major value is separated from the Minor value by a dot. Major stands for the group

number of the beacons and Minor stands for the individual number of the beacon in the group.

If you use the BluFi or Kilchherr source, specify the Beacon IDs in the Beacon Number field. If the beacon name is

not specified in the Beacon Name field, the value from the Beacon Number field will be displayed as the beacon

name on the building plan. To remove the beacon from the plan, double-click the beacon and in the window that

appears click Delete.
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Geofences

Allows you to unite the existing beacons to control the radios moving about the building. These geofences are

used in Indoor positioning rules. 

Routes

Allows you to create routes for radios. These routes are used in Indoor positioning rules.

Edit Plan

Opens the Floor Plan window that allows you to change the floor name, the floor order inside the building, or the

floor plan file.

Grid Size

The grid size of the building plan. For building plans based on raster images, the Grid Size option is not available.

Label Size

The size of the radio and beacon labels displayed on the building plan.

Beacons

Select a color for a beacon label.

Radios

Select a color for a radio label.

Radios on Plan

A list of radios which support the Indoor Tracking feature. Select the check box, to display the radio labels on the

building plan.

When the alarm is registered, the radio, that sent the alarm, will center on the building plan, and a red frame will

appear around it (if Indoor-positioning support is enabled). Other radios in the alarm zone and radios added to

the category for emergency will be displayed on the plan too. Radios not in the alarm zone will be hidden. After

resolving the emergency situation, the radios hidden during the alarm will not be automatically displayed.

For information on the category for emergency, see Emergencies.

Radio Tracks

Here you can record tracks of radios and watch them in real time, or check old records. To watch the radio move

about the building, click Add Track. In the window that appears specify the following parameters:

Source

The radioserver whose data will be used for building a track. If the list is empty, check that Event Log is activated in

SmartPTT Radioserver Configurator.

Radio

Radio ID or name.

User

User name.

Color

The color of the future radio track.

Start Date

Start time and date of the track record.
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End Date

End time and date of the track record. To watch the radio moving in real time, select Update in real time.

Show All

Shows tracks of all the radios from the Radios on Plan list. You can see details of each track. To open Track

details, click Track details (  ):

Clear All

Removes all the track records displayed at the moment.

The following buttons allow to control the way the building plan is displayed:

Zooming up the marked area of the building plan. Click the button, then left-click the building plan and

mark the necessary area.

Zooming up or zooming out the entire building plan. To zoom in, click the button and withholding the

button pressed move the mouse pointer up. To zoom out – move the mouse pointer down. Also, use

the wheel button to change the scale of the building plan.

Moving the building plan. Click the button and withholding the button pressed relocate the plan.

Fits the scale of the building plan to the size of the Indoor Tracking Overview Map panel.

The following object is available to three-dimensional building plans only. It allows to change an angle of the

displayed building plan.

4.8 Coverage Map

Coverage maps display information on the received signal strength (RSSI) of radios in a specific area.

Important

The coverage map feature is only available to the Administrator and operators with the corresponding permission.

For details, see Operators.

Important

To use the coverage map feature, the corresponding license must be installed. For details, see Licenses.
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To build a coverage map for a radio, make sure that it has GPS enabled, and there is GPS data in the database. For

details, see Radio Location Properties.

Important

A radio that uses the LIP protocol to transmit location data on the current channel can not be used as a source of

information about RSSI when building a coverage map. For information on protocol types, see “Location” in

SmartPTT Installation and Configuration Guide.

Example

For information on building a coverage map, see the sections below.
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4.8.1 RSSI Range Settings

The Coverage Map Settings window provides the ability to configure the number of ranges, their upper and lower

limits, and colors.

To open the Coverage Map Settings window, on the SmartPTT Dispatcher menu bar, click Map → Coverage map →

RSSI ranges.

The Coverage Map Settings window provides the following elements:

Add (   )

Adds an RSSI range.

Delete (   )

Deletes the selected RSSI range.

NOTE

The initial and end ranges can not be deleted.

Reset (   )

Resets the RSSI ranges settings to default.

RSSI Range Table

Provides the list of configured ranges. The table consists of the following columns:

• The From, dBm column contains the initial value of the RSSI range in decibel-milliwatts.

• The To, dBm column contains the end value of the RSSI range in decibel-milliwatts.

• The Color column provides a palette with colors that can be used to display the RSSI range.
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4.8.2 Configuring RSSI Ranges

Follow the procedure to configure RSSI ranges in SmartPTT Dispatcher.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure an operator has the View coverage map right. For details, see Operator Window.

Procedure: 

1. On the menu bar, click Map → Coverage map → Coverage Map Settings.

The Coverage Map Settings window appears.

2. In the Coverage Map Settings window, perform one of the following actions:

To add a new range, perform the following actions:

1. Click Add (   ).

2. In the RSSI Range Table, in the To, dBm column,

specify the end value of the added range.

To delete a range, in the RSSI Range Table, select the desired range, and

then click Delete (   ).

NOTE

The initial and end ranges can not be deleted.

To configure the range color, in the corresponding table entry, in the Color column,

from the expandable palette, select the desired color.

To reset ranges settings to default, click Reset(   ).

3. Click ОК to confirm changes and close the window.

Postrequisites: 

Build the coverage map. For details, see Building Coverage Map.



389

Maps Coverage Map

4.8.3 Coverage Map Settings

The Coverage Map Settings window provides the ability to configure the display of signal strength (RSSI) in a

specific area.

You can open the Coverage Map Settings window by clicking Map → Coverage map → Show on the menu bar.

The Coverage Map Settings window provides the following elements:

All radios

If selected, the coverage map will be built for all radios in the list on the right.

Select radios

If selected, the coverage map will be built for the radios selected in the list on the right.

Select categories

If selected, the coverage map will be built for the radio categories selected in the list on the right.

Source

Provides the list of the database sources which will be used to build the coverage map. Either the SmartPTT

Dispatcher database (the Dispatcher value) or the database of one of the available radioservers can be used as a

data source.

Resolution

Provides the list of radii to check the signal strength.

NOTE

The units of measurement can be selected in the positioning settings. For details, see Positioning Systems.
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Coverage Map with Different Resolutions Example

 

Start date

The beginning of the period, data from which will be used to build a coverage map.

End date

The end of the period, data from which will be used to build a coverage map.

4.8.4 Building Coverage Map

Follow the procedure to build coverage map SmartPTT Dispatcher.

Prerequisites: 

• Ensure you have the corresponding license. For details, see Licenses.

• Ensure an operator has the View coverage map right. For details, see Operator Window.

• Ensure that the GPS is enabled for the desired radios, and the database contains GPS data. For details, see

Radio Location Properties.

• Configure RSSI ranges in the RSSI settings window. For details, see Configuring RSSI Ranges.

Procedure: 

1. On the menu bar, click Map → Coverage map → Show.

The Coverage Map Settings window appears.

2. In the opened window, select radios to build a coverage map:

To build a coverage map for all available radios, select All radios.

To build a coverage map for specific radios, perform the following actions:

1. Select Select radios.
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2. Select the desired check boxes in the area on the

right.

To build a coverage map for specific radio

categories,

perform the following actions:

1. Select Select categories.

2. Select the desired check boxes in the area on the

right.

3. From the Source list, select the data source to build a coverage map:

To use the SmartPTT Dispatcher database as the

data source,

select Dispatcher.

To use the database of one of the available

radioservers as the  data source,

select the value with the desired SmartPTT

Radioserver name.

4. From the Resolution list, select the desired radius for checking signal strength.

5. In the Start date and End date fields, enter the desired date and time to build a coverage map for a specific

period.

6. Click OK to confirm changes and close the window.

The coverage map appears in the main area of SmartPTT Dispatcher.

Postrequisites: 

To hide the coverage map, on the menu bar, click Map → Coverage map → Hide.

4.9 Map Control Panel

On a map in SmartPTT Dispatcher you can see the control panel in the right part of the screen. The panel provides

features to manage displaying of radios, and other objects on maps. For details, see Radios. On the panel users can

perform the following actions:

• Configure displaying of radios on a map.

• Display information on radios movements on a map for a period of time by using tracks.

• Animate tracks of radios.

• Display important objects on a map by adding points of interest.

• Display location of SCADA points and monitor their state.

• Display location of cameras and watch live video.

• Configure geofences for radios.

• Configure routes for radios.

Radios are displayed on map as markers. Markers consists of the following elements:

• Radio icon — icon image that is set in the radio settings. For details, see Common Radio Properties.
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NOTE

If a status is assigned to a radio, a frame of status color appears around the radio icon. For information on radio

statuses, see Statuses.

• Radio label — contains radio name and/or time of receiving its coordinates. Radio labels with valid coordinates

are colored on a map in yellow. Radio labels with outdated coordinates are colored on a map in gray. Radio

label can be hidden. For information on displaying radio labels, see Map Settings.

By default, the expanded control panel is not pinned, and it automatically collapses by clicking on a map. The Pin ( 

 ) button pins the expanded panel, and in this state you can collapse it only by clicking Radios, Tracks, or Objects on

Map buttons.

For information on using the control panel, see the sections below.

4.9.1 Radios on Map

The Radios panel displays the list of mobile and portable radios that provide their coordinates to the SmartPTT

dispatch system. The user of the dispatch console may operate with the limited amount of radios.

You can open the panel by clicking Radios in the right part of the open map.
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The Radios panel consists of two tabs:

• Radios displays a list of radios

• Categories displays a list of radio categories and list of radios for every category

Both tabs have the following elements:

Search field (   )

You can search a radio in the list of radios by typing its name or ID.

All Radios

You can use the element to control displaying of all radios on a map.

Radio

Shows the name of the radio that either provides its GNSS coordinates to SmartPTT or which location is set by the

dispatch console user. Radios can be in one of two states:

• Online (   )

• Offline (   )

Valid coordinates (   )

Indicates that GPS coordinates of a radio are valid. You can see it to the right of the radio name.

Outdated coordinates (   )

Indicates that GPS coordinates of a radio are outdated or missing. You can see it to the right of the radio name.

NOTE

Validity period of GPS coordinates is determined by the Validity of GPS coordinates parameter in Positioning

Systems. For details, see Positioning Systems.

Indicators of radio state

Indicators determine radio displaying on a map. You can use indicators to change displaying of certain radios,

radio categories (in the Categories tab), or all radios (the All Radios element).

In the Radios panel, indicators have the following states:

Fixed on map (   )

A radio (or a radio category) is fixed on a map and it does not hide even if the radio goes offline or its coordinates

become outdated.

Hidden on map (   )

A radio (or a radio category) is hidden on a map and does not appear on it even if the radio becomes online or

sends its valid coordinates.

On map (   )

A radio is displayed on a map, but is hidden when the radio goes offline or its coordinates become outdated.

The indicator can be set by right-clicking when the following conditions are met:

• Radio is online, and the Hide offline radios check box is cleared in the Map Settings window. For details, see

Map Settings.

• Database has up-to-date location of the radio, and the Hide radios with outdated coordinates check box is

cleared in the Map Settings window.
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Not on map (   )

A radio is hidden on a map because its coordinates outdated or it is offline. When the radio becomes online or

sends its valid coordinates, it appears on a map.

The indicator can be set by right-clicking when the following conditions are met:

• Radio is offline, and the Hide offline radios check box is selected in the Map Settings window.

• Database has only outdated location of the radio, and the Hide radios with outdated coordinates check box

is selected in the Map Settings window.

Mixed state (   )

The indicator appears in the following conditions:

• After right-clicking the All Radios element to restore all radios to the states (on map or not on map) they were in

before clicking the indicators.

• Next to the radio categories names when radios in the categories are in mixed states.

On any open map, users can select an area by pressing Ctrl and left mouse button to find radios in the area. The

Radios panel with radios in the selected area opens. You can cancel the selection, by clicking the Cancel Selection

button.

For details, see Displaying Radios in Area.

4.9.2 Displaying Radios

Follow the procedure to configure displaying radios on a map.

Prerequisites: 

Determine the radios to display or hide on a map.

NOTE

For information on all radio state indicators and other elements of the Radios panel, see Radios on Map.

Procedure: 

1. In the right part of the open map, click Radios.

The Radios panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Radios panel, select the Radios tab.

4. Configure radios displaying on a map:

To display or hide all radios, click the indicator next to All Radios, until the desired

state appears.

To display or hide the radio, click the indicator next to the radio name, until the

desired state appears.

To cancel the changes of displaying the radio, right-click the indicator next to the radio name.
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To cancel the changes of displaying all radios, right-click the indicator next to All Radios.

The indicator changes to Mixed State (   ).

NOTE

Radios are hidden or displayed on a map depending on the map settings. For details, see Map Settings.

4.9.3 Displaying Radio Categories

Follow the procedure to configure displaying radio categories on a map.

Prerequisites: 

Determine the radio categories to display or hide on a map.

NOTE

For information on all radio state indicators and other elements of the Radios panel, see Radios on Map.

Procedure: 

1. In the right part of the open map, click Radios.

The Radios panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Radios panel, select the Categories tab.

4. Configure radio categories displaying on a map:

To display or hide all radios and all categories, click the indicator next to All Radios, until the desired

state appears.

To display or hide radios of the category, click the indicator next to the category name, until

the desired state appears.

To display or hide the radio in the desired category, select the desired category, and then click the

indicator next to the radio name, until the desired

state appears.

To cancel the changes of displaying the radio, right-click the indicator next to the radio name.

To cancel the changes of displaying all radios, right-click the indicator next to All Radios.

The indicator changes to Mixed State (   ).

NOTE

Radios are hidden or displayed on a map depending on the map settings. For details, see Map Settings.
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4.9.4 Displaying Radios in Area

Follow the procedure to display the list of radios located on the selected area of a map.

Prerequisites: 

Determine the desired area on a map, where you want to see radios.

Procedure: 

Press and hold Ctrl and with the left button of mouse select the desired area.

In the Radios panel, the list of radios which are in the selected area appears.

Postrequisites: 

To cancel the selection and display all radios in the list, click the Cancel selection button.

4.9.5 Setting Radio Location

Follow the procedure to set the radio location on a map.

Prerequisites: 

Determine the radio for which you want to set the location.

Procedure: 

1. Open the Set Location panel in one of the following ways:

• If the desired map is open, in the Radios panel in the right part of the screen, right-click the desired radio,

and then select Set Locations.

• If the desired map is closed, in the Actions Menu or Call Window of the radio, click Set Locations and select

the map.

The Set Location panel opens.

For information on the Actions or Call Window of a radio, see Radio Actions Menu and Radio Call Window.

2. Set the radio location in one of the following ways:

• Click the desired place on a map.

• In the Set Location panel, in the Latitude and Longitude fields, type the desired coordinates.

3. Click Save to save changes.

The radio appears on a map.

Postrequisites: 

To remove the radio from a map, in the Actions Menu or Call window of a radio, click Remove from Map.
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4.9.6 Tracks

On the Tracks panel you can manage radios tracks, display them, and track radio movements on a map.

Important

To manage tracks, an operator needs to have the corresponding permission. For details, see Operators.

You can open the panel by clicking Tracks in the right part of the open map.

When you start working with a map, the following controls are available on the panel:

Add Track

Opens the Track panel for adding a new track on the map.

For details, see Track.

Clear Tracks

Deletes all tracks from the current map.

When at least one track is added in the Tracks panel, the track entry appears on the panel. A track entry contains the

following elements and controls:

Radio name

Displays a name of a radio for which the track is shown.

Date and time of a track

Displays a period of a track, set in the Track panel when the track is added.

Color and thickness of a track

Displays a color and thickness of a track line, which are set in the Track panel when the track is added.

Track Details (   )

Opens the Track Details panel for the track animating.

For details, see Track Details.

Edit (   )

Opens the Track panel for the track editing.
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NOTE

If you edit a track with 30 minutes, 1 hour or Today period, the track will be changed for the set period according

to the moment the editing is finished.

Delete (   )

Deletes the track from a map and from the Tracks panel.

4.9.6.1 Track

On the Track panel you set parameters for showing a radio track on the current map.

You can open the panel by clicking the Add Track button on the Tracks panel. For details, see Tracks.

NOTE

For information on displaying a track on a map, see Displaying Tracks.

The Track panel provides the following elements:

Data source

Contains a list of available SmartPTT Dispatcher or radioserver databases to show a track of the selected radio.

Radios

A list that contains available radios to show a track. If the track is added from the Actions Menu of a radio, in the

list of radios, the radio is selected automatically.

For information on radio Actions Menu, see Radio Actions Menu.

Period

In the list you can select a period of radio moving to show a track:

• The 30 minutes period shows radio movement for the last 30 minutes.

• The 1 hour period shows radio movement for the last hour.

• The Several hours period shows radio movement for the last several hours.

• The Today period shows radio movement for today, starting from 00:00:00 hours of the current day until the

moment the track is shown.
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• The Custom range period shows radio movement for the desired time period.

Start date and End Date

The fields appear when from the Period list the Custom range value is selected. You should enter the start and

end dates of radio movement period. When you click  , the calendar opens. In these fields you also may enter the

desired time manually in the hh:mm:ss format.

Hours

The field appears when from the Period list the Several hours value is selected. You should enter the amount of

hours.

Color

Provides a palette with track line colors. The example of the line with the selected color appears on the right.

Line thickness

Provides parameters of a track line thickness. The example of the line with the desired thickness appears above

the list.

Show

Shows the track on the current map, and adds the track entry to the Tracks panel.

4.9.6.2 Track Details

On the Track Details panel you can get information on a track and animate it.

You can open the Track Details panel by clicking Track Details (   ) of the track entry on the Tracks panel. For

details, see Tracks.

NOTE

For information on track animating, see Animating Tracks.

The Track Details panel contains the following elements and controls:

Track name

Corresponds to the name of a radio for which the track is shown.

Track line color and thickness

Displays the track line color and thickness set in the Track panel when the track is added.
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Date and time

Displays a track period set in the Track panel when the track is added.

Track playback controls

Controls that are used to playback track animation:

• Start Playback (   ) — starts the track animation.

• Pause Playback (   ) — pauses the track animation.

• Stop Playback (   ) — stops the track animation.

• Decrease speed (   ) — decreases the track animation speed.

• Increase speed (   ) — increases the track animation speed.

NOTE

The system remembers the last track animation speed and uses it during next track animation.

Track details table

Contains the following columns:

• Date and time — displays date and time for each track point.

• Distance — displays the distance between the track points.

• Stop duration — displays the duration when the radio stops moving.

• Speed — displays the radio movement speed in the each track point.

• Precision — displays the coordinates precision.

You can double-click a table line to show a track on the map in the desired moment of time.

4.9.6.3 Displaying Tracks

Follow the procedure to display a radio track on a map.

Prerequisites: 

• Ensure an operator has rights to manage tracks. For details, see Operators.

• Ensure that saving GPS locations in databases is turned on in the Positioning Systems.

NOTE

Track can be shown on map when the radio has a least one coordinate.

Procedure: 

1. In the right part of the open map, click Tracks.

The Tracks panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Tracks panel, click Add Track.

The Track panel opens.

4. From the Data Source list in the Track panel, select the database which is used for creating the track.
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5. From the Radios list, select the radio whose track is displayed.

6. From the Period list, select the time period of the track.

• If from the Period list the Several hours value is selected, in the Hours field, enter the desired amount of

hours.

• If from the Period list the Custom range is selected, in the Start Date and End Date fields, set the desired

date and time.

7. From the Color palette, select the track line color on a map.

8. From the Line Thickness list, select the desired thickness of the track line.

9. Click Show to display the track on a map.

The track appears on the map, and the track entry appears in the Tracks panel.

Postrequisites: 

• To edit the track, in the Tracks panel, select the desired track in the list, and click Edit (   ).

• To remove a track, in the Tracks panel, select the desired track in the list, and click Delete (   ).

• To delete all tracks on the current map, in the Tracks panel, click Clear Tracks.

4.9.6.4 Animating Tracks

Follow the procedure to animate a radio track on a map.

Prerequisites: 

• Ensure the desired radio track is in the list of tracks.

• Ensure an operator has rights to manage tracks. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Tracks.

The Tracks panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. Select from the tracks list the desired track, and click Track Details (   ).

The Track Details panel opens.

4. On the Track Details panel, click Start Playback (   ).

The track starts animating on a map. The button Start Playback (   ) changes to Pause Playback (   ).

NOTE

You can control the animation speed of the track with the corresponding controls. For details, see Track Details.

5. (Optional) To display the radio position at certain time, double-click the desired entry in the track details table.

Postrequisites: 

To stop the track animation, click Stop Playback (   ).
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4.9.7 Objects on Map

In the Objects on Map panel you can add the following elements to a map:

• Points of interest to mark important objects.

• Geofences to select areas.

• Routes to connect key points.

• Cameras that are used to provide the ability at any time from any location to watch what is happening on the

object.

• SCADA points to display and monitor state of the points configured in the SCADA system.

NOTE

To interact with cameras and SCADA points, you must instal the corresponding licenses. For details, see Licenses.

For SCADA points the SCADA module in SmartPTT Dispatcher settings must be activated.

You can open the panel by clicking Objects on Map in the right part of the open map.

You can manage objects on maps in the corresponding tabs.

For details, see Points of Interest, Geofences, Routes, Cameras, and SCADA Points.

NOTE

The tabs with added points of interest, geofences, routes, cameras and SCADA points are the same for all maps.

4.9.7.1 Cameras

On the Cameras tab, you can add new or edit and delete existing camera markers.

Important

To manage camera markers on a map, an operator needs to have the Manage cameras right. For information on

the operator rights, see Operators.
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To add a camera marker on a map, it must first be added and configured in the Avigilon video monitoring system.

For details, see “Avigilon” in SmartPTT Installation and Configuration Guide.

When you first start working with a map, only one control is available on the tab:

Add camera

Opens the Camera panel for adding a new camera marker on a map. For details, see Camera.

When at least one point has been added to the list of camera markers, the following elements and controls appear in

the panel:

Show on Map

The check box responsible for showing or hiding the camera marker on a map.

NOTE

The window with live video is opened when clicking the desired camera marker on a map.

Camera Name

Camera name that is displayed on a map if the Show name on map check box is selected in the Camera panel.

When clicking the camera name, a map is centered on the camera.

Edit (   )

Opens the Camera panel where you can edit the camera marker settings.

Delete (   )

Removes a camera from the list of cameras and from all maps in SmartPTT Dispatcher.

NOTE

The Edit and Delete buttons are displayed only if an operator has the Manage cameras right. For details, see

Operator Window.

Status

Displays the current status of a camera. In SmartPTT, two statuses are available to cameras:

• Camera removed (a camera is deleted in the Avigilon system).
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• No connection:

• No connection between SmartPTT Dispatcher and SmartPTT Radioserver.

• No connection between SmartPTT Radioserver and the Avigilon server.

• No connection between the Avigilon server and a camera.

Important

When connection is established, no status will appear.

NOTE

When removing a camera from the Avigilon system, its name in SmartPTT is highlighted in pale gray. The Edit (   )

button becomes unavailable.

4.9.7.1.1 Camera

In the Camera panel, you can add and configure a new camera marker, or edit an existing one.

The panel appears when you add or edit camera markers.

For details, see Adding Cameras, Editing Objects Using Map, and Editing Objects Using Panel.

The Camera panel contains the following controls and elements:

Camera

List of cameras whose markers can be displayed on a map. The list of cameras is duplicated from the Avigilon

video monitoring system server. Cameras in the list are displayed in the same order as in the Avigilon system.

NOTE

If SmartPTT is connected to two SmartPTT Radioservers, each of which is connected to its own Avigilon system,

cameras in this list are displayed in the following order: cameras of one system, then cameras of the second

system. If no connection is established, the list with cameras will be empty.

Name

The camera name.
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Show name on map

This check box provides the ability to display the camera name over its marker on a map.

Latitude and Longitude

The coordinates of the camera marker in the format that is set in SmartPTT Dispatcher settings. By default, the

Decimal Degrees format is used.

Alternatively, you can set the camera marker location by clicking the desired position on a map.

Save

Adds a new camera marker on a map or saves changes in the settings of the existing one.

4.9.7.1.2 Adding Cameras

Follow the procedure to add a camera marker on a map.

Prerequisites: 

• Ensure the desired camera was added and configured in the Avigilon system.

• Ensure an operator has the Manage cameras right. For information on the operator rights, see Operators.

Procedure: 

1. In the right part of the desired map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, click the Cameras tab.

4. On the Cameras tab, click Add Camera.

The Camera panel appears.

5. From the Camera list, select the desired camera.

6. In the Name field, type the desired camera name.

7. (Optional) To show the name of the camera marker on a map, select the Show name on map check box.

8. Specify the camera marker location on a map in one of the following ways:

To specify the camera marker location on a map

with a mouse,

click the desired location on a map.

The camera marker appears in the specified

location on a map.

To specify the camera marker location in the other

way,

in the Latitude and Longitude fields, type the

desired coordinates.

The camera marker appears in the specified

location on a map.
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9. Click Save to save the camera marker.

The added camera marker appears in the list on the Cameras tab of the Object on Map panel.

Postrequisites: 

• To edit the camera marker, see Editing Objects Using Panel or Editing Objects Using Map.

• To delete the camera marker, see Deleting Objects.

4.9.7.1.3 Watching Live Video

SmartPTT with the integrated Avigilon video monitoring system, provides operators with the ability to monitor

what’s happening on the object at any given time.

Live video from a camera is carried out in a separate window, which appears when you click the marker of the desired

camera on a map.

Only one window with live video can be opened at a time. If you open the window and try to open another one, then

a previously opened window will automatically be closed.

If the live video is minimized together with SmartPTT Dispatcher, then when SmartPTT Dispatcher opens, the window

with live video will restore its previous location on the operator’s monitor screen. If the window with live video is

closed together with SmartPTT Dispatcher, then the next time SmartPTT Dispatcher opens, the window with live

video will not be restored.

4.9.7.2 Points of Interest

On the Points of Interest tab you can go to the panel for managing the existing points of interest on maps, or

adding new points of interest.

Important

To manage points of interest, an operator needs to have the corresponding permission. For details, see Operators.
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NOTE

For information on adding a point of interest on a map, see Adding Points of Interest.

When you start working with a map, only one control is available on the tab:

Create Point of Interest

Opens the Point of Interest panel for adding a new point of interest on a map.

When at least one object is added in the Points of Interest tab, the following elements and controls are available:

Show on Map

You can select or clear the check box to display or hide a point of interest on a map.

Point of Interest Name

Displays a point of interest name which is set in the Point of Interest panel when the object is added. When you

click the point of interest name, the map is centered on it.

Point of Interest Marker

Marker image of a point of interest which is selected in the Point of Interest panel when the point of interest is

added. When you click the point of interest marker, the map is centered on the point.

Edit (   )

Opens the Point of Interest panel, where you can edit a point of interest parameters.

Delete (   )

Removes a point of interest from the Points of Interest tab and from all maps.
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4.9.7.2.1 Point of Interest

In the Point of Interest panel you can configure parameters of a new point of interest, or edit an existing point of

interest.

The panel opens when you create a new or edit an existing point of interest.

For details, see Adding Points of Interest, Editing Objects Using Map, and Editing Objects Using Panel.

The Point of Interest panel contains the following controls and elements:

Name

In the field, a name of a point of interest is typed. The name appears when you hover the mouse cursor over the

point of interest on a map.

Icon

You can select the icon from the list or load the desired image that is used as the point of interest marker. The

image size must not exceed 5 MB.

Latitude and Longitude

You should enter coordinates of a point of interest. An alternative way of adding a point of interest is to click the

desired location on a map.

Save

Adds the point of interest to the points of interest list which is available on all maps.

4.9.7.2.2 Adding Points of Interest

Follow the procedure to add a point of interest on a map.

Prerequisites: 

Ensure an operator has the rights to configure points of interest. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, open the Points of Interest tab.
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4. On the Points of Interest tab, click Create Point of Interest.

The Point of Interest panel opens.

5. In the Name field of the Point of Interest panel, type the name of the point of interest.

6. (Optional) From the Icon list, select an image for the point on a map.

NOTE

You can download the image by clicking the button (   ). Images of large size are cropped to 48×48.

7. Set the point location on the map in one of the following ways:

• Click the desired location on a map.

• In the Latitude and Longitude fields, type the desired coordinates.

8. Click Save to save the point of interest.

The added point appears on a map, and in the list of the Points of Interest tab of the Object on Map panel.

For details, see Points of Interest.

Postrequisites: 

• To display or hide the point of interest on a map, in the points list, next to the desired point name select or

clear the Show on Map check box.

• To edit the point of interest, see Editing Objects Using Map.

• To remove the point of interest, see Deleting Objects.

4.9.7.3 Geofences

On the Geofences tab you can go to the panel for managing the existing geofences on maps, or adding new

geofences.

Important

To manage geofences, an operator needs to have the corresponding permission. For details, see Operators.

NOTE

For information on adding a geofence on a map, see Adding Geofences Using Map.
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When you start working with a map, only one control is available on the tab:

Create Geofence

Opens the Geofence panel for adding a new geofence on a map.

When at least one geofence is added in the Geofences tab, the following elements and controls are available:

Show on Map

You can select or clear the check box to display or hide a geofence on a map.

Geofence Name

Displays a geofence name which is set in the Geofence panel when the object is added. When you click the

geofence name, the map is centered on it.

Geofence Color

Displays color of a geofence, set in the Geofence panel, when the object is added. When you click the geofence

line, the map is centered on it.

Edit (   )

Opens the Geofence panel, where you can edit a geofence parameters.

Delete (   )

Removes a geofence from the Geofences tab and from all maps.

Geofences can be used in positioning rules to track radios in the area.

For details, see Positioning Rules.
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4.9.7.3.1 Geofence

On the Geofence panel, you can configure parameters of a new geofence, or edit the existing geofences.

The panel opens when you create a new geofence, or edit the existing.

For details, see Adding Geofences Using Map, Adding Geofences Using Table, Editing Objects Using Map, and Editing

Objects Using Panel.

The Geofence panel contains the following controls and elements:

Name

In the field, a name of a geofence is typed.

Geofence Color

Displays color of geofence, set in the Geofence panel, when the geofence is added.

Edit in Table

Activates adding or editing the existing geofence points using the Points table. When you click the button, its

name changes to Edit on Map.

Points Table

You can activate the table by clicking Edit in Table. You can add coordinates by clicking the Add coordinate (   )

button. The order of the geofence points in the table corresponds to the points sequence on a map.

Edit on Map

Activates adding or editing the existing geofence points on a map. To add a geofence, click at least three points on

the desired locations of a map.
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Save

Adds the geofence to the geofence list which is available on all maps.

4.9.7.3.2 Adding Geofences Using Map

Follow the procedure to add a geofence on a map.

Prerequisites: 

Ensure an operator has the rights to configure geofences. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, open the Geofences tab.

4. On the Geofences tab, click Create Geofence.

The Geofence panel opens.

5. In the Name field of the Geofence panel, type the name of the geofence.

6. From the Color palette, select the color for the geofence on a map.

7. Set the geofence location on a map by clicking at least three desired points on a map. Double-click the last

point to finish drawing.

8. Click Save to save the geofence.

The added geofence appears on a map, and in the list in the Geofences tab of the Objects on Map panel.

Postrequisites: 

• To show or hide the geofence, in the Geofences, select or clear the Show on map check box.

• To edit the geofence, see Editing Objects Using Panel or Editing Objects Using Map.

• To remove the geofence, see Deleting Objects.

4.9.7.3.3 Adding Geofences Using Table

Follow the procedure to add a geofence on a map.

Prerequisites: 

Ensure an operator has the rights to configure geofences. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, open the Geofences tab.
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4. On the Geofences tab, click Create Geofence.

The Geofence panel opens.

5. In the Name field of the Geofence panel, type the name of the geofence.

6. From the Color palette, select the color for the geofence on a map.

7. Click the Edit in Table button.

The Points table becomes active.

8. Add at least three points by clicking the Add coordinate (   ) button.

The lines for adding coordinates appear in the table.

9. In the table, perform the following actions:

a. In the Latitude column, type the desired latitude of points.

b. In the Longitude column, type the desired longitude of points.

10. Click the Save button.

The current panel changes to the Objects on Map panel.

Postrequisites: 

• To delete a point from the table, select the desired line with coordinates and click Delete coordinate (   ).

• To show or hide the geofence, in the Geofences, select or clear the Show on map check box.

• To edit the geofence, see Editing Objects Using Panel or Editing Objects Using Map.

• To remove the geofence, see Deleting Objects.

4.9.7.4 Routes

On the Routes tab, you can go to the panel for managing the existing routes on maps, or adding new routes.

Important

To manage routes, an operator needs to have the corresponding permission. For details, see Operators.

NOTE

For information on adding a route on a map, see Adding Routes Using Map.
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When you start working with a map, only one control is available on the tab:

Create Route

Opens the Route panel for adding a new route on a map.

When at least one route is added in the Routes tab, the following elements and controls are available:

Show on Map

You can select or clear the check box to display or hide a route on a map.

Route Name

Displays a route name which is set in the Route panel when the object is added. When you click the route name,

the map is centered on it.

Color and thickness of a route line

Displays color and thickness of a route line, which are set in the Route panel. When you click the route line, the

map is centered on it.

For details, see Route.

Edit (   )

Opens the Route panel, where you can edit a route parameters.

Delete (   )

Removes a route from the Routes tab and from all maps.

Routes can be used in positioning rules to track that radios follow the desired route.

For details, see Positioning Rules.
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4.9.7.4.1 Route

On the Route panel you can configure parameters of a new route, or edit the existing routes.

The panel opens when you create a new route, or edit the existing.

For details, see Adding Routes Using Map, Adding Routes Using Table, Editing Objects Using Map, and Editing

Objects Using Panel.

The Routes panel contains the following controls and elements:

Name

In the field, a name of a route is typed.

Possible deviation (m)

You can set a possible distance the radio can deviate from the route line. The maximum value is 999 m.

Color

Contains a palette with colors for a route line.

Edit in Table

Activates adding or editing the existing route points in the Points table. When you click the button, its name

changes to Edit on Map.

Points Table

You can activate the table by clicking Edit in Table. You can add coordinates by clicking the Add coordinate (   )

button. The order of the route points in the table corresponds to the points sequence on a map. A point of a route

can become a Key point with its Name. Key points are used for creating Radio Location reports. For details, see

Radio Locations.
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NOTE

A key point appears on a route line as a circle after clicking the Save button. At hovering the mouse cursor over

the point on a map, the key point name set in the Name column appears.

Edit on Map

Activates adding or editing the existing route points on a map. To add a route, click at least two points on the

desired locations of a map.

Save

Adds the route to the route list which is available on all maps.

4.9.7.4.2 Adding Routes Using Map

Follow the procedure to add a route on a map.

Prerequisites: 

Ensure an operator has the rights to configure routes. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, open the Routes tab.

4. On the Routes tab, click Create Route.

The Route panel opens.

5. In the Name field of the Route panel, type the name of the route.

6. In the Possible deviation (m) field, enter the possible deviation from the route.

7. From the Color palette, select the color for the route on a map.

8. Set the route location on a map by clicking at least two desired points on a map. Double-click the last point to

finish drawing.

9. Click Save to save the route.

The current panel changes to the Objects on Map panel.

Postrequisites: 

• To show or hide a route, on the Routes tab, select or clear the Show on map check box.

• To edit a route, see Editing Objects Using Panel or Editing Objects Using Map.

• To remove a route, see Deleting Objects.
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4.9.7.4.3 Adding Routes Using Table

Follow the procedure to add a route on a map.

Prerequisites: 

Ensure an operator has the rights to configure routes. For details, see Operators.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, open the Routes tab.

4. On the Routes tab, click Create Route.

The Route panel opens.

5. In the Name field of the Route panel, type the name of the route.

6. In the Possible deviation field, enter the distance the radio can deviate from the route line.

7. From the Color palette, select the color for the route on a map.

8. Click the Edit in Table button.

The Points table becomes active.

9. Add at least two points by clicking the Add coordinate (   ) button.

The lines for adding coordinates appear in the table.

10. In the table, perform the following actions:

a. In the Latitude column, type the desired latitude of points.

b. In the Longitude column, type the desired longitude of points.

c. (Optional) In the Key point column, select the check box.

NOTE

Key points can be displayed in the Radio Locations report. For details, see Radio Locations.

d. (Optional) In the Name column, in the entry, type the key point name.

11. Click the Save button.

The current panel changes to the Objects on Map panel.

Postrequisites: 

• To remove a point from the table, select the desired line with coordinates and click Delete coordinate (   ).

• To remove a key point from the route, in the Points table, clear the Key point check box next to the desired

point.

• To show or hide a route, on the Routes tab, select or clear the Show on map check box.

• To edit a route, see Editing Objects Using Panel or Editing Objects Using Map.

• To remove a route, see Deleting Objects.
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4.9.7.5 SCADA Points

On the SCADA points tab, you can add new or edit and delete existing SCADA points.

To add a SCADA point on a map, it must first be created and configured in the SCADA system. For details, see

“Connection to AdapTel Server and Database” in SCADA Module Setup and User Guide.

When you first start working with a map, only one control is available on the tab:

Create a SCADA point

Opens the SCADA point panel for adding a new SCADA point on a map.

When at least one point has been added to the list of SCADA points, the following elements and controls appear in

the panel:

SCADA Point Tooltip

Tooltip with information on all parameters of the SCADA point that appears when you point to the point entry in

the panel.

Alternatively, all parameters of the point can be viewed on its dashboard in the SCADA panel. For details, see

“SCADA Module” in SCADA Module Setup and User Guide.

Show on Map

You can show or hide the SCADA point on a map by selecting or clearing this check box.

SCADA point Name

Name of the SCADA point that is displayed on a map if the Name check box is selected in the SCADA point panel.

When you click the name of the point on the SCADA points tab, the map automatically centers on it even if it is

not displayed on a map.
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SCADA point Marker

Icon of the SCADA point that is displayed on a map if the Show on Map check box is selected. When you click the

marker of the point on the SCADA points tab, the map automatically centers on it even if it is not displayed on a

map.

Open in SCADA (   )

Opens the SCADA module with the SCADA point dashboard where all parameters of this point are displayed.

For information on SCADA point dashboards, see “SCADA Module” in SCADA Module Setup and User Guide.

Edit (   )

Opens the SCADA point panel where you can edit the SCADA point settings.

Delete (   )

Removes the SCADA point from the list and from all maps in SmartPTT Dispatcher.

NOTE

If a point is deleted from the SCADA system, it is not automatically deleted from SmartPTT Dispatcher. The name of

the deleted SCADA point is displayed in gray color. The rules that affect the point are not deleted, and the point

settings remain editable.

If one of the point parameters reports the alarm state, it is displayed in the Map panel with the indication

corresponding to its current state. For details, see SCADA Point Indication.
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4.9.7.5.1 SCADA Point

On the SCADA point panel, you can add and configure a new SCADA point, or edit an existing one. The changes in

the SCADA point settings made from the SCADA point panel are applied to it in all SmartPTT Dispatcher features .

The panel appears when you create or edit a SCADA point.

For details, see Adding SCADA Points, Editing Objects Using Map, and Editing Objects Using Panel.

The SCADA point panel contains the following controls and elements:

SCADA point

List of SCADA points from which you must select the desired point. SCADA points are created and configured in

the SCADA system.

Icon

The marker of the SCADA point that is displayed on a map. Icons are set in the SCADA system and cannot be

changed in SmartPTT Dispatcher.

Latitude and Longitude

The coordinates of the SCADA point in the format that is set in SmartPTT Dispatcher settings. By default, the

Decimal Degrees format is used.

Alternatively, you can set the SCADA point location by clicking the desired position on a map.

Save

Adds the new SCADA point on a map or saves changes in the settings of the existing point.
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4.9.7.5.2 SCADA Point Indication

To notify operators of emergencies on SCADA points, SmartPTT Dispatcher provides a number of indication options,

including color indication and animation.

When one of the SCADA points reports the alarm state, the following actions take place in SmartPTT Dispatcher to

attract the operator's attention to the emergency:

• If the Map panel is open, the map automatically centers on the point that reported the alarm state.

• If the point was hidden from the map, it appears on it with the marker indicating the alarm state.

• If the side panel is collapsed, it opens on the SCADA points tab.

• If the side panel is expanded but another tab is active, the panel switches to the SCADA points tab.

• The SCADA points list scrolls down to the point that reported the alarm state.

• If the Map panel is open but another panel is active at the time of emergency, the tab of the Map panel starts

flashing red.

Depending on the parameter values and the operator actions in regard to the emergency, SCADA points may exist in

several states. The following table provides information on the SCADA point states and their indication in the Map

panel.

State Description Indication

Operating All the point parameters are within the

normal range, or the emergency was

acknowledged and eliminated

(became outdated).

Standard colors, no animation.

Alarm One or more parameters reported the

alarm state.

Red flashing background layer under the

point.

Acknowledged

One of the SmartPTT Dispatcher

operators acknowledged the alarm

and is taking action to eliminate it.

Red background layer that appears after

one of the point parameters reports the

alarm state, stops flashing but does not

disappear.

Outdated unacknowledged The emergency on the point was

eliminated before any of the operators

acknowledged it in SmartPTT

Dispatcher.

Red frame around the point.

Red background layer that appears after

one of the point parameters reports the

alarm state disappears.



422

Maps Map Control Panel

State Description Indication

No connection

The connection to the point was lost,

the point was deleted from the SCADA

system, or the SCADA module was

deactivated in SmartPTT Dispatcher. 

The point icon and name are displayed in

gray color.

If the point was deleted from the SCADA

system, on the entry of the deleted point in

the list of SCADA points, the status message

appears: The Point was deleted from SCADA.

4.9.7.5.3 Adding SCADA Points

Follow the procedure to add a SCADA point on a map.

Prerequisites: 

Ensure the desired SCADA point was created and configured in the SCADA system. For details, see "Connection to

AdapTel Server and Database" in SCADA Module Setup and User Guide.

Procedure: 

1. In the right part of the desired map, click Objects on Map.

The Objects on Map panel appears.

2. (Optional) Click Pin (   ) to pin the panel.

3. In the Objects on Map panel, click the SCADA points tab.

4. On the SCADA points tab, click Create a SCADA point.

The SCADA point panel appears.

5. From the SCADA point list, select the desired SCADA point.

The icon of the selected point appears below.

6. (Optional) To show the name of the point on a map, select the Name check box.

7. Specify the point location on a map in one of the following ways:

• Click the desired location on a map.

• In the Latitude and Longitude fields, type the desired coordinates.

The point icon appears in the specified location on a map.

8. Click Save to save the SCADA point.

The added point appears in the list on the SCADA points tab of the Object on Map panel.

Postrequisites: 

• To display or hide the SCADA point on a map, on the SCADA points tab, select or clear the Show on Map check

box.

• To edit the SCADA point, see Editing Objects Using Panel or Editing Objects Using Map.

• To delete the SCADA point, see Deleting Objects.
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4.9.8 Editing Objects Using Map

Follow the procedure to edit a point of interest, geofence, route, camera marker or SCADA point on a map.

NOTE

You can also edit objects on the corresponding panel. For details, see Editing Objects Using Map.

Prerequisites: 

Ensure at least one desired object is added on a map.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. (Optional) Click Pin (   ) to pin the panel.

3. On the Objects on Map panel, select the desired tab.

4. On the selected tab, in the the desired object entry, click Edit (   ).

The panel with the object parameters opens.

5. On the open panel perform one of the following actions:

• To edit a point of interest, camera marker or a SCADA point, click the desired place on a map.

• To edit a geofence or a route, drag the object points to the desired position.

6. (Optional) To cancel changes, perform one of the following actions:

• For Google maps: To cancel the last action on a map, click (   ).

• To cancel changes and close the panel, in the upper-right corner of the panel, click (   ).

The panel changes to the Objects on Map panel.

7. If the Camera, Point of interest, Geofence, Route, or SCADA point panel is open, click Save.

The panel changes to the Objects on Map panel.

4.9.9 Editing Objects Using Panel

Follow the procedure to edit a point of interest, geofence, route, camera marker or SCADA point in the Objects on

Map panel.

NOTE

You can also edit objects on a map. For details, see Editing Objects Using Map.

Prerequisites: 

Ensure that at least one desired object exists in the list.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. On the Objects on Map panel, select the desired tab.
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3. (Optional) Click Pin (   ) to pin the panel.

4. Select the tab with the desired object in the Objects on Map panel.

5. On the selected tab, in the the desired object entry, click Edit (   ).

The panel with the object parameters opens.

6. On the open panel, perform the desired changes.

7. Click the Save button.

The current panel changes to the Objects on Map panel.

4.9.10 Deleting Objects

Follow the procedure to remove a point of interest, geofence, route, camera marker or SCADA point in the Objects

on Map panel.

Prerequisites: 

Ensure that at least one desired object is on the list.

Procedure: 

1. In the right part of the open map, click Objects on Map.

The Objects on Map panel opens.

2. On the Objects on Map panel, select the desired tab.

3. (Optional) Click Pin (   ) to pin the panel.

4. On the Objects on Map panel, select the tab with the desired object.

5. On the selected tab, in the the desired object entry, click Delete (   ).

The object disappears from the map and from the selected tab.
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5 Event Log

SmartPTT Dispatcher provides the ability to log events from the following sources:

• Current SmartPTT Dispatcher database. For details, see SmartPTT Dispatcher Event Log.

• All dispatch systems connected to the radioserver. For details, see SmartPTT Radioserver Event Log.

The Event Log menu provides access to the SmartPTT Dispatcher Event Log elements:

• All Events option provides access to the Event Log panel that displays all events of SmartPTT Dispatcher.

For details, see Displaying All Events.

• Events for Period option provides access to the Period window that provides the ability to set the period to

show events of SmartPTT Dispatcher.

For details, see Displaying Events for Period.

• Unread Messages option provides access to the Event Log: messages not read panel that provides the

ability to view unread messages in the SmartPTT Dispatcher Event Log.

For details, see Viewing Unread Messages.

• Event Log Settings option provides access to the Event Log Settings window that provides the abilities to

enable and to configure event logging for SmartPTT Dispatcher.

For details, see Configuring Event Logging for SmartPTT Dispatcher.

• Clear Event Log option provides access to the Clear Event Log window that provides the ability to remove all

event log entries added before the specific date in the SmartPTT Dispatcher Event Log.

For details, see Clearing Event Log.

NOTE

The Clear Event Log option is available in the Event Log menu only to the Administrator.

For information on the Event Log functionality, see the sections below.



426

Event Log SmartPTT Dispatcher Event Log

5.1 SmartPTT Dispatcher Event Log

The SmartPTT Dispatcher Event Log provides information on all events registered in the SmartPTT Dispatcher

database.

To display events in the Event Log, you should activate it.

For information on activating the event log, see Configuring Event Logging for SmartPTT Dispatcher.

You can open the Dispatcher Event Log by clicking Event Log → All Events on the menu bar.

The Event Log provides the following elements:

Event Log Table

Contains information on all events registered in the database.

For information on the table, see Dispatcher Event Log Table.

NOTE

You can activate recording of incoming and outgoing calls in SmartPTT Dispatcher. For details, see Records.

Brief Event Description

Located in the lower part of the Event Log panel, and contains the same information on the selected event as the

Event Log Table.

For information on event types, see Event Types.

Note

Contains notes a dispatcher can type for event log entries. The text from the box is also shown in the Note

column of the Event Log Table.

The Event Log entries can be selected in the following ways:

• Clicking a single entry selects only one entry.

• Clicking multiple entries with the Ctrl or Shift key held down selects multiple entries.
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For events of the Call type, the following actions are available in the Event Log panel and in the Play Records

window:

• Downloading call records to a folder. If a single call record is downloaded, you can also change the name of the

downloaded audio file.

NOTE

By default, the records are downloaded in the OGG format.

For information on setting the format of downloaded audio files, see Records.

• Playing call records.

• Opening call records location.

These actions can be performed from the shortcut menu that appears at right-clicking one or multiple selected

entries of the incoming and outgoing calls.

WARNING

Playing, downloading and opening location of the call records is unavailable to the calls made before activating

the incoming and outgoing calls recording functionality.

• For information on the Downloading audio files window, see Window of Call Records Downloading.

• For information on the Play records window, see Play Records Window.

• For information on the call records downloading procedure, see Downloading Call Records.

• For information on the call records playback procedure, see Playing Call Records.

• For information on the call records location opening procedure, see Opening Call Records Location.

5.1.1 Dispatcher Event Log Table

The Event Log Table of SmartPTT Dispatcher contains the following columns with the corresponding filters:

Column Name Description Filter

Direction Shows whether the event is incoming (   ),

or outgoing (   ).

Can be filtered by Incoming or

Outgoing direction.
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Column Name Description Filter

Event Type Shows the type of the event:

• Alarm (   )

• Block radio:

• Block (   )

• Unblock (   )

• Call (   )

• Dynamic Talkgroup (   )

• Job Ticket (   )

• Lone Worker (   )

• Message (   )

• Radio Check (   )

• Registration:

• Online (   )

• Offline (   )

• Power down (   )

• SCADA Alarm

• Status (   )

• Telemetry (   )

• User Authorization:

• Sign In (   )

• Sign Out (   )

Can be filtered by event types.

Date/Time Shows the date and time of the event. Can be filtered by date and time.

Not Read

Shows whether the message was read.

Can be filtered by read or unread

status.

Additional Information Contains the specific information depending

on the event type.

For details, see Additional Information

Column.

Can be filtered by values containing in

the column.

Operator Shows the operator who registered the

event.

Can be filtered by operator names.

Radioserver Shows the radioserver on which the event

was registered.

Can be filtered by radioserver names.
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Column Name Description Filter

Channel Shows the channel on which the event was

registered.

Can be filtered by channel names.

Radio Shows the radio that can be a source or

target of the event. For details, see Radios.

Also shows all radios that participated in a

group call.

Can be filtered by radio names.

User Shows the radio user which can be a source

or target of the event.

Can be filtered by radio user names.

Source Shows the name or ID of an event initiator. Can be filtered by event initiators.

Talkgroup Shows the talkgroup which participated in

the event.

Can be filtered by talkgroup names.

Status Shows the event status.

For information on possible event statuses,

see Status Column.

Can be filtered by statuses.

Duration Shows the event duration in seconds. Can be filtered by call duration.

Connection Type

Shows the connection type of the event.

Can be filtered by IP, PBX, or Radio

connection type.

Destination Shows the recipient ID or name. Can be filtered by event recipients.

Record Shows whether the call was recorded.

All event types except for Call always have

No value.

Yes or No filters can be used.

Lone Worker Shows whether a lone worker profile is

assigned to a radio.

Yes or No filters can be used.

Note Contains the text of a note attached to the

event log entry by dispatcher.

Can be filtered by the text typed in the

Note box.

If the user authorization service is activated, in the Source, Destination and Additional Information columns the

name of the user authorized on the radio is displayed next to the radio name in brackets.

For information on the check box, see General Settings.
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5.1.1.1 Additional Information Column

Depending on the event type, the Additional information column contains the following information:

Event Type Information in the column

Alarm Date and time of the alarm acknowledgment, and the

operator name who acknowledged it.

For SCADA points, the parameter that reported the

alarm state.

Block radio Empty column.

Call Identifiers of call initiators, or operator name.

Dynamic Group Information on operator actions related to a dynamic

group.

Job Ticket Job ticket number, name, and its description.

Lone Worker Empty column at activating/deactivating lone worker

profile. The column is filled when the profile changes.

Message Message text.

Radio Check Empty column.

Registration Empty column.

Status Changing of radio status.

For information on radio statuses, see Statuses.

Telemetry Description of telemetry action set in telemetry settings.

For details, see Telemetry Settings Window.

User Authorization Empty column.

5.1.1.2 Status Column

Depending on the event type, the following statuses are available in the Status column:

Event Type Information in the column

Alarm

• <empty> until the alarm is not acknowledged.

• Emergency accepted
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Event Type Information in the column

NOTE

For alarms on SCADA points, the Emergency accepted status

appears only when the emergency is eliminated on the point .

Acknowledging SCADA alarms does not affect the alarm status,

and the column is left empty until the parameter regains a normal

value.

Block radio • Unblocked

• Blocked

• Block failed

• Unblock failed

• Undelivered

• Target did not respond

Call • Group Call

• Private Call

• All Call

• Call Alert

• Monitoring

• Emergency Call

• Call Alert not delivered

Dynamic Group • Radio Added

• Radio Removed

Job Ticket • Status change

• Delivered

• Not delivered

• Sent

• Not sent

Lone Worker • Profile changed

• On

• Off

Message

• Message delivered

• Message not delivered

• Message accepted
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Event Type Information in the column

• Message sent

• Message not sent

Radio Check • Radio is available

• Radio is unavailable

Registration • Offline

• Online

• Power down

Status <radio status>

For details, see Statuses

Telemetry • Outgoing telemetry

• Incoming telemetry

User Authorization • User Authorization Sign Out

• User Authorization Sign In

5.1.1.3 Event Types

SmartPTT Dispatcher displays the following types of events that the system can register:

Event Type Description

Alarm Includes events concerning sending radio alarm signals to the radio network

and alarm signals from SCADA points.

Block Radio Includes events concerning sending blocking or unblocking radio commands to

radios.

Call Includes events concerning all types of calls including radio transmission

initiated by the Monitoring command.

For details, see Voice Calls.

Dynamic Group Includes events concerning dynamic groups in the SmartPTT system.

For details, see Dynamic Groups.

Job Ticket Includes events concerning sending special assignments to radios or

talkgroups.

For details, see Job Tickets.

Lone Worker Includes events related to the assignment of Lone Worker profiles to a radio.

For details, see Lone Worker Rules.
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Event Type Description

Message Includes events concerning sending and receiving text messages in the

SmartPTT system.

For details, see Text Messages.

Radio Check Includes events concerning sending the Radio Check command.

For details, see Radio Check.

Registration Includes events concerning radio availability in the radio system (offline, online,

power down).

Status Includes events concerning changing radio statuses in the SmartPTT system.

For details, see Statuses.

Telemetry Includes events concerning incoming or outgoing telemetry in the SmartPTT

system.

For details, see Telemetry.

User Authorization Includes events concerning user registration or unregistration on a radio.

5.2 SmartPTT Radioserver Event Log

The radioserver Event Log panel provides information on events from all dispatch systems connected to the

radioserver.

The radioserver Event Log can be activated and configured in SmartPTT Radioserver Configurator.

For information on configuring radioserver event log, see “Configuring Event Log Database Connection” in SmartPTT

Installation and Configuration Guide.

Important

The radioserver Event Log is available to the Administrator, or to operators with the corresponding permission.

For details, see Operators.

Important

Access to SmartPTT Radioserver Event Log can be limited by the client registered in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.
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For information on opening the radioserver Event Log, see Displaying SmartPTT Radioserver Event Log.

The radioserver Event Log provides the following elements::

Radioserver Event Log Table

Contains the columns with all information about events.

For information on the table, see Radioserver Event Log Table.

Brief Event Description

Located in the lower part of the radioserver Event Log panel, and contains the same details of the event as the

radioserver Event Log table.

Note

Contains notes a dispatcher can type for event log entries. The text from the box is also shown in the Note

column of the radioserver Event Log table.

The Event Log entries can be selected in the following ways:

• Clicking a single entry selects only one entry.

• Clicking multiple entries with the Ctrl or Shift key held down selects multiple entries.

For events of the Call type, the following actions are available on the Event Log panel and in the Play Records

window:

• Downloading call records to a folder. If a single call record is downloaded, you can also change the name of the

downloaded audio file.

NOTE

By default, the records are downloaded in the OGG format.

For information on setting the format of downloaded audio files, see Records.

NOTE

You can activate call recording in SmartPTT Radioserver Configurator. For details, see «Configuring Centralized

Voice Logging» in SmartPTT Installation and Configuration Guide.
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• Playing call records.

• For information on the Downloading audio files window, see Window of Call Records Downloading.

• For information on the Play records window, see Play Records Window.

• For information on the call records downloading procedure, see Downloading Call Records.

• For information on the call records playback procedure, see Playing Call Records.

5.2.1 Radioserver Event Log Table

The radioserver Event Log table contains the following columns with the corresponding filters:

Column Name Description Filter

Direction Shows whether the event is incoming (   ),

or outgoing (   ).

Can be filtered by Incoming or

Outgoing direction.

Event Type Shows the type of the event:

• Alarm (   )

• Block radio:

• Block (   )

• Unblock (   )

• Call (   )

• Dynamic Group (   )

• Job Ticket (   )

• Lone Worker (   )

• Message (   )

• Radio Check (   )

• Registration:

• Online (   )

• Offline (   )

• Power down (   )

• SCADA Alarm

• Status (   )

• Telemetry (   )

• User Authorization:

• Sign In (   )

• Sign Out (   )

Can be filtered by event types.

Date/Time Shows the date and time of the event. Can be filtered by date and time.
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Column Name Description Filter

Channel Shows the channel on which the event was

registered.

Can be filtered by channel names.

Talkgroup Shows the talkgroup which participated in

the event.

Can be filtered by talkgroup names.

Source Shows the name or ID of an event initiator. Can be filtered by event initiators.

Dispatcher Shows the operator who participated in the

event.

Can be filtered by operator names.

Status Shows the event status.

For information on possible event statuses,

see Status Column.

Can be filtered by statuses.

Duration Shows the event duration in seconds. Can be filtered by call duration.

Additional Information Contains the specific information depending

on the event type.

For details, see Additional Information

Column.

Can be filtered by values containing in

the column.

Record Shows whether the call was recorded.

All event types except for Call always have

No value.

Yes or No filters can be used.

Destination Shows the recipient ID or name. Can be filtered by event recipients.

Note Contains the text of a note attached to the

event log entry by dispatcher.

Can be filtered by the text typed in the

Note field.

User Shows the radio user which can be a source

or target of the event.

Can be filtered by radio user names.

If the user authorization service is activated, in the Source, Destination and Additional Information columns the

name of the user authorized on the radio is displayed next to the radio name in brackets.

For information on the check box, see General Settings.

5.2.2 Displaying SmartPTT Radioserver Event Log

Follow the procedure to open the radioserver Event Log panel.

Prerequisites: 

• Ensure the radioserver Event Log is activated in SmartPTT Radioserver Configurator. For details, see

“Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.
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• Ensure an operator has the View radioserver event log right. For details, see Operators.

• Ensure SmartPTT Radioserver Event Log is available to the client registered in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the Radio Fleet panel, in the right part of the radioserver entry, click the Actions button (   ), and then

select Show Radioserver Event Log (   ).

The Period window appears.

2. In the open Period window, set the period of events to be shown in the radioserver Event Log:

To show events starting from the specified date

only,

select the Start Date check box.

To show events before the specified date only, select the End Date check box.

To show events for a certain period of time only, select the Start Date and the End Date check

boxes.

To show all events from the dispatcher database, clear the Start Date and the End Date check boxes.

3. Click the Date (   ) button, and select the desired start and end dates, or enter the dates manually.

4. (Optional) In the fields with the dates, type the start and end time.

5. Click OK to apply changes, and display the Dispatcher Event Log.

If events for the specified period exist in the database, they are displayed in the open Dispatcher Event Log.

5.3 Managing Event Log

Managing of the SmartPTT Dispatcher Event Log provides the following abilities:

• Enabling event logging. For details, see Configuring Event Logging for SmartPTT Dispatcher.

• Viewing unread messages. For details, see Viewing Unread Messages.

• Managing event log entries. For details, see Managing Event Log Entries.

Managing of Event Log elements (sorting, grouping, filtering, etc.) is applicable both to Dispatcher and radioserver

Event Log. For details, see Managing Event Log Elements.
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5.3.1 Configuring Event Logging for SmartPTT Dispatcher

Follow the procedure to enable event logging for SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Event Log → Event Log Settings.

The Event Log Settings window appears.

2. In the Event Log Settings window, select the Enable event logging check box to record events to the

SmartPTT Dispatcher database.

3. (Optional) In the Maximum number of Event Log records field, type the desired value. The maximum value

is 9999.

4. In the Options of Event Log clearing area, click the desired option button:

• Click Do not clear Event Log to record new events to the database until the hard drive is full.

• Click Period of records retention (days) to delete records made a specified amount of days ago.

5. (Optional) If Period of records retention (days) is selected, type the desired amount of days to keep records.

The maximum value is 999. The default value is 30 days.

6. (Optional) Select the Show time with milliseconds check box to display milliseconds in the Data/Time

column of the event log.

7. Click OK to apply changes and close the window.

5.3.2 Viewing Unread Messages

Follow the procedure to view unread messages in the SmartPTT Dispatcher Event Log.

Procedure: 

View unread messages in one of the following ways:

• Click Event Log → Unread Messages on the menu bar.

• Click Unread messages: <number> if it is displayed in the lower-left corner of SmartPTT Dispatcher.
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The Event Log: messages not read panel appears.

5.3.3 Managing Event Log Entries

Managing Event entries of SmartPTT Dispatcher provides the following abilities:

• Displaying all events. For details, see Displaying All Events.

• Displaying events for a certain period. For details, see Displaying Events for Period.

• Removing all event log entries added before the specific date. For details, see Clearing Event Log.

5.3.3.1 Displaying All Events

Follow the procedure to display all events of SmartPTT Dispatcher.

Procedure: 

On the menu bar, click Event Log → All Events.

The Dispatcher Event Log panel with all events appears.

NOTE

Alerts and events initiated in the emergency mode are displayed in the Event Log in red.
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5.3.3.2 Displaying Events for Period

Follow the procedure to display events of SmartPTT Dispatcher for a certain period.

Procedure: 

1. On the menu bar, click Event Log → Events for Period.

The Period window appears.

2. In the open Period window, set the period to show events:

To show events starting from the specified date

only,

select the Start Date check box.

To show events before the specified date only, select the End Date check box.

To show events for a certain period of time only, select the Start Date and the End Date check

boxes.

To show all events from the dispatcher database, clear the Start Date and the End Date check boxes.

3. Click the Date (   ) button, and select the desired start and end dates, or enter the dates manually.

4. (Optional) In the boxes with the dates, type the start and end time.

5. Click OK to apply changes, and display the Radioserver Event Log.

If events for the specified period exist in the database, they are displayed in the open Radioserver Event Log.

5.3.3.3 Clearing Event Log

Follow the procedure to remove all event log entries added before the specific date in the SmartPTT Dispatcher Event

Log.

Procedure: 

1. On the menu bar, click Event Log → Clear Event Log.

The Clear Event Log window appears.
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2. In the open Clear Event Log window, set the desired date manually, or click the Date (   ) button.

3. Click OK to remove event log entries.

All event log entries added before the set date disappear from the Dispatcher Event Log.

5.3.4 Managing Event Log Elements

The procedures below are applicable both to Dispatcher and radioserver Event Log.

You can perform the following actions for managing the Event Log elements:

• Sort event entries. For details, see Sorting Events.

• Group log entries by columns. For details, see Grouping Events.

• Filter column contents by specific values. For details, see Filtering Events.

• Hide, show, or change the order of columns. For details, see Displaying Columns and Moving Columns.

• Keep the columns position independently of scrolling. For details, see Keeping Column Positions.

5.3.4.1 Sorting Events

Follow the procedure to sort events.

Procedure: 

Sort entries of the desired column in one of the following ways:

• To sort the entries in ascending order, click the column header until the Up (   ) icon appears.

• To sort the entries in descending order, click the column header until the Down (   ) icon appears.

Postrequisites: 

To cancel entries sorting, click the column header until the sorting icon disappears.
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5.3.4.2 Grouping Events

Follow the procedure to group log entries by columns.

Procedure: 

1. Click the column header, and drag it to the Move column header here for grouping area.

2. (Optional) Repeat step 1 to group entries in several columns.

Postrequisites: 

To cancel grouping, drag the header from the Move column header here for grouping area, and drop it when the

cross icon (   ) appears.

5.3.4.3 Filtering Events

Follow the procedure to filter column contents by specific values.

Procedure: 

1. Point to the desired column header, and then click the appeared icon (   ).

2. From the list, select the desired check boxes, or click the Select All button.

Next to the filtered column header the filter icon (   ) appears.

Postrequisites: 

To cancel filtering, click the filter icon, and then click the Clear Filter button.



443

Event Log Managing Event Log

5.3.4.4 Displaying Columns

Follow the procedure to hide or show columns.

Procedure: 

Right-click any column header, and select the desired titles from the list.

NOTE

By default, all the columns are displayed in the event log.

5.3.4.5 Moving Columns

Follow the procedure to change the order of columns.

Procedure: 

Drag the desired column header to the left or right of any other column.

5.3.4.6 Keeping Column Positions

Follow the procedure to keep the desired columns position independently of scrolling.

Procedure: 

In the column headers, drag the element (   ) to the right of the column you want to keep the position.

All columns to the left of the element are fixed.
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5.4 Call Records

The Call Records functionality is available from both Dispatcher and Radioserver Event Log. Using this functionality

you can perform the following actions:

• Play call records. For details, see Playing Call Records.

• Download call records. For details, see Downloading Call Records.

• Open call records location. For details, see Opening Call Records Location.

5.4.1 Play Records Window

In the Play Records window you can play call records, download them, or open their location.

NOTE

The opening of call records location is unavailable to SmartPTT Radioserver Event Log.

The window opens when one or multiple call records are played.

For information on playing, see Opening Call Records Location.

The Play Records window provides the following elements:

Call Record Table

Contains records of calls selected in the Event Log Table. Consists of columns identical to the columns of the Event

Log Table. For details, see Dispatcher Event Log Table or Radioserver Event Log Table.

Start Playback (   ) / Pause Playback (   )

Plays the selected record or pauses the currently played.

Stop Playback (   )

Stops playback of the current record.

Return to Previous Record (   )

Plays the previous record.

Go to Next Record (   )

Plays the next record.

Play All Records (   )

Activates the mode to play all the records one by one. The mode is active by default.
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Replay (   )

Activates the mode to replay the current record.

If more than one record is in the call record table and the Play All Records button is pressed, the records in the

table are replayed one by one.

Volume Slider

Adjusts the volume of the audio records playback.

5.4.2 Window of Call Records Downloading

The process of call records downloading is displayed in the Downloading audio file window (if a single call record is

downloaded) or in the Downloading audio files window (if multiple call records are downloaded).

The window is open when you start a single or more call records downloading.

For information on the procedure of call records downloading, see Downloading Call Records.

If a call or call records are downloaded successfully, the Complete message appears, and the Cancel button changes

to the Open folder and Close buttons.

Using these buttons, you can open the destination folder of downloaded call records or close the window.
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When multiple call records are downloaded and the destination folder contains audio files with the same names as

the downloaded call records, the corresponding error occurs. The Cancel button changes to the Replace and Skip

buttons.

Using these buttons, you can replace the audio file or skip it and resume download.

When other errors occur, the corresponding message with an error type appears and the Cancel button changes to

the Try again and Skip buttons.

Using these buttons, you can try to repeat to download the call record again or skip it and resume download.

5.4.3 Playing Call Records

Follow the procedure to play call records from the SmartPTT Dispatcher or SmartPTT Radioserver Event Log.

Procedure: 

1. Depending on the amount of desired records, play them in one of the following ways:

To play a single call record, right-click the desired call record, and then click Play

audio file.

To play multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then

click Play selected records.

The Play Records window appears and the playback of the selected records starts.
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2. (Optional) In the Play Records window, configure the playback options:

• Click Play all records (   ) to play all selected records one by one.

• Click Replay (   ) to activate the call records replay.

Postrequisites: 

• To put the playback on pause, click Pause Playback (   ).

• To stop the playback, click Stop Playback (   ).

5.4.4 Downloading Call Records

Follow the procedure to download call records from the SmartPTT Dispatcher or SmartPTT Radioserver Event Log, or

from the Play Records window.

Procedure: 

Depending on the amount of desired records, download them in one of the following ways:

To download a single call record, perform the following actions:

1. Right-click the desired call record, and then click

Download audio file.

2. In the window that appears, specify the folder for saving

the audio file and the file name, and then click Save.

The Downloading audio file window appears displaying

information on the download progress.

To download multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then click

Download audio files.

3. In the window that appears, specify the existing folder or

create a new one for saving the audio files, and then click

Save.

The Downloading audio files window appears displaying

information on the download progress.

Postrequisites: 

• To open the folder with the downloaded call records, click Open in File Explorer.

• If an error occurred during the download, see Window of Call Records Downloading.
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5.4.5 Opening Call Records Location

Follow the procedure to open the call records location from the SmartPTT Dispatcher Event Log.

NOTE

This function is unavailable to the SmartPTT Radioserver Event Log.

Procedure: 

Depending on the amount of desired records, open their location in one of the following ways:

To open the location of a single call record, right-click the desired call record, and then click Open

in File Explorer.

The folder containing the selected call record opens in a

new window.

To open the location of multiple call records, perform the following actions:

1. Select the desired records.

2. Right-click any of the selected records, and then

click Open in File Explorer.

The folder or folders containing the selected

records open in a new window.
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6 Service

The Service menu provides access to a range of SmartPTT Dispatcher features that extend its main functionality. It

provides the following options:

• Sending the Radio Check command for identifying the current radio status.

For details, see Radio Check.

• Sending audio messages to talkgroups.

For details, see Voice Notifications.

• Sending audio and text messages to offline radios automatically on their appearance in the network.

For details, see Deferred Actions.

NOTE

The Deferred Actions option is unavailable in the Service menu if an operator does not have the corresponding

permission.

For information on the operator rights, see Operators.

• Managing files received by SmartPTT Radioserver via SmartPTT File Transfer.

For details, see Received Files.

• Viewing system information related to SmartPTT Dispatcher operation.

For details, see Statistics.

• Exporting the list of registered radios to files in the XML, XLS, or CSV format.

For details, see Export Radio List.

• Importing the list of registered radios from files in the XML, XLS, or CSV format.

For details, see Import Radio List.

• Exporting current radio coordinates to KML files.

For details, see Upload to KML.

• Saving current SmartPTT Dispatcher settings, layout, and database.

For details, see Save Dispatcher Settings.

• Importing SmartPTT Dispatcher settings, layout and database from the previously created files.

For details, see Restore Dispatcher Settings.

NOTE

The Restore Dispatcher Settings and Save Dispatcher Settings options are unavailable in the Service menu if

SmartPTT Dispatcher is connected to a remote database.

NOTE

The Restore Dispatcher Settings and Save Dispatcher Settings options are available only to the

Administrator.
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6.1 Radio Check

Radio Check is a signaling feature that provides the ability to check whether a radio is currently available in the radio

system. This feature can be useful in several cases:

• If the radio does not respond due to some reasons. For example, the radio is participating in a call or it is offline.

• If you want to check radio availability manually before the radio inactivity timeout expires. For information on

inactivity timeout, see “Configuring ARS” in SmartPTT Installation and Configuration Guide.

Important

The Radio Check feature is not available in Linked Capacity Plus, Capacity Max, and Connect Plus radio systems.

When the radio receives a Radio Check command, it automatically sends the acknowledgment, no user involvement

is required. The only indication available to the user of the checked radio is the Busy LED on it.

You can send the Radio Check command to all MOTOTRBO radios in the dispatched radio systems. No special license

or configuration is required.

NOTE

The Radio Check feature is not supported by radios with MDC and 5 Tone IDs. It is also unavailable to SmartPTT

Mobile users. For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and

Configuration Guide.

The following statuses are available to the checked radios:

• The Radio is available status means that the checked radio is available and it is online.

• The Radio is unavailable status means that the checked radio is busy at the moment (for example, participates

in a call) or is offline.

NOTE

If the checked radio is offline, and its inactivity timeout has not yet expired, the radio is displayed as online in

SmartPTT Dispatcher until inactivity timeout expiration.

For information on sending the Radio Check command, see the sections below.

6.1.1 Radio Check Window

The Radio Check window provides the ability to send the Radio Check command to the radio using its ID.

You can open the Radio Check window for sending the command by clicking Service → Radio Check on the menu

bar.

The window provides the following elements:
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Radio ID

Provides the ability to specify the ID of the desired radio to check.

Send

Sends the Radio Check command.

Cancel

Closes the Radio Check window.

For information on sending the Radio Check command using the radio ID, see Sending Radio Check Using Radio ID.

6.1.2 Sending Radio Check

You can send the Radio Check command in one of the following ways:

• Using the controls provided by SmartPTT Dispatcher panels or the radio Call Window. For details, see Sending

Radio Check from Dispatcher Panels.

• Using the ID of the target radio. For details, see Sending Radio Check Using Radio ID.

This method is recommended in the following cases:

• If the target radio is not displayed in SmartPTT Dispatcher.

• If each radio in the dispatched radio system has a unique ID.

NOTE

If more than one radio with the same radio ID operate in the dispatched radio system, it is recommended to use

the controls provided by SmartPTT Dispatcher panels or the radio Call Window for sending the Radio Check

command.

6.1.2.1 Sending Radio Check from Dispatcher Panels

Follow the procedure to send the Radio Check command to the radio displayed in one of the SmartPTT Dispatcher

panels.

Procedure: 

Send the Radio Check command in one of the following ways:

To send the Radio Check command from the

Radio Fleet panel,

click the Actions (   ) button next to the desired

radio, and then click Radio Check (   ).

For information on the Actions menu, see Radio

Actions Menu.

To send the Radio Check command from the

Radios panel,

click the Actions (   ) button on the desired radio

element, and then click Radio Check (   ).

To send the Radio Check command from the map

panel,

on the map or on the expandable Radios panel,

right-click the desired radio, and then click Radio

Check (   ).
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To send the Radio Check command from the radio

Call Window,

in the Call Window of the desired radio, click Radio

Check (   ).

For information on Call Windows, see Radio Call

Window.

The target radio status is displayed in the Event Log and the log field of the target radio Call Window. For details, see

Dispatcher Event Log Table and Radio Call Window.

6.1.2.2 Sending Radio Check Using Radio ID

Follow the procedure to send the Radio Check command using the target radio ID.

Prerequisites: 

Obtain the ID of the desired radio.

Procedure: 

1. On the menu bar, click Service → Radio Check.

The Radio Check window appears.

2. In the Radio ID field, type the radio ID.

3. Click Send to send the Radio Check command to the radio.

The radio status appears in the Status column of the Event Log and in the Call Window of the target radio. For

details, see Dispatcher Event Log Table and Radio Call Window.

NOTE

If the target radio is not displayed in SmartPTT Dispatcher, its status appears only in the Event Log. In this case,

the Call Window does not appear.

6.2 Voice Notifications

The Voice Notifications feature provides the ability to send audio files configured on SmartPTT Radioserver to

SmartPTT Dispatcher talkgroups.

Using this feature, you can play a voice notification in the selected talkgroups to inform them of emergencies or

deliver other important information in the audio message format.

Voice notifications are created and configured in SmartPTT Radioserver Configurator. For details, see “Voice

Notifications” in SmartPTT Installation and Configuration Guide.

If the radio channel is busy when a voice notification is sent, the notification may interrupt the active transmission.

The voice notification priority depends on the system settings. For information on the voice notifications priority in

the dispatched radio systems, contact your system administrator.

NOTE

SmartPTT Dispatcher does not provide voice notification details. To obtain information on the selected audio file,

channels for which the notification is configured, and playback parameters, contact your system administrator.
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Voice notifications can be played in one of the following ways:

• From the Voice Notifications window. For details, see Playing Voice Notifications.

• From the Voice Notification element in Custom Consoles. For details, see Voice Notifications.

• Automatically, when triggered by a rule configured in SmartPTT Radioserver Configurator. For details, see

“Rules” in SmartPTT Installation and Configuration Guide.

For information on playing voice notifications, see the sections below.
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6.2.1 Voice Notifications Window

The Voice Notifications window provides the ability to send a voice notification and displays the playback details

even if the notification is played from a custom console or is triggered by an event configured in the rule in SmartPTT

Radioserver Configurator.

For information on rule configuring in the SmartPTT system, see “Rules” in SmartPTT Installation and Configuration

Guide.

You can open the Voice Notifications window by clicking Service → Voice Notifications on the menu bar.

The Voice Notifications window provides the following elements:

Radioserver

Contains the list of available servers that are currently active and registered in SmartPTT Dispatcher.

Voice Notifications

Contains the table of the voice notifications configured in SmartPTT Radioserver Configurator.

The table consists of the following columns:

• The Active column contains the check box indicating the status of the voice notification. The selected check

box indicates that the voice notification is currently playing or is being sent.
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• The Name column contains the name of the voice notification.

You can sort content of the table by clicking the desired column header. You can sort entries only by one column,

clicking the name of another column automatically discards the sorting order applied earlier.

Notifications left

Shows how many playbacks of the voice notification are left.

For information on the voice notification parameters, see “Voice Notifications” in SmartPTT Installation and

Configuration Guide.

Channels (   /   )

Hide and show the table with information on the currently playing voice notification.

The table consists of the following columns:

• The Slot column displays the radio network channel or control station on which the voice notification is or has

been played.

• The Talkgroup column shows the name of the talkgroup for which the voice notification is or has been played.

• The Successfully Completed column shows the number of successful voice notification playbacks.

The color of the Channels table entries indicates the voice notification playback status for each of the channels.

The following color indicators are available:

• The yellow entry color ( ⬛ ) indicates that the voice notification is currently playing.

• The green entry color ( ⬛ ) indicates that the voice notification has been successfully played.

• The red entry color ( ⬛ ) indicates that the voice notification was not played due to connection, audio file, or

hardware problems.

Start

Initiates playback of the selected voice notification.

Stop

Terminates the voice notification playback. The playback cannot be resumed from the point where it was stopped.

6.2.2 Playing Voice Notifications

Follow the procedure to send a voice notification from the Voice Notification window.

Procedure: 

1. On the menu bar, click Service → Voice Notifications.

The Voice Notifications window appears.

2. In the Radioserver area, select the desired server from the list.

NOTE

Only the servers that are currently active and registered in SmartPTT Dispatcher are displayed in the Radioserver

list.
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3. In the Voice Notifications area, in the table, select the voice notification that you want to send.

4. At the bottom of the window, click Start to start the voice notification playback.

The information on the playback appears in the Channels table.

Postrequisites: 

To stop the voice notification playback, click Stop.

NOTE

If you click the Stop button, you will not be able to resume the current voice notification playback.

6.3 Deferred Actions

The Deferred Actions feature provides the ability to create and deliver various messages to offline and online radios.

Offline radios receive the sent messages after becoming online, and online radios receive them right after sending.

In SmartPTT Dispatcher the following types of deferred actions are possible:

• Actions with voice messages

• Actions with text messages

• Actions with combined messages (both voice and text)

Important

Deferred actions can be created by the Administrator or operators with the corresponding rights. For information

on the operator rights, see Operators.

After the radio receives the deferred message, the corresponding entry appears in the Event Log and in the

radioserver Event Log. If only a text message is sent, its entry appears also in the log field of the radio Call Window.

For information on using deferred actions, see the sections below.

6.3.1 Create Deferred Action Window

In the Create Deferred Action window, you can create voice and text messages (or both) that are sent to radios

when they become online.
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You can open the window in one of the following ways:

• By clicking Create Deferred Action (   ) in the Actions menu of the desired radio.

For information on the Actions menu, see Radio Actions Menu.

• By clicking Create Deferred Action (   ) in the Call Window of the desired radio.

For information on the Call Window, see Radio Call Window.

• By clicking Edit (   ) in the Deferred Actions window after selecting the desired action.

For information on the window, see Deferred Actions Window.

The Create Deferred Action window provides the following elements:

Radioserver

Provides the list of active radioservers to which the radio belongs.

NOTE

The list is unavailable if the window is open for editing an existing deferred action.

Send Audio Message

Unlocks the Record and Play buttons.

Record

Starts voice message recording. When clicked, changes to the Stop button.

Play

Plays the recorded voice message. When clicked, changes to the Stop button.

Send Text Message

Unlocks the field below for typing a text message. If you clear the check box after typing, the text will be kept in

the unavailable field and will not be included into the action when you save it.

NOTE

You can create deferred combined actions that include both audio and text messages.

View Deferred Actions

Closes the Create Deferred Action window without saving and opens the Deferred Actions window.

For information on the Deferred Actions window, see Deferred Actions Window.

Save

Saves the action and sends it to the radioserver. After clicking the button, one of the following operation statuses

appears above it:

• The The action was successfully saved status appears if action creating is successful.

• The Changes were successfully saved status appears if action changing is successful.

• The Please add text and/or audio message status appears if the Send Audio Message and Send Text Message

check boxes are cleared.

• The Audio message cannot be empty. Please add the audio message status appears if the Send Audio Message

check box is selected, but the voice message is not recorded.

• The Text message cannot be empty. Please add text of the message status appears if the Send Text Message

check box is selected, but the field for typing a text message is empty.
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• The Failed to save the action. Please check radioserver connection status appears when the action cannot be

created or edited due to connection problems (for example, if SmartPTT Radioserver is inactive).

Cancel

Closes the window without saving.

6.3.2 Deferred Actions Window

In the Deferred Actions window, you can manage existing deferred actions.

You can open the window in one of the following ways:

• By clicking Service → Deferred Actions on the menu bar.

• By clicking View Deferred Actions in the Create Deferred Actions window.

For details, see Create Deferred Action Window.

The Deferred Actions window provides the following elements:

Current Radioserver

Provides a list of radioservers from which you can load existing actions.

NOTE

If the desired radioserver is not in the list, it may be inactive.

For information on radioservers, see Radioservers.

Load Action List

Loads deferred actions from the active radioserver or all active radioservers to the Deferred Actions Table located

below, or refreshes the table.

You can load only incomplete actions. When a radio receives the deferred message, it disappears from the

Deferred Actions Table.

NOTE

If SmartPTT Dispatcher is not connected to any radioserver, the No radioservers available message is displayed

instead of the Current Radioserver list and the Load Action List button.

Edit (   )

Opens the Create Deferred Action window in which you can edit the selected deferred action.

For information on the window, see Create Deferred Action Window.
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Delete (   )

Deletes the selected deferred action.

Deferred Actions Table

Displays all existing incomplete actions.

The table consists of the following columns:

• The Create Date column contains the date and time when the action was created.

• The Radio Name column contains the action recipient name specified in the radio properties.

• The Audio column contains information on whether the action has a voice message attached.

• The Text column contains information on whether the action has a text message attached.

• The Message Text column displays the content of the text message if it is attached to the action.

You can sort the deferred actions in the table by columns and arrange the entries in ascending or descending

order by clicking the name of the desired column. You can sort entries only by one column, clicking the name of

another column automatically discards the sorting order applied earlier.

6.3.3 Deferred Actions Procedures

You can use the Deferred Actions feature to perform the following actions:

• Create audio, text and combined deferred messages. For details, see Creating Deferred Messages.

• Edit and delete deferred actions. For details, see Managing Deferred Actions.

6.3.3.1 Creating Deferred Messages

Follow the procedure to create a deferred message.

Prerequisites: 

• If you want to record an audio message, ensure the recording device is connected to the computer and is

active.

• Ensure an operator has the Create deferred actions right. For details, see Operators.

Procedure: 

1. Open the Create Deferred Action window in one of the following ways:

To open the window from the Radio Fleet panel, click the Actions (   ) button next to the desired

radio, and then click Create Deferred Action (   ).

For information on the Actions menu, see Radio

Actions Menu.

To open the window from the Radios panel, click the Actions (   ) button on the desired radio

element, and then click Create Deferred Action ( 

 ).
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To open the window from the map panel, on the map or on the expandable Radios panel,

right-click the desired radio, and then click Create

Deferred Action (   ).

To open the window from the radio Call Window, in the Call Window of the desired radio, click Create

Deferred Action (   ).

For information on Call Windows, see Radio Call

Window.

2. In the opened window, from the Radioserver list, select the desired radioserver.

3. Create the desired deferred message:

To create an audio message, perform the following actions:

1. Clear the Send Text Message check box.

The field for typing message becomes

unavailable.

2. Select the Send Audio Message check box.

The Record button becomes available.

3. Click Record.

The button changes to Stop; other elements

become unavailable.

4. Speak into the microphone.

5. Click Stop after you finished speaking.

The button changes to Record; the Play button

becomes available.

6. (Optional) Click Play to listen to the recorded

message.

To create a text message, perform the following actions:

1. Clear the Send Audio Message check box.

The Record button becomes unavailable.

2. Select the Send Text Message check box.

The field for typing message below becomes

available.

3. Type the desired message in the field.

To create a combined message that includes

both audio and text messages,

perform the following actions:

1. Select the Send Audio Message and Send Text

Message check boxes.
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2. Record the audio message and type the text

message according to the instructions above.

4. Click Save.

If the action creating is successful, the The action was successfully saved message appears.

Postrequisites: 

• To re-record the deferred audio message, repeat the corresponding actions of the step 3.

If the re-recording is successful, when clicking Save, the Changes were successfully saved message appears.

• To change the text message, delete the text from the corresponding field, type a new text, and then click Save.

6.3.3.2 Managing Deferred Actions

Follow the procedure to edit or delete an existing deferred action.

Prerequisites: 

• Ensure the radioserver whose deferred actions you want to manage is online.

• Ensure an operator has the Create deferred actions right. For details, see Operators.

Procedure: 

1. Open the Deferred Actions window in one of the following ways:

To open the window from the Create Deferred

Action window,

click the View Deferred Actions button.

To open the window from the menu bar, click Service → Deferred Actions.

2. In the opened window, from the Current Radioserver list, select the desired radioserver or All radioservers.

3. Click Load Action List.

Existing deferred actions appear in the Deferred Actions Table below.

4. In the Deferred Actions Table, select the desired deferred action.

5. Perform the desired operation:

To edit the deferred action, perform the following actions:

1. Click Edit (   ).

The Create Deferred Action window appears.

2. In the opened window, perform the desired

changes.

3. Click Save.

If the action changing is successful, the Changes

were successfully saved message appears.
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To delete the deferred action, click Delete (   ).

The selected deferred action disappears from the

Deferred Actions Table.

NOTE

If connection to the radioserver to which the selected deferred action belongs is lost after loading the action list,

when clicking Edit or Delete, the Radioserver is unavailable message appears.

6.4 Received Files

The Received Files window provides the ability to view files that were sent from radios using the SmartPTT File

Transfer application.

For information on SmartPTT File Transfer, see “SmartPTT File Transfer” in SmartPTT Installation and Configuration

Guide and SmartPTT File Transfer User Guide.

You can open the Received Files window for loading a list of received files by clicking Service → Received Files on

the menu bar.

The Received Files window provides the following elements:

Current Radioserver

Provides a list of radioservers from which you can load received files.

NOTE

If the desired radioserver is not in the list, it may be inactive.

For information on radioservers, see Radioservers.

Retrieve File List

Loads received files from the active radioserver or all active radioservers to the Received Files Table located below,

or refreshes the table.

NOTE

If SmartPTT Dispatcher is not connected to any radioserver, the No Server Connected message is displayed instead

of the Current Radioserver list and the Retrieve File List button.

Received Files Table

Displays all received files. The table consists of the following columns:

• The File Name column contains the received file name.
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• The Radio column contains the name of the radio which is a file sender.

• The Date/Time column contains the date and time when the file was received.

• The Size (Bytes) column contains information on the file size.

• The Radioserver column contains the name of the radioserver from which the file was loaded.

You can sort the received files in the table by columns and arrange the entries in ascending or descending order by

clicking the name of the desired column. You can sort entries only by one column, clicking the name of another

column automatically discards the sorting order applied earlier.

Download

Opens the window for saving the selected file. You can also open this window by double-clicking the selected file.

Delete

Deletes the selected file from the list.

Close

Closes the Received Files window.

For information on managing received files, see the section below.

6.4.1 Managing Received Files

Follow the procedure to view, download received files, or delete them from the list.

Prerequisites: 

Ensure the desired radioserver to load received files is online.

Procedure: 

1. On the menu bar, click Service → Received Files.

The Received Files window appears.

2. In the opened window, from the Current Radioserver list, select the desired radioserver or All radioservers.

3. Click Retrieve File List.

A list of received files appears in the Received Files Table below.

4. Perform the desired action:

To download the file, perform the following actions:

1. In the Received Files Table, double-click the

desired file or select the file, and then click

Download.

The window for downloading appears.

2. In the opened window, specify a folder to save

the file, and then click Save.

To delete the file from the table, select the desired file, and then click Delete.

5. Click Close to close the window.
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6.5 Statistics

The Statistics window provides the summary of information stored in the SmartPTT Dispatcher database.

You can open the Statistics window by clicking Service → Statistics on the menu bar.

The window contains the following areas:

Events

Contains the summary of system events logged in SmartPTT Dispatcher:

• Registration displays the number of subscribers' registrations.

• Call displays the number of the logged incoming and outgoing calls.

• Messages displays the number of the logged incoming and outgoing text messages.

• Telemetry displays the number of the sent telemetry commands and received telemetry data messages.

• Alarm displays the number of the logged system alarms.

Database

Contains information on SmartPTT Dispatcher database:

• Name displays the name of the database.

• Current Size displays the amount of space on the drive used by the database (in megabytes).

• Max Size displays the database drive space limit (in gigabytes).

NOTE

The maximum database size is set during the SQL Server configuration and depends on the SQL Server version

and edition. For details, see “DBMS Configuration” in SmartPTT Installation and Configuration Guide.
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When the database reaches 90 % of its maximum size, a warning message prompting to perform the automatic

database cleanup appears. It also indicates the percentage of the hard drive space the database currently

occupies relative to the Max Size value.

When the database size reaches its Max Size value, another warning message appears. It indicates that new

records cannot be added to the database until it is cleaned up.

Warning messages appear at every start of the SmartPTT application whose database is approaching or reached

its maximum size. Warning messages appear every 30 minutes until you clean up the relevant database.

Audio

In this area, the Record Folder Size parameter is available, which provides information on the size of the folder

where SmartPTT Dispatcher stores audio records. For information on the folder, see Records.

6.6 Export Radio List

The Export Radio List feature provides the ability to export current properties and settings of the radios from the

SmartPTT Dispatcher database to a separate file.

The exported files can be used for the following purposes:

• Transfer of the exported radio list to another SmartPTT Dispatcher

• Adding new radios to the radio list

• Updating properties and settings of the exported radios

• Performing the radio system analysis

• Generating reports

For information on options of the radio list import in SmartPTT Dispatcher, see Import Radio List.

You can export the radio list in one of the following formats:

• Microsoft Excel 97-2003 (XLS)

• XML

• CSV
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The choice of the export format depends on the export purposes and does not affect its informational content.

The exported file provides information in the form of a table whose columns correspond to radio properties in

SmartPTT Dispatcher.

For information on radio properties and settings, see Radio Properties Window.

XLS File Example

The exported table consists of the following columns:

Column Name Description

ID Automatically generated radio ID.

Radio IP address Radio IP address.

Network ID Radio network ID that is set in the radio codeplug.

Radio ID Unique radio identifier.

Name Radio name in SmartPTT Dispatcher.

GPS Indicates whether SmartPTT Dispatcher processes the radio GPS coordinates.

MDC ID Identifier of the radio from an analog radio system in MDC-1200 format.

Icon Path to the icon that is set for the radio in SmartPTT Dispatcher. If the default

icon is used, the cell is left empty.

Show on map Indicates whether the radio is displayed on the map in SmartPTT Dispatcher.

Lone Worker Indicates whether the radio is in the Lone Worker mode.

Select 5 ID Identifier of the radio from an analog radio system in the Select 5 format.

Indoor Support Indicates whether the radio location relative to the beacons is displayed on the

building layout when using the Indoor Tracking feature.

Indoor Request Indicates whether a time interval for sending indoor coordinates requests to the

radio is set.

Indoor Update Interval Time interval in seconds after which indoor location data requests are sent to

the radio.
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Column Name Description

GPS update with time interval Indicates whether a time interval for the radio to send GPS coordinates is set.

Time Interval Time interval in seconds after which the radio provides its GPS coordinates.

GPS update with distance

interval

Indicates whether the radio update location with distance interval parameter for

the GPS feature is set.

Distance Interval Distance in meters or feet after which the radio provides its GPS coordinates.

GPS on GPIO pin status change Indicates whether the radio provides its GPS coordinates when it sends the

telemetry signal.

GPS on emergency Indicates whether the radio provides its GPS coordinates when it sends the

emergency alarm.

GPS on pressing PTT button Indicates whether the radio provides its GPS coordinates when the PTT button

is pressed on it.

NOTE

Some properties have only two possible values: True and False.

If a property is not applicable to the radio, the cell in the corresponding column is left empty.

For information on exporting the radio list, see the sections below.

6.6.1 Export Radio List Window

The Export Radio List window provides the ability to export properties and settings of the radios from the

SmartPTT Dispatcher database to a separate file.

You can open the Export Radio List window by clicking Service → Export Radio List on the menu bar.

The window provides the following elements:

Format

Provides the ability to select the desired export file format: Microsoft Excel (XLS), XML, or CSV.
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Save Export File As

Provides the ability to specify the desired path and name for the file to export the radio list into by clicking the

Browse (   ) button.

6.6.2 Exporting Radio List

Follow the procedure to export the list of radios to a file.

Prerequisites: 

Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Export Radio List.

The Export Radio List window appears.

2. In the Format area, select the desired export format.

3. To the right of the Save Export File As field, click Browse (   ).

4. In the Specify File Name window, specify the path to the desired folder, and then perform one of the

following actions:

To export the radio list to a new file, perform the following actions:

1. In the File name field, type the name for the

exported file, and then click Save.

In the Save Export File As field, the path to the

file and its name appear.

2. Click OK.

To export the radio list to an existing file, perform the following actions:

1. Select the file that you want to replace, and then

click Save.

In the Save Export File As field, the path to the

file and its name appear.

2. Click OK.

3. In the Confirmation window, click OK.

5. In the window indicating successful radio list export, click OK.

6.7 Import Radio List

The Import Radio List feature provides the ability to import a list of radios with their properties and settings to

SmartPTT Dispatcher.

The feature can be used for the following purposes:

• Transfer of the radio list from another SmartPTT Dispatcher
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• Adding new radios to the SmartPTT Dispatcher radio list

• Updating current properties and settings of radios in the SmartPTT Dispatcher radio list

For information on the radio list export options in SmartPTT Dispatcher, see Export Radio List.

You can import the radio list from a file in one of the following formats:

• Microsoft Excel 97-2003 (XLS)

• XML

• CSV

For information on radio properties, see Radio Properties Window.

For information on importing the radio list, see the sections below.

6.7.1 Import Radio List Window

The Import Radio List window provides the ability to import a list of radios from a separate file to SmartPTT

Dispatcher.

You can open the Import Radio List window by clicking Service → Import Radio List on the menu bar.

The window provides the following elements:

Format

Provides the ability to select the desired import file format: Microsoft Excel (XLS), XML, or CSV.

Choose File to Import

Provides the ability to specify the desired path and name for the file to import the radio list from by clicking the

Browse (   ) button or typing it in the text field.

Add New Records

Provides the ability to add new radios from the imported file.

Update Existing Records

Provides the ability to update properties and settings of existing radios when importing.
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6.7.2 Importing Radio List

Follow the procedure to import the list of radios from a file.

Prerequisites: 

Obtain the format of the file that you want to import. For details, see Import Radio List.

Procedure: 

1. On the menu bar, click Service → Import Radio List.

The Import Radio List window appears.

2. In the Format area, select the format of the file that you want to import.

3. To the right of the Choose File to Import field, click Browse (   ).

4. In the Specify File Name window, specify the file that you want to import, and then click Open.

NOTE

Only files in the format selected in step 2 are displayed in the Specify File Name window.

The specified path and file name are displayed in the Choose File to Import field.

NOTE

You can also type or paste the full file path into this field.

5. At the bottom of the Import Radio List window, select the desired option:

To add new radios from the imported file, select the Add New Records check box.

To update properties and settings of existing radios, select the Update Existing Records check box.

To add new and update the existing radios, select the Add New Records and

Update Existing Records check boxes.

6. In the Import Radio List window, click OK.

To cancel the radio list import, click Cancel.

7. In the window indicating successful radio list import, click OK.

8. Restart SmartPTT Dispatcher to complete the radio list import.

NOTE

If the imported file contains no changes that can be uploaded to the current radio list, a window indicating the

absence of changes appears.
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6.8 Upload to KML

The Upload to KML feature provides the ability to export radio coordinates from SmartPTT Dispatcher to a separate

KML file.

The exported KML file contains location information only on those radios that are currently displayed on the map in

SmartPTT Dispatcher.

For information on location tracking settings of radios, see Radio Location Properties and Positioning Systems.

You can export the location data to a local file or to a file on the FTP server.

Depending on the settings, the location information in the exported file may be fixed or receive regular updates.

If the corresponding check box is selected in the export settings, the exported file will be updated at a defined

interval to reflect the location changes in the dispatched radio system.

Exported files can be viewed in a web browser or in compatible desktop applications. The KML file format is used in

Google Maps, Google Earth, and other services based on Google maps.

For information on exporting location data to a local KML file or to a KML file on the FTP server, see the sections

below.

6.8.1 Export to KML

The Export to KML window provides the ability to export radio coordinates to a local KML file or to a KML file on the

FTP server.

You can open the Export to KML window by clicking Service → Upload to KML on the menu bar.

The window provides the following elements:

Local File

If selected, radio coordinates are exported from SmartPTT Dispatcher to a file in the local storage.

For information on exporting radio coordinates to a local KML file, see Exporting Coordinates to Local KML File.



472

Service Upload to KML

FTP

If selected, radio coordinates are exported from SmartPTT Dispatcher to a file on the FTP server.

Unlocks the Login and Password fields.

For information on exporting radio coordinates to a KML file on the FTP server, see Exporting Coordinates to

KML File on FTP Server.

KML File

Provides the ability to specify the desired path and name for the file to export radio coordinates into by clicking

the Browse (   ) button, if the Local File option is selected, or typing it in the text field, if the FTP option is

selected.

Login

Provides the ability to type the login of the FTP server user.

Password

Provides the ability to type the user password for access to the FTP server.

Auto upload time interval (sec)

Provides the ability to configure automatic update of the exported file to reflect the radio location changes.

Unlocks the field on the right to specify the update interval (in seconds).

6.8.2 Exporting Coordinates to Local KML File

Follow the procedure to export radio coordinates to a local KML file.

Prerequisites: 

• Ensure that the desired radios are displayed on the map in SmartPTT Dispatcher.

For details, see Radio Location Properties.

• Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Upload to KML.

The Export to KML window appears.

2. At the top of the window, select Local File.

3. (Optional) Configure automatic update of the location data in the exported file:
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a. Select the Auto upload time interval (sec) check box.

b. In the field to the right of the check box, specify the interval in seconds at which the exported file will be

updated.

NOTE

If you leave the Auto upload time interval (sec) field empty or move the exported file to another directory, the

location data in the file will not be updated.

4. To the right of the KML File field, click Browse (   ).

5. In the Select KML File window, specify the path to the desired folder, and then perform one of the following

actions:

To export radio coordinates to a new file, perform the following actions:

1. In the File name field, type the name for the

exported file, and then click Save.

In the KML File field, the path to the file and its

name appear.

2. Click Export.

To export radio coordinates to an existing file, perform the following actions:

1. Select the file that you want to replace, and then

click Save.

In the KML File field, the path to the file and its

name appear.

2. Click Export.

3. In the Confirmation window, click OK.

6. In the window indicating successful export, click OK.

Postrequisites: 

To cancel the coordinates export and save current export settings, in the Export to KML window, click Cancel.

6.8.3 Exporting Coordinates to KML File on FTP Server

Follow the procedure to export radio coordinates to a KML file on the FTP server.

Prerequisites: 

• Ensure that the desired radios are displayed on the map in SmartPTT Dispatcher.

For details, see Radio Location Properties.
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• Ensure that you have access to the desired export destination folder.

• (Optional) Obtain the user login and password for access to the desired FTP server.

Procedure: 

1. On the menu bar, click Service → Upload to KML.

The Export to KML window appears.

2. At the top of the window, select FTP.

3. In the KML File field, specify the path and the name for saving the exported file. For example,

ftp://myserver/smartptt/Radios_smartptt.kml.

4. (Optional) If the target FTP server requires user authentication, perform the following actions:

a. In the Login field, type the login of the FTP server user.

b. In the Password field, type the user password for access to the FTP server.

5. (Optional) Configure automatic update of the location data in the exported file:

a. Select the Auto upload time interval (sec) check box.

b. In the field to the right of the check box, specify the interval in seconds at which the location data in the

exported file will be automatically updated.

NOTE

If you leave the Auto upload time interval (sec) field empty or move the exported file to another directory, the

location data in the file will not be updated.

6. At the bottom of the Export to KML window, click Export.

7. In the window indicating successful export, click OK.

Postrequisites: 

To cancel the coordinates export and save current export settings, in the Export to KML window, click Cancel.

6.9 Save Dispatcher Settings

The Save Dispatcher Settings feature provides the ability to export the SmartPTT Dispatcher database and settings

to a ZIP file for their further transfer to the same or another SmartPTT Dispatcher. For details,

see Restore Dispatcher Settings.

Important

The Save Dispatcher Settings feature is available only to the Administrator.

NOTE

The feature is unavailable if SmartPTT Dispatcher is connected to a remote database.

Export of the SmartPTT Dispatcher settings and database can be useful for the following purposes:

• Transfer of the SmartPTT Dispatcher database and current configuration settings to another SmartPTT

Dispatcher
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• Transfer of the current SmartPTT Dispatcher position to another computer

• Settings and database backup

The exported file is an archive in the ZIP format that contains XML and JSON files storing data on the current

configuration settings.

The SmartPTT Dispatcher database is exported to a BAK file stored in the same archive.

For information on exporting SmartPTT Dispatcher settings and database, see the sections below.

6.9.1 Save Dispatcher Settings Window

The Save Dispatcher Settings window provides the ability to preserve the current state of SmartPTT Dispatcher,

including the database, language settings, layout, and other configuration settings.

You can open the Save Dispatcher Settings window by clicking Service → Save Dispatcher Settings on the menu

bar.

The window provides the following elements:

Archive File

Provides the ability to specify the desired path and name for the file to export the selected objects into by clicking

the Browse (   ) button.

Objects

Provides the ability to configure the export parameters:

• The Settings check box allows/denies exporting the SmartPTT Dispatcher settings.

• The Database check box allows/denies exporting the SmartPTT Dispatcher database.
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6.9.2 Saving Dispatcher Settings

Follow the procedure to export the SmartPTT Dispatcher database and/or settings in their current state to a ZIP file.

Prerequisites: 

Ensure that you have access to the desired export destination folder.

Procedure: 

1. On the menu bar, click Service → Save Dispatcher Settings.

The Save Dispatcher Settings window appears.

2. In the Archive File area, click Browse (   ).

3. In the Specify File Name window, specify the path to the desired folder and the name of the exported ZIP file,

and then click Save.

4. In the Objects area, configure the desired export parameters:

To export the SmartPTT Dispatcher settings, select the Settings check box.

To export the SmartPTT Dispatcher database, select the Database check box.

To export the SmartPTT Dispatcher database and

settings,

select the Settings and Database check boxes.

5. At the bottom of the Save Dispatcher Settings window, click Save.

6. In the window indicating successful export, click OK.

Postrequisites: 

Import the SmartPTT Dispatcher database and/or settings. For details, see Restoring Dispatcher Settings.

6.10 Restore Dispatcher Settings

The Restore Dispatcher Settings feature provides the ability to import the SmartPTT Dispatcher database and

settings from the current or another SmartPTT Dispatcher. For details, see Save Dispatcher Settings.

Important

The Restore Dispatcher Settings feature is available only to the Administrator.

NOTE

The feature is unavailable if SmartPTT Dispatcher is connected to a remote database.

Using this feature, you can perform the following actions:

• Import SmartPTT Dispatcher settings, including language settings, layout, and other configuration settings

• Import the SmartPTT database

• Overwrite the Globally Unique Identifier (GUID) of the current SmartPTT Dispatcher with the imported one

Import of the SmartPTT Dispatcher settings and database can be useful for the following purposes:

• Transfer of the SmartPTT database and configuration settings from another SmartPTT Dispatcher
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• Transfer of a SmartPTT Dispatcher position from one computer to another

• Restoring the SmartPTT Dispatcher settings and database from a backup file

For information on importing SmartPTT Dispatcher settings and database, see the sections below.

6.10.1 Restore Dispatcher Settings Window

The Restore Dispatcher Settings window provides the ability to import the SmartPTT Dispatcher database and

settings as well as overwrite the Globally Unique Identifier (GUID) of the current SmartPTT Dispatcher.

You can open the Restore Dispatcher Settings window by clicking Service → Restore Dispatcher Settings on

the menu bar.

The window provides the following elements:

Archive File

Provides the ability to specify the desired path and name for the file to import the selected objects from by clicking

the Browse (   ) button.

Objects to restore

Provides the ability to configure the import parameters:

• The Settings check box allows/denies importing the SmartPTT Dispatcher settings.

Unlocks the Overwrite Dispatcher GUID check box.

• The Overwrite Dispatcher GUID check box allows/denies replacing the GUID of the current SmartPTT

Dispatcher with the GUID from the imported file.

• The Database check box allows/denies importing the SmartPTT Dispatcher database.
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6.10.2 Restoring Dispatcher Settings

Follow the procedure to import the SmartPTT Dispatcher database and/or settings from a ZIP file and/or overwrite

the Globally Unique Identifier (GUID) of the current SmartPTT Dispatcher.

Procedure: 

1. On the menu bar, click Service →Restore Dispatcher Settings.

The Restore Dispatcher Settings window appears.

2. In the Archive File area, click Browse (   ).

3. In the Specify File Name window, specify the path to the desired ZIP file, and then click Open.

4. In the Objects to restore area, depending on the desired and available import parameters, perform the

following actions:

To import the SmartPTT Dispatcher settings, select the Settings check box.

To import the SmartPTT Dispatcher database, select the Database check box.

Important

When recovering a database from another SmartPTT

Dispatcher, you also need to restore the dispatch

console GUID to save access to records in the

database to be restored.

To replace your GUID with the GUID from the

imported file,

perform the following actions:

1. Select the Settings check box.

2. Select the Overwrite Dispatcher GUID check

box.

WARNING

Do not replace GUID if you want to keep using the

SmartPTT Dispatcher from which the settings were

exported. If two dispatch consoles with the same

GUID operate in the radio system at the same time, it

may lead to errors and malfunctioning.

5. At the bottom of the Restore Dispatcher Settings window, click Restore.

6. In the window indicating successful import, click OK.

7. Restart SmartPTT Dispatcher to apply changes.



479

Reports  

7 Reports

The Reports menu provides access to a range of tools for creating reports on the SmartPTT Dispatcher and

SmartPTT Radioserver operation for a specified period of time.

Important

The menu is available only to the Administrator or to operators with the corresponding permission. For details,

see Operators.

The menu provides the following reporting options:

• Creating a report on the basis of SmartPTT Dispatcher or SmartPTT Radioserver Event Log.

For details, see Report Wizard.

• Viewing the number of All Calls and group calls.

For details, see Radio Activity Report.

• Displaying GPS coordinates of the selected radios.

For details, see Radio Locations.

• Creating a report on the selected radios movement on the basis of the GPS data received from them.

For details, see Radio Movement.

• Viewing registered and non-registered online radios.

For details, see Online Radios.

• Creating reports based on the data provided by the SmartPTT monitoring feature.

For details, see Monitoring Reports.

• Viewing information about events registered on the radios in the Lone Worker mode.

For details, see Lone Workers.

• Creating a report on the selected radios movement inside buildings based on the data received from the

connected beacons.

For details, see Indoor Tracking.

NOTE

The monitoring reports, the Lone Workers and Indoor Tracking reports are unavailable to SmartPTT Mobile

users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

7.1 Report Wizard

The Report Wizard functionality provides the ability to create reports based on information stored in the SmartPTT

Dispatcher or SmartPTT Radioserver Event Log.

You can open the Report Wizard window by clicking Reports → Report Wizard on the menu bar.

To create a report, you need to fill in the required fields and set the required check boxes in the windows below.

The Select data source window contains the Data source element that provides the ability to select a data source

for creating a report: SmartPTT Dispatcher or SmartPTT Radioserver.
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Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT

Radioserver is not running, SmartPTT Radioserver will not be displayed as a data source.

Important

Access to the report based on the SmartPTT Radioserver Event Log data can be limited by the client registered in

SmartPTT Radioserver Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

The Select data for the report window contains check boxes with the names of the data that will be included in the

report. For information on the data that can be included in the report, see Dispatcher Event Log Table and

Radioserver Event Log Table.
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The Group and sort report data window contains lists with parameters that provide the ability to group or sort the

report data.

The Group and sort report data window provides the following elements:
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Group by

Provides the ability to group data in a report.

Sort by

Provides the ability to sort data in a report.

The Filter conditions window contains lists with conditions and values, under which the data in a report will be

filtered in one way or another.

The Filter conditions window provides the following elements:

Parameters

List of parameters whose values can be filtered.

Active

Enables or disables the ability to filter the parameter next to which the check box is selected.

Condition

Contains a condition under which the parameter value will be filtered. The condition values may be as follows:

Equal to; Not Equal to; Between.

Value

Sets the values that match the selected conditions.

The Create and save report window contains the Save as element, which provides the ability to specify the path for

saving the report on the computer by clicking the Browse (   ) button.
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For information on report exporting, see Report Exporting.

7.1.1 Creating Report Based on Event Log

Follow the procedure to create a report based on the information stored in the SmartPTT Dispatcher or SmartPTT

Radioserver Event Log.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise

it will be unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in

SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure Event Log is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Report Wizard.

The Report Wizard window appears.

2. In the Select data source window, select the data source for a report:

To select the SmartPTT Dispatcher database as

the data source,

perform the following actions:
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1. From the Data source list, select the Dispatcher

value.

2. Click Next.

To select the SmartPTT Radioserver database as

the data source,

perform the following actions:

1. From the Data source list, select the value with

the desired SmartPTT Radioserver name.

2. Click Next.

3. In the Select data for the report window, select the data to display in a report:

To display data in a report, perform the following actions:

1. Select the check box next to the desired

parameter name.

2. Click Next.

To prevent data from displaying in a report, perform the following actions:

1. Clear the check box next to the desired

parameter name.

2. Click Next.

NOTE

The number of parameters available for displaying in the report depends on the selected data source.

4. (Optional) In the Group and sort report data window, from the Group by list, select the desired parameter by

which the report data will be grouped.

NOTE

If the grouping is not specified, the report will be created with the grouping of data set in the Report Wizard by

default.

5. (Optional) From the Sort by list, select the desired parameter by which the report data will be sorted.

NOTE

If the sorting is not specified, the report will be created with the sorting of data set in the Report Wizard by default.

6. Click Next.

7. In the Filter conditions window, specify the data filtering conditions:

a. Next to the desired parameter, select the Active check box to apply filtering.

b. From the Condition list, select the required condition to filter the desired parameter: Equal to, Not Equal to,

Between.

c. From the Value list, select the value by which the desired parameter will be filtered.

d. Click Next.
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7. In the Create and save report window, specify the path to the report file on the computer:

a. Click the Browse (   ) button.

b. In the Specify File Name window, specify the path to save a report on the computer.

c. In the corresponding field, specify the name of a report.

d. From the corresponding list, select the desired format to save a report. For information on report

exporting, see Report Exporting.

8. Click Finish to create a report.

7.2 Radio Activity Report

The Radio Activity Report contains information on the number of All Call and group calls with the grouping by

hours, minutes or days.

You can open the Radio Activity Report window for creating a report by clicking Reports → Radio Activity Report

on the menu bar.

The Radio Activity Report window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Source

Provides the ability to select the data source whose database will be used for the report. Either the SmartPTT

Dispatcher database (the Dispatcher value) or the database of one of the available radioservers can be used as a

data source.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT

Radioserver is not running, SmartPTT Radioserver will not be displayed as a data source.

Important

Access to the report based on the SmartPTT Radioserver Event Log data can be limited by the client registered in

SmartPTT Radioserver Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.
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Channel

Provides the ability to select the desired radio network channel, control station or trunked radio system to create

a report. To create a report based on data from all channels, use the All value.

Group by

Provides the ability to group the data in the report by days, hours, or minutes. Available values are: Days, Hours,

30 minutes, 10 minutes, and Minutes.

For information on report exporting, see Report Exporting.

7.2.1 Creating Radio Activity Report

Follow the procedure to create a report based on radio activity data.

Prerequisites: 

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise

it will be unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in

SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure Event Log is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Activity Report.

The Radio Activity Report window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report on

the radio activity for the specified period.

3. From the Source list, select the data source for a report:

To select the SmartPTT Dispatcher database as the

data source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the

data source,

select the value with the desired SmartPTT

Radioserver name.

4. From the Channel list, select the channel for a report:

To display data for the specific channel in the report, select a value with the name of the desired channel.

To display data for all channels in the report, select the All value.

5. In the Group by list, specify data grouping in the report:

To group data in the report by days, select the Days value.
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To group data in the report by hours, select the Hours value.

To group data in the report by 30 minutes, select the 30 minutes value.

To group data in the report by 10 minutes, select the 10 minutes value.

To group data in the report by minutes, select the Minutes value.

6. Click OK to create a report.

Postrequisites: 

Determine the format to export a report. For information on report exporting, see Report Exporting.

7.3 Radio Locations

The Radio Location report contains information on the radio coordinates for a certain period.

Important

For report creating, you must have the license supporting GPS. For details, see Licenses.

You can open the Radio Locations window for creating a report by clicking Reports → Radio Locations on the

menu bar.

The Radio Locations window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.
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Source

Provides the ability to select the data source whose database will be used for the report. Either the SmartPTT

Dispatcher database (the Dispatcher value) or the database of one of the available radioservers can be used as a

data source.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT

Radioserver is not running, SmartPTT Radioserver will not be displayed as a data source.

Important

Access to the report based on the SmartPTT Radioserver Event Log data can be limited by the client registered in

SmartPTT Radioserver Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Radio

Activates the ability to select from the list below the desired radio for which a report will be created. The list of

radios is taken from the connected database. If the All radios value is selected from the list, a report will be created

for those radios whose GPS coordinates are stored in the database.

User

Activates the ability to select from the list below the desired user for whom a report will be created. The list of

users is taken from the connected database. If the All users value is selected from the list, a report will be created

for those users whose GPS coordinates are stored in the database.

Group by radios

Provides the ability to group data in a report by radios.

Group by users

Provides the ability to group data in a report by authorized users.

UTC Time

Provides the ability to display the report time, as well as the report start and end dates in the Coordinated

Universal Time standard (UTC+00:00). If the check box is not selected, the report time, as well as the report start

and end dates will be displayed according to the time zone set on the dispatcher's computer (for example,

UTC+07:00).

RSSI

Provides the ability to display the RSSI signal level in decibels in the report.

Address

Provides the ability to display radio address based on the received GPS coordinates. Google or OpenStreetMap is

used as a data source. For information on selecting the address data provider, see Positioning Systems.

NOTE

The Address check box is not displayed in the Radio Locations window, if the Address data provider check box

is not selected in the positioning systems settings.

NOTE

If address mapping is not selected, the report displays the Find on Map link to Google Maps or OpenStreetMap

service. Clicking the link displays the radio location.
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Route

Unlocks the ability to select a route, on which basis the report will be created, from the list on the right. For details,

see Routes.

Only Key Points

Displays only key route points in the report.

NOTE

The Only Key Points check box is available only when the Route check box is selected.

NOTE

The Precision column of a report does not provide data for the Movement Reports Restoration feature. For such

coordinates, it remains empty. For details, see the “Location with Option Boards” section in SmartPTT Installation

and Configuration Guide.

For information on report exporting, see Report Exporting.

7.3.1 Creating Radio Location Report

Follow the procedure to create a report displaying radio coordinates data.

Prerequisites: 

• Ensure you have the license supporting GPS. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise

it will be unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in

SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure an operator has the Request radio location right. For details, see Operators.

• Ensure Event Log is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Locations.

The Radio Locations window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report

displaying radio coordinates for the specified period.

3. From the Source list, select the data source for a report:

To select the SmartPTT Dispatcher database as the

data source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the

data source,

select the value with the desired SmartPTT

Radioserver name.

4. Specify which coordinates will be displayed in a report:
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To display coordinates for unregistered radios in

the report,

perform the following actions:

1. Select Radio.

2. From the list below, select the desired radio or the

All radios value.

3. (Optional) If the grouping by radios is required,

select the Group by radios check box.

To display coordinates for registered users in the

report,

perform the following actions:

1. Select User.

2. From the list below, select the desired user or the

All users value.

3. (Optional) If the grouping by users is required,

select the Group by users check box.

5. (Optional) Configure displaying additional information in the report:

To display time in the Coordinated Universal Time

standard (UTC+00:00) in the report,

select the UTC Time check box.

To display the RSSI signal level in decibels in the

report,

select the RSSI check box.

To display the radio address in the report, select the Address check box.

NOTE

The Address check box is not displayed in the Radio

Locations window, if the Address data provider

check box is not selected in the positioning systems

settings.

To select the route, on which basis the report will

be created,

perform the following actions:

1. Select the Route check box.

2. From the unlocked list on the right, select the

desired route.

3. (Optional) If displaying only the coordinates of key

route points is required, select the Only Key

Points check box.

6. Click OK to create a report.

Postrequisites: 

Determine the format to export a report. For information on report exporting, see Report Exporting.
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7.4 Radio Movement

The Radio Movement report contains information on the radio movement based on the received GPS coordinates.

Important

For report creating, you must have the license supporting GPS. For details, see Licenses.

You can open the Radio Movement window for creating a report by clicking Reports → Radio Movement on the

menu bar.

The Radio Movement window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Source

Provides the ability to select the data source whose database will be used for the report. Either the SmartPTT

Dispatcher database (the Dispatcher value) or the database of one of the available radioservers can be used as a

data source.

Important

If the SmartPTT Radioserver Event Log is not activated in SmartPTT Radioserver Configurator or SmartPTT

Radioserver is not running, SmartPTT Radioserver will not be displayed as a data source.

Important

Access to the report based on the SmartPTT Radioserver Event Log data can be limited by the client registered in

SmartPTT Radioserver Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.
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Select radios

Activates the ability to select from the list on the right the desired radios whose movement data will be displayed

in the report.

Select categories

Activates the ability to select from the list on the right the desired radio categories whose movement data will be

displayed in the report.

Select users

Activates the ability to select from the list on the right the desired users whose movement data will be displayed in

the report.

Minimum stop time interval (min)

Provides the ability to set the time duration to determine a radio is stopped. If the radio stands still longer than

the specified value, it is considered to be parked.

Enable points of interest

Provides the ability to take into account the coordinates of points of interest when creating a report. For details,

see Points of Interest.

NOTE

If the Enable points of interest check box is selected, the point of interest name will be indicated instead of the

address in the Location column of a report.

Radius (m)

Provides the ability to set the acceptable distance of the radio deviation from the point of interest.

NOTE

The Radius (m) field is available only when the Enable points of interest check box is selected.

For information on report exporting, see Report Exporting.

7.4.1 Creating Radio Movement Report

Follow the procedure to create a report based on radio movement data.

Prerequisites: 

• Ensure you have the license supporting GPS. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator, otherwise

it will be unavailable for creating a report. For details, see “Configuring Event Log Database Connection” in

SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running, otherwise it will be unavailable for creating a report.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure an operator has the Request radio location right. For details, see Operators.
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• Ensure Event Log is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Radio Movement.

The Radio Movement window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report

displaying radio movement for the specified period.

3. From the Source list, select the data source for a report:

To select the SmartPTT Dispatcher database as the

data source,

select the Dispatcher value.

To select the SmartPTT Radioserver database as the

data source,

select the value with the desired SmartPTT

Radioserver name.

4. Specify which movement information will be displayed in the report:

To display information about the unregistered

radios movement in the report,

perform the following actions:

1. Select the Select radios element.

2. From the list next to the element, select the

desired radios.

To display information about the radio categories

movement in the report,

perform the following actions:

1. Select the Select categories element.

2. From the list next to the element, select the

desired radio categories.

To display information about the registered users

movement in the report,

perform the following actions:

1. Select the Select users element.

2. From the list next to the element, select the

desired users.

5. To specify the time after which a radio will be considered as stopped, enter the desired value in the Minimum

stop time interval (min) field.

6. (Optional) Configure displaying points of interest in the report:

To include points of interest in the report, select the Enable points of interest check box.

To set the acceptable distance of the radio

deviation from the point of interest,

perform the following actions:

1. Select the Enable points of interest check box.
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2. Enter the desired value in the unblocked Radius

(m) field.

7. Click OK to create a report.

Postrequisites: 

Determine the format to export a report. For information on report exporting, see Report Exporting.

7.5 Online Radios

The Online Radios report provides the ability to export the list of radios that are currently in the network. The

report displays both registered and unregistered radios.

You can open the Online Radios window for creating a report by clicking Reports → Online Radios on the menu

bar.

The window provides the following elements:

All

Provides the ability to include all online radios in the report.

Radio ID range

Provides the ability to create a report for a specific range of radios. For this, in the fields next to the element, the

range of radio identifiers must be entered.

The report will be created after clicking the OK button. For information on report exporting, see Report Exporting.

NOTE

The Channel Type column of a report can have three values: MOTOTRBO, Analog, Select 5.

7.6 Monitoring Reports

The Monitoring submenu is available from the Reports menu on the SmartPTT Dispatcher menu bar. It provides

the following reporting tools:

• Displaying radio system calls information, such as repeater IDs, IDs of the call participants, event duration and

type, RSSI, and other related call parameters.

For details, see Air Monitoring Report.
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• Displaying information on events and alarms registered on the radio system devices, such as repeaters,

routers, and UPS.

For details, see Event Log Report.

• Displaying information on the system load, uptime, downtime, and other related radio system parameters.

For details, see System Usage Report.

Important

The reporting functionality is available only if you have the corresponding license and the Monitoring feature is

activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

NOTE

These reports are not available to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

7.6.1 Air Monitoring Report

Monitoring report is created on the basis of data stored in the air monitoring.

Important

The reporting functionality is available only if you have the corresponding license and the Monitoring feature is

activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.
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You can open the Air Monitoring window for creating the air monitoring report by clicking Reports →

Monitoring → Air Monitoring on the menu bar.

The Air Monitoring window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Radioserver

Provides the ability to select SmartPTT Radioserver whose database will be used as a data source for reporting.

System

Provides the ability to select the radio network for which the air monitoring report will be created. It contains both

active networks and inactive ones that are no longer in use. The network identifier is displayed for inactive

networks, and the network name is displayed for active networks. The All value is used to display all radio

networks in the report.

Radio

Provides the ability to select a radio for which the air monitoring report will be created. If the All value is selected,

the air monitoring report will be created for all radios.

UTC Time

Provides the ability to display the report time, as well as the report start and end dates in the Coordinated

Universal Time standard (UTC+00:00). If the check box is not selected, the report time, as well as the report start

and end dates will be displayed according to the time zone set on the dispatcher's computer (for example,

UTC+07:00).

Sort by

Activates the parameters by which the report data can be sorted: System, Repeater, Slot, Event type, From, To,

Duration (ms), RSSI (dBm).

For information on report exporting, see Report Exporting.



497

Reports Monitoring Reports

7.6.1.1 Creating Air Monitoring Report

Follow the procedure to create the air monitoring report.

Prerequisites: 

• Ensure you have the monitoring license. For details, see Licenses.

• Ensure the monitoring feature is activated in SmartPTT Radioserver Configurator. For details, see “Configuring

Monitoring Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure monitoring is available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. On the menu bar, click Reports → Monitoring → Air Monitoring.

The Air Monitoring window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create the air

monitoring report for the specified period.

3. From the Radioserver list, select the desired SmartPTT Radioserver.

4. From the System list, select the network to create a report:

To create a report for the specific network, select the desired network.

To create a report for all networks, select the All value.

5. From the Radio list, select the radio to create a report:

To build a report for the specific radio, select the desired radio.

To create a report for all radios, select the All value.

6. (Optional) Configure additional parameters to create a report:

To display time in the Coordinated Universal Time

standard (UTC+00:00) in the report,

select the UTC Time check box.

To sort data in the report, perform the following actions:

1. Select the Sort by check box.

2. Select one of the parameters to sort data in the

report: System, Repeater, Slot, Event type, From, To,

Duration (ms), RSSI (dBm).

7. Click OK to create a report.
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Postrequisites: 

Determine the format to export a report. For information on report exporting, see Report Exporting.

7.6.2 Event Log Report

The Event Log report is created on the basis of data stored in the monitoring Event Log.

Important

The reporting functionality is available only if you have the corresponding license and the Monitoring feature is

activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

You can open the Event Log window for creating the Event Log report by clicking Reports → Monitoring → Event

Log on the menu bar.

The Event Log window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Radioserver

Provides the ability to select SmartPTT Radioserver whose database will be used as a data source for reporting.

The All radioservers value provides the ability to receive data for all radioservers.

The report will be created after clicking the OK button.

For information on report exporting, see Report Exporting.
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7.6.3 System Usage Report

The System Usage report provides information on the radio network channel load, radio network uptime, radio

network downtime, etc.

Important

The reporting functionality is available only if you have the corresponding license and the Monitoring feature is

activated in SmartPTT Radioserver Configurator.

For information on configuring monitoring, see “Configuring Monitoring Database Connection“ in SmartPTT

Installation and Configuration Guide.

For information on licenses, see Licenses.

Important

Access to monitoring can be limited by the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

You can open the System Usage window for creating the system usage report by clicking Reports → Monitoring →

System Usage on the menu bar.

The System Usage window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Radioserver

Provides the ability to select SmartPTT Radioserver whose database will be used as a data source for reporting.

System

Provides the ability to select the radio network for which a report will be created. It contains both active networks

and inactive ones that are no longer in use. The network identifier is displayed for inactive networks, and the

network name is displayed for active networks. The All value is used to display all radio networks in the report.

The report will be created after clicking the OK button.

NOTE

For drop repeaters of the backhaul chain, the report does not provide information on the channel load. For link

repeaters, the report does not provide any information. For information on backhaul chain repeater roles, see

Diagnostics Table.
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NOTE

If a radio is not registered by a drop repeater of a backhaul chain, the Radios table of the report will indicate that

the radio is registered by the proxy repeater of the backhaul chain, or is registered on the site of the proxy

repeater.

For information on report exporting, see Report Exporting.

7.7 Lone Workers

The Lone Workers report provides information about registration, calls, sending messages, and other events for

radios which are in the Lone Worker mode. For details, see Lone Worker Rules.

NOTE

The report is unavailable to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

You can open the Lone Workers window for creating a report by clicking Reports → Lone Workers on the menu

bar.

The window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Radio

Provides the ability to select a radio for which a report will be created. If the All value is selected, the report will be

created for all radios.

Sort By

Activates the parameters by which the report data can be sorted: Direction, Event Type, Date/Time, Additional

information, Operator, Radioserver, Channel, Radio, Talkgroup, Status, Duration, Destination. For details, see

Dispatcher Event Log Table.

The report will be created after clicking the OK button. For information on report exporting, see Report Exporting.
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7.8 Indoor Tracking

The Indoor Tracking report contains information on the movement of indoor radios based on the data received

from special beacons. For details, see Indoor Tracking.

Important

For report creating the Indoor Tracking license is required. For details, see Licenses.

NOTE

The report is unavailable to SmartPTT Mobile users.

For information on the mobile application, see “SmartPTT Mobile” in SmartPTT Installation and Configuration Guide.

You can open the Indoor Tracking window for creating a report by clicking Reports → Indoor Tracking on the

menu bar.

The Indoor Tracking window provides the following elements:

Period

Contains the start and end dates of events including time that will be displayed in the report.

Radioserver

Provides the ability to select SmartPTT Radioserver whose database will be used as a data source for reporting.

The All radioservers value provides the ability to create a report for all radioservers.

Beacon

Provides the ability to select the beacon for which a report will be created. The All beacons value provides the

ability to create a report for all beacons.

Radio

Activates the ability to select from the list below the desired radio for which a report will be created. If the All radios

value is selected from the list, a report will be created for those radios that have been registered on the beacons

side.
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User

Activates the ability to select from the list below the desired user for whom a report will be created. The list of

users is taken from the connected database. If the All users value is selected from the list, a report will be created

for those users that have been registered on the beacons side.

Group by

Activates the ability to group data in a report by the following values: Beacons, Radios and Users.

For information on report exporting, see Report Exporting.

Important

Under the high load conditions of a repeater, the report may contain corrupted beacon IDs. To resolve the

problem, it is necessary to increase the number of acknowledgments sent from the beacon to the radio by

increasing the values in the Beacon sign on count and the Beacon sign off count fields in the K-Term CPS

settings (applied for K-Term beacons by Kilchherr Elektronik AG). In the Indoor Tracking settings of SmartPTT

Radioserver Configurator, the Set list of allowed beacons check box must be selected and beacon IDs which

data are processed by SmartPTT Radioserver must be specified. You can also submit a request to the SmartPTT

Technical Support Center.

NOTE

N/A is displayed in the Beacons column of the report if a radio leaves the coverage area of the beacons.

7.8.1 Creating Indoor Tracking Report

Follow the procedure to create a report on the movement of indoor radios based on data received from special

beacons.

Prerequisites: 

• Ensure you have the Indoor Tracking license. For details, see Licenses.

• Ensure that the SmartPTT Radioserver Event Log is activated in SmartPTT Radioserver Configurator. For details,

see “Configuring Event Log Database Connection” in SmartPTT Installation and Configuration Guide.

• Ensure that the desired SmartPTT Radioserver is running.

• Ensure an operator has the Build reports right. For details, see Operators.

• Ensure an operator has the Request radio location right. For details, see Operators.

Procedure: 

1. On the menu bar, click Reports → Indoor Tracking.

The Indoor Tracking window appears.

2. In the window that appears, in the Period field, enter the desired dates and time of events to create a report

for the specified period.

3. From the Radioserver list, select SmartPTT Radioserver for creating a report:

To create a report for the specific SmartPTT

Radioserver,

select SmartPTT Radioserver with the desired name.

http://support.smartptt.com/hc/en-us/
http://support.smartptt.com/hc/en-us/
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To create a report for all radioservers, select the All radioservers value.

4. From the Beacon list, select the beacon for creating a report:

To create a report for the specific beacon, select a beacon with the desired name.

To create a report for all beacons, select the All beacons value.

5. Specify which data will be displayed in a report:

To display data for unregistered radios in the

report,

perform the following actions:

1. Select Radio.

2. From the list below, select the desired radio or the

All radios value.

To display data for registered users in the report, perform the following actions:

1. Select User.

2. From the list below, select the desired user or the

All users value.

6. (Optional) Specify data grouping in the report:

a. Select the Group by check box.

b. Select the desired value:

To group data in the report by beacons, from the unblocked list on the right, select the

Beacons value.

To group data in the report by radios, from the unblocked list on the right, select the

Radios value.

To group data in the report by users, from the unblocked list on the right, select the Users

value.

7. Click OK to create a report.

Postrequisites: 

Determine the format to export a report. For information on report exporting, see Report Exporting.

7.9 Report Exporting

Reports on the SmartPTT Dispatcher and SmartPTT Radioserver operation are created as separate files that can be

saved on a computer in the desired format, printed or sent to the desired email address. All these actions are

performed in the Print Preview window, where the created report is opened.

Reports on the SmartPTT Dispatcher and SmartPTT Radioserver operation are saved on the computer in the PRNX

format.



504

Reports Report Exporting

If necessary, the created report can be exported in any of the following formats: PDF, HTML, MHT, RTF, XLS, XLSX,

CSV, TXT, XPS. The created reports can also be saved as image files of the following formats: BMP, EMF, WMF, GIF,

JPEG, PNG, TIFF.

NOTE

Reports created by the Report Wizard on the basis of SmartPTT Dispatcher and SmartPTT Radioserver Event Logs

are saved on a computer as separate files of the following formats: HTML, MHT, XLS, XLSX, CSV, TXT.
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8 Conference Calls

The Conference Calls feature provides the ability to connect multiple people in a single call. All participants of the

conference call can hear and speak to each other.

Conference calls are initiated in SmartPTT Dispatcher. Participants of the conference do not see other participants.

Only the dispatcher that initiated the call can see, add, and remove participants from the conference.

Important

Conference calls are available to the Administrator, or to operators with the corresponding permission. For details,

see Operators.

The following user groups can participate in conference calls:

• Radios

• Talkgroups

• Dispatchers

• Telephone subscribers

NOTE

Connection to telephone subscribers through a conference call does not require the Telephone Interconnect

Service license.

The conference call initiates automatically when you add a participant to the Participants box in the

Conference Calls window.

The conference call finishes automatically when the Conference call idle session timeout period set in SmartPTT

Radioserver Configurator expires. For details, see “Configuring Phone Calls” in SmartPTT Installation and Configuration

Guide.

For information on ways of initiating conference calls, see the sections below.
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8.1 Conference Calls Window

The Conference Calls window provides controls for organizing a conference call. In this window, you can add and

remove the conference call participants and manage your sound settings.

You can open the Conference Calls window in one of the following ways:

• By clicking the Make Conference Call (   ) button on the menu bar. For details, see Dispatchers.

• By clicking the Make Conference Call (   ) button:

• In the Actions Menu or Call Window of a radio, or talkgroup. For details, see Dispatchers.

• In the radio menu from the Maps panel. For details, see Dispatchers.

• In the Telephone Subscribers window. For details, see Telephone Subscribers Settings.

• In the Dispatchers window. For details, see Dispatchers.

The Conference Calls window consists of two areas.

The area in the right part of the window contains information on the current conference call.

The Participants box in the upper-right corner contains information on the conference call participants. It provides

the following elements:

Icon

Indicates the type of the participant (radio, talkgroup, dispatcher, or telephone subscriber).

Name

Name of the conference call participant registered in SmartPTT Dispatcher or number of the unregistered

telephone subscriber.

Status

The connection status. It can have the following values:
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• The Ringing status indicates that the invitation request has been sent, and SmartPTT Dispatcher is waiting for

connection to be established.

• The Call status indicates that connection has been successfully established and the conference call is in

progress.

If SmartPTT Dispatcher failed to send the invitation request, the user does not appear in the Participants box. The

relevant entry appears in the Event Log.

Finish Conference Call (   )

Finishes the conference call for the participant. If connection has not yet been established, it stops connection

attempts.

The Log box below the Participants box contains the conference call history. It provides information on the

connection status changes and errors that occurred during the connection establishing.

The left area of the Conference Calls window contains groups of available participants divided according to their

type. This area provides the following elements::

Telephone Subscribers

Expands the list of telephone subscribers registered in SmartPTT Dispatcher. For details, see Telephone

Subscribers Settings.

Radios

Expands the list of radios that are currently registered in SmartPTT Dispatcher.

Talkgroups

Expands the list of talkgroups configured on SmartPTT Radioserver. For details, see “Talkgroups” in the

corresponding network settings description in SmartPTT Installation and Configuration Guide.

Dispatchers

Expands the list of SmartPTT Dispatchers that are currently online.

NOTE

If no dispatchers are added to the list of dispatchers, the Dispatchers group is not displayed.

Dial Pad

Expands the dial pad using which you can dial the number of a telephone subscriber that is not registered in

SmartPTT Dispatcher.

Mute (   )

Turns off the conference call sound in SmartPTT Dispatcher. When activated, the dispatcher's microphone is

turned off automatically.

Turn off microphone (   )

Turns off the dispatcher's microphone.

Stop

Finishes the conference call.

NOTE

A special tone indicates the end of the call on the radio. If the radio user initiates a new transmission before they

hear the tone, the transmission will be initiated incorrectly and may fail.
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For information on the Conference Calls functionality, see Conference Calls.

For information on ways of initiating conference-calls, see Initiating Conference Calls.

8.2 Initiating Conference Calls

The Conference Calls feature provides the ability to organize conference with radios, talkgroups, dispatchers, and

telephone subscribers.

In SmartPTT Dispatcher you can organize a conference call in one of the following ways:

• By selecting the desired participants from the Conference Calls window. For details, see Initiating Calls from

the Conference Calls Window.

• By inviting a specific participant to the conference using the following SmartPTT Dispatcher elements:

• SmartPTT Dispatcher panels. For details, see Initiating Calls from Dispatcher Panels.

• The Dispatchers window. For details, see Initiating Calls from the Dispatchers Window.

• The Telephone Subscribers window. For details, see Initiating Calls from the Telephone Subscribers

Window.

8.2.1 Initiating Calls from the Conference Calls Window

Follow the procedure to initiate a conference call using the Make Conference Call (   ) button.

Prerequisites: 

• Ensure that the desired radio, or dispatcher is online.

• Ensure an operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Make Conference Call (   ).

The Conference Calls window appears.

2. In the Conference Calls window, invite the desired participant to the conference:

To invite a radio, talkgroup, dispatcher, or

a telephone subscriber registered in

SmartPTT Dispatcher,

in the left part of the Conference Calls window, expand the

desired group, and then double-click or drag and drop the

desired conference participant to the Participants box in the

upper-right corner of the window.

To invite a telephone subscriber not

registered in SmartPTT Dispatcher,

perform the following actions:

1. In the left part of the Conference Calls window, click

Dial Pad.

The dial pad appears.
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2. On the dial pad, dial the desired subscriber's number,

and then click the Phone (   ) button.

NOTE

If the VoIP gateway default settings are specified in

SmartPTT Radioserver Configurator, you only need to dial

the subscriber's phone number. If default settings are not

specified, you need to dial the subscriber's full address.

The selected user appears in the Participants box in the right part of the window.

Postrequisites: 

• To invite more participants to the conference call, repeat step 2.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone ( 

 ).

• To remove a participant from the current conference call, click Finish Conference Call (   ) next to the name

of the desired participant in the Participants field.

• To finish the conference call for all participants, click Stop.

8.2.2 Initiating Calls from Dispatcher Panels

Follow the procedure to initiate a conference call by sending an invitation request to a radio, or talkgroup.

Prerequisites: 

• Ensure that the desired radio is online.

• Ensure an operator has the Make conference calls right. For details, see Operators.

Procedure: 

Initiate a conference call in one of the following ways:

To send an invitation request to a radio, or

talkgroup from the Radio Fleet panel,

click the Actions (   ) button on the desired radio object, and

then click Make Conferenc  Call (   ).

To send an invitation request to a radio

from the Radios panel,

click the Actions (   ) button on the desired radio object

element, and then click Make Conference Call (   ).

To send an invitation request to a radio

from the Maps panel,

on the map or on the expandable Radios panel, right-click the

desired radio object, and then click Make Conference Call ( 

 ).

To send an invitation request to a radio, or

talkgroup from the Call Window,

in the Call Window of the desired radio object, click Make

Conference Call (   ).

For information on Call Windows, see Radio Call Window.
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 The Conference Calls window with information on the initiated conference call appears.

Postrequisites: 

• For information on adding more participants to the conference call, see Initiating Calls from the Conference

Calls Window.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone ( 

 ).

• To remove a participant from the conference call, click Finish Conference Call (   ) next to the name of the

desired participant in the Participants field.

• To finish the conference call, click Stop.

8.2.3 Initiating Calls from the Dispatchers Window

Follow the procedure to initiate a conference call by sending an invitation request to a dispatcher from the

Dispatchers window.

Prerequisites: 

• Ensure that the desired dispatcher is added to SmartPTT Dispatcher and online.

• Ensure an operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Dispatchers (   ).

The Dispatchers window appears.

2. From the list of dispatchers, select the desired dispatcher, and then click Make Conference Call (   ) in the

lower-right corner of the window.

The Conference Calls window with information on the initiated conference call appears.

The log of the call appears in the Log box in the lower-right corner of the window.

NOTE

If during the conference call the Dispatchers window is open, closing it will automatically remove the dispatcher

from the conference-call.

Postrequisites: 

• For information on adding more participants to the conference call, see Initiating Calls from the Conference

Calls Window.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone ( 

 ).

• To remove a participant from the conference call, click Finish Conference Call (   ) next to the name of the

desired participant in the Participants field.

• To finish the conference call, click Stop.
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8.2.4 Initiating Calls from the Telephone Subscribers Window

Follow the procedure to initiate a conference call by sending an invitation request to a telephone subscriber.

Prerequisites: 

• Ensure that the desired telephone subscriber is online.

• Ensure that the required conference calls parameters are configured in the Telephone Interconnect settings.

• Ensure an operator has the Make conference calls right. For details, see Operators.

Procedure: 

1. On the menu bar, click Telephone Subscribers (   ).

The Telephone Subscribers window appears.

2. Initiate the conference call in one of the following ways:

To invite a telephone subscriber registered in

SmartPTT Dispatcher,

on the Telephone Subscribers tab, from the list of

telephone subscribers, select the desired subscriber,

and then click Make Conference Call (   ) in the

lower-right corner of the window.

To invite a telephone subscriber not registered in

SmartPTT Dispatcher,

on the Dial Pad tab, dial the desired subscriber's

number, and then click Make Conference Call (   )

in the lower-right corner of the window.

NOTE

If the VoIP gateway default settings are specified,

you only need to dial the subscriber's phone

number. If default settings are not specified, you

need to dial the subscriber's full address.

The Conference Calls window with information on the initiated conference call appears.

The log of the call appears in the Log field in the lower-right corner of the window.

Postrequisites: 

• For information on adding more participants to the conference call, see Initiating Calls from the Conference

Calls Window.

• To mute the conference call sound and turn off your microphone, click Mute (   ).

• To turn off your microphone and keep listening to the conference participants, click Turn off microphone ( 

 ).

• To remove a participant from the conference call, click Finish Conference Call (   ) next to the name of the

desired participant in the Participants field.

• To finish the conference call, click Stop.
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9 Text Messages

The Text Messaging feature provides the ability to send and receive text messages in SmartPTT Dispatcher. Using

this feature, you can also create templates for frequently sent messages.

In SmartPTT Dispatcher you can perform the following actions:

• Send messages to radios and talkgroups.

• Receive messages from radios.

• Send and receive messages from other dispatchers.

For details, see Sending Messages to Dispatchers.

Important

To use the text messages, an operator needs to have the corresponding permission. For details, see Operators.

Important

The ability to send and receive text messages can be limited by the client registered in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

NOTE

The Text Messaging feature is unavailable to WAVE and SmartPTT Mobile users.

For information on WAVE users and the mobile application, see “WAVE Systems” and “SmartPTT Mobile” in

SmartPTT Installation and Configuration Guide.

The character limit for a text message is 500 characters including spaces and punctuation marks.

Text messages to radios and talkgroups in SmartPTT Dispatcher can be sent in one of the following ways:

• From the Send Message window.

This window provides full functionality of the Text Messaging feature in SmartPTT Dispatcher. For details, see

Sending Messages from the Send Message Window and Managing Message Templates.

• From the Call Window of a radio or talkgroup.

The Call Window is normally used for sending quick messages. For details, see Sending Messages from the Call

Window.

• From the TMS element in the Custom Console.

The TMS element can be used for sending quick messages and message templates without the ability to edit

them. For details, see Sending Messages.

• Automatically when triggered by a rule configured in the Custom Rules settings. For details, see Custom Rules.

Only online radios can receive messages. You can track your messages in the Status column in Event Log and in the

log box of the Call Window.

After sending or receiving a message, the information on it appears in the the log box of the Call Window and in the

Event Log. SmartPTT Dispatcher provides the following statuses:

Status Description

Message delivered The message was successfully delivered to the target

radio.
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Message not delivered The message was not delivered due to issues with the

radio connection to the radio system

Message accepted A message from a radio or another dispatcher was

received.

Message sent The message was successfully sent to the talkgroup.

Message was not sent The message was not sent to the talkgroup due to

issues with the SmartPTT Dispatcher connection to

SmartPTT Radioserver.

SmartPTT Dispatcher does not provide information on which of the radios in the talkgroup received the message. To

check the message delivery status for a specific radio, you can resend the message to the desired radio individually.

NOTE

The delivery status may be affected by the radio device settings. For information on your system configuration,

contact your system administrator.

When a message from a radio is received, a new entry with the message details appears in the Event Log. In the

Call Windows settings you can also configure the Call Window to appear automatically. For details, see Call Window

Settings.

When a message from another dispatcher is received, the Dispatchers window appears. For details, see Dispatchers.

An audio file can be set to play to inform you of a new incoming message. For details, see “Rules” in SmartPTT

Installation and Configuration Guide.

For information on ways of sending text messages, see the sections below.
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9.1 Send Message Window

The Send Message window provides the full text messaging functionality in SmartPTT Dispatcher. In this window,

you can perform the following actions:

• Send your own messages or preconfigured message templates. For details, see Sending Messages from the

Send Message Window.

• Create, edit, and delete message templates. For details, see Managing Message Templates.

The Send Message window provides the following elements:

Template

Expands the list of existing message templates.

Save Template

Opens the Message Template Name window where you can set the name for the new template. It also saves

the changes that you make to an existing template.

Delete Template

Deletes the template that is currently selected in the Template list.

Send

Sends the message from the text field to the selected radio or talkgroup.

Cancel

Closes the Send Message window.
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9.2 Sending Messages from the Send Message Window

Follow the procedure to send a text message from the Send Message window to a radio or a talkgroup.

Prerequisites: 

• Ensure an operator has the permission to send messages. For details, see Operators.

• Ensure text messages are available to the client registered in SmartPTT Radioserver Configurator. For details,

see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Open the Send Message window in one of the following ways:

To open it from the Radio Fleet panel, to the right of the desired radio, talkgroup, or

category name, click the Actions (   ) button, and

then click Send Message (   ).

To open it from the Radios panel or the Custom

Console panel,

click the Actions (   ) button on the desired radio or

talkgroup element, and then click Send Message ( 

 ).

To open it for a radio from the Maps panel, on the map or in the Radios tab of the Radios panel,

right-click the desired radio, and then click

Send Message (   ).

To open it for a category from the Maps panel, in the expandable Radios panel, in the Categories

tab, right-click the desired category, and then click

Send Message (   ).

To open it from the Call Window of a radio or a

talkgroup,

in the Call Window, click Message (   ).

For information on call windows, see Radio Call

Window and Talkgroup Call Window..

2. Depending on the message that you want to send, perform one of the following actions:

To type a new text message, in the text field, type your message, and then click

Send.

To use a message template, perform the following actions:

1. From the Template list, select the name of the

desired template.

The text of the message appears in the text field

below.

2. (Optional) In the text field, edit the text of the

message.

3. Click Send.
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 The information on the sent message appears in the log field of the Call Window and in the Event Log.

NOTE

If you send the message to a radio group or a category on the Radio Fleet panel, the information on its delivery is

displayed for each radio and talkgroup individually.

Postrequisites: 

For information on working with message templates, see Managing Message Templates.

9.3 Sending Messages from the Call Window

Follow the procedure to send a quick message from the Call Window of a radio or a talkgroup.

Prerequisites: 

• Ensure you an operator has the permission to send messages. For details, see Operators.

• Ensure that the Call Window of the desired radio or talkgroup is open.

For information on ways to access the Call Window, see Radio Call Window.

• Ensure text messages are available to the client registered in SmartPTT Radioserver Configurator. For details,

see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

Send the message in one of the following ways:

To type a new message and send it from the Call

Window,

at the bottom of the Call Window, in the text field, type

your message, and then click the Send (   ) button.

To type a new message or use a message

template and send it from the Send Message

window,

perform the following actions:

1. Click the Message (   ) button to the right of the

text field.

2. In the Send Message window, type the message

in the text field or use a message template, and

then click Send.

For information on sending messages from the

Send Message window, see Sending Messages

from the Send Message Window.

 The information on the sent message appears in the log field of the Call Window and in the Event Log.
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9.4 Managing Message Templates

Follow the procedure to to configure message templates for frequently sent messages.

Prerequisites: 

• Ensure you an operator has the permission to send messages. For details, see Operators.

• Ensure text messages are available to the client registered in SmartPTT Radioserver Configurator. For details,

see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Open the Send Message window. For details, see Send Message Window.

2. Depending on what you want to do with the template, perform one of the following actions:

To create a new template, perform the following actions:

1. In the text field, type your message, and then click

Save Template.

2. In the Message Template Name window, in the text

field, type the template name.

NOTE

If you leave the field empty, the template gets the New

Template name that you can change later.

To edit an existing template, perform the following actions:

1. From the Template list, select the name of the desired

template.

2. In the text field below, edit the template message.

3. Click Save Template.

To delete an existing template, perform the following actions:

1. From the Template list, select the name of the desired

template.

The text of the message appears in the text field below.

2. Click Delete Template.

3. In the Delete Template window, click OK.
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10 Voice Calls

In SmartPTT Dispatcher you can initiate and reinitiate a range of voice calls inside the radio system. These voice calls

include the following types:

• Private voice calls. For details, see Initiating Private Voice Calls.

• Group voice calls and All Calls. For details, see Initiating Group Voice Calls and All Calls.

• Multiselect calls. For details, see Multicalls.

Important

To initiate voice calls, an operator needs the Make voice calls permission. For information on the operator rights,

see Operators.

Important

The ability to initiate and receive voice calls can be limited by the client registered in SmartPTT Radioserver

Configurator. For details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Dispatchers also receive private calls from any radio that appears in the list of radios available in SmartPTT

Dispatcher. They also receive group calls targeted to any talkgroup (or All Call) they see in the user interface.

For information on initiating voice calls, see the sections below.

10.1 Color Indication of Voice Calls

For operator convenience all voice calls in SmartPTT Dispatcher have their own color indication depending on the

voice call status. This indication informs the operator about the current voice call status, thus allowing to work faster

with the main functionality of the dispatch system.

The following colors for radio objects elements are used during voice calls in SmartPTT Dispatcher:
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Color Indication Call Status

Light-orange Establishing connection via the radio channel. Refers to

outgoing calls made by the Dispatcher.

Orange Sending a voice transmission to a radio. Refers to outgoing

calls made by the Dispatcher.

Light-green Waiting for the radio to answer the call. Refers to outgoing

calls made by the Dispatcher.

Green Sending a voice transmission from a radio to SmartPTT

Dispatcher, including the (remote) monitoring mode. Refers

to incoming calls received by the Dispatcher.

Blue Channel hold mode (none of the parties are transmitting the

voice call).

Clicking the PTT button before the hold time expires resumes

the call. Clicking it after initiates a new call.

NOTE

The duration of hangtime can be different for different

radio objects.

NOTE

Colors in SmartPTT Dispatcher are gradient.

During voice calls color indication is displayed in the following places in SmartPTT Dispatcher:

• The Calls panel ongoing call entries. For details, see Calls.

• PTT buttons of the Radio Fleet panel. For details, see Radio Fleet.

• PTT buttons of the Cross Patches panel. For details, see Cross Patches.

• PTT button in an emergency notification of the Emergencies panel. For details, see Emergencies.

• The Radios panel elements. For details, see Radios.

• The Channel panel elements. For details, see Channels.

• The custom consoles elements. For details, see Custom Consoles.

• The Call Window of the desired object. For details, see Radio Call Window, Talkgroup Call Window, or All Call

Window.

Color indication of radio objects elements during voice calls is accompanied by displaying additional information (for

example, the names of the voice call initiator and recipient).

In addition, the color of radio objects elements can be changed in the following cases:

• During the radio object status change (online or offline).

• When changing the radio object element color in the custom console.
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10.2 Initiating Private Voice Calls

Follow the procedure to initiate a private call.

NOTE

A call can also be initiated using hotkeys. For information on hotkeys, see Keys.

Prerequisites: 

• Check the current settings of the pointing devices. For details, see Pointing Devices.

• Ensure the one of the following panels or windows are opened:

• The Radio Fleet panel. For details, see Radio Fleet.

• The Radios panels. For details, see Radios.

• The radio Call Window. For details, see Radio Call Window.

• The Custom Console. For details, see Custom Consoles.

• Ensure an operator has the Make voice calls right. For information on the operator rights, see Operators.

• Ensure voice calls are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Initiate a private call in one of the following ways:

To initiate a private call using the PTT

button,

press and hold, or click the PTT button of the desired radio.

To initiate a private call using the Radio

element,

press and hold, or click the Radio element of the desired

radio.

The PTT button or the Radio element becomes light-orange (⬛ ), and three dots appear on it.

2. After the color indication appears, perform the following actions:

If the PTT button or the Radio element becomes

orange ( ⬛ ), and three dots appear on it,

perform the following actions:

1. Speak into your microphone.

2. Release or click again the PTT button or the

Radio element to end the radio transmission.

If the PTT button or the Radio element becomes

light-green ( ⬛ ),

perform the following actions:

1. When the PTT button or Radio element becomes

green ( ⬛ ), listen to the radio transmission.

The PTT button or the Radio element becomes

blue ( ⬛ ), when the radio ends the transmission.

2. Click the PTT button or the Radio element again.
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3. When the PTT button or the Radio element

becomes orange ( ⬛ ), speak into your

microphone.

4. To end the radio transmission, release or click

again the PTT button or the Radio element.

When the radio transmission is over, the PTT button or the Radio element becomes blue ( ⬛ ).

3. When the blue color indication ( ⬛ ) appears perform one of the following actions:

To transmit again, repeat the step 1.

To listen to the radio transmission, wait until the PTT button or the Radio element becomes

green ( ⬛ ), and audio is heard from the speakers or

headsets.

To end the call, wait until the blue indication ( ⬛ ) disappears.

10.3 Initiating Group Voice Calls

Follow the procedure to initiate a call into a talkgroup, or an All Call.

NOTE

A call can also be initiated using hotkeys. For information on hotkeys, see Keys.

Prerequisites: 

• Check the current settings of the pointing devices. For details, see Pointing Devices.

• Ensure one of the following panels is open:

• The Radio Fleet panel. For details, see Radio Fleet.

• The Channels panel. For details, see Channels.

• The Custom Console. For details, see Custom Consoles.

• Ensure an operator has the Make voice calls right. For information on the operator rights, see Operators.

• Ensure voice calls are available to the client registered in SmartPTT Radioserver Configurator. For details, see

“Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. Initiate a group call or All Call in one of the following ways:

To initiate a call using the PTT button, press and hold, or click the PTT button of the

desired talkgroup or All Call.

To initiate a call using the Radio element, press and hold, or click the Group Call or All Call

element.

 The PTT button or the call element becomes light-orange ( ⬛ ), and three dots appear on it.
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2. When the PTT button or the call element becomes orange ( ⬛ ), speak into your microphone.

3. To end the transmission, release or click again the PTT button or the call element.

The PTT button or the element becomes blue ( ⬛ ).

4. When the blue color indication ( ⬛ ) appears, perform one of the following actions:

To transmit again, repeat the step 1.

To listen to the radio transmission, wait until the PTT button or the call element becomes

green ( ⬛ ), and audio is heard from the speakers or

headsets.

To end the call, wait until the blue indication ( ⬛ ) disappears.

10.4 Multicalls

For operator convenience SmartPTT Dispatcher provides the ability to initiate calls simultaneously to several selected

radios and/or talkgroups, including All Call.

Multicalls can be initiated in the following ways:

• On the Radios panel. For details, see Radios.

• On the Channels panel. For details, see Channels.

• On the Custom Console. For details, see Custom Consoles.

To initiate a multicall, it is necessary to select the desired radio object elements while pressing and holding the CTRL

or SHIFT button. The blue frame appears on the Radio elements.

NOTE

The same action is performed to deselect the radio object elements.

A call to the selected objects is initiated by pressing and holding or pressing the hotkey for the PTT button. For

information on hotkeys, see Keys.

When the call is initiated, the radio objects become orange ( ⬛ ). For information on color indication of voice calls, see

Color Indication of Voice Calls.

Multicalls can also be initiated with the help of special elements of the Custom Console, in particular:

• The Panel element. For details, see Panel.

• The Multiselect element. For details, see Multiselect.

• The Broadcast Call element. For details, see Broadcast Call.
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10.5 Incoming/Outgoing Transmissions Interrupt

In some networks, voice calls from operators can interrupt voice calls from radios and, vice versa, voice calls from

radios can interrupt voice calls from operators. These settings are set in SmartPTT Radioserver.

NOTE

These settings do not relate to the radio codeplug settings. To apply these settings, the permission to interrupt in

both ways must be configured in the radio codeplug.

Regardless of the specified settings, emergency calls from radios cannot be interrupted. They always have the

highest priority regarding outgoing voice calls from an operator and other voice calls.

If a voice call involving multiple channels simultaneously was interrupted, then SmartPTT stops sending sound only

to the channel on which a voice call was interrupted.

If the corresponding settings are specified, then radios can be interrupted as the result of the following actions:

• Sending sound notifications to the radio network.

• Performing a deferred action with sending sound to the radio network.

• Performing a server rule related to sending sound to the radio network.

• Sending a voice message to the lone worker.

• Initiating a voice call to a cross patch or any other type of a voice call.
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11 Bridging Service

In SmartPTT you can use bridging service to interconnect subscribers of multiple networks. The bridging service is

implemented by SmartPTT Radioserver, and you should activate the service in SmartPTT Radioserver Configurator.

By using the bridging service in SmartPTT, you can perform the following actions:

• Connect various radio networks

• Route voice calls from selected radios, talkgroups, and radio groups

• Route private calls dynamically

Important

For this functionality the corresponding license is required. For details, see Licenses.

The bridging service is supported between digital and analog channels in the following networks:

• IP Site Connect

• Capacity Plus sites

For information on using the bridging service, see the sections below.

11.1 Bridging Configuration Window

The main idea of bridging configuration in SmartPTT Dispatcher is using of profiles and route groups. Profiles contain

information on the bridging rules, which are specified in routes and route groups.

In the Bridging Configuration window you can create routes and route groups, and add them to profiles. For

details, see Configuring All Routes, Adding Route Groups, Adding Profiles. Bridging settings can be configured

individually for each SmartPTT Radioserver.

Important

The bridging service is available to the Administrator, or to operators with the corresponding permission. For

details, see Operators.

Important

Access to the bridging service can be limited by the client registered in SmartPTT Radioserver Configurator. For

details, see “Profiles” in SmartPTT Installation and Configuration Guide.
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You can open the window by clicking the Actions (   ) button next to SmartPTT Radioserver on the Radio Fleet

panel, and selecting Configure Call Bridging Table. For details, see Radioserver Actions Menu.

The Bridging Configuration window provides the following elements:

Radioserver

Name of the current radioserver.

Profile

Name of the current profile. If no profile is applied, the No text is displayed. For information on profiles, see

Bridging Profiles Window.

All / Active

Displays all or only active route groups in the Route Groups table.

Change Profile

Opens the Bridging Profiles window where you can manage profiles. For information on profiles management,

see Adding Profiles.

Save

Saves changes of the configuration to the current profile.

Save As

Opens the Enter Profile Name window. Saves the current configuration as a new profile.

Add Route Group

Opens the Add Route Group window for adding a new route group.

Edit Group

Opens the Add Route Group window for editing the selected group.

Delete Route Group

Removes the selected route group from all profiles.

Show Details / Hide Details

Show or hide detailed information on all groups respectively.
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Apply

Activates the current profile settings. After activating the profile, the asterisk character ( * ) appears next to the

profile name.

Route Groups table

Contains a list of of available routes organized in groups.

The table provides the following elements:

• Expand (   ) or Collapse (   ) controls next to the group name show or hide the group detailed information.

NOTE

When the group is expanded, it contains the routes added in the Add Route Group window. For details, see Add

Route Group Window.

• The Active column contains the check box to activate or deactivate the desired groups.

• The Route Group column contains the route group name.

11.1.1 Add Route Group Window

A route group unites several routes into one group. Route groups provide a neat look to profiles. Route groups can

be activated and deactivated for using routes inside these groups.

In the Add Route Group window you can create a new route group, or edit the existing group. For details, see

Adding Route Groups.

The Add Route Group window provides the following elements:

Name

Name of a route group.

Add Route

Opens the Route window for adding a new route.

Edit Route

The button is available when at least one route is added. Opens the Route window of the existing route for

editing.
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Delete Route

The button is available when at least one route is added. Removes the route from the group.

Routes Table

Contains the added routes. For details, see Route Window.

11.1.2 Route Window

Route is a basic unit of bridging process, and is an integral part of a route group. Routes cannot be used separately

from route groups.

In the Route window you can create a new route, or edit the existing.

The Route window provides the following elements:

Route Number

Contains a unique route number. The field appears at creating a new route.

Source Control Station

Provides the list of available source channels for the route. In the Routes Group table it calls as Source Network.

Route Type

Provides the list of route types to configure:

• All type for routing all voice calls from the source network to the destination network.

• Talkgroup type for routing non-private calls (group calls and All Calls).

• Radio type for routing individual calls between subscribers.

• Dynamic type for routing radio private calls inside radio groups created in SmartPTT Radioserver Configurator.

For details, see “Managing Radio Groups” in SmartPTT Installation and Configuration Guide.

Destination Control Station

Provides the list of available destination channels for the route. In the Routes Group tables it calls as Destination

Network.

Important

Bridging is unavailable to systems accessed over the 4-wire interfaces.
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Source

Contains a source ID or name for the route (radio ID, talkgroup name, or All Call name).

Direction

Provides the list of directions for the route:

• If One-way (   ) direction is selected, only source network can route calls.

For the one-way direction of the Radio route, a radio from the source network can initiate calls to the

destination channel and receive private calls from this channel.

• If Two-way (   ) direction is selected, both source and destination networks can route calls.

For the two-way direction of the Radio route, a radio from the source network can initiate calls to the

destination channel, receive private calls from this channel, and repeat these actions when re-registering on the

destination channel.

NOTE

You can select any direction for the Dynamic route type, because connection between subscribers occurs within

the subscriber group.

Target

Contains the target ID or name for the route (radio ID, talkgroup name, or All Call name).

Process Routed Calls

When selected, it provides routing of incoming calls of the channel by another route.

EXAMPLE

You can add all these routes without the Process Routed Calls check box selected:

• IPSC 01 slot 01 ←→ IPSC 02 slot 01

• IPSC 01 slot 01 ←→ IPSC 03 slot 01

• IPSC 01 slot 01 ←→ IPSC 04 slot 01

• IPSC 02 slot 01 ←→ IPSC 03 slot 01

• IPSC 02 slot 01 ←→ IPSC 04 slot 01

• IPSC 03 slot 01 ←→ IPSC 04 slot 01

Or, you can select the check box, and add only three routes:

• IPSC 01 slot 01 ←→ IPSC 02 slot 01

• IPSC 02 slot 01 ←→ IPSC 03 slot 01

• IPSC 03 slot 01 ←→ IPSC 04 slot 01

Important

Do not use round routes. They can cycle all routes and lead to unstable system operation (for example, IPSC 01

slot 01 ←→ IPSC 04 slot 01).
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11.1.3 Bridging Profiles Window

You can use profiles for quick switching between preconfigured activated route groups. Profiles can be created for

general purposes, for carrying out engineering work, for emergency situations, etc.

In the Bridging Profiles window you can manage profiles (add, rename, delete, and switch between them). For

details, see Adding Profiles. The window appears by clicking Change Profile in the Bridging Configuration window.

The Bridging Profiles window provides the following elements:

No Profile

When selected, the created groups have no reference to a specific profile. The profile list and buttons for profile

edition become unavailable.

Select Profile

When selected, the profile list is available for editing, and route groups can be assigned to the selected profile.

Add

Opens the Enter Profile Name window for adding a new profile.

Edit

Opens the Enter Profile Name window for renaming the existing profile.

Delete

Removes the selected profile.

11.2 Adding Route Groups

Follow the procedure to add a route group.

Prerequisites: 

• Ensure an operator has the Manage bridging settings right. For information on the operator rights, see

Operators.
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• Ensure the bridging service is available to the client registered in SmartPTT Radioserver Configurator. For

details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the Bridging Configuration window, click Add Route Group.

The Add Route Group window appears.

2. In the Name box, type the group name.

3. Add the desired routes to the group depending on the call types:

• To route any type of voice calls, see Configuring All Routes.

• To route group calls and All Calls, see Configuring Non-Private Routes.

• To route individual calls only, see Configuring Private Routes.

• To route private voice calls initiated and received by radios included in the radio group, see Configuring

Dynamic Routes.

4. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route group, in the Bridging Configuration window, select the desired group, and then click Edit

Group.

• To delete the route group, in the Bridging Configuration window, select the desired group, and then click

Delete Group.

11.2.1 Configuring All Routes

Follow the procedure to route all voice calls from the source network to the destination network.

Prerequisites: 

Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

Procedure: 

1. In the Bridging Configuration window, click Add Route Group.

The Add Route Group window appears.

2. In the Add Route Group window, click Add Route.

The Route window appears.

3. In the Route window, in the Route Number box, type a unique route number.

4. From the Route Type list, select All.

5. From the Source Control Station list, select the desired source channel.

6. From the Destination Control Station list, select the desired destination channel.

7. From the Direction list, select one-way or two-way direction.
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8. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

9. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route.

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route.

11.2.2 Configuring Private Routes

Follow the procedure to route individual radio calls.

Important

Private calls cannot be routed in networks with control stations.

Prerequisites: 

• Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

• Obtain the desired radio ID from the source network.

Procedure: 

1. In the Bridging Configuration window, click Add Route Group.

The Add Route Group window appears.

2. In the Add Route Group window, click Add Route.

The Route window appears.

3. In the Route window, in the Route Number box, type a unique route number.

4. From the Route Type list, select Radio.

5. From the Source Control Station list, select the desired source channel.

6. From the Destination Control Station list, select the desired destination channel.

7. In the Source box, type the radio ID from the source network.

NOTE

The Target box is unavailable when you configure individual radio calls.

8. From the Direction list, select one-way or two-way direction.

9. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

10. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route.

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route.
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11.2.3 Configuring Non-Private Routes

Follow the procedure to route group calls or All Calls.

Prerequisites: 

Ensure that the desired networks are configured in SmartPTT Radioserver Configurator.

Procedure: 

1. In the Bridging Configuration window, click Add Route Group.

The Add Route Group window appears.

2. In the Add Route Group window, click Add Route.

The Route window appears.

3. In the Route window, in the Route Number box, type a unique route number.

4. From the Route Type list, select Talkgroup.

5. From the Source Control Station list, select the desired source channel.

6. From the Destination Control Station list, select the desired destination channel.

7. From the Source list, select the desired source talkgroup or All Call.

8. From the Target list, select the desired destination talkgroup or All Call.

9. From the Direction list, select one-way or two-way direction.

10. (Optional) Select the Process Routed Calls check box to route incoming calls by another route.

11. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route.

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route.

11.2.4 Configuring Dynamic Routes

Follow the procedure to route private voice calls initiated and received by radios included in the radio group.

Important

Private calls cannot be routed in networks with control stations.

Prerequisites: 

Ensure the radio group is added in SmartPTT Radioserver Configurator.

For details, see “Managing Radio Groups” in SmartPTT Installation and Configuration Guide.

NOTE

Do not confuse radio groups (created in SmartPTT Radioserver Configurator) and talkgroups (radio system

entities which are set in radio codeplugs).
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Procedure: 

1. In the Bridging Configuration window, click Add Route Group.

The Add Route Group window appears.

2. In the Add Route Group window, click Add Route.

The Route window appears.

3. In the Route window, in the Route Number box, type a unique route number.

4. From the Route Type list, select Dynamic.

5. In the Subscriber Group box, select the desired radio group.

6. From the Direction list, select any direction.

7. Click OK to apply changes and close the window.

Postrequisites: 

• To edit the route, in the Add Route Group window, select the desired route, and then click Edit Route.

• To delete the route, in the Add Route Group window, select the desired route, and then click Delete Route.

11.3 Configuring Profiles

Configuration and managing of profiles in SmartPTT Dispatcher include the following:

• Adding profiles. For details, see Adding Profiles.

• Switching between added profiles, and renaming and deleting of profiles. For details, see Managing Profiles.

11.3.1 Adding Profiles

Follow the procedure to to save the current configuration as a new profile.

Prerequisites: 

• Ensure you added the desired route groups.

For details, see Adding Route Groups.

• Ensure an operator has the Manage bridging settings right. For information on the operator rights, see

Operators.

• Ensure the bridging service is available to the client registered in SmartPTT Radioserver Configurator. For

details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the Bridging Configuration window, in the Route Groups table, select the Active check boxes next to the

desired route groups.

2. (Optional) On the right of Routes, click All or Active to display all or only active route groups.

3. Save the configuration as a new profile:

a. In the Bridging Configuration window, click Save As.

The Enter Profile Name window appears.
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b. In the Profile Name box, type the desired profile name.

c. Click OK to apply changes and close the window.

The saved profile configuration opens.

4. To activate the profile settings, click Apply.

The asterisk character ( * ) appears next to the profile name.

11.3.2 Managing Profiles

Follow the procedure to switch, rename, or delete the profile.

Prerequisites: 

• Ensure an operator has the Manage bridging settings right. For information on the operator rights, see

Operators.

• Ensure the bridging service is available to the client registered in SmartPTT Radioserver Configurator. For

details, see “Profiles” in SmartPTT Installation and Configuration Guide.

Procedure: 

1. In the Bridging Configuration window, click Change Profile.

The Bridging Profiles window appears.

2. Click No Profile or Select Profile for managing groups by using profiles.

3. If Select Profile is selected, in the Bridging Profiles window, perform one of the following actions:

To switch between profiles, select the desired profile from the list.

To rename the profile, perform the following actions:

1. Select the desired profile from the list, and click Edit.

2. In the open Enter Profile Name window, type a new

name for the profile.

3. Click OK to apply changes and close the window.

To delete the profile, perform the following actions:

1. Select the desired profile from the list, and click Delete.

2. In the open confirmation window, click OK.

4. In the Bridging Profiles window, click OK to apply changes and close the window.
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12 Help

The Help (   ) menu provides the following elements:

SmartPTT Help

Contains information on the system objects and functionality. You can also open the SmartPTT Help file any time

by pressing F1.

About

Contains information on the application version, license, and the third-party software used in development

process.



536

Remote Assistance  

13 Remote Assistance

SmartPTT contains Remote Assistance program which provides the remote access to your computer for SmartPTT

technical support engineer. Using this program he can resolve technical issues on your computer.

To use Remote Assistance program, perform the following actions:

1. Run Remote Assistance.

2. Contact technical support engineer and pass your ID and password to it.

3. When the connection is established, you will see session window on the screen.

4. (Optional) To communicate with the engineer, use the chat function.

To stop the session, click Close (   ).
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Technical Support

Customer support is provided by SmartPTT Technical Support Center. The official website of the Center is

support.smartptt.com.

To contact a support engineer, perform one of the following actions:

• Fill in and submit a support request on the website.

• Email a support request to support@smartptt.com.

In America, customer support is also provided by Elcomplus, Inc. To contact support engineers, use the following

contact information:

• Phone: +1 786-362-5525

• Email: miami@smartptt.com

• Mailbox: 290 NW 165th St, Ste P-200, 3rd Flr

Miami, FL, 33169, USA

SmartPTT Technical Support Center and Elcomplus, Inc. do not consult on deployment and maintenance of Motorola

Solutions products except on settings related to SmartPTT connection and data communication. For technical

support on Motorola Solutions products, please contact an authorized Motorola Solutions representative in your

region.

Customer Documentation

This document is authored and published by Elcomplus LLC. If you have any comments and suggestions on it, please

email them to support@smartptt.com.

No part of this document must be reproduced, quoted, or translated to another language without explicit

permission from Elcomplus LLC.
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